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Legal Notice

Aim and purpose
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Liability
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munications GmbH is only liable within the terms of its conditions of sale and supply and accepts no li-
ability for technical inaccuracies and/or omissions.

The information in this manual can be changed without notice. You will find additional information and
also release notes for funkwerk devices under www.funkwerk-ec.com .

Funkwerk devices make WAN connections as a possible function of the system configuration. You
must monitor the product in order to avoid unwanted charges. Funkwerk Enterprise Communications
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Trademarks

funkwerk trademarks and the funkwerk logo, bintec trademarks and the bintec logo, artem trademarks
and the artem logo, elmeg trademarks and the elmeg logo are registered trademarks of Funkwerk En-
terprise Communications GmbH.

Company and product names mentioned are usually trademarks of the companies or manufacturers
concerned.

Copyright

All rights reserved. No part of this manual may be reproduced or further processed in any way without
the written consent of Funkwerk Enterprise Communications GmbH. The documentation may not be
processed and, in particular, translated without the consent of Funkwerk Enterprise Communications
GmbH.

You will find information on guidelines and standards in the declarations of conformity under
www.funkwerk-ec.com .

How to reach Funkwerk Enterprise Communications GmbH

Funkwerk Enterprise Communications GmbH, Stidwestpark 94, D-90449 Nuremberg, Germany,
Phone: +49 180 300 9191 0, Fax: +49 180 300 9193 0

Funkwerk Enterprise Communications France S.A.S., 6/8 Avenue de la Grande Lande, F-33174
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Funkwerk Enterprise Communications GmbH 1 Introduction

Chapter 1 Introduction

The powerful devices bintec R1xxx/R3xxx/R4xxx have been specially developed for high-
speed Internet access and for VPN connections in SMEs and branch offices.

Safety notices

The safety precautions, which are supplied with your device, tell you what you need to take
into consideration when using your bintec gateway.

Installation

How to connect your device is shown in Setting Up and Connecting on page 6. This
chapter also tells you what preliminary tasks are necessary for configuration.

Configuration

How to get your device running is explained in Basic configuration on page 12. There we
show you how to start up your device from a Windows PC and how to install other useful
online assistants. At the end of the chapter, you will be in a position to surf the Internet,
send or receive e-mails and set up a connection to a partner network to access data at
your company head office, for example.

Password

If you are already familiar with configuring bintec devices and want to get started right
away, all you really need to know is the factory default user name and password.

&n Note

User Name: admin

Password: funkwerk

@ Note

Remember to change the password immediately when you log in to the device for the
first time. All bintec devices are supplied with the same password, which means they
are not protected against unauthorised access until you change the password. How to
change the passwords is described in chapter Passwords on page 103.

Workshops



Step-by-step instructions for the most important configuration tasks can be found in the
separate FEC Application Workshop guide for each application, which can be down-
loaded from the www.funkwerk-ec.com website from the Product menu under Solutions.

Dime Manager

The devices are also designed for use with Dime Manager. The Dime Manager manage-
ment tool can locate your Funkwerk devices within the network quickly and easily. The
.Net-based application, which is designed for up to 50 devices, offers easy to use functions
and a comprehensive overview of devices, their parameters and files.

By using SNMP multicast all of the devices in your local network can be located irrespect-
ive of their current IP address. A new IP address and password and other parameters can
also be assigned. A configuration can then be initiated over HTTP or TELNET. If using HT-
TP, the Dime Manager automatically logs into the devices on your behalf.

System software files and configuration files can be managed individually as required or in
logical groups for devices of the same type.

P R1xxx/R3xxx/R4xxx
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Funkwerk Enterprise Communications GmbH 2 About this guide

Chapter 2 About this guide

This document is valid for bintec devices with system software as of software version
7.9.1.

The Reference, which you have in front of you, contains the following chapters:

User's Guide - Reference

Chapter Description

Introduction You see an overview of the the device:

About this guide We explain the various components of this manual and how to
use it.

Installation This contains instructions for how to set up and connect your
device.

Basic configuration This chapter provides a step-by-step guide to the basic func-
tions on your device.

Reset This chapter explains how to reset your device to the ex works
state.

Technical data This section contains a description of all the device's technical
properties.

Access and configura-  This includes explanations about the different access and con-
tion figuration methods.

Assistants These chapters describe all configuration options of the Funk-
werk Configuration Interface. The individual menus are de-

System Management e in the order of navigation.

Physical Interfaces The individual chapters also contain more detailed explanations

LAN on the subsystem in question.

Wireless LAN
Routing

WAN

VPN

Firewall



2 About this guide Funkwerk Enterprise Communications GmbH

VolP

Local Services
Maintenance
External Reporting

Monitoring

Glossary The glossary contains a reference to the most important tech-
nical terms used in network technology.

The index lists all the key terms for operating the device and all
Index the configuration options and gives page numbers so they can
be found easily.

To help you locate information easily, this user's guide uses the following visual aids:

List of visual aids

Indicates practical information.

Indicates general and important points.

Indicates a warning of risk level Attention (points out possible
dangers that may cause damage to property if not observed).

Indicates a warning of risk level Warning (points out possible
dangers that may cause physical injury or even death if not ob-
served).

> B 6

The following typographical elements are used to help you find and interpret the informa-
tion in this user's guide:

Typographical elements
Typographical element |Use

Indicates lists.

Menu -> Submenu Indicates menus and sub-menus in the Funkwerk Configura-

tion Interface and Windows interface.
File -> Open



Typographical element |Use

Non-proportional Indicates commands that you must enter as written.
(Courier), e.g. ping

192.168.1.254

bold, e.g. Windows Indicates keys, key combinations and Windows terms.
Start menu

bold, e.g. biboAdmLo- Indicates fields in the Funkwerk Configuration Interface .
ginTable

italic, e.g. none Indicates values that you enter or that can be configured.

Online: blue and italic, Indicates hyperlinks.

e.g.
www.funkwerk-ec.com

R1xxx/R3xxx/R4xxx 5
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Chapter 3 Installation

f Caution

Please read the safety notices carefully before installing and starting up your device.
These are supplied with the device.

3.1 Setting Up and Connecting

Note

i

All you need for this are the cables and antennas supplied with the equipment.

f Caution

The use of the wrong mains adapter may damage your device. Only use the mains ad-
aptor supplied with the equipment.

Incorrect cabling of the ISDN and ETH interfaces may also damage your device. Con-
nect only the ETH interface of the device to the LAN interface of the computer/hub or a
WAN interface if available and the ISDN interface of the device only to the ISDN con-
nection.

6 R1xxx/R3xxx/R4xxx
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Fig. 2: Connection options using the example of R3000w
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Fig. 4: Connection options using the example of R41000

When setting up and connecting, carry out the steps in the following sequence (refer to the
connection diagrams for the individual devices in chapter Technical data on page 25):

(1) Antennas (only R1200w, R1200wu and R3000w): Screw the external standard anten-
nas provided to their RSMA connections Main and AUX and align the antennas.
(2) Place your device on a solid, level base.

(3) LAN
For the standard configuration of your device via Ethernet, connect the first switch
port (ETH1) of your device to your LAN using the Ethernet cable supplied. The
device automatically detects whether it is connected to a switch or directly to a PC.
(4) ADSL (only R3000 and R3000w)
Connect the ADSL interface (ADSL) of your device to the DSL output of the splitter
using the DSL cable supplied.

(5) SHDSL (only R3400 and R3800)

R1xxx/R3xxx/R4xxx 9



3 Installation
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Connect the SHDSL interface (SHDSL) of your device to the SHDSL connection us-
ing the DSL cable supplied.

(6) Mains connection
Connect the device to a mains socket using the mains adaptor supplied.

Optional connections

* |SDN
Connect the ISDN interface (ISDN or ISDN-x) of the device to your ISDN socket using
the ISDN cable provided.

e Other LANs/WANs
Connect any other terminals in your network to the remaining switch ports ETH2, ETH3
or ETH4) of your device using other Ethernet cables.

 Serial connection
For alternative configuration options, connect the serial interface of your PC with the seri-
al interface of the device. The serial interface can also be assigned to Ethernet socket 1

(ETH1). Use the serial cable provided, and if necessary connect your network to another
Ethernet socket. However, configuration via the serial interface is not provided by default.

e xDSL modem or DMZ
Connect the WAN interface (ETH5/DMZ) of your device to an xDSL modem (not sup-
plied) via another Ethernet cable or with the Ethernet connection on your DMZ.

¢ PRI (only R4100)

Connect the ISDN PRI interface (PRI-0 or PRI-1) of the device to your PRI connection.
¢ X.21 (only R4300)

Connect an X.21 interface on your device to your X.21/V.35 or X.21/V.36 connection us-
ing a suitable cable (which you can order as an accessory for your router). Make sure
that you use an enabled X.21 interface. The left X.21 interface on the back of the device
is enabled by default ex works. The right X.21 interface can also be enabled if licensed.

e UMTS (only R1200wu)
Insert the UMTS card into the CardBus / UMTS slot.

The device is now prepared for configuration using the Funkwerk Configuration
Interface.



3.2 Cleaning

You can clean your device easily. Use a damp cloth or antistatic cloth. Do not use solvents.
Never use a dry cloth; the electrostatic charge could cause electronic faults. Make sure that
no moisture can enter the device and cause damage.

3.3 Support Information
If you have questions about your product or are looking for additional information, the Funk-
werk Enterprise Communications GmbH Support Centre can be reached Monday to Friday

between the hours of 8.30 am and 5 pm. They can be contacted as follows:

e-mail hotline @ funkwerk-ec.com
International Support Coordina- Telephone: +49 180 300 9191 550
tion

Fax: +49 180 300 9191 599

End-customer Hotline 0900 110 2636 (1.24 €/min on land-lines in Germany)

For detailed information on our support services, contact www.funkwerk-ec.com.

R1xxx/R3xxx/R4xxx
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Chapter 4 Basic configuration

You configure your device using the Funkwerk Configuration Interface.

The way to obtain the basic configuration is explained below step-by-step. Detailed know-
ledge of networks is not necessary. A detailed online help system gives you extra support.

The Companion CD also supplied includes all the tools that you need for the configuration
and management of your device.

The BRICKware contains useful applications for managing your device.

4.1 Presettings

4.1.1 Preconfigured data

Your device is shipped with a pre-defined IP configuration:

e I[P Address: 192.168.0.254
e Netmask: 255.255.255.0

Use the following access data to configure your device in an ex works state:

e User Name: admin

e Password: funkwerk

Note

All bintec devices are delivered with the same username and password. As long as
the password remains unchanged, they are therefore not protected against unauthor-
ised use. Make sure you change the passwords to prevent unauthorised access to
your device!

4.1.2 Software update

Your device contains the version of the system software available at the time of production.
More recent versions may have since been released. You can easily perform an update
with the Funkwerk Configuration Interface using the Maintenance-> Software & Con-
figuration menu.
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4.2 System requirements

Your bintec gateway contains extensive features for encrypted data transfer and Internet
access for both individual users and companies.

For configuration of the device, your PC must meet the following system requirements:

* Microsoft Windows operating system Windows 2000 or higher

¢ Internet Explorer 6 or 7, Mozilla Firefox Version 1.2 or higher

Installed network card (Ethernet)
e CD ROM drive
Installed TCP/IP log

* High colour display (more than 256 colours) for correct representation of the graphics

4.3 Preparations

To prepare for configuration, you need to...

* have the data for the basic configuration and the Internet connection to hand and also
gather the data needed for connecting the required WLAN clients.

» check whether the PC from which you want to perform the configuration meets the ne-
cessary requirements.

You can also...

¢ install the BRICKware software, which provides more tools for working with your device.
This installation is optional and not essential for the configuration or operation of the
device.

4.3.1 Gathering data

You can gather the main data for configuration with the Funkwerk Configuration Inter-
face quickly, because you do not need any information that requires in-depth knowledge of
networks.

If necessary, you can use the sample values.

Before you start the configuration, you should gather the data for the following purposes:

¢ Basic configuration (if your device is in the ex works state)

¢ Internet access (optional)
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* Wireless LAN (optional, only for R1200w, R1200wu and R300w)

» Connecting to a corporate network (optional)

The following table shows examples of possible values for the necessary access data. You
can enter your personal data in the "Your values" column, so that you can refer to these
values later when needed.

If you configure a new network, you can use the given example values for IP addresses
and netmasks. In cases of doubt, ask your system administrator.

Basic configuration

For a basic configuration of your gateway, you need information that relates to your net-
work environment:

Basic information

Access data Example value Your values

IP address of your gateway 192.168.0.254
Netmask of your gateway 255.255.255.0

Internet Access

If you want to set up Internet access, you need an Internet Service Provider (ISP). You also
receive your personal access data from your ISP. The terms used for the required access
data may vary from provider to provider. However, the type of information you need for dial-
in in is basically the same.

The following table lists the access data that your device also needs for a DSL connection
to the Internet.

Data for Internet access

Access data Example value Your values
Provider name GoInternet
Protocol PPP over Ethernet
(PPPOE)
Encapsulation bridged-no-fcs
VPI (Virtual Path Identifier) 1
VCI (Virtual Circuit Identifier) 32
Your user name MyName
Password TopSecret

Some Internet Service Providers, such as T-Online, require additional information:
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Additional information for T-Online

Access data Example value Your values

T-Online number 081512345678

Joint user account 0001

@ Note

To configure T-Online Internet access, in the Username field, enter the following suc-
cession of numbers without intervening spaces:

User account (12 digits) + T-Online number (usually 12 digits) + co-user number (for
the main user, always 0001).

If your T-Online number is less than 12 digits long, a "#" character is required between
the T-Online number and the co-user number.

If you use T-DSL, you must add the character string "@t-online.de" at the end of this
string of numbers.

You username could, for example, look like this:

00012345678906112345678#0001 @t-online.de

Wireless LAN (only for bintec R1200w, bintec R1200wu and bintec R3000w)

You can operate your device as an access point and therefore connect individual work sta-
tions (e.g. laptops, PCs with wireless card or wireless adapter) by wireless connections to
your local network via WLAN (Wireless LAN) and let them communicate with each other.
The table "Data for the Wireless LAN configuration" shows the information required.

As data can be transmitted over the air in the WLAN, this data can in theory be intercepted
and read by any attacker with the appropriate resources. Particular attention must therefore
be paid to protecting the wireless connection.

Note the following:

* Follow the safety precautions when configuring your WLAN.

¢ Please also read the information on WLAN operation published by the Federal Office for
Information Security, see http://www.bsi.bund.de.

Data for the Wireless LAN configuration
Access data Example value Your values

Preshared key for WPA-PSK without default
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Access data Example value Your values

Installation location of your device Germany

Channel to be used for WLAN 3

Network name (SSID) for your without default
WLAN

Visibility of the network name not visible
Security setting WPA-PSK

Company network connection

To connect a remote network (e.g. head office), you need to know some data of the remote
terminal that will take your call. The remote terminal must also know your details. You have
to agree this data between you.

Your device and the device at your head office check before every connection to see if they
should take the call from the partner. To protect the network against unauthorised access,
the call is accepted only after correct authentication. This authentication is based on a com-
mon password and two codes that you and your partner use for the connection.

Data for connection to a company network
Access data Example value Your values

Partner name BigBoss

(Key of company head office)

Dial-in number: 0911987654321

(Call number of the company head
office's device)

Local name LittleIndian

(Your own code. Your partner (the
head office) must enter this name
as the partner name on its device.)

Password Secret

(Common password for this con-
nection, entered on both devices.)
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Access data Example value Your values

Network address(es) of the com-  10.1.1.0
pany head office

Netmask(s) of the company head 255.255.255.0
office

4.3.2 Configuring a PC

In order to reach your device via the network and to be able to carry out configuration using
the Express Setup Assistant, the PC used for the configuration has to satisfy some pre-
requisites.

* Make sure that the TCP/IP protocol is installed on the PC.

 Assign fixed IP address to your PC.

Checking the TCP/IP protocol

Proceed as follows to check whether you have installed the protocol:

(1) Click the Windows Start button and then Settings -> Network and Dial-up Connec-
tions (Windows 2000) or Settings -> Network Connections (Windows XP).

(2) Click on LAN Connection.
(3) Click on Properties in the status window.

(4) Look for the Internet Protocol (TCP/IP) entry in the list of network components.

Installing the TCP/IP protocol

If you cannot find the Internet Protocol (TCP/IP) entry, install the TCP/IP protocol as fol-
lows:

(1) First click Properties, then Install in the status window of the LAN Connection.
(2) Select the Protocol entry.

(3) Click Add.
(
(

~

4) Select Internet Protocol (TCP/IP) and click on OK.

~

5) Follow the on-screen instructions and restart your PC when you have finished.

Allocating PC IP address

Allocate an IP address to your PC as follows:

(1) Select Internet Protocol (TCP/IP) and click on Properties.
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(2) Choose Use next IP address and enter a suitable IP address.

Entering the gateway IP address in your PC
Then continue by entering the IP address of the gateway in the configuration of your PC as
follows:

(1) In Internet Protocol (TCP/IP) -> Properties under Default gateway, enter the IP ad-
dress of your gateway.

(2) Enter the IP address of your device under Use next DNS server address.
(3) Click OK.
(4) Close the status window with OK.

The computer now has an IP configuration and can access the Internet via the gateway.

&n Note

You can open the Funkwerk Configuration Interface by entering the IP address of
your device (192.168.0.254) in a supported browser (Internet Explorer 6 or 7, Mozilla
Firefox version 1.2 or later) and entering the pre-configured login information ( User:
admin, Password: funkwerk).

4.4 Modify system password

All bintec devices are delivered with the same username and password. As long as the
password remains unchanged, they are therefore not protected against unauthorised use.
Make sure you change the passwords to prevent unauthorised access to your device!

Proceed as follows:

(a) Go to System Management -> Global Settings -> Passwords
(b

(c) Enter the new password again under Confirm Admin Password .
(d) Click OK.

(e

~

Enter a new password under System Admin Password .

~

) Save the configuration by clicking on the Save Configuration button above the menu
navigation.

Note the following rules on password use:

* The password must not be easy to guess. Names, car registration numbers, dates of
birth, etc. should not be chosen as passwords.
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¢ The password should contain at least one character that is not a letter (special character
or number).

e The password should be at least 8 characters long.

* Change your password regularly, e.g. every 90 days.

4.5 Setting up an ADSL connection

(1) Go to the WAN -> ATM -> Profiles menu. There is a pre-configured profile that you
can adapt to your requirements.

(2) Choose [ to check the settings of the existing profile.

(3) Simply check that the values for Virtual Path Identifier (VPI) and Virtual Channel
Identifier (VCI) and the Encapsulation agree with the data that you received from
your ISP. If you did not receive this data, keep the default values. The value Ether-
net over ATM for Type corresponds to a PPPoE connection.

4) Change the description of the profile as required, e.9. GoInternet.
5) Once you have made the changes, confirm them with OK.

6) Now go to the Internet+Dialup ->PPPoE menu and click on New.

(
(
(
(7) Enter a Description for the connection, e.g. GoInternet.
(8) For PPPoE Ethernet Interface, select ethoa50-0.

(9) As User Name and Password, enter the access data provided by your ISP.
(

10) If you have an interface with a flatrate, check Always Active. This means the ADSL
connection is always on and is re-established each time it is terminated.

(11) Check Default Route and Create NAT Policy .

(12) Leave the default settings for all other values.

(13) Confirm with OK. You return to the overview of PPPoE connections.
(14)

If the connection is active, you will see the following symbol in the Status column: £y.

However, this does not automatically have to be the case, therefore you should check
the connection as described in Testing the Configuration on page 19.

(15) Save the configuration by clicking on the Save Configuration button above the menu
navigation.
4.5.1 Testing the Configuration

Once you have completed the configuration of your device, you can test the connection in
your LAN and to the Internet.

Carry out the following steps to test your device:
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)
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Test the connection to your device. Click Run in the Start menu and enter ping, fol-
lowed by a space and the IP address of your system (e.g. 192.168.0.254). A win-
dow appears with the response "Reply from...".

Test Internet access by entering www.funkwerk-ec.com in the Internet browser. Funk-
werk Enterprise Communications GmbH's Internet site offers you the latest news, up-
dates and documentation.

Note

Incorrect configuration of the devices in your LAN may result in unwanted connections
and increased charges! Monitor your device and make sure it only sets up connections
at the times you want it to. Watch the LEDs on your device (LED for ISDN, ADSL and
the Ethernet interface to which you have connected one or more WANS).

4.6 Setting up wireless LAN

Proceed as follows to use your device (only bintec R1200w, R1200wu and R3000w) as an
access point in WPA-PSK mode:

(1)
)

(8)

9)

Go to the Wireless LAN -> WLAN menu. One VSS is pre-configured: Funkwerk-ec.
Choose [i&] to modify the settings of the existing VSS.

Set operation mode to Access Point and confirm your entry with OK.

You can now configure a wireless network in the Wireless LAN -> WLAN -> Virtual
Service Sets -> New VSS menu.

Change the Network Name (SSID) as desired, e.g. Client-1.
Under Security Mode, select wpA-PSK.

Under Preshared Key, enter a password of your choice. This must be at least eight
characters long, and for security reasons should contain special characters, numbers,
and upper and lower case.

Retain the default values for all the other fields and confirm with OK. You return to the
VSS overview.

In the line for the VSS that you have just configured, under Action, click on |E| to ac-
tivate the VSS and the wireless module.

(10) Save the configuration by clicking on the Save Configuration button above the menu

navigation.
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4.6.1 Configuring the WLAN Adapter under Windows XP

After installing the drivers for your WLAN card, Windows XP set up a new connection in the
network environment. Proceed as follows to configure the Wireless LAN connection:

(1) Right-click on Start -> Settings ->Network Connections -> Wireless Network Con-
nections.

(2) Select Properties.
(3) Go to the Wireless networks tab.
(4) Click Add.

Proceed as follows:

(1) Enter a Network Name, e.g. C1ient-1.

(2) Set Network Authentication to wpA-PSK.

(3) Set Data Encryption to TKTP.

(4) Under Network Key and Confirm Network Key, enter the configured preshared key.
(5) Exit each menu with OK.

4.7 Software Update

The range of functions of bintec devices is continuously being extended. These extensions
are made available to you by Funkwerk Enterprise Communications GmbH free of charge.
Checking for new software versions and the installation of updates can be carried out eas-
ily with the Funkwerk Configuration Interface. An existing internet connection is needed
for an automatic update.

Proceed as follows:

(1) In the menu Maintenance -> Software & Configuration.

(2) Under Action, select Update System Software and, under Source, Latest
Software from Funkwerk Server.

(3) Then click GO.
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The device will now connect to the Funkwerk Enterprise Communications GmbH download
server and check whether an updated version of the system software is available. If so,
your device will be updated automatically. When installation of the new software is com-
plete, you will be invited to restart the device.

Caution

Once you have clicked on GO , the update cannot be cancelled/interrupted. If an error
occurs during the update, do not re-start the device and contact support.

R1xxx/R3xxx/R4xxx



Funkwerk Enterprise Communications GmbH 5 Reset

Chapter 5 Reset

If the configuration is incorrect or if your device cannot be accessed, you can reset the
device to the ex works standard settings using a special reset procedure.

Practically al existing configuration data will then be ignored, only the current user pass-
words are retained. Configurations stored in the device are not deleted and can, if required,
be reloaded when the device is rebooted.

Proceed as follows:

(1) If your device is in operation, switch it off and then on again. The device runs through
the boot sequence.

(2) Observe the LEDs on the front of your device. After the device runs through the start
mode, the yellow LEDs on the right block light at the same.

(3) Switch off the device while the LEDs light on the right block. You have about four
seconds for this.

(4) Repeat the on/off operation twice. Your router has now been switched on and off three
times altogether.

(5) Switch on your router for the fourth time. If you do not interrupt the boot sequence this
time, the router starts in the "factory reset" state. This state is indicated by the LEDs
on the right block flashing three times.

If you switch the equipment off and on again, it starts with the saved boot configura-
tion.

Proceed as follows if you also want to reset all the user passwords to the ex works state
and delete stored configurations when resetting the device:

* Set up a serial connection to your device. Reboot your device and monitor the boot se-
quence. Read the message Press <sp> for boot monitor or any other key
to boot system. Start the BOOTmonitor, choose (4) Delete Configuration and follow
the instructions.

or

* Carry out the reset procedure described above by switching on and off. Next establish a
serial connection or a Telnet connection (Telnet: Use the IP address of the ex works
standard settings) for your device. At the login prompt enter erase bootconfig as the
Login in the command line. Leave the password empty and press the Return key. The
device runs through the boot sequence again.
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Note

The device is also reset to ex works state including all user passwords if you switch
the device on and off five times instead of three times when the device is off.

Note

If you delete the boot configuration using the Funkwerk Configuration Interface
(menu Maintenance -> Software & Configuration), all passwords will also be reset
and the current boot configuration deleted. The next time, the device will boot with the
standard ex works settings.

You can now configure your device again as described from Basic configuration on page
12.

R1xxx/R3xxx/R4xxx
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This chapter summarises all the hardware properties of the R1200, R1200w, R1200wu,

R3000, R3000w, R3400, R3800, R4100 and R4300 devices.

6.1 Scope of supply

Your device is supplied with the following parts:

Cable sets/mains unit/
other

Software

Documentation

R1200

Ethernet cable
ISDN cable
Serial connecting cable

Mains unit

bintec Companion CD

Quick Install Guide (printed)
User's Guide (on CD)
Release Notes, if required

Safety notices

R1200w

Ethernet cable

ISDN cable

Serial connecting cable
Mains unit

2 standard antennas

bintec Companion CD

Quick Install Guide (printed)
User's Guide (on CD)
Release Notes, if required

Safety notices

R1200wu

Ethernet cable

ISDN cable

Serial connecting cable
Mains unit

2 standard antennas

bintec Companion CD

Quick Install Guide (printed)
User's Guide (on CD)
Release Notes, if required

Safety notices

R3000

Ethernet cable
ISDN cable
Serial connecting cable

Mains unit
2 DSL cables (for Annex A
and for Annex B)

bintec Companion CD

Quick Install Guide (printed)
User's Guide (on CD)
Release Notes, if required

Safety notices

R1xxx/R3xxx/R4xxx



Cable sets/mains unit/
other

Software

Documentation

R3000w

Ethernet cable
ISDN cable
Serial connecting cable

Mains unit
2 DSL cables (for Annex A
and for Annex B)

2 standard antennas

bintec Companion CD

Quick Install Guide (printed)
User's Guide (on CD)
Release Notes, if required

Safety notices

R3400

Ethernet cable
ISDN cable
Serial connecting cable

Mains unit
DSL cable

bintec Companion CD

Quick Install Guide (printed)
User's Guide (on CD)
Release Notes, if required

Safety notices

R3800

Ethernet cable

ISDN cable

Serial connecting cable
Mains unit

DSL cable

Splitter (Y adapter)

bintec Companion CD

Quick Install Guide (printed)
User's Guide (on CD)
Release Notes, if required

Safety notices

R4100

Ethernet cable

ISDN cable

Serial connecting cable
Mains unit

Splitter (Y adapter)

bintec Companion CD

Quick Install Guide (printed)
User's Guide (on CD)
Release Notes, if required

Safety notices

R4300

Ethernet cable

ISDN cable

Serial connecting cable
Mains unit

X.21 DTE (optional)

bintec Companion CD

Quick Install Guide (printed)
User's Guide (on CD)
Release Notes, if required

Safety notices

R1xxx/R3xxx/R4xxx
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other

Cable sets/mains unit/

X.21 DCE (optional)

V.35 DTE (optional)

Software

6.2 General Product Features

Documentation

The general product features cover performance features and the technical prerequisites

for installation and operation of your device.

General product features bintec R1200, bintec R1200w, bintec R1200wu

Product name

bintec R1200

bintec R1200w

bintec R1200wu

Dimensions and
weights:

Equipment dimensions
without cable (B x H x
D):

295 mm x 45 mm x 160
mm

295 mm x 45 mm x 160
mm + 8 mm (antenna
socket)

295 mm x 45 mm x 160
mm + 8 mm (antenna
socket)

Weight

approx. 1,260 g

approx. 1,260 g

approx. 1,260 g

Transport weight (incl.
documentation,
cables, packaging)

approx. 2.6 kg

approx. 2.6 kg

approx. 2.6 kg

Memory 32 MB SDRAM, 32 MB SDRAM, 32 MB SDRAM,
8 MB flash ROM 8 MB flash ROM 8 MB flash ROM
LEDs 18 (1x Power, 1x Status, 20 (1x Power, 1x Status, 20 (1x Power, 1x Status,

Power consumption of
the device

5x2 Ethernet, 3x2 Func-
tion)

max. 15 Watt, normally
13 Watt

5x2 Ethernet, 4x2 Func-
tion)

max. 15 Watt, normally
13 Watt

5x2 Ethernet, 4x2 Func-
tion)

max. 15 Watt, normally
13 Watt

Voltage supply

15V AC 1.3 AEU PSU

15V AC 1.3 AEU PSU

24V AC1AEUPSU

Environmental require-
ments:

Storage temperature

-20° to +70 °C

-20°to +70 °C

-20°to +70 °C

Operating temperature

0°to 40 °C

0°to 40 °C

0°to 40 °C
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Product name

Relative atmospheric
humidity

bintec R1200

10 % to 90 % non-
condensing in operation,

5 % to 95 % non-
condensing when stored

Funkwerk Enterprise Communications GmbH

bintec R1200w

10 % to 90 % non-
condensing in operation,

5 % t0 95 % non-
condensing when stored

bintec R1200wu

10 % to 90 % non-
condensing in operation,

5 % to 95 % non-
condensing when stored

Room classification

Only use in dry rooms.

Only use in dry rooms.

Only use in dry rooms.

Available interfaces:

Ethernet IEEE 802.3
LAN (4-port switch), a
port with serial inter-
face function

ISDN-WAN S0 (2)
DMZ/ETH5

WLAN interface
(antennas)

Permanently installed
(twisted pair only),
10/100 mbps, auto-
sensing, MDIX; supports
Baud rates: 1200, 2400,
4800, 9600, 19200,
38400, 57600, 115200
Baud

Permanently installed

Additional Ethernet
switch port

Permanently installed
(twisted pair only),
10/100 mbps, auto-
sensing, MDIX; supports
Baud rates: 1200, 2400,
4800, 9600, 19200,
38400, 57600, 115200
Baud

Permanently installed

Additional Ethernet
switch port

802.11b, 802.11g and
802.11a with Antenna
Diversity

Permanently installed
(twisted pair only),
10/100 mbps, auto-
sensing, MDIX; supports
Baud rates: 1200, 2400,
4800, 9600, 19200,
38400, 57600, 115200
Baud

Permanently installed

Additional Ethernet
switch port

802.11b, 802.11g and
802.11a with Antenna
Diversity

CardBus interface
(PCMCIA)

Available sockets:

Serial interface V.24

Ethernet interface

ISDN interface

CardBus interface

Standards &
Guidelines

SAFERNET TM Se-
curity Technology

RJ45 socket

RJ45 socket

RJ45 socket

R&TTE Directive
1999/5/EC

CE symbol for all EU
states

Community passwords,
PAP, CHAP, MS-CHAP,
MS-CHAP v.2, PPTP,

RJ45 socket

RJ45 socket

RJ45 socket

R&TTE Directive
1999/5/EC

CE symbol for all EU
states

Community passwords,
PAP, CHAP, MS-CHAP,
MS-CHAP v.2, PPTP,

Interface for integrating a
UMTS modem card

RJ45 socket

RJ45 socket

RJ45 socket
68-pole PCMCIA socket

R&TTE Directive
1999/5/EC

CE symbol for all EU
states

Community passwords,
PAP, CHAP, MS-CHAP,
MS-CHAP v.2, PPTP,



Product name bintec R1200 bintec R1200w bintec R1200wu
PPPoE, PPPoA, Call- PPPoE, PPPoA, Call- PPPoE, PPPoA, Call-
back, Access Control back, Access Control back, Access Control

Lists, CLID, NAT, SIF, Lists, CLID, NAT, SIF, Lists, CLID, NAT, SIF,
MPPE Encryption, PPTP MPPE Encryption, PPTP MPPE Encryption, PPTP
Encryption, VPN with Encryption, VPN with Encryption, VPN with
PPTP or IPSec PPTP or IPSec PPTP or IPSec

Software supplied BRICKware for Windows | BRICKware for Windows BRICKware for Windows

BRICKtools for Unix BRICKtools for Unix BRICKtools for Unix

Printed documentation Quick Reference Quick Reference Quick Reference
supplied
Online documentation User's Guide User's Guide User's Guide

BRICKware for Windows BRICKware for Windows BRICKware for Windows

Software Reference Software Reference Software Reference

General product features bintec R3000, bintec R3000w

Product name bintec R3000 bintec R3000w

Dimensions and

weights:

Equipment dimensions 295 mm x 45 mm x 160 mm 295 mm x 45 mm x 160 mm + 8 mm
without cable (B x H x (antenna socket)

D):

Weight approx. 1,260 g approx. 1,260 g

Transport weight (incl. | approx. 2.6 kg approx. 2.6 kg

documentation,

cables, packaging)

Memory 32 MB SDRAM, 32 MB SDRAM,
8 MB flash ROM 8 MB flash ROM

LEDs 18 (1x Power, 1x Status, 5x2 Ether- 20 (1x Power, 1x Status, 5x2 Ether-
net, 3x2 Function) net, 4x2 Function)

Power consumption of 'max. 15 Watt, normally 13 Watt max. 15 Watt, normally 13 Watt

the device

Voltage supply 15V AC 1.3 AEU PSU 15V AC 1.3 AEU PSU

R1xxx/R3xxx/R4xxx



Product name

bintec R3000

bintec R3000w

Environmental require-
ments:

Storage temperature

-20°1t0 +70 °C

-20°t0 +70 °C

Operating temperature

0°to 40 °C

0°to 40 °C

Relative atmospheric
humidity

10 % to 90 % non-condensing in op-
eration,

5 % to 95 % non-condensing when
stored

10 % to 90 % non-condensing in op-
eration,

5 % to 95 % non-condensing when
stored

Room classification

Only use in dry rooms.

Only use in dry rooms.

Available interfaces:

ADSL interface

Internal ADSL modem for Annex A
and Annex B

Internal ADSL modem for Annex A
and Annex B

Ethernet IEEE 802.3
LAN (4-port switch), a
port with serial inter-
face function

Permanently installed (twisted pair
only), 10/100 mbps, autosensing,
MDIX; supports Baud rates: 1200,
2400, 4800, 9600, 19200, 38400,
57600, 115200 Baud

Permanently installed (twisted pair
only), 10/100 mbps, autosensing,
MDIX; supports Baud rates: 1200,
2400, 4800, 9600, 19200, 38400,
57600, 115200 Baud

ISDN-WAN S0 (2)

Permanently installed

Permanently installed

DMZ/ETH5 Additional Ethernet switch port Additional Ethernet switch port
WLAN interface - 802.11b, 802.11g and 802.11a with
(antennas) Antenna Diversity. Data rates 1, 2,

Available sockets:

5.5,6,9, 11,12, 18, 24, 36, 48, 54
mbps 1-, 2-, 5.5-, 6-, 9-, 11-, 12-, 18-,
24-, 36-, 48-, 54 mbps

Serial interface V.24 RJ45 socket RJ45 socket
Ethernet interface RJ45 socket RJ45 socket
ISDN interface RJ45 socket RJ45 socket
ADSL interface RJ45 socket RJ45 socket

Standards &
Guidelines

R&TTE Directive 1999/5/EC

CE symbol for all EU states

R&TTE Directive 1999/5/EC

CE symbol for all EU states

R1xxx/R3xxx/R4xxx
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Product name

bintec R3000

bintec R3000w

SAFERNET TM Se-
curity Technology

Community passwords, PAP, CHAP,
MS-CHAP, MS-CHAP v.2, PPTP,
PPPoE, PPPoA, Callback, Access
Control Lists, CLID, NAT, SIF, MPPE
Encryption, PPTP Encryption, VPN
with PPTP or IPSec

Community passwords, PAP, CHAP,
MS-CHAP, MS-CHAP v.2, PPTP,
PPPoE, PPPoA, Callback, Access
Control Lists, CLID, NAT, SIF, MPPE
Encryption, PPTP Encryption, VPN
with PPTP or IPSec

Software supplied

BRICKware for Windows

BRICKtools for Unix

BRICKware for Windows

BRICKtools for Unix

Printed documentation
supplied

Online documentation

General product features bintec R3400, bintec R3800

Quick Reference

User's Guide
BRICKware for Windows

Software Reference

Quick Reference

User's Guide
BRICKware for Windows

Software Reference

Product name

bintec R3400

bintec R3800

Dimensions and
weights:

Equipment dimensions
without cable (B x H x
D):

295 mm x 45 mm x 160 mm

295 mm x 45 mm x 160 mm

Weight

approx. 1,260 g

approx. 1,260 g

Transport weight (incl.
documentation,
cables, packaging)

approx. 2.6 kg

approx. 2.6 kg

Memory 32 MB SDRAM, 32 MB SDRAM,
8 MB flash ROM 8 MB flash ROM
LEDs 18 (1x Power, 1x Status, 5x2 Ether- 20 (1x Power, 1x Status, 5x2 Ether-

net, 3x2 Function)

net, 4x2 Function)

Power consumption of
the device

max. 15 Watt, normally 10 Watt

max. 15 Watt, normally 12 Watt

Voltage supply

15V AC 1.3 AEU PSU

15V AC 1.3 AEU PSU




Product name

bintec R3400

bintec R3800

Environmental require-
ments:

Storage temperature

-20°1t0 +70 °C

-20°t0 +70 °C

Operating temperature

0°to 40 °C

0°to 40 °C

Relative atmospheric
humidity

10 % to 90 % non-condensing in op-
eration,

5 % to 95 % non-condensing when
stored

10 % to 90 % non-condensing in op-
eration,

5 % to 95 % non-condensing when
stored

Room classification

Only use in dry rooms.

Only use in dry rooms.

Available interfaces:

SHDSL interface

Internal SHDSL 4-wire modem for An-
nex A and Annex B.

Bonding technology with 2-wire/4-wire
as an inverse multiplexer - performed
over IMA in accordance with the ATM
forum.

Internal SHDSL 8-wire modem for An-
nex A and Annex B.

Bonding technology with
2-wire/4-wire/6-wire/8-wire as an in-
verse multiplexer - performed over
IMA in accordance with the ATM for-
um.

Ethernet IEEE 802.3
LAN (4-port switch), a
port with serial inter-
face function

Permanently installed (twisted pair
only), 10/100 mbps, autosensing,
MDIX; supports Baud rates: 1200,
2400, 4800, 9600, 19200, 38400,
57600, 115200 Baud

Permanently installed (twisted pair
only), 10/100 mbps, autosensing,
MDIX; supports Baud rates: 1200,
2400, 4800, 9600, 19200, 38400,
57600, 115200 Baud

ISDN-WAN S0 (2)

Permanently installed

Permanently installed

DMZ/ETH5

Additional Ethernet switch port

Additional Ethernet switch port

Available sockets:

Serial interface V.24 RJ45 socket RJ45 socket
Ethernet interface RJ45 socket RJ45 socket
ISDN interface RJ45 socket RJ45 socket
SHDSL interface
RJ45 socket RJ45 socket
Standards & R&TTE Directive 1999/5/EC R&TTE Directive 1999/5/EC
Guidelines

R1xxx/R3xxx/R4xxx
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Product name

bintec R3400

bintec R3800

CE symbol for all EU states

CE symbol for all EU states

SAFERNET TM Se-
curity Technology

Community passwords, PAP, CHAP,
MS-CHAP, MS-CHAP v.2, PPTP,
PPPoE, PPPoA, Callback, Access
Control Lists, CLID, NAT, SIF, MPPE
Encryption, PPTP Encryption, VPN
with PPTP or IPSec

Community passwords, PAP, CHAP,
MS-CHAP, MS-CHAP v.2, PPTP,
PPPoE, PPPoA, Callback, Access
Control Lists, CLID, NAT, SIF, MPPE
Encryption, PPTP Encryption, VPN
with PPTP or IPSec

Software supplied

BRICKware for Windows

BRICKtools for Unix

BRICKware for Windows

BRICKtools for Unix

Printed documentation
supplied

Quick Reference

Quick Reference

Online documentation

General product features bintec R4100, bintec R4300

User's Guide

BRICKware for Windows

Software Reference

User's Guide

BRICKware for Windows

Software Reference

Product name

bintec R4100

bintec R4300

Dimensions and
weights:

Equipment dimensions
without cable (B x H x
D):

295 mm x 45 mm x 160 mm

295 mm x 45 mm x 160 mm

Weight

approx. 1,260 g

approx. 1,260 g

Transport weight (incl.
documentation,
cables, packaging)

approx. 2.6 kg

approx. 2.6 kg

Memory 32 MB SDRAM, 32 MB SDRAM,
8 MB flash ROM 8 MB flash ROM
LEDs 20 (1x Power, 1x Status, 5x2 Ether- 20 (1x Power, 1x Status, 5x2 Ether-

Power consumption of
the device

net, 4x2 Function)

max. 15 Watt, normally 10 Watit

net, 4x2 Function)

max. 15 Watt, normally 13 Watt




Product name

bintec R4100

bintec R4300

Voltage supply

24V AC1AEUPSU

15V AC 1.3 AEU PSU

Environmental require-
ments:

Sto rage temperature

-20° to +70 °C

-20° to +70 °C

Operating temperature

0°t0 40 °C

0°to 40 °C

Relative atmospheric
humidity

10 % to 90 % non-condensing in op-
eration,

5 % to 95 % non-condensing when
stored

10 % to 90 % non-condensing in op-
eration,

5 % to 95 % non-condensing when
stored

Room classification

Only use in dry rooms.

Only use in dry rooms.

Available interfaces:

Ethernet IEEE 802.3
LAN (4-port switch), a
port with serial inter-
face function

ISDN-WAN S0 (2)

Permanently installed (twisted pair
only), 10/100 mbps, autosensing,
MDIX; supports Baud rates: 1200,
2400, 4800, 9600, 19200, 38400,
57600, 115200 Baud

Permanently installed

Permanently installed (twisted pair
only), 10/100 mbps, autosensing,
MDIX; supports Baud rates: 1200,
2400, 4800, 9600, 19200, 38400,
57600, 115200 Baud

Permanently installed

ISDN-PRI (2)

Permanently installed

DMZ/ETH5
X.21 interface (2)

Additional Ethernet switch port

Additional Ethernet switch port

Permanently installed

Available sockets:

Serial interface V.24 RJ45 socket RJ45 socket
Ethernet interface RJ45 socket RJ45 socket
ISDN interface RJ45 socket RJ45 socket
ISDN-PRI interface RJ45 socket -

X.21 interface - RJ45 socket

Standards &
Guidelines

SAFERNET TM Se-

R&TTE Directive 1999/5/EC

CE symbol for all EU states

Community passwords, PAP, CHAP,

R&TTE Directive 1999/5/EC

CE symbol for all EU states

Community passwords, PAP, CHAP,

R1xxx/R3xxx/R4xxx
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Product name

curity Technology

Software supplied

Printed documentation
supplied

bintec R4100

MS-CHAP, MS-CHAP v.2, PPTP,
PPPoE, PPPoA, Callback, Access
Control Lists, CLID, NAT, SIF, MPPE
Encryption, PPTP Encryption, VPN
with PPTP or IPSec

BRICKware for Windows

BRICKTtools for Unix

Quick Reference

6 Technical data

bintec R4300

MS-CHAP, MS-CHAP v.2, PPTP,
PPPoE, PPPoA, Callback, Access
Control Lists, CLID, NAT, SIF, MPPE
Encryption, PPTP Encryption, VPN
with PPTP or IPSec

BRICKware for Windows

BRICKTtools for Unix

Quick Reference

Online documentation

Note

User's Guide

BRICKware for Windows

Software Reference

Antenna Diversity

User's Guide

BRICKware for Windows

Software Reference

The two antennas do not have equality of access. One is used both to transmit and re-
ceive (marked as "main", "primary" or "1"; the antenna next to the power switch), the
other is only used to receive. During reception, the AP (Access Point) checks which
antenna is receiving a better signal. This is then used for decoding.

6.3 LEDs

The device LEDs provide information on certain activities and statuses of the device.

The LEDs on bintec R1200 are arranged as follows:

Fig. 5: LEDs on bintec R1200

In operation mode, the LEDs on bintec R1200 display the following status information for

your device:



6 Technical data Funkwerk Enterprise Communications GmbH

LED status display
Power on The power supply is connected.
State Permanently on or Error.

off

flashing The device is active.
ETH1to5 on The device is connected to the Ethernet.
Top row

flashing Data traffic via the Ethernet interface.
ETH1to5 on Data traffic at 100 mbps.
Bottom row

off Data traffic at 10 mbps.
ISDN-0 B/D on ISDN D-channel is active.
Top row
ISDN-0 B/D on One ISDN B-channel is active.
Bottom row

flashing Both ISDN B-channels are active.
ISDN-1 B/D on ISDN D-channel is active.
Top row
ISDN-1 B/D on One ISDN B-channel is active.
Bottom row

flashing Both ISDN B-channels are active.
MA / HA flashing BRRP packets are received.

Top row



Funkwerk Enterprise Communications GmbH 6 Technical data

MA / HA on A user is logged in to the system (e.g. over Tel-

net).
Bottom row

The LEDs on bintec R1200w are arranged as follows:

Fig. 6: LEDs on bintec R1200w

In operation mode, the LEDs on bintec R1200w display the following status information for

your device:
LED status display
Power on The power supply is connected.
State Permanently on or Error.
off
flashing The device is active.
ETH1to5 on The device is connected to the Ethernet.
Top row
flashing Data traffic via the Ethernet interface.
ETH1to5 on Data traffic at 100 mbps.
Bottom row
off Data traffic at 10 mbps.
ISDN-0 B/D on ISDN D-channel is active.
Top row

ISDN-0 B/D on One ISDN B-channel is active.
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LED

Bottom row

ISDN-1 B/D

Top row

ISDN-1 B/D

Bottom row

MA /HA

Top row

MA /HA

Bottom row

WLAN

Top row

WLAN

Bottom row

flashing

on

on

flashing

flashing

on

on

flashing

Funkwerk Enterprise Communications GmbH

Both ISDN B-channels are active.

ISDN D-channel is active.

One ISDN B-channel is active.

Both ISDN B-channels are active.

BRRP packets are received.

A user is logged in to the system (e.g. over Tel-

net).

The WLAN module is active.

Data traffic via the WLAN interface.

The LEDs on bintec R1200wu are arranged as follows:

Fig. 7: LEDs on bintec R1200wu

In operation mode, the LEDs on bintec R1200wu display the following status information

for your device:

LED status display



Funkwerk Enterprise Communications GmbH

Power

State

ETH1to5

Top row

ETH1to5

Bottom row

ISDN-0 B/D

Top row

ISDN-0 B/D

Bottom row

ISDN-1 B/D

Top row

ISDN-1 B/D

Bottom row

UMTS

Top row

on

The power supply is connected.

Permanently on or Error.

off
flashing

on

flashing

on

off

on

on

flashing

on

on

flashing

on

The device is active.

The device is connected to the Ethernet.

Data traffic via the Ethernet interface.

Data traffic at 100 mbps.

Data traffic at 10 mbps.

ISDN D-channel is active.

One ISDN B-channel is active.

Both ISDN B-channels are active.

ISDN D-channel is active.

One ISDN B-channel is active.

Both ISDN B-channels are active.

UMTS connection set up.

6 Technical data
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Funkwerk Enterprise Communications GmbH

UMTS flashing Data traffic over UMTS.
Bottom row
WLAN flashing Data traffic via the WLAN interface.
Top row
WLAN slow flashing The WLAN module is active.
Bottom row
on At least one WLAN client is connected.

The LEDs on bintec R3000 are arranged as follows:

Fig. 8: LEDs on bintec R3000

In operation mode, the LEDs on bintec R3000 display the following status information for
your device:

LED status display
Power on The power supply is connected.
State Permanently on or Error.
off
flashing The device is active.
ETH1to5 on The device is connected to the Ethernet.
Top row
flashing Data traffic via the Ethernet interface.

ETH1to5 on Data traffic at 100 mbps.



Funkwerk Enterprise Communications GmbH
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Bottom row

off
ISDN-0 B/D on
Top row
ISDN-0 B/D on
Bottom row

flashing
ISDN-1 B/D on
Top row
ISDN-1 B/D on
Bottom row

flashing
ADSL flashing
Top row

on
ADSL flashing
Bottom row

synchronous flash-
ing

asynchronous
flashing

Data traffic at 10 mbps.

ISDN D-channel is active.

One ISDN B-channel is active.

Both ISDN B-channels are active.

ISDN D-channel is active.

One ISDN B-channel is active.

Both ISDN B-channels are active.

The device synchronises with the DSLAM of the
ADSL provider.

The device has successfully synchronized with
the DSLAM of the ADSL provider.

Data traffic via the ADSL interface.

ADSL Handshake.

ADSL system error.

The LEDs on bintec R3000w are arranged as follows:
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Fig. 9: LEDs on bintec R3000w

In operation mode, the LEDs on bintec R3000w display the following status information for

your device:
LED status display
LED State Information
Power on The power supply is connected.
State Permanently on or Etrror.

off

flashing The device is active.
ETH1to5 on The device is connected to the Ethernet.
Top row

flashing Data traffic via the Ethernet interface.
ETH1to5 on Data traffic at 100 mbps.
Bottom row

off Data traffic at 10 mbps.
ISDN-0 B/D on ISDN D-channel is active.
Top row
ISDN-0 B/D on One ISDN B-channel is active.
Bottom row

flashing Both ISDN B-channels are active.
ISDN-1 B/D on ISDN D-channel is active.

Top row



Funkwerk Enterprise Communications GmbH
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ISDN-1 B/D on
Bottom row

flashing
ADSL flashing
Top row

on
ADSL flashing
Bottom row

synchronous flash-

ing
asynchronous
flashing
WLAN flashing
Top row
WLAN slow flashing
Bottom row
on

One ISDN B-channel is active.

Both ISDN B-channels are active.

The device synchronises with the DSLAM of the
ADSL provider.

The device has successfully synchronized with
the DSLAM of the ADSL provider.

Data traffic via the ADSL interface.

ADSL Handshake.

ADSL system error.

Data traffic via the WLAN interface.

The WLAN module is active.

At least one WLAN client is connected.

The LEDs on bintec R3400 are arranged as follows:

Fig. 10: LEDs on bintec R3400

In operation mode, the LEDs on bintec R3400 display the following status information for
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your device:
LED status display
LED ' State ' Information
Power on The power supply is connected.
State Permanently on or Etrror.
off
flashing The device is active.
ETH1to5 on The device is connected to the Ethernet.
Top row
flashing Data traffic via the Ethernet interface.
ETH1to5 on Data traffic at 100 mbps.
Bottom row
off Data traffic at 10 mbps.
ISDN-0 B/D on ISDN D-channel is active.
Top row
ISDN-0 B/D on One ISDN B-channel is active.
Bottom row
flashing Both ISDN B-channels are active.
MA / HA flashing BRRP packets are received.
Top row
MA / HA on A user is logged in to the system (e.g. over Tel-
net).
Bottom row
SHDSL-2/1 on The wire pair 4-5 on the SHDSL line has suc-

cessfully synchronized with the DSLAM of the
Top row SHDSL provider.
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flashing Data traffic over the SHDSL wire pair 4-5.
SHDSL-2/1 on The wire pair 7-8 on the SHDSL line has suc-
cessfully synchronized with the DSLAM of the
Top row SHDSL provider.
flashing Data traffic over the SHDSL wire pair 7-8.

The LEDs on bintec R3800 are arranged as follows:

Fig. 11: LEDs on bintec R3800

In operation mode, the LEDs on bintec R3800 display the following status information for

your device:
LED status display
LED 7 State 7 Information
Power on The power supply is connected.
State Permanently on or Etrror.

off

flashing The device is active.
ETH1to5 on The device is connected to the Ethernet.
Top row

flashing Data traffic via the Ethernet interface.
ETH1to5 on Data traffic at 100 mbps.
Bottom row

off Data traffic at 10 mbps.
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LED

ISDN-0 B/D

Top row

ISDN-0 B/D

Bottom row

MA /HA

Top row

MA /HA

Bottom row

SHDSL-2/1

Top row

SHDSL-2/1

Top row

SHDSL-4/3

Top row

SHDSL-4/3

Top row

on

on

flashing

flashing

on

on

flashing

on

flashing

on

flashing

on

flashing

Funkwerk Enterprise Communications GmbH

ISDN D-channel is active.

One ISDN B-channel is active.

Both ISDN B-channels are active.

BRRP packets are received.

A user is logged in to the system (e.g. over Tel-
net).

The wire pair 4-5 on the SHDSL line has suc-
cessfully synchronized with the DSLAM of the
SHDSL provider.

Data traffic over the SHDSL wire pair 4-5.
The wire pair 7-8 on the SHDSL line has suc-
cessfully synchronized with the DSLAM of the
SHDSL provider.

Data traffic over the SHDSL wire pair 7-8.

The wire pair 3-6 on the SHDSL line has suc-
cessfully synchronized with the DSLAM of the
SHDSL provider.

Data traffic over the SHDSL wire pair 3-6.
The wire pair 1-2 on the SHDSL line has suc-
cessfully synchronized with the DSLAM of the
SHDSL provider.

Data traffic over the SHDSL wire pair 1-2.

The LEDs on bintec R4100 are arranged as follows:
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Fig. 12: LEDs on bintec R4100

In operation mode, the LEDs on bintec R4100 display the following status information for

your device:
LED status display
Power on The power supply is connected.
State Permanently on or Error.

off

flashing The device is active.
ETH1to5 on The device is connected to the Ethernet.
Top row

flashing Data traffic via the Ethernet interface.
ETH1to5 on Data traffic at 100 mbps.
Bottom row

off Data traffic at 10 mbps.
ISDN-1/0 on ISDN-0: ISDN D-channel is active.
Top row

flashing ISDN-O0: At least one ISDN B-channel is active.
ISDN-1/0 on ISDN-1: ISDN D-channel is active.
Bottom row

flashing ISDN-1: At least one ISDN B-channel is active.
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ISDN-3/2 on ISDN-2: ISDN D-channel is active.
Top row

flashing ISDN-2: At least one ISDN B-channel is active.
ISDN-3/2 on ISDN-3: ISDN D-channel is active.
Bottom row

flashing ISDN-3: At least one ISDN B-channel is active.
PRI 1/0 on PRI-0: ISDN D-channel is active.
Top row

flashing PRI-0: At least one ISDN B-channel is active.
PRI 1/0 on PRI-1: ISDN D-channel is active.
Bottom row

flashing PRI-1: At least one ISDN B-channel is active.
MA / HA flashing BRRP packets are received.
Top row
MA / HA on A user is logged in to the system (e.g. over Tel-

net).

Bottom row

The LEDs on bintec R4300 are arranged as follows:

Fig. 13: LEDs on bintec R4300

In operation mode, the LEDs on bintec R4300 display the following status information for
your device:
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LED status display
Power on The power supply is connected.
State Permanently on or Error.

off

flashing The device is active.
ETH1to5 on The device is connected to the Ethernet.
Top row

flashing Data traffic via the Ethernet interface.
ETH1to5 on Data traffic at 100 mbps.
Bottom row

off Data traffic at 10 mbps.
ISDN-0 B/D on ISDN D-channel is active.
Top row
ISDN-0 B/D on One ISDN B-channel is active.
Bottom row

flashing Both ISDN B-channels are active.
ISDN-1 B/D on ISDN D-channel is active.
Top row
ISDN-1 B/D on One ISDN B-channel is active.
Bottom row

flashing Both ISDN B-channels are active.
X.21 21 on X.21 1: Connection is set up.

Top row



6 Technical data Funkwerk Enterprise Communications GmbH

flashing X.21 1: Data traffic.
X.21 21 on X.21 2: Connection is set up.
Bottom row
flashing X.21 2: Data traffic.
MA / HA flashing BRRP packets are received.
Top row
MA / HA on A user is logged in to the system (e.g. over Tel-
net).
Bottom row

6.4 Connections

All the connections are located on the back of the device.

bintec R1200 has a 4-port Ethernet switch including a port with serial interface function, a
DMZ/ETHS5 interface and two ISDN interfaces.

The connections are arranged as follows:

5 5
|
ETHz ETHY
ETHS ‘
i : [RE—
[ [ ]
o PWR Toer ETHL ETHL SON-0  IS0H-1
| [ N
1 2 3 6 -] 7 7

Fig. 14: Back of bintec R1200

Back of bintec R1200

1 I/0 Mains switch

2 PWR Socket for plug-in power pack
3 DMZ/ETH5 Ethernet interface

5 ETH2 - ETH4 Ethernet interface




6 ETH1 / Console Ethernet interface with serial interface function
ISDN-0 - ISDN-1 ISDN interface

bintec R1200w has a 4-port Ethernet switch including a port with serial interface function,
a DMZ/ETHS interface and two ISDN interfaces.

The connections are arranged as follows:

Fig. 15: Back of bintec R1200w

Back of bintec R1200w

1 I/0 Mains switch

2 PWR Socket for plug-in power pack

3 DMZ/ETH5 Ethernet interface

4 Main and AUX RSMA connection

5 ETH2 - ETH4 Ethernet interface

6 ETH1 / Console Ethernet interface with serial interface function
7 ISDN-0 - ISDN-1 ISDN interface

bintec R1200wu has a 4-port Ethernet switch including a port with serial interface function,
a DMZ/ETHS5 interface and two ISDN interfaces and a CardBus slot for connecting a UMTS
modem.

The connections are arranged as follows:

R1xxx/R3xxx/R4xxx



Fig. 16: Back of bintec R1200wu

Back of bintec R1200wu

I/0 Mains switch

PWR Socket for plug-in power pack
DMZ/ETH5 Ethernet interface

Main and AUX RSMA connection

ETH2 - ETH4 Ethernet interface

ETH1 / Console Ethernet interface with serial interface function
ISDN-O0 - ISDN-1 ISDN interface
CardBus CardBus slot for UMTS modem

O Nl || N =

bintec R3000 has a 4-port Ethernet switch including a port with serial interface function, a
DMZ/ETHS5 interface, two ISDN interfaces and an ADSL interface.

The connections are arranged as follows:

Fig. 17: Back of bintec R3000

Back of bintec R3000

1 I/0 Mains switch

2 PWR Socket for plug-in power pack
3 DMZ/ETH5 Ethernet interface

5 ETH2 - ETH4 Ethernet interface

R 1xxx/B3xxx/R4xxx



6 ETH1 / Console

Ethernet interface with serial interface function

ISDN-O - ISDN-1

ISDN interface

8 ADSL

ADSL interface

bintec R3000w has a 4-port Ethernet switch including a port with serial interface function,
a DMZ/ETHS interface, two ISDN interfaces and an ADSL interface.

The connections are arranged as follows:

Fig. 18: Back of bintec R3000w

Back of bintec R3000w

I/0

Mains switch

PWR

Socket for plug-in power pack

DMZ/ETH5

Ethernet interface

Main and AUX

RSMA connection

ETH2 - ETH4

Ethernet interface

ETH1 / Console

Ethernet interface with serial interface function

ISDN-0 - ISDN-1

ISDN interface

(N [ WO N =

ADSL

ADSL interface

bintec R3400 has a 4-port Ethernet switch including a port with serial interface function, a
DMZ/ETHS5 interface, an ISDN interface and an SHDSL interface.

The connections are arranged as follows:

R1xxx/R3xxx/R4xxx



Fig. 19: Back of bintec R3400

Back of bintec R3400

1 I/0 Mains switch

2 PWR Socket for plug-in power pack

3 DMZ/ETH5 Ethernet interface

5 ETH2 - ETH4 Ethernet interface

6 ETH1 / Console Ethernet interface with serial interface function
7 ISDN ISDN interface

8 SHDSL SHDSL interface

bintec R3800 has a 4-port Ethernet switch including a port with serial interface function, a
DMZ/ETHS5 interface, an ISDN interface and an SHDSL interface.

The connections are arranged as follows:

Fig. 20: Back of bintec R3800

Back of bintec R3800

1 I/0 Mains switch

2 PWR Socket for plug-in power pack
3 DMZ/ETH5 Ethernet interface

5 ETH2 - ETH4 Ethernet interface

6

ETH1 / Console

Ethernet interface with serial interface function

R 1xxx/B3xxx/R4xxx



7 ISDN ISDN interface
8 SHDSL SHDSL interface

bintec R4100 has a 4-port Ethernet switch including a port with serial interface function, a
DMZ/ETH5 interface, four ISDN interfaces and two ISDN-PRI interfaces.

The connections are arranged as follows:

Fig. 21: Back of bintec R4100

Back of bintec R4100

1 I/0 Mains switch

2 PWR Socket for plug-in power pack

3 DMZ/ETH5 Ethernet interface

5 ETH2 - ETH4 Ethernet interface

6 ETH1 / Console Ethernet interface with serial interface function
7 ISDN-0 - ISDN-3 ISDN interface

9 PRI-0 - PRI-1 ISDN-PRI interface

bintec R4300 has a 4-port Ethernet switch including a port with serial interface function, a
DMZ/ETHS interface, two ISDN interfaces and two X.21 interfaces.

The connections are arranged as follows:

Fig. 22: Back of bintec R4300

R1xxx/R3xxx/R4xxx
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Back of bintec R4300

1 I/0 Mains switch

2 PWR Socket for plug-in power pack

3 DMZ/ETH5 Ethernet interface

5 ETH2 - ETH4 Ethernet interface

6 ETH1 / Console Ethernet interface with serial interface function
7 ISDN-O - ISDN-1 ISDN interface

10 X.21/V.35 X.21 interface

6.5 Pin Assignments

6.5.1 Ethernet interface

bintec R1200, bintec R1200w, R1200wu, R3000, R3000w, R3400, R3800, R4100 and
R4300 have an Ethernet interface with integrated 4-port switch (ETH1 - ETH4) and a sep-
arate Ethernet interface (DMZ/ETHS).

The 4-port switch is used to connect individual PCs or other switches. The ETH1 /Console
interface can also be used as a serial interface. The DMZ/ETHS5 interface can be used to
connect an optional DSL modem or a DMZ.

The connection is made via an RJ45 socket.

Fig. 23: Ethernet 10/100 Base-T interface (RJ45 socket)
The pin assignment for the Ethernet 10/100 Base-T interface (RJ45 socket) is as follows:

RJ45 socket for Ethernet connection

—_

TD +
TD -
RD +

A WO DN

Not used
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5 Not used
6 RD -

7 Not used
8

Not used

The Ethernet 10/100 BASE-T interface does not have an Auto-MDI-X function.
The pin assignment for the Ethernet 10/100 Base-T interface (RJ45 socket) is as follows:

RJ45 socket for Ethernet connection or serial interface (console)

1 TD + (Ethernet)
TD - (Ethernet)
RD + (Ethernet)
RX (console)
GND (console)
RD - (Ethernet)
GND (console)

o N o o »~ 0w N

TX (console)

The combined serial Ethernet 10/100Base-T interface does not have an Auto-MDI-X func-
tion.

6.5.2 ISDN SO port

bintec R1200, R1200w, R1200wu, R3000, R3000w, R3400, R3800, R4100 and R4300
have two additional ISDN-SO interfaces, which can be used for backup functions, for ex-
ample.

The connection is made via an RJ45 socket:

Fig. 24: ISDN S0 BRI interface (RJ45 socket)

The pin assignment for the ISDN S0 BRI interface (RJ45 socket) is as follows:
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RJ45 socket for ISDN connection

1 Not used
Not used
Transmit (+)
Receive (+)
Receive (-)
Transmit (-)

Not used

o N o o »~ W N

Not used

6.5.3 ISDN-PRI interface

Both of the ISDN PRI interfaces on bintec R4100 are connected via an RJ45 plug. The
cable supplied connects the RJ45 plug needed for the device to an RJ45 plug needed for
the PRI connection.

The following pins are used for the connection:

Fig. 25: ISDN PRI interface (RJ45 socket)
The pin assignment for the ISDN PRI interface (RJ45 socket) is as follows:

RJ45 socket for ISDN PRI connection

T+
T

—_

Not used
R+
R_

Not used

N o o0 AW

Not used
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8 Not used

Note for NTs in Germany

&n Note

In Germany, "Transmit" (NT-->TE) is often designated "S2Mab" (a and b) on the plug
and "Receive" (TE-->NT) "S2Man" (a and b).

6.5.4 CardBus interface (PCMCIA)

The CardBus interface on bintec R1200wu allows a UMTS CardBus modem to be added
to the system.

The modem card is inserted in the existing CardBus slot and is integrated automatically by
the system. You can insert the card even when the device is running (hot-pluggable).

If the card is not integrated automatically, the system does not support this specific card.
Our support staff will be pleased to help if you have any questions.

Pin 34

/
e

Pin 68\

Pin 35

Fig. 26: 68-pin CardBus slot for UMTS modem card
The pin assignment is as follows:

Pin assignment of the CardBus slot

N

1 GND Ground

2 CADO Mpx address/data 0
3 CAD1 Mpx address/data 1
4 CAD3 Mpx address/data 3
5 CAD5 Mpx address/data 5
6 CAD7 Mpx address/data 7



6 Technical data Funkwerk Enterprise Communications GmbH

N I

7 CCBEO# Command/Byte possible 0
8 CAD9 Mpx address/data 9

9 CADTM1 Mpx address/data 11
10 CAD12 Mpx address/data 12
11 CAD14 Mpx address/data 14
12 CCBE1# Command/Byte possible 1
13 CPAR CardBus Parity

14 CPERR# CardBus Parity error
15 CGNT# CardBus Grant

16 CINT# CardBus IREQ

17 VCC Card power supply

18 VPP1 Programming voltage 1
19 CCLK CardBus cycle

20 CIRDY# CardBus initiator ready
21 CCBE2# Command/Byte possible 2
22 CAD18 Mpx address/data 18
23 CAD20 Mpx address/data 20
24 CAD21 Mpx address/data 21
25 CAD22 Mpx address/data 22
26 CAD23 Mpx address/data 23
27 CAD24 Mpx address/data 24
28 CAD25 Mpx address/data 25
29 CAD26 Mpx address/data 26
30 CAD27 Mpx address/data 27
31 CAD29 Mpx address/data 29
32 RFU Reserved

33 CCLKRUN# Start CardBus cycle
34 GND Ground

35 GND Ground

36 CCD1# Card ID 1

37 CAD2 Mpx address/data 2

38 CAD4 Mpx address/data 4
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N N

39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68

CAD6
RFU
CAD8
CAD10
CVS1
CAD13
CAD15
CAD16
RFU
CBLOCK#
CSTOP#
CDEVSEL#
VCC
VPP2
CTRDY#
CFRAME#
CAD17
CAD19
CvSs2
CRST#
CSERR#
CREQ#
CCBE3#
CAUDIO
CSTSCHG
CAD28
CAD30
CAD31
CCD2#
GND

Mpx address/data 6
Reserved

Mpx address/data 8

Mpx address/data 10
Voltage ID 1

Mpx address/data 13
Mpx address/data 15
Mpx address/data 16
Reserved

CardBus blocked
CardBus stop

CardBus device selection
Card power supply
Programming voltage 2
CardBus destination ready
CardBus Cycle Frame
Mpx address/data 17
Mpx address/data 19
Voltage ID 2

Reset CardBus

CardBus system error
CardBus request
Command/Byte possible 3
CardBus audio

CardBus status change
Mpx address/data 28
Mpx address/data 30
Mpx address/data 31
Card ID 2

Ground
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6.5.5 ADSL interface

The ADSL interface on bintec R3000 and R3000w is connected via an RJ45 plug. The
cable supplied connects the RJ45 plug needed for the device to an RJ45 plug provided for
Annex A. The second cable supplied connected the RJ45 plug with an RJ45 plug for Annex
B.

The following pins are used for the ADSL connection:

Fig. 27: ADSL interface (RJ45 socket)

The pin assignment for the ADSL interface (RJ45 socket) is as follows:

RJ45 socket for ADSL connection

1 Not used
Not used
Not used
Line a
Line b
Not used

Not used

0o N o 0o A~ W N

Not used

6.5.6 SHDSL interface

The SHDSL interface on bintec R3400 is connected via an RJ45 connector. The cable
supplied connects the RJ45 connector needed for the device to an RJ45 connector needed
for the SHDSL connection.

The following pins are used for the SHDSL connection:
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Fig. 28: SHDSL interface (RJ45 connector) bintec R3400
The pin assignment for the SHDSL interface (RJ45 connector) is as follows:

RJ45 socket for SHDSL connection bintec R3400

o s ]
1 Not used

Not used

Not used

Line a1

Line b1

Not used

Line a2

Line b2

0o N o 0o A~ W N

The SHDSL interface on bintec R3800 is connected via an RJ45 connector. The cable
supplied connects the RJ45 connector needed for the device to an RJ45 connector needed
for the SHDSL connection.

The following pins are used for the SHDSL connection:

Fig. 29: SHDSL interface (RJ45 connector) bintec R3800
The pin assignment for the SHDSL interface (RJ45 connector) is as follows:

RJ45 socket for SHDSL connection bintec R3800

1 Line a4
2 Line b4
3 Line a3
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4 Line a1
5 Line b1
6 Line b3
7 Line a2
8 Line b2

6.5.7 X.21 interface
bintec R4300 has two X.21 interfaces

The connection is made via a 26-pole mini Delta ribbon socket:

Fig. 30: X.21 interface (26-pole mini Delta ribbon socket)
The 26-pole mini Delta ribbon socket has the following pin assignment:

Pin assignment of 26-pole mini Delta ribbon socket

X.21 X.21 V.35 V.36 V.36
(DB-15) |(DB-15) (M34)  |(DB-37) |(DB-37)

DTE DCE DTE DCE

Shield  A1(1) 1 1 A A 1 1
GND A2 8 8 B B 19 19
TXD(B) A3(3) 9 1 s T 22 24
TXD(A) A4(4) 2 4 P R 4 6
RxD(B) A5(5) 11 9 T S 24 22
RxD (A) A6(6) 4 2 R P 6 4
RTS(B) A7(7) 10 12 25 27
RTS(A) A((8) 3 5 C D 7 9
CBS(B) A9(9) 12 10 27 25
CBS(A) A10(10) 5 3 D C 9 7

RxC (B) A11(11) 13 14 X w 26 35
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RxC (A)

Mode
DCE

Mode 0
DTR (B)
DTR (A)
DCD (B)
DCD (A)
DSR (B)
DSR (A)
TxC (B)
TxC (A)
Mode 1
Mode 2
TxCE (B)
TxCE (A)

X.21 X.21
(DB-15) |(DB-15)
DTE DCE

A12 (12) 6 7

A13 (13) 8

B1 (14)
B2 (15)
B3 (16)
B4 (17)
B5 (18)
B6 (19)
B7 (20)
B8 (21)
B9 (22)
B10 (23)
B11(24) 8 8
B12 (25) 13
B13 (26) 6

AA

AA

V.36
(DB-37)

DTE

19
30
12
31

13
29
11

23

35
36

6 Technical data

V.36
(DB-37)

DCE
17
19

19
29
11

31
13
30
12
23

26



6.6 WEEE information

The waste container symbol with the »X« through it on the device indicates that the device must
be disposed of separately from normal domestic waste at an appropriate waste disposal facility at
the end of its useful service life.

Das auf dem Gerit befindliche Symbol mit dem durchgekreuzten Miillcontainer bedeutet, dass
das Geriit am Ende der Nutzungsdauer bei den hierfiir vorgesehenen Entsorgungsstellen getrennt
vom normalen Hausmiill zu entsorgen ist.

Le symbole se trouvant sur I'appareil et qui représente un conteneur a ordures barré signifie que
l'appareil, une fois que sa durée d'utilisation a expiré, doit étre éliminé dans des poubelles spécia-
les prévues a cet eftet, de maniére séparée des ordures ménagéres courantes.

1l simbolo raffigurante il bidone della spazzatura barrato riportato sull apparecchiatura significa
che alla fine della durata in vita dell'apparecchiatura questa dovra essere smaltita separatamente
dai rifiuti domestici nei punti di raccolta previsti a tale scopo.

El simbolo del contenedor con la cruz, que se encuentra en el aparato, significa que cuando el
equipo haya llegado al final de su vida til, deberd ser llevado a los centros de recogida previstos, y
que su tratamiento debe estar separado del de los residuos urbanos.

Symbolen som sitter pd apparaten med den korsade avfallstunnan betyder att apparaten nir den
Eiil:;at vl.}; sika kasseras och lamnas till de forutsedda sortergirdarna och skiljas frin normalt hus-
allsavfall.

Tegnet pd apparatet som viser en avfallcontainer med et kyss over, betyr atapparatet ma kastet pa
hertil egnet avfallssted og ikke sammen med vanlig avfall fra husholdningen.

To cbpPolo mov PpiokeTar oV CUOKEVT {E TO OTAUPWHEVO KOVTEIVED ATOPPINKATWY OTjHaivel,
OTL1) oVOKeT 070 TENOG TE Siapkeiag xprone Tne mpenel va diatebel Eexwpiotd and ta kavovikd
anoppippata ota yi' quto Tov akond mpophenopeva onpeia Siabeonc.

Symbolet med gennemkrydset affaldsbeholder pa apparatet betyder, at apparatet, nir det ikke
kan bruges lengere, skal bortskaffes adskilt fra normalt husholdningsaffald pa et af de dertil be-
regnedegborlskaf‘fe]sessleder.

Znajdujacy si¢ na urzadzeniu symbol przekreslonego pojemnika na $mieci oznacza, ze po
uplywie zywotnoéci urzadzenia nalezy go odda¢ do odpowiedniej placéwki utylizacyjnej i nie
wyrzuca¢ go do normalnych smieci domowych.

Het doorgehaalde symbool van de afvalcontainer op hetapparaat betekent dat het apparaat op het
einde van zijn levensduur niet bij het normale huisvuil mag worden verwijderd. Het moet bij een
erkend inzamelpunt worden ingeleverd.

0 simbolo com um caixote de lixo riscado, que se encontra no aparelho, significa, que o aparelho
no fim da sua vida til deve ser eliminado separadamente do lixo doméstico nos centros de recol-

ha adequados.

D 1 1 D g 13 1 1 g 13 13

R1xxx/R3xxx/R4xxx
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Chapter 7 Variable switching of S0 interfaces

71 Switching the S0 interfaces from external to in-
ternal

The devices bintec R1200, bintec R3000 and bintec R4100 have two or four ISDN con-
nections. All ISDN connections can be operated as internal or as external SO connections.
The external SO connections are used for connection to the network operator's ISDN net-
work. The internal SO connections are provided for connecting various ISDN terminals
(telephone, PC, etc.). In the ex works state, the ISDN connections are configured as ex-
ternal connections.

The two SO interfaces ISDN-0 and ISDN-1 can be switch from external (ex works state) to
internal via a link plug field on the PCB for the device. Additional interfaces ISDN-2 and
ISDN-3 can be swtiched via the link plugs on the side of the ISDN-L module.

If you use a SO interface as an internal connection, you can specify for each interface
whether or not the connection is powered via your device when the conncted terminal does
not have its own power supply. The respective link plugs must be moved to do this.

In addition, you can switch the 100 Ohm terminators on/off for each interface via additional

link plugs. You require terminators:

* if you connect an external connection directly with the external NTBA

e for a point-to-point connection

« if the bus starts directly with the connection of your device

You can also connect the interfaces ISDN-2 and ISDN-3 to each other. This can guarantee
the power supply for a terminal on an ISDN interface switched to internal mode in the event
that your device is switched off or the power supply fails. For example, an external SO can

be placed on an internal SO. In this case, an idle relay loops through from external SO to in-
ternal SO and so creates an emergency supply for the internal SO bus/telephone.

To carry out the switch proceed as follows:
Unscrew the two screws on the back of the device and slide the cover upwards.

The link plugs for the ISDN-0 and ISDN-1 interfaces can be found on all devices on the
main PCB behind the ISDN terminal block.
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Insert the link plugs for interfaces ISDN-0 and ISDN-1 as shown in the following figure:
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Use Interface Link plug Position Position
area

Internal/external switching ISDN-0 JOM Internal external
ol |
Internal/external switching ISDN-1 J1M Internal external

Power supply for internal ISDN-0 JOP Off On
connection

Power supply for internal ISDN-1 J1P Off On
connection

100 Ohm terminator ISDN-0 JoT Off On
100 Ohm terminator ISDN-1 J1T Off On

You can also switch the interfaces ISDN-2 and ISDN-3. The link plugs are on the side of
the ISDN-L module.

I

l

-
J2M (Mode)
L]

J3M (Mode)

J2P (Power)
s J3P (Power)

ISDN L-Module

J23

2 JZT (Termination)
s J3T (Termination)

Insert the link plugs for interfaces ISDN-2 and ISDN-3 as shown in the following figure:

R1xxx/R3xxx/R4xxx
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side view

in.  ext.
| P
1S0M Made Swatch -
intern | extam } \

J2M ISDN-2

J3M ISDN-3

on  off o cfl J2P ISDN-2

Power for intamal 50 : :
JIP ISDN-3
Port 3 - 4 connact = B8
luqetl]e-r in poweress ; : : J23
e = S

100 Ohm x,/‘ ==l J2T ISDN-2
terminatian -.k_‘\\ = e —

* "on" is only permitted, if J2M ISDN-2 is set to internal mode and J3M ISDN-3 is set to ex-
ternal mode.

Use Interface Link plug Position Position
area

Internal/external switching ISDN-2 J2M Internal external
Internal/external switching ISDN-3 J3M Internal external

Power supply for internal ISDN-2 J2P Off On
connection
Power supply for internal ISDN-3 J3P Off On
connection
100 Ohm terminator ISDN-2 J2T Off On
100 Ohm terminator ISDN-3 J3T Off On



Use Interface Link plug Position Position
area

Connection of ISDN-2 and - J23 Off Z On

ISDN-3 E
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Chapter 8 Access and configuration

This chapter describes all the access and configuration options.

8.1 Access Options

The various access options are presented below. Select the procedure to suit your needs.

There are various ways you can access your device to configure it:

¢ Via your LAN
¢ Via the serial interface

¢ Via an ISDN connection

8.1.1 Access via LAN

Access via one of the Ethernet interfaces of your device allows you to to open the Funk-
werk Configuration Interface in a web browser for configuration purposes and to access
your device via Telnet or SSH.

8.1.1.1 HTTP/HTTPS

With a current web browser, you can use the HTML interfaces to configure your device. For
this, enter the following in your web browser's address field:

* http://192.168.0.254
or

https://192.168.0.254

8.1.1.2 Telnet

Apart from configuration using a web browser, with a Telnet connection you can also ac-
cess the SNMP shell and use other configuration options.

You do not need any additional software on your PC to set up a Telnet connection to your
device: Telnet is available on all operating systems.

Proceed as follows:

Windows

R1xxx/R3xxx/R4xxx
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(1) Click Run... in the Windows Start menu.
(2) Enter telnet <IP address of your device>.

(3) Click OK.
A window with the login prompt appears. You are now in the SNMP shell of your
device.

(4) Continue with Logging in for Configuration on page 78.

Unix

You can also set up a Telnet connection on UNIX and Linux without any problem:

(1) Enter telnet <IP address of your device>in aterminal.
A window with the login prompt appears. You are now in the SNMP shell of your
device.

(2) Continue with Logging in for Configuration on page 78.

8.1.1.3 SSH

In addition to the unencrypted and potentially viewable Telnet session, you can also con-
nect to your device via an SSH connection. This is encrypted, so all the remote mainten-
ance options can be carried out securely.

The following preconditions must be met in order to connect to the device via SSH:

* The encryption keys needed for the process must be available on the device.

¢ An SSH client must be installed on your PC.

Encryption keys

First of all, make sure that the keys for encrypting the connection are available on your
device:

(1) Login to one of the types already available on your device (e.g. via Telnet - for login
see Logging in on page 77).

(2) Enter update -1 forthe input prompt. You are now in the Flash Management shell.

(8) Call up a list of all the files saved on the device: 1s -al.

If you see a display like the one below, the keys needed are already there and you can
connect to the device via SSH:

Flash-Sh > 1s -al
Flags Version Length Date Name ...

Vr-xpbc-B 7.1.04 2994754 2004/09/02 14:11:48 box150 srel.ppc860
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Vrw-pl--f 0.0 350 2004/09/07 10:44:14 sshd host rsa key.pub
Vrw-pl--f 0.0 1011 2004/09/07 10:44:12 sshd_host_rsa_key
Vrw-pl--f 0.0.01 730 2004/09/07 10:42:17 sshd host dsa key.pub
Vrw-pl--f 0.0.01 796 2004/09/07 10:42:16 sshd_host_dsa_key

Flash-Sh >

Note

The device generates a key pair for each of the algorithms (RSA and DSA), i.e. two
files must be stored in the flash for each algorithm (see example at above).

If no keys are available, you have to generate these first. Proceed as follows:
(1) Leave the Flash Management shell with exit.

(2) Call the Funkwerk Configuration Interface and log on to your device (see Calling
the Funkwerk Configuration Interface on page 81).

(3) Make sure that English is selected as the language.

(4) Check the key status in the System Management -> Administrative Access -> SSH
menu. If both keys are available, you will see the Generated value in the two RSA
key Status and DSA key Status fields.

(5) If one or both of these fields contains the value Not Generated, you must generate
the relevant key. To have the device generate the key, click Generate.
The device generates the key and stores it in the FlashROM. Generated indicates
that generation was successful.

(6) Make sure that both keys have been successfully generated. If necessary, repeat the
procedure described above.

Login via SSH
Proceed as follows to log in on your device via SSH:

If you have made sure that all the keys needed are available on the device, you have to
check whether an SSH client is installed on your PC. Most UNIX and Linux distributions in-
stall a SSH client by default. Additional software, e.g. PuTTY, usually has to be installed on
a Windows PC.

Proceed as follows to log in on your device via SSH:

UNIX

(1) Enter ssh <IP address of the device> inaterminal.
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The login prompt window appears. This is located in the SNMP shell of the device.

(2) Continue with Logging in on page 77.

Windows

(1) How an SSH connection is set up very much depends on the software used. Consult
the documentation for the program you are using.

As soon as you have connected to the device, the login prompt window will appear.
You are now in the SNMP shell of your gateway.

(2) Continue with Logging in on page 77.

@ Note

PuTTY requires certain settings for a connection to a bintec device. The support
pages of http://www.funkwerk-ec.com include FAQs, which list the required settings.

8.1.2 Access via the Serial Interface

Each bintec gateway has a serial interface, with which a PC can be connected directly.
The following chapter describes what you have to remember when setting up a serial con-
nection and what you can do to configure your device in this way.

Access via the serial interface is ideal if you are setting up an initial configuration of your
device and a LAN access is not possible via the pre-configured IP address
(192.168.0.254/255.255.255.0).

Windows

If you are using a Windows PC, you need a terminal program for the serial connection, e.g.
HyperTerminal. Make sure that HyperTerminal was also installed on the PC with the Win-
dows installation. However, you can also use any other terminal program that can be set to
the corresponding parameters (see below).

If you have accessed and installed the BRICKware at www.funkwerk-ec.com, two links
are provided in the Windows Start menu. If you use these, you do not have to make any
other settings for the serial connection to your device.

Proceed as follows to access your device via the serial interface:

(1) In the Windows Start menu, click on Programs -> BRICKware -> Device on COM1
(or Device on COM2 , if you use the COM2 port of your PC) to start HyperTerminal.

(2) Press Return (at least once) after the HyperTerminal window opens.

A window with the login prompt appears. You are now in the SNMP shell of your device.
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You can now log in on your device and start the configuration.

Check

If the login prompt does not appear after you press Return several times, the connection to
your device has not been set up successfully.

Therefore, check the COM1 or COM2 settings on your PC.

(1) Click on File ->Properties.

(2) Click Configure in the Connect to tab.
The following settings are necessary:
- Bits per second: 9600
- Data bits: 8
- Parity: open
- Stopbits: 1
- Flow control: open
(3) Enter the values and click OK.
(4) Make the following settings in the Settings tab:
- Emulation: vT100

(5) Click OK.

The changes to the terminal program settings do not take effect until you disconnect the
connection to your device and then make the connection again.

If you use HyperTerminal, there may be problems with displaying umlauts and other special
characters. If necessary, therefore, set HyperTerminal to Autodetection instead of vT
100.

Unix

You will require a terminal program such as cu (on System V), tip (on BSD) or minicom
(on Linux). The settings for these programs correspond to those listed above.

Example of a command line for using cu: cu -s 9600 -c/dev/ttyS1l

Example of a command line for using tip: tip -9600 /dev/ttySl

8.1.3 Access over ISDN

All devices that have an ISDN interface can be accessed and configured from another
device via an ISDN call.

Access over ISDN with ISDN Login is especially recommended if your device is to be re-
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motely configured or maintained. This is also possible even if your device is still in the ex
works state. Access is then obtained with the aid of a device that is already configured or a
PC with an ISDN card in the remote LAN. The device to be configured in your own LAN is
reached via a number of the ISDN connection (e.g. 1234). This enables the administrator in
the Remote LAN to configure your device remotely, for example.

@ Note

If you connect an unconfigured device to an ISDN connection in parallel to a PBX, the
PBX cannot take any calls until an ISDN number is configured on the device.

Access over ISDN costs money. If your device and your computer are in the LAN, it is
cheaper to access your device via the LAN or via the serial interface.

Your device in your LAN merely needs to be connected to the ISDN connection and
switched on.

To reach your device over ISDN Login, proceed as follows:
(1) Connect your device to the ISDN.
(2) Log in as administrator on your device in the remote LAN in the usual way.

(8) Inthe SNMP shell, type in isdnlogin <number of the ISDN connection of
your device>, e.g. isdnlogin 1234.

(4) The login prompt appears. You are now in the SNMP shell of your device.

Continue with Logging in for Configuration on page 78.

8.2 Logging in

With certain access data, you can log in on your device and carry out different actions. The
extent of the actions available depend on the authorisations of the user concerned.

A login prompt appears first, regardless of how you access your device. You cannot view
any information on the device or change the configuration without authentication.
8.2.1 User names and passwords in ex works state

In its ex works state, your device is provided with the following user names and passwords:

User names and passwords in ex works state

admin funkwerk Read and change system variables, store configurations; use
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Funkwerk Configuration Interface.

write public Read and write system variables (except passwords) (changes
are lost when you switch off your device).

read public Read system variables (except passwords).

It is only possible to change and save configurations if you log in with the user name ad-
min. Access information (user names and passwords) can also only be changed if you log
in with the user name admin. For security reasons, passwords are normally shown not in
plain text but only as asterisks. The user names, on the other hand, are displayed as plain
text.

The security concept of your device enables you to read all the other configuration settings
with the user name read, but not the access information. It is therefore impossible to log in
with read, read the password of the admin user and subsequently log in with admin and

make changes to the configuration.

f Caution

All bintec devices are delivered with the same username and password. As long as
the password remains unchanged, they are therefore not protected against unauthor-
ised use. How to change the passwords is described in Passwords on page 103.

Make sure you change the passwords to prevent unauthorised access to your device!

If you have forgotten your password, you must reset your device to the ex works state,
which means your configuration will be lost.

8.2.2 Logging in for Configuration

Set up a connection to the device. The access options are described in Access Options on
page 72.

Funkwerk Configuration Interface

Log in via the HTML surface as follows:

(1) Enter your user name in the User field of the input window.

(2) Enter your password in the Password field of the input window and confirm with Re-
turn or click the Login button.

The status page of the Funkwerk Configuration Interface opens in the browser.
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SNMP shell

Log into the SNMP shell as follows:
(1) Enter your user name e.g. admin, and confirm with Return.

(2) Enter your user password e.g. funkwerk, and confirm with Return.

Your device logs in with the input prompt, e.g. TR200bw: >. The login was successful. You
are now in the SNMP shell.

To leave the SNMP shell after completing the configuration, enter exit and press Return.

8.3 Configuration options

This chapter first offers an overview of the various tools you can use for configuration of
your device.

You can configure your device in the following ways:

¢ Funkwerk Configuration Interface

* SNMP shell commands
The configuration options available to you depend on the type of connection to your device:

Types of connections and configurations
Type of connection Possible types of configuration

LAN Funkwerk Configuration Interface, shell commands

Serial connection Shell command

Therefore, several types of configuration are available for each type of connection.

&. Note

To change the device configuration, you must log in with the user name admin. If you
do not know the password, you cannot make any configuration settings. This applies to
all types of configuration.

8.3.1 Funkwerk Configuration Interface

The Funkwerk Configuration Interface is a web-based graphic user surface that you can
use from any PC with an up-to-date web browser via an HTTP or HTTPS connection.



You can use the Funkwerk Configuration Interface to carry out all configuration tasks
easily. It is integrated in your device and is available in English. If required, other languages
can be downloaded from the download areaSoftware & Configuration on page 459 of
www.funkwerk-ec.com and installed on your device. To do this, proceed as described in .

The settings you make with the Funkwerk Configuration Interface are applied with the
OK or Apply button of the menu, and you do not have to restart the device.

If you finish the configuration and want to save your settings so that they are loaded as the
boot configuration when you reboot your device, save these by clicking the Save configur-
ation button.

You can also use the Funkwerk Configuration Interface to monitor the most important
function parameters of your device.

bintec R1200 Language | English v | View |Standard v| | oOnline Help | Logout

Automatic Retresh Interval |50 sscands [ Apply )

0 ing: System not
GlohaliSattinn e System Information
Interface Mode / Bridge
e Uptime 2 Dawy(s) 22 Hour(s) 27 Minute(s)
Systemn Date Mon Jan 16 23:53:01 2006
Serial Number R1E180006500018
BOSE Version V.7.9 Rev. 1 IPSec from 2009/11:09 00:00:00
Resource Information
CPU Usage 0%
Memary Usage 22.1/31.9 MB (70%)
ISDMN Usage External 0 /4B Channels
Active Sessions (SIF, RTP, elc.. ) 0
Active IPSec Tunnels /o
Physical Interface Interface Specifics Link
ent1-0 192.168.0.254/ 255.255.255.0 [+]
ent-4 Mat configured /Mot configured
WLAN off (]
com0-8 Mot configured [+]
briz-0 Mot configured
briz-1 Mot configured [+]
Configured
Recert System Logs
Time Level Subsystem Message
01:25:24 Infarmation WalP PABKD: Adminstatus is disabled, all PABX features will be disabled
01:25:23 Information IPSec init: starting
01:25:23 Information  |PSec BinTec ipsecd version 3.0 Copyright (c) 1998-2008 by Funkwerk Enterprise Communications GmbH
01:25:23 Infarmation IPSec init: running
01:25:23 Information INET sshd: pid 57 - listening on 0.0.0.0 port 22
01:25:22 Infarmation Conflauration  swstern r1200 started at Sat Jan 14 1:25:22 2006
01:25:21 Debug Ethernet ent-0: add multicast 01:00:5e:00000:02
012521 Debug Ethernet en1-0: add multicast 01:00:5e:00:00:16
01:25:21 Debug HTTP hittpd[24]: pem: unakle to read key file
012521 Debug HTTP hitpd[25]: using default cerificate

Fig. 32: Funkwerk Configuration Interface Initial Screen

R1xxx/R3xxx/R4xxx
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8.3.1.1 Calling the Funkwerk Configuration Interface

(1) Check whether the device is connected and switched on and that all the necessary
cables are correctly connected (see Setting Up and Connecting on page 6).

(2) Check the settings of the PC from which you want to configure your device (see Con-
figuring a PC on page 17).

(3) Open a web browser.
(4) Enter http://192.168.0.254 in the address field of the web browser.

(5) Enter admin in the User field and funkwerk in the Password field and click LOGIN.

You are not in the status menu of your device's Funkwerk Configuration Interface (see
Status on page 98).

8.3.1.2 Operating elements

Funkwerk Configuration Interface window

The Funkwerk Configuration Interface window is divided into three areas:

* The header
* The navigation bar

e The main configuration window

m Passwords Date and Time  System Licences

Navigation bar

Basic Parameters

Global Settings.

System Narme 200
= Interface Mode / Bridge =
Main configuration —— = Location
window inistrative Access

Remote Authentication Contact FUNKWERK.
: Maximum Number of Syslog Entries 50
Maximum Message Level of Syslog Entries

Maximurn Number of Accounting Log Entries | |20

d oK D ( cancel )

Fig. 33: Areas of the Funkwerk Configuration Interface

Header

R1xxx/R3xxx/R4xxx
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| http:if192.165.0,254 + -

i 1 L= OIS k !
k' ! ‘ (=3 saroren i oy

[ec R QUS| anguage | English | | view [ Standard v | Online Help | Logout fl.lnhll'rkﬂ
- .| = w’ wr x

Save configuration
Fig. 34: Funkwerk Configuration Interface header

Funkwerk Configuration Interface header

o r—— Language selection: From the dropdown menu, select the lan-
| Language| English [v| | ‘ : X . :
= — : guage in which the Funkwerk Configuration Interface is to be
displayed. Here, you can select the language in which you want
to carry out the configuration. German and English are avail-
able.

“iew | Standard = View: Select the desired view from the dropdown menu. Stand-
ard and SNMP browsers can be selected.

[reser | Online Help: Click this button if you want help with the menu

| Online Help . o

= —| now active. The description of the sub-menu where you are now
is displayed.

Logout: If you want to end the configuration, click this button to
Logout log out of your device. A window is opened offering you the fol-
' lowing options:

¢ Continue with the configuration,
¢ Save the configuration and close the window,

» Exit the configuration without saving.

Navigation bar

Save configuration

Fig. 35: Save Configuration button



Status

Glohal Settings
Interface Mode / Bridge
Groups

Administrative Access
Remote Authentication

Fig. 36: Menus

The Save Configuration button is found in the navigation bar. Click the Save Configura-
tion button to save all configuration changes, so that they are loaded as the boot configura-
tion the next time you start the device.

The navigation bar also contains the main configuration menus and their sub-menus.
Click the main menu you require. The corresponding sub-menu then opens.

If you click the sub-menu you want, the entry selected will be displayed in red. All the other
sub-menus will be closed. You can see at a glance the sub-menu you are in.

Status page

If you call the Funkwerk Configuration Interface, after you log in the status page of your
device is displayed. The most important data of your device can be seen on this at a
glance.

Main configuration window

The sub-menus generally contain several pages. These are called using the buttons at the

R1xxx/R3xxx/R4xxx
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top of the main window. If you click a button, the window is opened with the basic paramet-
ers. You can extend this by clicking the Advanced Settings tab, which displays the addi-
tional options.

Configuration elements

The various actions that you can perform when configuring your device in the Funkwerk
Configuration are triggered by means of the following buttons:

Funkwerk Configuration Interface buttons

Updates the view.

ApPly
Cancel If you do not want to save a newly configured list entry, cancel
this and any settings made by pressing Cancel.
—CI_I{— '.. Confirms the settings of a new entry and the parameter
— changes in a list.
Go Immediately starts the configured action.
New Calls the the sub-menu to create a new entry.
; Inserts an entry in an internal list.
Add ) U

Funkwerk Configuration Interface buttons for special functions

In the Access Point Search menu, you use this button to start
automatic detection of all the access points available and con-
nected by Ethernet in the network.

Discover

In the VPN -> Certificates -> Certificates and the VPN -> Cer-
tificates -> CRLs menus, this button opens the sub-menus for
configuring the certificates or CRL imports.

Import

In the VPN -> Certificates -> Certificates menu, this button
opens the sub-menu for the configuration of the certificate re-
quest.

Request

Release Call In. thg Survei.llance -> ISDN/Mode_m -> Current Ca!ls menu,
i clicking on this button ends the active calls selected in the

column .
Various icons indicate the following possible actions or statuses:

Funkwerk Configuration Interface icons
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Deletes the list entry.
Displays the menu for changing the settings of an entry.
Displays the details for an entry.

Moves an entry. A combo box opens in which you can choose
the list entry that selected entry is to be be placed in front of/
after.

Creates another list entry first and opens the configuration
menu.

Sets the status of the entry to Tnactive .
Sets the status of the entry to Active.

Indicates "Dormant" status for an interface or connection.
Indicates "Up" status for an interface or connection.
Indicates "Down" status for an interface or connection.
Indicates "Blocked" status for an interface or connection.
Indicates "Going up" status for an interface or connection.
Indicates that data traffic is encrypted.

Triggers a WLAN bandscan.

Displays the next page in a list.

Displays the previous page in a list.

You can select the following operating functions in the list view:

Funkwerk Configuration Interface list options

Update Interval

Filter

Here you can set the interval in which the view is to be updated.

To do this, enter a period in seconds in the input field and con-

You can have the list entries filtered and displayed according to
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certain criteria.

You can determine the number of entries displayed per page by
entering the required number in View x per Page.

Use the [¢| and 3| buttons to scroll one page forward and one
page back.

You can filter according to certain keywords within the configur-
ation parameters by selecting the filter rule you want under Fil-
ter in x <Option> y and entering the search word in the input
field. g starts the filter operation.

Configuration elements  Some lists contain configuration elements.

You can therefore change the configuration of the correspond-
ing list entry directly in the list.

Automatic Refresh Interval B0 Seconds Apply

Fig. 37: Configuration of the update interval

wigw |20 per page | 1®Fiterin | None v || equal |» Go

Fig. 38: Filter list

Structure of the Funkwerk Configuration Interface configuration menus

The menus of the Funkwerk Configuration Interface contain the following basic struc-
tures:

Funkwerk Configuration Interface menu structure

Basic configuration When you select a menu from the navigation bar, the menu of

menu/list basic parameters is displayed first. In a sub-menu containing
several pages, the menu containing the basic parameters is dis-
played on the first page.

The menu contains either a list of all the configured entries or
the basic settings for the function concerned.

Sub-menu The New button is available in each menu in which a list of all
: ; the configured entries is displayed. Click the button to display
the configuration menu for creating a new list entry.

Mew
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Sub-menu Click this button to process the existing list entry. You go to the
configuration menu.
Menu Click this tab to display extended configuration options.

Advanced Settings

The following options are available for the configuration:

Funkwerk Configuration Interface configuration elements

Input fields e.g. empty text field

Text field with hidden input

L 1111
Enter the data.

Radio buttons e.g.

Address Mode ) Static ) DHCP

Select the corresponding option.

Checkboxes e.g. activation by selecting checkbox
(] Enabled
Selection of several possible options
Encryption Algorithms [13pEs [IBlowfish [£] AES-128 [] AES-256
Hashing Algerithms #lmps sHA-1 [ Ripemp 160
Dropdown menus e.g.
Configured Spaed!ﬁnde
| Full Autonegotiation iv
Full Autonegatiation v
Full Autonegatiation b
Full Autonegatiation v

Click the arrow to open the list. Select the required option using

the mouse.
Internal lists e.g.
Remote IP Address Metmask
255.255.255.0 i
Add

Click Add - A new list entry is created. Enter the correspond-
ing data. If list input fields remain empty, these are not saved
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when you confirm with OK. Delete the entries by clicking the
icon.

Display of options that are not available

Options that are not available because they depend on the selection of other options are
generally hidden. If the display of these options could be helpful for a configuration de-
cision, they are instead greyed out and cannot be selected.

Important

Please look at the messages displayed in the sub-menus. These provide information
on any incorrect configurations.

Warning symbols

Icon Meaning

n This symbol appears in messages referring you to settings
that were made with the Setup Tool.

f This symbol appears in messages referring you to the fact
that values were entered or selected incorrectly.

Pay particular attention to the following message:

"Warning: changes not supported by the Setup Tool!". If you makes these changes
with the Funkwerk Configuration Interface, this can cause inconsistencies or mal-
functions. Therefore, it is recommended that the configuration is continued with the
Setup Tool.

8.3.1.3 Funkwerk Configuration Interface menus

The configuration options of your device are contained in the sub-menus, which are dis-
played in the navigation bar in the left-hand part of the window.

Note

Please note that not all devices have the full range of functions. Check the software of
your device on the corresponding product page under www.funkwerk-ec.com .

The Funkwerk Configuration Interface contains the following menus:
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Assistants

In this menu you can make the basic settings that are required

First steps to add your gateway to your local network (LAN).

The assistant guides you through the individual configuration

Internet Access steps to connect your local network (LAN) to the internet.

In this menu you are guided through all of the settings that are

VPN required to set up your LAN-LAN connection as a virtual private
network.
Wireless LAN involves the set-up of a network using wireless
Wireless LAN

technology.

System Management

Status In this menu, general information on your device is displayed at
a glance.

This information includes serial number, software version, cur-
rent memory and processor use, status of the physical inter-
faces and the last 10 system messages.

Global Settings In this menu, you enter the basic system settings of your device,
such as, for example, system name, system date, system time
and passwords.

You can also manage licences that are necessary for the use of
certain functions.

Interface Mode / Bridge In this menu, you define the mode in which the interfaces of
Groups your device are to run (routing or bridging) and if necessary can
define bridge groups.

Administrative Access In this menu, you configure the access options for the individual
interfaces.

Remote Authentication In this menu, you configure the authentication via a RADIUS
server or TACAS+ server.

Physical Interfaces

AUX You can define various settings for communication between the
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gateway and modem in this menu.

Ethernet Ports In this menu, you configure the Ethernet interfaces of your
device. To do this, you select the speed and type of interface,
for example.

ISDN Ports In this menu, you configure the ISDN interface of your device.

Here you enter data such as the type of ISDN connection to
which your device is connected.

ADSL Modem Only R3000 and R3000w.

In this menu, you configure the ADSL interface of your device.
Here you specify whether Annex A or Annex B is used as ADSL
mode for the broadband connection.

SHDSL Only R3400 and R3800w.

In this menu, you configure the SHDSL interface of your device.
Here you enter how many change pairs are used for the SHDSL
connection.

Serial Ports Only R4300.

In this menu you can configure the serial WAN interface(s) for
your device, i.e. one or two integrated X.21/V.35 interfaces de-
pending on the licence. Here you enter which clock rate is used
for the connection.

UMTS Only R1200wu.

In this menu, you configure the CardBus interface of your
device. Here you specify that UMTS is enabled.

LAN

IP Configuration In this menu, you carry out the IP configuration of the LAN inter-
faces for your device.

VLAN In this menu, you configure the VLANS.

Wireless LAN (only bintec R1200w, R1200wu and R3000w)
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WLAN In this menu, you configure your wireless modules as an access
point or as an access client.

Administration In this menu, you make the basic WLAN settings.

Routing

Routes In this menu, you enter additional routes.

NAT In this menu, you configure the NAT firewall (NAT, Network Ad-

dress Translation).

RIP In this menu, you configure the dynamic updating of the routing
table via RIP.

Load Balancing In this menu, you configure application-controlled bandwidth
management.

Multicast In this menu, you configure the use of multimedia streaming

protocols for e.g. voice over IP or video and audio streaming
(e.g. IPTV or Webradio) or TriplePlay (voice, video, data).

WAN

Internet + Dialup In this menu, you define the Internet connections for the various
connection protocols or dialup connections.

ATM In this menu, you carry out configuration of the ATM profiles that

are needed for all the ADSL connections and also connection
monitoring (OAM) and ATM QoS.

Leased Line In this menu, the permanent connections of two communication
partners are displayed.

Real Time Jitter Con-  In this menu, you can set the upstream speed.
trol

VPN

IPSec In this menu, you configure VPN connections over IPSec.
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L2TP In this menu you configure the use of L2TP (Layer 2 Tunnelling
Protocol).
PPTP In this menu, you configure the an encrypted PPTP tunnel.
GRE This menu shows a list of all configured GRE tunnels.
Certificates In this menu you can generate and import keys and have them
certified.
Firewall
Policies In this menu you configure the filter rules for the firewall.
Interfaces In this menu, you can group together the interfaces to be
filtered.
Addresses In this menu, you can create the address aliases to be filtered.
Services In this menu, you can create the service aliases to be filtered.
VolP
Application Level In this menu, you configure a proxy for IP telephony, which im-
Gateway plements the necessary NAT and firewall releases for connec-

tion to the VoIP provider.

Media Gateway In this menu, you configure a network transition between vari-
ous telecommunication networks.

Local Services

DNS In this menu, you configure the name resolution.

DynDNS Client In this menu, you configure the dynamic name resolution.
DHCP Server In this menu, you configure your device as a DHCP server.
Web Filter In this menu, you configure the use of the URL-based Proventia

Web Filter from ISS (www.iss.net).
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CAPI Server In this menu, you configure your device as a CAPI server.

Scheduling In this menu, you configure time-dependent standard actions of
your devices.

Surveillance In this menu, you configure the surveillance of interfaces or
hosts in the network.

ISDN Theft Protection In this menu you can configure the ISDN theft protection func-
tion for each interface.

Funkwerk Discovery In this menu, you can configure management functions for
bintec Access Point.

UPnP In this menu, you configure the UPnP settings individually for
each interface of your gateway.

HotSpot Gateway In this menu, you configure the bintec HotSpot Gateway.

Maintenance

Diagnostics In this menu you can test the accessibility of hosts, DNS servers
or routing.

Software & Configura- In this menu, you can manage your device's configuration files.
tion You can save them either locally on your device or on your
computer, for example.

You can also start an update of the system software.
Reboot In this menu, you can initiate the rebooting of the device.

External Reporting

Syslog In this menu, you configure the host to which the data logged in-
ternally on the device is forwarded for saving and further pro-
cessing.

IP Accounting In this menu, you decide for which interfaces accounting mes-

sages are to be generated.

E-mail Alert Depending on the configuration, in this menu e-mails are sent to
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SNMP

Activity Monitor

Monitoring

the administrator as soon as relevant syslog messages occur.

In this menu, you configure whether the device is to listen for
external SNMP accesses and send SNMP traps.

In this menu, you configure the surveillance of your device with
the Windows Tool Activity Monitor (component of BRICKware
for Windows).

Internal Log

IPSec

ISDN/Modem

Interfaces

WLAN
Bridges

HotSpot Gateway

8.3.2 SNMP shell

In this menu, the system messages are displayed.

In this menu, the IPSec connections and connection statistics
that are currently active are displayed.

In this menu, the ISDN connections are displayed.

In this menu, connection statistics and status of all interfaces
are displayed.

This menu shows you the WLAN connections statistics.

In this menu you can view the current values of the configured
bridges.

This menu shows a list of all bintec HotSpot users.

SNMP (Simple Network Management Protocol) is a protocol that defines how you can ac-
cess the configuration settings.

All configuration settings are stored in the MIB (Management Information Base) in the form
of MIB tables and MIB variables. You can access these directly from the SNMP shell via
SNMP commands. This type of configuration requires a detailed knowledge of our devices.

8.4 BOOTmonitor

The BOOTmonitor is only available over a serial connection to the device.

The BOOTmonitor provides the following functions, which you select by entering the cor-
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responding number:

(1) Boot System (reboot the system):
The device loads the compressed boot file from the flash memory to the working
memory. This happens automatically on starting.

(2) Software Update via TFTP:
The devices performs a software update via a TFTP server.
(8) Software Update via XMODEM:
The device performs a software update via a serial interface with XMODEM.
(4) Delete configuration:
The device is reset to the ex works state. All configuration files are deleted and the
BOOTmonitor settings are set to the default values.
(5) Default BOOTmonitor Parameters:
You can change the default settings of the BOOTmonitor of the device, e.qg. the
baud rate for serial connections.
(6) Show System Information:

Shows useful information about your device, e.g. serial number, MAC address and
software versions.

The BOOTmonitor is started as follows.

The devices passes through various functional states when starting:

e Start mode
¢ BOOTmonitor mode

¢ Normal mode

After some self-tests have been successfully carried out in the start mode, your device
reaches the BOOTmonitor mode. The BOOTmonitor prompt is displayed if you are serially
connected to your device.

Press <sp> for boot monitor or any other key to boot system

R120@ Bootmonitor V.7.9.1 Rev. 1 from 2009/10/19 08:00:00
Copyright {c) 1996-2005 by Funkwerk Enterprise Communications GmbH

1) Boot System

2) Software Update via TFTP

3} Software Update via HMODEM

4) Delete Configuration

5) Default Bootmonitor Parameters
6) Show System Information

(
(
(
(
(
(

Your Choice> _



After display of the BOOTmonitor prompt, press the space bar within four seconds to use
the functions of the BOOTmonitor. If you do not make an entry within four seconds, the
device changes back to normal operating mode.

&n Note

If you change the baud rate (the preset value is 9600 baud), make sure the terminal
program used also uses this baud rate. If this is not the case, you will not be able to
establish a serial connection to the device.
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Chapter 9 Assistants

The Assistants menu offers step-by-step instructions for the following basic configuration
tasks:

* First steps

* Internet Access

¢ VPN

Wireless LAN

* SWYX (only with active optional DSP module)

Choose the corresponding task from the navigation bar and follow the instructions and ex-
planations on the separate pages of the Assistant.
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Chapter 10 System Management

The System Management menu contains general system information and settings.

You see a system status overview. Global system parameters such as the system name,
date/time, passwords and licences are managed and the access and authentication meth-
ods are configured.

10.1 Status

If you log into the Funkwerk Configuration Interface, your device's status page is dis-
played, which shows the most important system information.

You see an overview of the following data:

* System status

¢ Your device's activities: Resource utilisation, active sessions and tunnels

 Status and basic configuration of the LAN, WAN, ISDN, WLAN, and ADSL interfaces
¢ Information on plugged add-on modules (if any)

* The last 10 system messages

You can customise the update interval of the status page by entering the desired period in
seconds as Automatic Update Interval and clicking on the Apply-button.

f Caution
Under Automatic Refresh Interval do not enter a value of less than 5 seconds, other-
wise the refresh interval of the screen will be too short to make further changes!
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R1 J"ll“" Language English ~| | View |Standard ~| | online Help | Logout ﬁ-ll'lk“l‘k@
B | = w w

Save configuration

Assistants ~7
System Management - Automatic Refresh Intsrval B0 Seconds Apply
Status (:] ‘Warning: System Password not changed!
GlohaliSattinn e System Information
Interface Mode / Bridge
e Uptime 2 Dawy(s) 22 Hour(s) 27 Minute(s)
Administrative Access System Date Mon Jan 16 23:53:01 2006
emateAuthenticalion Gerial Number R1E180006500018
Elpicalkmonaces = BOSS Version V.7.9 Rev. 1 IPSec from 2009/11109 00:00:00
LAN T Resource Information
Wireless LAN - CPU Usage 0%
Routing = Memary Usage 22.1/31.9 MB (70%)
WAN = 130N Usage Esternal 0/4B Channels
VPN ~ Active Sessions (SIF, RTP, ete...) 0
Firewall T Active IPSec Tunnels 0/0
VolP > Physical Interface Interface Specifics Link
Local Services - ent-0 102.168.0.254] 265.266.265.0 (]
Maitenance - ent-4 Mat configured /Mot configured [+]
WLAN off (]
ExdamalRenciting hd com0-8 Mot configured [+]
Monitoring = briz-0 Mot configured [+]
briz-1 Mot configured [+]
Configured [+]
Recert System Logs
Time Level Subsystem Message
01:25:24 Infarmation WalP PABKD: Adminstatus is disabled, all PABX features will be disabled
01:25:23 Information IPSec init: starting
01:25:23 Information  |PSec BinTec ipsecd version 3.0 Copyright (c) 1998-2008 by Funkwerk Enterprise Communications GmbH
01:25:23 Infarmation IPSec init: running
01:25:23 Information INET sshd: pid 57 - listening on 0.0.0.0 port 22
01:25:22 Infarmation Conflauration  swstern r1200 started at Sat Jan 14 1:25:22 2006
01:25:21 Debug Ethernet ent-0: add multicast 01:00:5e:00000:02
012521 Debug Ethernet en1-0: add multicast 01:00:5e:00:00:16
01:25:21 Debug HTTP hittpd[24]: pem: unakle to read key file
012521 Debug HTTP hitpd[25]: using default cerificate

Fig. 40: System Management -> Status
The System Management -> Status menu consists of the following fields:

Fields in the Status System Information menu

Uptime Displays the time past since the device was rebooted.
System Date Displays the current system date and system time.

Serial Number Displays the device serial number.

BOSS Version Displays the currently loaded version of the system software.

Fields in the Status Resource Information menu

CPU Usage Displays the CPU usage as a percentage.

Memory Usage Displays the usage of the working memory in MByte in relation
to the available total working memory in MByte. The usage is
also displayed in brackets as a percentage.
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ISDN Usage Internal Shows the number of active B channels and the maximum num-
ber of available B channels for internal connections.

ISDN Usage External Shows the number of active B channels and the maximum num-
ber of available B channels for external connections.

Active Sessions (SIF, Displays the total of all SIF, TDRC, and IP load balancing ses-
RTP, etc... ) sions.

Active IPSec Tunnels Displays the number of currently active IPSec tunnels in relation
to the number of configured IPSec tunnels.

Fields in the Status Module menu

DSP Module Shows the type of plugged DSP module if any. An acquired fax
licence, if any, can be displayed.

Other fields in the Status menu
I

Physical Interface - In-  The physical interfaces are listed here and their most important
terface Specifics - Link  settings are shown. The system also displays whether the inter-
face is connected or active.

Interface specifics for Ethernet interfaces:

¢ |P Address
e Subnet Mask

Interface specifics for serial/ISDN interfaces:

» Configured

* Not configured

Interface specifics for xDSL interfaces:
* Downstream/Upstream Line Speed
Interface Specifics for WLAN Interfaces:

Access Point Mode:

¢ Operation Mode: Access Point or Off
¢ The channel used on this wireless module

¢ Number of connected clients



Field Value

¢ Number of WDS links

» Software version of the wireless card
Access Client Mode:

¢ Operation Mode: Access Client or Off

¢ The channel used on this wireless module

» Software version of the wireless card

Recent System Logs Displays the last 10 system messages.

10.2 Global Settings

The basic system parameters are managed in the Global Settings menu.

10.2.1 System

The System Management -> Global Settings -> System menu is used for entering the
basic system data of your device.

Language |English | | ‘iew |Standard ~| | Online Help | Logout

System Passwords Date and Time | System Licences

Basic Parameters

Global Settings

nterface Mode / Bridge System Name rz00
[l —— Lacation

dministrative Access
Authentication Contact FUNIWERK.

Maximurn Murnber of Syslog Entries a0
Maxirnum Message Level of Syslog Entries

Maximum MNumber of Accounting Log Entries | |20
€ oK ) ( Cancel )

Fig. 41: System Management -> Global Settings -> System

The System Management -> Global Settings -> System menu consists of the following
fields:
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Fields in the System Basic Parameters menu
.

System Name Enter the system name of your device. This is also used as the
PPP host name.

A character string of up to 255 characters is possible.

The device type is entered as the default value.
Location Enter the location of your device.

Contact Enter the relevant contact person. Here you can enter the e-
mail address of the system administrator, for example.

A character string of up to 255 characters is possible.

The default value is FUNKWERK.

Maximum Number of Enter the maximum number of syslog messages that are stored
Syslog Entries internally in the device.

Possible values are 0to 1000.

The default value is 50. You can view the stored messages in
Monitoring -> Internal Log.

Maximum Message Select the priority of system messages above which a log
Level of Syslog Entries  should be created.

System messages are only recorded internally if they have a
higher or identical priority to that indicated, i.e. all messages
generated are recorded at syslog level debug.

Possible values:

* Emergency: Only messages with emergency priority are re-
corded.

e Alert: Messages with emergency and alert priority are recor-
ded.

* Critical: Messages with emergency, alert and critical prior-
ity are recorded.

* Errors: Messages with emergency, alert, critical and error
priority are recorded.



Field Value

* Warning: Messages with emergency, alert, critical, error and
warning priority are recorded.

* Notice: Messages with emergency, alert, critical, error,
warning and notice priority are recorded.

* Information (default value) Messages with emergency,
alert, critical, error, warning, notice and information priority are
recorded.

* Debug: All messages are recorded.

Maximum Number of Ac- Enter the maximum number of accounting entries that are
counting Log Entries stored internally in the device.

Possible values are 0to 1000.

The default value is 20.

10.2.2 Passwords

Setting the passwords is another basic system setting.

Language | English v | View |Standard ~| | online Help | Logout

System Passwords Date and Time System Licences

System Password

Global Settings

Interface Mode | Bridge System Admin Password LLLLTTIT]
Groups
| EkocE Caonfirm Admin Passward CITTTTTT)
Administrative Access
Remote Authentication SMMP Communities
SNMP Read Community CITTTTTTY
SNMP Write Community LLLLTTIT]

Global Password Options

Show passwords and keys in cleartext = Show

( oK ) ( Cancel )

Fig. 42: System Management -> Global Settings -> Passwords
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@ Note

All bintec devices are delivered with the same username and password. As long as
the password remains unchanged, they are not protected against unauthorised use.

Make sure you change the passwords to prevent unauthorised access to the device

If the password is not changed, under System Administration -> Status appears the
warning: "System password not changed!"

The System Management -> Global Settings -> Passwords menu consists of the follow-
ing fields:

Fields in the Passwords System Password menu
T

System Admin Pass- Enter the password for the user name admin.

word
This password is also used with SNMPv3 for authentication

(MD5) and encryption (DES).

Confirm Admin Pass- Confirm the password by entering it again.
word

Fields in the Passwords SNMP Communities menu

Field Value

SNMP Read Community Enter the password for the user name read.

SNMP Write Community Enter the password for the user name write.

Fields in the Passwords Global Password Options menu

Show passwords and Define whether the passwords are to be displayed in clear text
keys in clear text (plain text).

The function is activated with Display.
The function is disabled by default.

If you activate the function, all passwords and keys in all menus
are displayed and can be edited in plain text.

The WLAN and IPSec keys are one exception here. They can
only be entered in plain text. If you press OK or call the menu
again, they are displayed as asterisks.



10.2.3 Date and Time

You need the system time for tasks such as correct timestamps for system messages, ac-
counting or IPSec certificates.

bintec R1200 " Language [English | | View [Standard ~| | Online Help | Logout

System Passwords Date and Time System Licences

System Time
Global Settings

nterface Mode / Bridge Systern Time Zone UTC+00 v
Toups Current Local Time Tue Jan 17 23:40:31 2006
minizlpine Accezz Manual Time Settings
Remote Authentication
0 Day Month Year
New Date
Hour Minute
MNew Local Time
Automatic Time Settings (Time Protocol)
Update systern time from [SDN CJEnabled
Primary Timesener I SMNTF ~
Secondary Timeserer I SMNTF ~
Third Timeserver I SNTFP v
Time Update Interval 1440 Minute(s)
Time Update Policy
Internal Time Server Clenabled

C oK 0 ( cancel )

Fig. 43: System Management -> Global Settings -> Date and Time

You have the following options for determining the system time (local time):

ISDN/Manual

The system time is updated via ISDN, i.e. the date and time are taken from the ISDN when
the first outgoing call is made, or is set manually on the device.

If the correct location of the device (country/city) is set for the System Time Zone, switch-
ing from summer time to winter time (and back) is automatic. This is independent of the ex-
change time or the ntp server time. Summer time starts on the last Sunday in March by
switching from 2 a.m. to 3 a.m. The calendar-related or schedule-related switches that are
scheduled for the missing hour are then carried out. Winter time starts on the last Sunday
in October by switching from 3 a.m. to 2 a.m. The calendar-related or schedule-related
switches that are scheduled for the additional hour are then carried out.

If a value other than Universal Time Coordinated (UTC), option UTC+-x, has been chosen
for the System Time Zone, the switch from summer to winter time must be carried out
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manually when required.

Time Server

You can obtain the system time automatically, e.g. using various time servers. To ensure
that the device uses the desired current time, you should configure one or more time serv-
ers. Switching from summer time to winter time (and back) must be carried out manually if
the time is derived using this method by changing the value in the System Time Zone field
with an option UTC+ or UTC-.

@ Note

If a method for automatically deriving the time is defined on the device, the values ob-
tained in this way automatically have higher priority. A manually entered system time is
therefore overwritten.

The System Management -> Global Settings -> Date and Time menu consists of the fol-
lowing fields:

Fields in the Date and Time System Time menu

I =

System Time Zone Select the time zone in which your device is installed.

You can select Universal Time Coordinated (UTC) plus or
minus the deviation in hours or a predefined location, e.g.
Europe/Berlin.

Current Local Time The current date and current system time are shown here. The
entry cannot be changed.

Fields in the Date and Time Manual Time Settings menu
Field Description
New Date Enter a new date.

Format:
e Day: dd
¢ Month: mm

* Year: yyyy

New Local Time Enter a new time.
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Format:

e Hour: hh

¢ Minute: mm

Fields in the Date and Time Automatic Time Settings (Time Protocol) menu

Field Description

Update system time Define whether the time information received at an incoming

from ISDN ISDN connection is used to update the system time. If a time
server is configured, the time is only determined over ISDN until
a successful update is received from this time server. Updating
over ISDN is deactivated for the period in which the time is de-
termined by means of a time server.

The function is activated with Enabled.

The function is disabled by default.

Primary Timeserver Enter the primary time server, using either a domain name or an
IP address.

In addition, select the protocol for the time server request.

Possible values:
e SNTP (default value): This server uses the simple network
time protocol with UDP port 123.

e Time Service / UDP: This server uses the Time service
with UDP port 37.

e Time Service / TCP: This server uses the Time service
with TCP port 37.

e None: This time server is not currently used for the time re-
quest.

Secondary Timeserver  Enter the secondary time server, using either a domain name or
an |IP address.

In addition, select the protocol for the time server request.

Possible values:

e SNTP (default value): This server uses the simple network
time protocol with UDP port 123.
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Third Time Server

Time Update Interval

Time Update Policy

Time Service / UDP: This server uses the Time service
with UDP port 37.

Time Service / TCP: This server uses the Time service
with TCP port 37.

None: This time server is not currently used for the time re-
quest.

Enter the tertiary time server, using either a domain name or an
IP address.

In addition, select the protocol for the time server request.

Possible values:

SNTP (default value): This server uses the simple network
time protocol with UDP port 123.

Time Service / UDP: This server uses the Time service
with UDP port 37.

Time Service / TCP: This server uses the Time service
with TCP port 37.

None: This time server is not currently used for the time re-
quest.

Enter the time interval in minutes at which the time is automatic-
ally updated.

The default value is 1440.

Enter the time period after which the system attempts to contact
the time server again following a failed time update.

Possible values:

Normal (default value): The system attempts to contact the
time server after 1, 2, 4, 8, and 16 minutes.

Aggressive: For ten minutes, the system attempts to con-
tact the time server after 1, 2, 4, 8 seconds and then every 10
seconds.

Endless: For an unlimited period, the system attempts to
contact the time server after 1, 2, 4, 8 seconds and then every
10 seconds.
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If certificates are used to encrypt data traffic in a VPN, it is ex-
tremely important that the correct time is set on the device. To
ensure this is the case, for Time Update Policy, select the
value Endless.

Internal Time Server Select whether the internal timeserver is to be used.

The function is enabled by choosing Enabled. Time requests
from a client will be answered with the current system time. This
is given as GMT, without offset.

The function is disabled by default. Time requests from a client
are not answered.

10.2.4 System Licenses

This chapter describes how to activate the functions of the software licences you have pur-
chased.

The following licence types exist:

¢ Licences already available in the device's ex works state

* Free extra licences

¢ Extra licences at additional cost

The data sheet for your device tells you which licences are available in the device's ex

works state and which can also be obtained free of charge or at additional cost. You can
access this data sheet at www.funkwerk-ec.com.

Entering licence data

You can obtain the licence data for extra licences via the online licensing pages in the sup-
port section at www.funkwerk-ec.com . Please follow the online licensing instructions.
(Please also note the information on the licence card for licences at additional cost.) You
will then receive an e-mail containing the following data:

* License Key and

* Licence Serial Number

You enter this data in the System Management -> Global Settings-> System Licenses -
> New menu.

In the System Management -> Global Settings -> System Licenses menu, a list of all re-


http://www.funkwerk-ec.com
http://www.funkwerk-ec.com

gistered licenses is shown (Description, License Type, License Serial Number, Status).

Possible values for Status:

Licence Meaning

OK Subsystem is activated.
Not OK Subsystem is not activated.
Not supported You have entered a licence for a subsystem your device does

not support.

In addition, above the list is shown the System License-ID required for on-line licensing.

10.2.4.1 Edit/New

Choose the @ icon to edit existing entries. Choose the New button to add licences.

bintec R1200 ; Language |English | | wiew |Standard ~| | Online Help | Logout

System Passwords Date and Time System Licences

Status
lobal Settings
nterface Mode / Bridge

Basic Parameters

Licence Serial Mumber I

roups
dministrative Access
mote Authentication

Licence Key I

€ oK ) ( Cancel )

Fig. 44: System Management -> Global Settings -> System Licenses -> New

Activating extra licences

You activate extra licences by adding the received licence information in the System Man-
agement -> Global Settings -> System Licenses -> New menu.

The System Management -> Global Settings -> System Licences -> New menu con-
sists of the following fields:

Fields in the System Licences Basic Parameters menu
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Licence Serial Number  Enter the licence serial number you received when you bought
the licence.

Licence Key Enter the licence key you received by e-mail.

@ Note

If Not OKis displayed as the status:
* Enter the licence data again.

¢ Check your hardware serial number.

If Not Supportedis displayed as the status, you have entered a license for a sub-
system that your device does not support. This means you cannot use the functions of
this licence.

Deactivating a licence

Proceed as follows to deactivate a licence:
(1) Go to System Management -> Global Settings-> System Licenses.

(2) Pressthe icon in the line containing the licence you want to delete.

(3) Confirm with OK.

The licence is deactivated. You can reactivate your additional licence at any time by enter-
ing the valid licence key and licence serial number.

10.3 Interface Mode / Bridge Groups

In this menu, you define the operation mode for your device's interfaces.

Routing versus bridging

Bridging connects networks of the same type. In contrast to routing, bridges operate at lay-
er 2 of the OSI model (data link layer), are independent of higher-level protocols and trans-
mit data packets using MAC addresses. Data transmission is transparent, which means the
information contained in the data packets is not interpreted.

With routing, different networks are connected at layer 3 (network layer) of the OSI model
and information is routed from one network to the other.



Conventions for port/interface names

If your device has a radio port, it receives the interface name WLAN. If there are several ra-
dio modules, the names of wireless ports in the user interface of your device are made up
of the following parts:

(a) WLAN
(b) Number of the physical port (1 or 2)

Example: WLANI

The name of the Ethernet port is made up of the following parts:

(a) ETH, where en stands for Ethernet
(b) Number of the port

Example: ETHI

The names of the interfaces connected to an Ethernet port are made up of the following
parts:

(a) Abbreviation for interface type
(b) Number of the Ethernet port

(c) Number of the interface
Example: en1-0 (first interface on the first Ethernet port)
The name of the bridge group is made up of the following parts:

(a) Abbreviation for interface type

(b) Number of the bridge group
Example: bro (first bridge group)
The name of the wireless network is made up of the following parts:

(a) Abbreviation for interface type
(b) Number of the wireless module

(c) Number of the interface
Example: vss1-0 (first wireless network on the first wireless module)

The name of the WDS link or bridge link is made up of the following parts:

(a) Abbreviation for interface type
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(b) Number of the wireless module on which the WDS link or bridge link is configured
(¢) Number of the WDS link or bridge link

Example: wds1-0 (first WDS link or bridge link on the first wireless module)

The name of the client link is made up of the following parts:

(a) Abbreviation for interface type
(b) Number of the wireless module on which the client link is configured

(c) Number of the client link
Example: stal-0 (first client link on the first wireless module)

The names of the virtual interfaces connected to an Ethernet port are made up of the fol-
lowing parts:

(a) Abbreviation for interface type

(b) Number of the Ethernet port

(c) Number of the interface connected to the Ethernet port

(d) Number of the virtual interface

Example: en1-0-1 (first virtual interface based on the first interface on the first Ethernet
port)

10.3.1 Interfaces
You define separately whether each interface is to operate in routing or bridging mode.

If you want to set bridging mode, you can either use existing bridge groups or create a new
bridge group.

The default setting for all existing interfaces is routing mode. On selecting the New Bridge
Group option for Mode / Bridge Group, a bridge group, i.e. br0 , brl etc., is automatic-
ally created and the interface is run in bridging mode.
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Save configuration
Assistants

System Management
Status
Global Settings
Interface Mode /Bridge
Groups
Administrative Access
Remote Authentication

Physical Interfaces
LAN

Wireless LAN
Routing

WAN

VPN

Firewall

VolP

Local Services
Maintenance
External Reporting

Monitoring

' Language
1

wom =

Caonfiguration Interface

Intertace Description

ent-0
ent-4

ws51-0

English | | View | Standard v

Funkwerk Enterprise Communications GmbH

Online Help | Logout E_I;I_k“rkﬂ
W u w r .

Interfaces

Mode / Bridge Group
Fiouting Mode ~

Fiouting Mode b
Fiouting Mode b

Selectone v

QK Cancel

Fig. 45: System Management -> Interface Mode / Bridge Groups -> Interfaces

The System Management -> Interface Mode / Bridge Groups -> Interfaces menu con-
sists of the following fields:

Fields in the Interfaces menu

Field Description

#

Interface Description

Mode / Bridge Group

Configuration Interface

Shows the serial number of the interface.
Displays the name of the interface.

Select whether you want to run the interface in Routing Mode
or whether you want to assign the interface to an existing ( bro0,
brl etc.) or new bridge group ( New Bridge Group). If you
select New Bridge Group, a new bridge group is created
automatically when you click OK.

Select the interface via which the configuration is to be carried
out.

Possible values:

e Select one (default value): Ex works setting The right con-
figuration interface must be selected from the other options.

e Tgnore : No interface is defined as configuration interface.

* <Interface name>: Select the interface to be used for con-
figuration. If this interface is in a bridge group, it is assigned
the group's IP address when it is taken out of the group.



10.3.1.1 <stax-x> Edit

Click the @ icon to edit additional settings for WLAN clients in bridge mode (so-called
MAC bridge).

bintec R1200 ' Language [English v| | view |Standard ~| | Online Help | Logout

Interfaces

Layer-2.5 Options
Interface stal-0

‘Wildcard Mode
dministrative Access
S _Remote Authentication ( OK ) _cancel )

Fig. 46: System Management -> Global Settings -> Interface Mode / Bridge Groups ->
Edit

You can realise bridging for devices behind access clients with the MAC Bridge function. In
wildcard mode you cannot define how Unicast non-IP frames or non-ARP frames are pro-
cessed. To use the MAC bridge function, you must carry out configuration steps in several
menus.

(1) Select the Funkwerk Configuration Interface menu Wireless LAN -> WLANXx ->
Radio Settings and click the icon to change an entry.

(2) Set Operation Mode to Access Client and save the settings with OK.

(3) Select the menu options System Management -> Interface Mode / Bridge Groups -
> Interfaces. The additional interface sta1-0 is displayed.

(4) Forinterface sta1-0 select Mode / Bridge Group = br0 and Configuration Interface
= enl-0 and save the settings with OK.

(5) Click the Save Configuration button to save all of the configuration settings. You can
use the MAC Bridge.

The System Management -> Interface Mode / Bridge Groups -> Edit menu consists of
the following fields:
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Fields in the <stax-x> Layer 2.5 Option menu

Interface Shows the interface that is being edited.

Wildcard Mode
Select the Wildcard mode you want to use on the interface.

Possible values:

* None (default value): Wildcard mode is not used.

e Static: With this setting, you must enter the MAC address of
a device that is connected over IP under Wildcard MAC Ad-
dress. Each packet without IP and without ARP is forwarded
to this device. This occurs even when the device is no longer
connected.

e First: If you choose this setting the MAC address of the first
non-IP unicast frame or non-ARP unicast frame, which occurs
on any of the Ethernet interfaces, is used as the wildcard
MAC address. This wildcard MAC address can only be reset
by rebooting the device or by selecting another wildcard
mode.

* Last: If you choose this setting the internal WLAN MAC ad-
dress is used to establish a connection to the access point. As
soon as a non-IP unicast frame or non-ARP unicast frame ap-
pears, it is forwarded to the MAC address from which the last
non-IP unicast frame or non-ARP unicast frame was received
on the Ethernet interface of the device. This wildcard MAC ad-
dress is renewed with each non-IP unicast frame or non-ARP
unicast frame.

Wildcard MAC Address  Only for Wildcard Mode = Static

Enter the MAC address of a device that is connected over IP.

Transparent MAC Ad- Only for Wildcard Mode = Static, First

dress
Choose whether or not the Wildcard MAC Address is used in

addition to the WLAN MAC address to establish the connection
to the access point.

The function is activated with Enabled.

The function is disabled by default.



10.4 Administrative Access

In this menu, you can configure the administrative access to the device.

10.4.1 Access

In the Administrative Access -> Access menu, a list of all IP-configurable interfaces is
shown.

bintec R1200 Language |English | | Wiew |Sandard ~| | online Help | Logout
e i s e
Interface Telnet s5H HTTP HTTPS Ping BN 1SDH Lagin
Global Settings eni-o O
Interface Mode | Bridge
o ent-4 O
ive Access ford O
| Remote Authentication 0 0 0 0 0 0
hriz-0 O O O O O O
briz-1 O O O ] O ]
C Add ) C OK 0 cancel )

Fig. 47: System Management -> Administrative Access -> Access

For the Ethernet interface you can select the access parameters Telnet, SSH, HTTP, HT-

TPS

, Ping, SNMP, and for the ISDN interfaces you can select ISDN Login.

R1xxx/R3xxx/R4xxx




10.4.1.1 Add

Press the Add button to configure administrative access for additional interfaces.

bintec. R1200 Language |English | | View |Standard v| | Online Help | Logout

Access SSH SNMP

" Interface
Global Settings

| Interface Mode / Bridge

Groups ok ) (_ cancel )

Administrative Access
Remote Authentication

Fig. 48: System Management -> Administrative Access -> Access -> Add

The System Management -> Administrative Access -> Access -> Add menu consists of
the following fields:

Fields in the Access menu

Field Description

Interface Select the interface for which administrative access is to be con-
figured.

10.4.2 SSH

Your devices offers encrypted access to the shell. You can enable ( enabled, default value)
or disable this access in the System Management -> Administrative Access -> SSH
menu and have access to the options for configuration of the SSH login.

R1xxx/R3xxx/R4xxx
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Fig. 49: System Management -> Administrative Access -> SSH

You need an SSH client application, e.g. PuTTY, to be able to reach the SSH Daemon.

If you wish to use SSH Login together with the PuTTY client, you may need to comply with
some special configuration requirements, for which we have prepared FAQs. You will find
these in the Service/Support section at www.funkwerk-ec.com .

To be able to reach the shell of your device via an SSH client, make sure the settings for
the SSH Daemon and SSH client are the same.

Note

If configuration of an SSH connection is not possible, restart the device to initialise the
SSH Daemon correctly.

The System Management -> Administrative Access -> SSH menu consists of the follow-

ing fields:

Fields in the SSH SSH (Secure Shell) Parameters menu

Field Value

SSH service active

Select whether the SSH Daemon is to be enabled for the inter-

face.

The function is enabled by choosing Enabled.
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The function is enabled by default.

Compression Select whether data compression should be used.
The function is enabled by choosing Enabled.

The function is disabled by default.

TCP Keepalives Select whether the device is to send keepalive packets.
The function is enabled by choosing Enabled.

The function is enabled by default.

Logging Level Select the syslog level for the syslog messages generated by
the SSH Daemon.

Possible settings:

* Information (default value) Fatal and simple errors of the
SSH Daemon and information messages are recorded.

* Fatal: Only fatal errors of the SSH Daemon are recorded.

e Errors: Fatal and simple errors of the SSH Daemon are re-
corded.

* Debug: All messages are recorded.

Fields in the SSH Authentication and Encryption Parameters menu
T

Encryption Algorithms  Select the algorithms that are to be used to encrypt the SSH
connection.

Possible options:

* 3DES
® Blowfish
* AES-128

® AES-256

3DES, Blowfish and AES-128 and are enabled by default.

Hashing Algorithms Select the algorithms that are to be available for message au-
thentication of the SSH connection.
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Possible options:

* MD5
® SHA-1

® RipeMD160

MD5, SHA-1 and RipeMD1 60 are enabled by default.

Fields in the SSH Key Status menu
Field Value

RSA Key Status Shows the status of the RSA key.

If an RSA key has not been generated yet, Not Generatedis
displayed in red and a link, Generate, is provided. If you select
the link, the generation process is triggered and the view is up-
dated. The status Generatingis displayed in green. When
generation has been completed successfully, the status
changes from Generatingto Generated. If an error occurs
during generated, Not Generated and the Generate link are
displayed again. You can then repeat generation.

If the status Unknown is displayed, generation of a key is not
possible, for example because there is not enough space in the
FlashROM.

DSA Key Status Shows the status of the DSA key.

If a DSA key has not been generated yet, Not Generatedis
displayed in red and a link, Generate, is provided. If you select
the link, the generation process is triggered and the view is up-
dated. The status Generatingis displayed in green. When
generation has been completed successfully, the status
changes from Generatingto Generated. If an error occurs
during generated, Not Generated and the Generate link are
displayed again. You can then repeat generation.

If the status Unknown is displayed, generation of a key is not
possible, for example because there is not enough space in the
FlashROM.



10.4.3 SNMP

SNMP (Simple Network Management Protocol) is a network protocol used to monitor and
control network elements (e.g. routers, servers, switches, printers, computers etc.) from a
central station. SNMP controls communication between the monitored devices and monit-
oring station. The protocol describes the structure of the data packets that can be transmit-
ted, as well as the communication process.

The data objects queried via SNMP are structured in tables and variables and defined in
the MIB (Management Information Base). This contains all the configuration and status
variables of the device.

SNMP can be used to perform the following network management tasks:

» Surveillance of network components
* Remote controlling and configuration of network components

¢ Error detection and notification

You use this menu to configure the use of SNMP.

bintee R1200 Language |English | | Wiew |Sandard v| | online Help | Logout

Access SSH SNMP

Basic Parameters
Global Settings
| Interface Mode / Bridge BNMP Version vt Evae Hva

| Growps SMMP Listen UDP Port 181
dministrative Access

Remote Authentication

€ OK ) € Cancel )

Fig. 50: System Management -> Administrative Access -> SNMP

The System Management -> Administrative Access -> SNMP menu consists of the fol-
lowing fields:

Fields in the SNMP Base Parameters menu

R1xxx/R3xxx/R4xxx
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SNMP Version Select the SNMP version your device is to use to listen for ex-
ternal SNMP accesses.

Possible values:

e v1: SNMP Version 1
e v2c: Community-Based SNMP Version 2
* v3: SNMP Version 3

v1, v2c and v3 are active by default.

If no option is selected, the function is deactivated.

SNMP Listen UDP Port Shows the UDP port ( 161) at which the device receives SNMP
requests.

The value cannot be changed.

@ .
If your SNMP Manager supports SNMPv3, you should, if possible, use this version as
older versions transfer all data unencrypted.

10.5 Remote Authentication

This menu contains the settings for user authentication.

10.5.1 RADIUS

RADIUS (Remote Authentication Dial In User Service) is a service that enables authentica-
tion and configuration information to be exchanged between your device and a RADIUS
server. The RADIUS server administrates a database with information about user authen-
tication and configuration and for statistical recording of connection data.

RADIUS can be used for:

¢ Authentication
¢ Accounting

¢ Exchange of configuration data

For an incoming connection, your device sends a request with user name and password to
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the RADIUS server, which then searches its database. If the user is found and can be au-
thenticated, the RADIUS server sends corresponding confirmation to your device. This con-
firmation also contains parameters (called RADIUS attributes), which your device uses as
WAN connection parameters.

If the RADIUS server is used for accounting, your device sends an accounting message at
the start of the connection and a message at the end of the connection. These start and
end messages also contain statistical information about the connection (IP address, user
name, throughput, costs).

RADIUS packets

The following types of packets are sent between the RADIUS server and your device
(client):

Packet types
Field Value
ACCESS_REQUEST Client -> Server

If an access request is received by your device, a request is
sent to the RADIUS server if no corresponding connection part-
ner has been found on your device.

ACCESS_ACCEPT Server -> Client

If the RADIUS server has authenticated the information con-
tained in the ACCESS_REQUEST, it sends an AC-
CESS_ACCEPT to your device together with the parameters
used for setting up the connection.

ACCESS_REJECT Server -> Client

If the information contained in the ACCESS_REQUEST does
not correspond to the information in the user database of the
RADIUS server, it sends an ACCESS_REJECT to reject the
connection.

ACCOUNTING_START Client -> Server

If a RADIUS server is used for accounting, your device sends
an accounting message to the RADIUS server at the start of
each connection.

ACCOUNTING_STOP  Client -> Server
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If a RADIUS server is used for accounting, your device sends
an accounting message to the RADIUS server at the end of
each connection.

In the System Management -> Remote Authentication -> RADIUS menu, a list of all re-
gistered RADIUS servers is displayed.

10.5.1.1 Edit/New

Choose the [i] icon to edit existing entries. Choose the New button to add RADIUS serv-

ers.
E: h o Py ¥ X
5 - =m, L i
tec R1 J1 | SIS | - uage [English v | view [Sandard ~| | Onling Help | Logout fl.ll'lk“l‘k@
- x = w w 1 : e
Save confyuration, RADIUS TACACS+ Options
Assistants -
System Management -
Slatuz Basic Parameters
Global Settings
Interface Mode / Bridge Authentication Twpe Authentication v
(e Senier IP Address
Administrative Access
Remote Authentication RADIUS Secret CITTTTTT)
Physical Interfaces - Priority 0~
LAN ~
Entry active [Enabled
Wireless LAN ~7
Routing - Group Description Default Group 0 v
WAN - -
Advanced Settings
VPN A
Firewall - Policy Authoritative L
. hd UDF Part 1812
Local Services -
Server Timeout 1000 Milliseconds
Maintenance ~7
Alive Chaeck Y| Ena
External Reporting - it MlEnabled
Monitoring - Retries 1
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RADIUS Dialout Reload Interval 0 Seconds
Default User Passward sssssass
OK Cancel

Fig. 51: System Management -> Remote Authentication -> RADIUS -> New

The System Management -> Remote Authentication -> RADIUS -> New menu consists
of the following fields:

Fields in the RADIUS Basic Parameters menu
I

Authentication Type Select what the RADIUS server is to be used for.

10 System Management
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Vendor Mode

Server IP Address

RADIUS Secret

Priority

Entry active

Possible values:
* Authentication (default value): The RADIUS server is
used for controlling access to a network.

* Accounting: The RADIUS server is used for recording stat-
istical call data.

* Login Authentication: The RADIUS server is used for
controlling access to the SNMP shell of your device.

* IPSec Authentication: The RADIUS server is used for
sending configuration data for IPSec peers to your device.

* WLAN (802.1X): The RADIUS server is used for controlling
access to a wireless network.

e XAUTH: The RADIUS server is used for authenticating IPSec
peers via XAuth.

Only for Authentication Typ = Accounting.

For HotSpot applications select the mode that is defined by the
vendor.

For standard applications keep the value Standard.
Possible values for Hotspot applications:

e FT: For Hotspot applications of France Telecom.

e bintec HotSpot Server: For bintec Hotspot applications.
Enter the IP address of the RADIUS server.

Enter the shared password used for communication between
the RADIUS server and your device.

If a number of RADIUS server entries were created, the server
with the highest priority is used first. If this server does not an-
swer, the server with the next-highest priority is used.

Possible values from 0 (highest priority) to 7 (lowest priority).
The default value is 0.

See also Policy in the Advanced Settings.

Select whether the RADIUS server configured in this entry is to
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be used.
The function is enabled by choosing Enabled.

The function is enabled by default.

Group Description Define a new RADIUS group description or assign the new RA-
DIUS entry to a predefined group. The configured RADIUS
servers for a group are queried according to priority and
policy.

Possible values:
* New (default value): Enter a new group description in the text
field.

* Default Group O0: Select this entry for special applications,
such as HotSpot Server configuration.

* <Group Name>: Select a predefined group from the list.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu
Field Value

Policy Select how your device is to react if a negative answer to a re-
quest is received.

Possible values:

* Authoritative (default value): A negative response to a
request is accepted.

* Non-authoritative : A negative response to a request is
not accepted. A request is sent to the next RADIUS server un-
til your device receives a response from a server configured
as authoritative.

UDP Port Enter the UDP port to be used for RADIUS data.

RFC 2138 defines the default ports 1812 for authentication
(1645 in older RFCs) and 1813 for accounting (4,180.84 cm
older RFCs). You can obtain the port to be used from the docu-
mentation for your RADIUS server.

The default value is 1812.
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Server Timeout

Alive Check

Retries

RADIUS Dialout

Enter the maximum wait time between ACCESS_REQUEST
and response in milliseconds.

After timeout, the request is repeated according to Retries or
the next configured RADIUS server is requested.

Possible values are whole numbers between 50 and 50000.

The default value is 1000 (1 second).

Here you can activate a check of the reachability of a RADIUS
server in Status Down.

An Alive Check is carried out regularly (every 20 seconds) by
sending an ACCESS_REQUEST to the IP address of the RADI-
US server. If the server is reachable, Status is setto alive
again. If the RADIUS server is only reachable over a switched
line (dialup connection), this can cause additional costs if the
server is down for a long time.

The function is enabled by choosing Enabled.

The function is enabled by default.

Enter the number of retries for cases when there is no response
to a request. If an answer has still not been received after these
attempts, the Status is set to down. If the Active Check = En-
abledyour device tries to reach the server every 20 seconds. If
the server answers, the Status is set back to alive.

Possible values are whole numbers between 0 and 10.

The default value is 1. To prevent Status being set to down, set
this value to 0.

Only for Authentication Type = Authentication and IPSec
Authentication.

Select whether your device receives requests from RADIUS
server dialout routes. This enables temporary interfaces to be
configured automatically and your device can initiate outgoing
connections that are not configured permanently.

The function is enabled by choosing Enabled.
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The function is disabled by default.
If the function is active, you can enter the following options:

* Reload Interval Enterthe time period in seconds
between the update intervals.

The default entry here is 0 i.e. an automatic reload is not car-
ried out.

* Default User Password: This is the shared password
used for communication between the RADIUS server and
your device.

10.5.2 TACACS+

TACACS+ permits access control for your device, network access servers (NAS) and other
network components via one or more central servers.

Like RADIUS, TACACS+ is an AAA protocol and offers authentication, authorisation and
accounting services (TACACS+ Accounting is currently not supported by bintec devices).

The following TACACS+ functions are available on your device:

¢ Authentication for login shell

* Command authorisation on the shell (e.g. telnet, show)
TACACS+ uses TCP port 49 and establishes a secure and encrypted connection.

In the System Management -> Remote Authentication -> TACACS+ menu, a list of all
registered TACACS+ servers is displayed.

10.5.2.1 Edit/New

Choose the [i] icon to edit existing entries. Choose the New button to add TACACS+ serv-
ers.
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Fig. 52: System Management -> Remote Authentication -> TACACS+ -> New

The System Management -> Remote Authentication -> TACACS+ -> New menu con-
sists of the following fields:

Fields in the TACACS+ Basic Parameters menu
Field Description

Authentication Type Displays which TACACS+ function is to be used. The value
cannot be changed.

Possible values:

* Login Authentication: Here, you can define whether the
current TACACS+ server is to be used for login authentication
to your device.

Server IP Address Enter the IP address of the TACACS+ server that is to be re-
quested for login authentication.

TACACS+ Secret Enter the password to be used to authenticate and, if applic-
able, encrypt data exchange between the TACACS+ server and
the net-access server (your device). The maximum length of the
entry is 32 characters.

Priority Assign a priority to the current TACACS+ server. The server
with the lowest value is the one used first for TACACS+ login
authentication. If this does not respond or access is denied
(only if Policy = Non-authoritative), the entry with the
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next-highest priority is used.

The available values are 0 to 9, the default value is 0.

Entry active Select whether this server is to be used for login authentication.
The function is enabled by choosing Enabled.

The function is enabled by default.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu
I =

Policy Select the interpretation of the TACACS+ response.
Possible values:

* Non-authoritative (default value): The TACACS+ serv-
ers are queried in order of their priority (see Priority) until a
positive response is received or a negative response is re-
ceived from an authoritative server.

e Authoritative : A negative response to a request is ac-

cepted, i.e. a request is not sent to another TACACS+ server.
The device's internal user administration is is not turned off by
TACACS+. It is checked after all TACACS+ servers have been
queried.

TCP Port Shows the default TCP port ( 49) used for the TACACS+ pro-
tocol. The value cannot be changed.

Timeout Enter time in seconds for which the NAS is to wait for a re-
sponse from TACACS+.

If a response is not received during the wait time, the next con-
figured TACACS+ server is queried (only if Policy = Non-
authoritative) and the current server is set to status
Blocked.

The possible values are 1 to 60, the default value is 3.

Block Time Enter the time in seconds for which the current server is to re-
main in blocked status.
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Encryption

10.5.3 Options

At the end of the block time, the server is set to the status spe-
cified in the Administrative Status field.

The possible values are 010 3600, the default value is 60. The
value 0 means that the server is never set to Blocked status
and thus no other servers are queried.

Select whether data exchange between the TACACS+ server
and the NAS is to be encrypted with MD5.

The function is enabled by choosing Enabled.
The function is enabled by default.

If the function is not enabled, the packets and all related inform-
ation are transferred unencrypted. Unencrypted transfer is not
recommended as a default setting and should only be used for
debugging.

This setting possible here causes your device to carry out authentication negotiation for in-
coming calls, if it cannot identify the calling party number (e.g. because the remote terminal
does not signal the calling party number). If the data (password, partner PPP ID) obtained

by executing the authentication protocol is the same as the data of a listed remote terminal
or RADIUS user, your device accepts the incoming call.
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Fig. 53: System Management -> Remote Authentication -> Options

The System Management -> Remote Authentication -> Options menu consists of the
following fields:

Fields in the Options Global RADIUS options menu
Field Description

Authentication for PPP By default, the following authentication sequence is used for in-
Dialin coming calls with RADIUS: First CLID, then PPP and then PPP
with RADIUS.

Options:

e TInband: Only inband RADIUS requests (PAP,CHAP, MS-
CHAP V1 & V2) (i.e. PPP requests without CLID) are sent to
the RADIUS server defined in Server IP Address.

* Outband (CLID) :Only outband RADIUS requests (i.e. re-
quests for calling line identification, CLID) are sent to the RA-
DIUS server.

Inband is activated by default.

R1xxx/R3xxx/R4xxx



Chapter 11 Physical Interfaces

11.1 AUX

You require a special cable for the console port of your gateway (e.g. AUX Backup cable)
to connect an external analogue modem to the AUX port on a bintec gateway.

11.1.1 AUX

With an analogue/GSM interface, the gateway also supports connections for analogue and
GSM modems (e.g. as backup). In principle, you can use any Hayes- or
GSMO07.07-compatible modem with a serial interface for this purpose. The following mo-
dems have been tested successfully for bintec:

* US Robotics Sportster Flash (analogue modem)

* US Robotics 56K Fax Modem (analogue modem)

¢ Siemens TC35i (GSM modem)

9-pol Sub-D male [ RJ45 plug | 9-pol Sub-D male
RXD
TXD

9-

2

3

4 DSR
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6

7

8

Ethernet RJ45 plug

Router O Modem i E
—

=0

GND
DTR
CTs
RTS

Fig. 54: PIN assignment modem cable
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Fig. 55: Physical Interfaces -> AUX -> AUX

The Physical Interfaces -> AUX -> AUX menu consists of the following fields:

Fields in the AUX Basic Parameters menu

I == =

AUX Port Status

Line Speed

Select whether the AUX port should be enabled or disabled.

The port is enabled by choosing Enabled. The port is disabled
by default.

Only for AUX Port Status enabled

Here you select the speed at which the gateway addresses the
modem (in bps).

Possible values:

e Default: The Baud rate of the serial terminal connection is
retained. (9600 in ex works state)

All other values mean that the modem is addressed at the cor-
responding speed in bps.

* 9600 bps (default value)

® 19200 bps

* 38400 bps

* 57600 bps: Recommended for communication with a GSM
modem.
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* 115200 bps: Recommended for communication with an ana-
logue modem.

Incoming Service Type  Only for AUX Port Status enabled

Here you select the gateway subsystem to which an incoming
call over the modem is to be assigned.

Possible values:

e Disabled: No call is accepted.

e ISDN Login: The call is assigned to the ISDN Login subsys-
tem.

e PPP Dialin(default value): The call is assigned to the PPP
subsystem.

SIM Card Uses PIN Only for AUX Port Status enabled

Here you enter the PIN of your GSM modem, if your modem
asks for it.

Entering a wrong PIN blocks communication with the modem
until the entry in the profile is corrected.

Modem Escape Charac- Only for AUX Port Status enabled

ter
The value for this field is set by default to +. It should only be

changed if the escape character of the modem is different.

Modem Init Sequence Only for AUX Port Status enabled

Here you can enter an initialization string for your modem. The
command ATX3&K3\V1 is the default setting (the modem does
not wait for a free signal before dialling).

You can add other AT commands by separating them with
semicolons. The entry is limited to 50 characters. Make sure
you enter the command for activating the XON/XOFF software
flow control. This is proprietary and cannot be set automatically.
The command sequence can be obtained from your modem
manual or the manufacturer.

APN (Access Point Only for AUX Port Status enabled
Name )
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If GPRS is used, the so-called Access Point Name of the pro-
vider must be entered, e.g. internet.eplus.de for eplus and so
on.

A maximum of 40 characters can be entered. If no APN or an
incorrect APN is entered, a configured GPRS connection will
not function.

11.2 Ethernet Ports

An Ethernet interface is a physical interface for connection to the local network or external
networks.

The Ethernet ports ETH1 to ETH4 are assigned to a single logical Ethernet interface in ex
works state. The logical Ethernet interface, en1-0, is assigned and is preconfigured with
the IP Address 192.168.0.254 and Netmask 255.255.255. 0.

The logical Ethernet interface en1-4 is assigned to the ETH5 port and is not precon-
figured.

@ Note

To ensure your device can be reached, when splitting ports make sure that Ethernet
interface en1-0 is assigned - with the preconfigured IP address and netmask - to a

port that can be reached via Ethernet. If in doubt, carry out the configuration using a
serial connection via the Console interface.

ETH1 - ETH4

The interfaces can be used separately. They are logically separated from each other, each
separated port is assigned the desired logical Ethernet interface in the Ethernet Interface
Selection field of the Port Configuration menu. For each assigned Ethernet interface, an-
other interface is displayed in the list in the LAN -> IP Configuration menu and a com-
pletely independent configuration of the interface is possible.

ETH5

By default, the logical Ethernet interface en1-4 is assigned to the ETH5 port. The configur-
ation options are the same as those for the ports ETH1 - ETH4.



VLANSs for Routing Interfaces

Configure VLANS to separate individual network segments from each other, for example
(e.g. individual departments of a company) or to reserve bandwidth for individual VLANs
when managed switches are used with the QoS function.

11.2.1 Port Configuration

Port Separation

Your device makes it possible to run the switch ports as one interface or to logically separ-
ate these from each other and to configure them as independent Ethernet interfaces.

By default, the same configuration applies for all switch ports.

During configuration, please note the following: The splitting of the switch ports into several
Ethernet interfaces merely logically separates these from each other. The available total
bandwidth of 100 mbps full duplex for all resulting interfaces remains the same. For ex-
ample, if you split all the switch ports from each other, each of the resulting interfaces only
uses a part of the total bandwidth. If you group together several switch ports into one inter-
face, the full bandwidth of 100 mbps full duplex is available for all the ports together.

bintec R1200 Language | English v | View |Standard ~| | Online Help | Logout

Port Configuration

Automatic Refresh interval [300 Seconds ( Apply )

Switch Configuration

Ethernet Ports

= Switch Fort Ethernet Intertace Selection Configurer Speed / Mode Current Speed / Mode
Bl 1 [ Full Autonegatiation v Down
2 [ Full Autonegatiation v Down
3 | Full Autoneguotistion ~ 100 mbps { Full Duplex
4 ‘ Full Autonegotiation V\ Down
4 ‘ Full Autonegotiation V\ Down

( oK ) ( Cancel )

Fig. 56: Physical Interfaces -> Ethernet Ports -> Port Configuration

The Physical Interfaces -> Ethernet Ports -> Port Configuration menu consists of the
following fields:

Fields in the Port Configuration Switch Configuration menu

R1xxx/R3xxx/R4xxx
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Switch Port

Ethernet Interface Selec-
tion

Configured Speed /
Mode

Current Speed / Mode

Shows the respective switch port. The numbering corresponds
to the numbering of the Ethernet ports on the back of the
device.

Assign a logical Ethernet interface to the switch port.

You can select from five interfaces, eni-0to eni-4. In the ba-
sic setting, switch ports 1-4 are assigned to interface eni1-0
and switch port 5 is assigned to interface en1-4

Select the mode in which the interface is to run.

Possible values:

e Full Autonegotiation (default value)
® Auto 100 mbps only

* Auto 10 mbps only

® Auto 100 mbps / Full Duplex
® Auto 100 mbps / Half-Duplex
* Auto 10 mbps / Full Duplex

* Auto 10 mbps / Half-Duplex

e Fixed 100 mbps / Full Duplex
e Fixed 100 mbps / Half-Duplex
e Fixed 10 mbps / Full Duplex
* Fixed 10 mbps / Half-Duplex

e Disabled: The interface is created but remains inactive.

Shows the actual mode and actual speed of the interface.

Possible values:

® 100 mbps / Full Duplex
® 100 mbps / Half-Duplex
® 10 mbps / Full Duplex
® 10 mbps / Half-Duplex

® Tnactive



11.3 ISDN Ports

In this menu, you configure the ISDN interfaces of your device. Here you enter data such
as the type of ISDN connection to which your gateway is connected. You can use the ISDN
interfaces of your gateway for various types of use.

You must carry out two steps to configure the ISDN interfaces:

¢ Enter the settings for your ISDN connection: Here you set the most important parameters
of your ISDN connection.

* MSN Configuration: Here you tell your device how to react to incoming calls from the
WAN.

11.3.1 ISDN Configuration

&1 Note

If the ISDN protocol is not detected, it must be selected manually under Port Usage
and ISDN Configtype. The automatic D channel detection is then switched off. An in-
correctly set ISDN protocol prevents ISDN connections being set up.

In the Physical Interfaces -> ISDN Ports -> ISDN Configuration menu, a list of all ISDN
ports and their configurations is shown.

11.3.1.1 Working with @

Choose the @ button to edit the configuration of the ISDN port.

ISDN BRI interface

You can use the ISDN BRI interface of your gateway for both dialup connections and
leased lines over ISDN.

R1xxx/R3xxx/R4xxx
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Fig. 57: Physical Interfaces -> ISDN Ports -> ISDN Configuration->

The Physical Interfaces -> ISDN Ports -> ISDN Configuration-> menu consists of the
following fields:

Fields in the ISDN Configuration Basic Parameters menu

Field Description

Port Name Shows the name of the ISDN port.
Autoconfiguration on Select whether the ISDN switch type (D channel detection for
Bootup switched line) is to be automatically identified.

The function is activated with Enabled.

The function is enabled by default.

Result of Autoconfigura- Shows the status of the ISDN Auto Config.

tion
Automatic D-channel detection runs until a setting is found or
until the ISDN protocol is selected manually under Port Usage.
This field cannot be edited. The result of autoconfiguration is
displayed for Port Usage and ISDN Configuration Type.

Possible values:
* All possible values for Port Usage and ISDN Configtype.

* Running: Detection is still running.

Port Usage Only if Automatic Configuration on Startup is disabled.
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ISDN Configuration
Type

ISDN Switch Type

Subscriber Number

Select the protocol that you want to use for the ISDN port.

Possible values:

e None: The ISDN connection is not used.

® Dialup (Euro ISDN)

® Leased Line

* 0-SIG

Only if Autoconfig on Bootup is disabled and if Port Usage =

Dialup (Euro ISDN) or Q-SIG.

Select the ISDN connection type.

Possible values:

* Point-to-Multipoint (default value): Point-to-multipoint
connection

* Point-to-point: Point-to-point ISDN access

Only if Port Usage = Leased Line

Select the ISDN protocol supplied by your provider.

Possible values:

* Leased Line Bl 648S: Leased line over B channel 1 (64
kbps)

* Leased Line B1+B2 6452:Leased line over both B chan-
nels (128 kbps)

* Leased Line D+Bl+B2 TS02: Leased line over D-channel
and both B channels (144 kbps)

* Leased Line BI1+B2 Different Endpoints:Leased
line to two different endpoints.

e Leased Line B1+D TS01:Leased line over B channel 1
and D-channel (80 kbps)

* Leased Line B2+D TS01: Leased line over B channel 2
and D-channel (80 kbps)

* Leased Line B2 648S: Leased line over B channel 2 (64
kbps)

Only if Port Usage = Dialup (Euro ISDN) and ISDN Con-
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figtype = Point-to-point
Enter the call number for the connection.
The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu

Field Description

X.31 (X.25 in D Chan- Select whether you want to use X.31 (X.25 in the D channel)
nel) e.g. for CAPI applications.

The function is activated with Enabled.

The function is disabled by default.

X.31 TEI Value Only if X.31 (X.25 in D channel) is enabled

With the ISDN autoconfiguration, the X.31-TEl is detected auto-
matically. If the autoconfiguration has not detected TEI, you can
manually enter the value assigned by the exchange.

Possible values are 01to 63.

The default value is -1 (for automatic detection).

X.31 TEI Service Only if X.31 (X.25 in D channel) is enabled
Select the service for which you want to use X.31 TEI.

Possible values:

* CAPI

* CAPI Default

* Packet Switch (default value)

CAPI and CAPI Default are for using X.31 TEI for CAPI ap-
plications. For cAPI, the TEI value set in the CAPI application is

used. For CAPI Default, the value of the CAPI application is
ignored and the default value set here is always used.

Set Packet Switch if you wish to use X.31 TEI for the X.25
device.

ISDN-PRI interface



For a Primary Rate Interface (PRI, or S2M), the channels are transmitted in series in so-
called time slots.

Choose the @ button to edit the configuration of the ISDN port.

bintec R4100 Language |English v| | view |Standard v| | online Help

ISDN Configuration MSHN Configuration

Basic Parameters
QL Fort Name priz-4 (TE)
Ethernet Ports

| 1sDuPorts Port Usage
; ISDM Switch Type ‘ Leased Line {Custom Time Slots) V‘
; Description  Bundle Type  Number of Channels
_ Custom Time Slots Mew Bundle PFP 0 2
R
_ ISDM Line Framing CRCA (Standard) v
L M

L HEre— —
ety

; Bundle Type @PPP Multilink O Physical (Hyperchannel)
_ Timeslot Selection O Range Selection @ Timeslot Matrix

O¢ Oz |0z Os Os Os
Or |Oe |de O O Oz
iz O4e  O1s Oe  Oir | Oas
O1g | Oz0 | D21 Ozz Oz Oz
[a2s O2s Oz Ozs Oa2e | Oan

Timeslot Matrix

K74 Layer 2 Mode @pce ODTE

( oKk ) (__ cancel )

Fig. 58: Physical Interfaces -> ISDN Ports -> ISDN Configuration ->@|

The Physical Interfaces -> ISDN Ports -> ISDN Configuration ->@ menu consists of the
following fields:

Fields in the ISDN Configuration Basic Parameters menu
Field Description

Port Name Shows the name of the ISDN port.

Port Usage
Select whether the ISDN switch type (D channel detection for

switched line) is to be automatically identified.
Possible values:

¢ None (default value): ISDN connection is not used.

® EURO ISDN s2M (TE): EURO ISDN S2M User Profile

R1xxx/R3xxx/R4xxx
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ISDN Line Framing

Subscriber Number

Channel Selection

e EURO ISDN S2M (NT):EURO ISDN S2M Network Profile

® Back to Back (dialup): Two S2M connections are
linked directly.

e Leased Line: You can select a leased line.

Only if a Port Usage is selected.
Select the framing type for layer 1.
Possible values:

® CRC4 (Standard)

(default value)
* No CRC
The default value can be left in the majority of scenarios. You

can use the No CRC if required (e.g. in Sweden and France), if
the device is to be connected to a PABX.

Only if Port Usage = EURO ISDN S2m (TE) of EURO ISDN
S2m (NT)Enter the call number for the connection.

Only if Port Usage = EURO ISDN S2m (TE)

To ensure compatibility with special service providers, a further
option is provided for Port Usage = Euro ISDN S2m (TE): If
you set the switch type appropriately, you can select a value for
the variable Channel Selection. This defines how the B chan-

nel is selected for an outgoing call.

Possible values:

* Any Channel (default value): The device tells the PABX that
all channels are available. The exchange of the PABX selects
the channel to be used.

® No channel identification
: The device sends no |E (Information Element) for channel
identification. The exchange selects the channel to be used.

® Submit preferred channel

: The device selects the channel to be used and signals this to
the exchange.
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Clock Mode

ISDN Switch Type

Custom Time Slots

You can normally use the default value. It is only necessary to
change the setting in a few special cases.

If you encounter problems with outgoing calls, ask your provider
whether a special value has to be set.

Only if Port Usage = Back to Back (dialup)

Defines which connection partner sends the clock signal for
synchronization between the sender and the recipient. If the
clock signal is not sent by the exchange itself, one of the con-
nection partners must sent the signal.

Possible values:

* External: The device receives the clock signal.

* Internal: The device sends the clock signal.

Only if Port Usage = Leased LineSelect the ISDN connection
type.

Possible values:

* Leased Line (Custom Time Slots):Up to 31 PPP in-
terfaces can be configured for leased lines to different destin-
ations.

® Leased Line, 1 Hyperchannel (G.703 +
G.704):1984 Kkbps, structured

* Leased Line Unstructured G.703:2048 kbps, unstruc-
tured

Only if Port Usage = Leased Line and ISDN Switch Type =
Leased Line (Custom Time Slots)

You have the option to bundle any channels on the physical lay-
er as so-called hyper channels. You can also group together
channels as PPP multilink channel bundles.

Timeslots divide the available 2 Mbps bandwidth of an S2M
connection into logical channels. No distinction is made below
between timeslots and channels, as the difference is immaterial
for configuration purposes.

A list of the channel bundles already configured is shown.
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Click Add to configure new channel bundles.

You can use the Add button under Custom Time Slots to configure further bundles.

@ Note

This function is only available for leased lines.

Fields in the ISDN Configuration New Bundle menu

Field Description

Description Enter the name of the channel bundle.

Bundle Type Displays the type of channel bundle.
Possible values:
e pPPP Multilink: The channels are bundled as PPP Multilink

channels.

®* Physical (Hyperchannel): The channels are bundled as
physical hyperchannels.

Timeslot Selection Choose between Range Selectionand Timeslot Matrix.

Timeslot Range Only if Timeslot Selection = Range Selection.

Shows the logical channels (timeslots) combined to form this
channel bundle.

¢ From: Shows the first of the channels used for this channel
bundle. Possible values: 1 to 31.

e to: Shows the last of the channels used for this channel
bundle. Possible values: 1 to 31.

* Specify Selection: Here you can make a different selec-
tion.

Timeslot Matrix Only if Timeslot Selection = Timeslot Matrix Shows a list
of all channels in detail. If you do not wish to use all the chan-
nels between a certain start and end channel for a channel
bundle, you can make a selective assignment here.

X.75 Layer 2 Mode Here you define how the interface created by this channel
bundle is to behave during connection setup. You only need to
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configure these parameters if you used X.75 in layer 2.

Possible values:

* DCE

* DTE

11.3.2 MSN Configuration

In this menu, you can assign the available ISDN numbers to the required services (e.g.
PPP routing, ISDN login).

If you use the ISDN interface for outgoing and incoming dialup connections, your own num-
bers for this interface can be entered in this menu (these settings are not possible for
leased lines). Your device distributes the incoming calls to the internal services according
to the settings in this menu. Your own number is included as the calling party number for
outgoing calls.

The device supports the following services:

* PPP (routing): The PPP (routing) service is your device's general routing service. This
enables ISDN remote terminals to establish data connections with your LAN, among oth-
er things. This enables partners outside your own local network to access hosts within
your LAN. It is also possible to establish outgoing data connections to ISDN remote ter-
minals.

* |SDN Login: The ISDN login service enables both incoming data connections with access
to the SNMP shell of your device, and outgoing data connections to other bintec devices.
As a result, your device can be remotely configured and administrated.

¢ |[PSec: bintec devices support the DynDNS service to enable hosts without fixed IP ad-
dresses to obtain a secure connection over the Internet. With the IPSec Callback function
and using a direct ISDN call to an IPSec peer with a dynamic IP address you can signal
to this IPSec peer that you are online and waiting for the setup of an IPSec tunnel over
the Internet. If the called peer currently has no connection to the Internet, the ISDN call
causes a connection to be set up. The identification of the caller from his or her ISDN
number is enough information to initiate setting up a tunnel.

* X.25 PAD: X.25 PAD is used to provide a protocol converter, which converts non-
packet-oriented protocols to packet-oriented communication protocols and vice versa.
Data terminal equipment sending or receiving data on a non-data-packet-oriented basis
can this be adapted in line with Datex-P (public data packet network based on the prin-
ciple of a packet switching exchange).

When a call comes in, your device first uses the entries in this menu to check the type of



call (data or voice call) and the called party number, whereby only part of the called party
number reaches the device, which is forwarded from the local exchange or, if available, the
PBX. The call is then assigned to the corresponding service.

@ Note

If no entry is specified (ex works state), every incoming ISDN call is accepted by the
ISDN Login service. To avoid this, you should make the necessary entries here. As
soon as an entry exists, the incoming calls not assigned to any entry are forwarded to
the CAPI service.

In the Physical Interfaces -> ISDN Ports -> MSN Configuration menu a list of all MSNs
is shown.

11.3.2.1 New

Choose the New button to edit MSNs.

bintec R1200 Language | English | | View  Standard ~| | Online Help | Logout

E.Save configuration &8 ISDN Configuration 'MSN Configuration

Basic Parameters

I
o
£
5

AUX -
Ethernet Ports SR
~ ISDHPorts Service
MEN
MSMN Recognition @mgmm Left OLeftto Right (DDI}
Bearer Service © pata + Veice OData OVoice

C oK 0 ( cancel )

Fig. 59: Physical Interfaces -> ISDN Ports -> MSN Configuration -> New

The Physical Interfaces -> ISDN Ports -> MSN Configuration -> New menu consists of
the following fields:

Fields in the MSN Configuration Basic Parameters menu
Field Description

ISDN Port Select the ISDN port for which the MSN is to be configured.

R1xxx/R3xxx/R4xxx
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Service

MSN

MSN Recognition

BearerService

Select the service to which a call is to be assigned on the MSN
below.

Possible values:

* ISDN Login (default value): Enables logging in with 7SDN

Login.

* PPP (Routing): Default setting for PPP routing. Contains

the automatic detection of the PPP connections stated below
except PPP DOVB.

e 7pSec: Enables a number to be defined for IPSec callback.

e Oother (PPP): Other services can be selected: PPP 64k

(enables 64 kbps PPP data connections), PPP 56k (enables
56 kbps PPP data connections), PPP V.110 (9600,
14400, 19200, 38400) (enables PPP connections with
V.110 and bit rates of 9600 bps, 14400 bps, 19200 bps,
38400 bps), PPP V. 120 (enables incoming PPP connections
with V.120).

Enter the number used to check the called party number. For

the call to be accepted, it is sufficient for the individual numbers

in the entry to agree, taking account of MSN Recognition.

Select the mode your device is to use for the number comparis-

on of MSN with the called party number of the incoming call.

Possible values:

e Right to Left (defaultvalue)

e Left to Right (DDI): Always select if your device is con-
nected to a point-to-point connection.

Select the type of incoming call (service detection).
Possible values:
* Data + Voice (default value): Both data and voice calls.

e Data: Data call

* Voice: Voice call (modem, voice, analogue fax).



11.4 ADSL Modem

11.4.1 ADSL Configuration

In this menu, you make the basic settings for your ADSL connection.

R3000 and R3000w are ADSL multiprotocol routers with integrated ADSL(2+) modem and
automatic ISDN backup. The ADSL modem on the R3000/ R3000w is compatible with AN-
NEX A and ANNEX B standards and so can be used universally in several countries. It is
particularly suitable for high-speed Internet access and remote access use in SMEs or re-
mote offices. The device is supplied ex works with 10 IPSec tunnels including hardware ac-
celeration. Up to 100 additional IPSec tunnels can also be enabled if licensed. The integ-
rated second ISDN SO0 interface can also be enabled by licence if required.

glEm T : i otz

bintec R3000 Language English v | ‘iew  Stancard ~| | Online Help | Logout

ADSL Configuration

Automatic Refresh Interval |60 Seconds Apply D]

AUX

T ADSL Fort Status
| ISDH Ports ADSL Chipset Globespan Titanium Ultra Plus
= ADSL Modem Physical Cannection Unknown
WAL st 0 s
| Frewal | aDsLbade O hmex & © amexB
(WP T ApeLsneTe
; Transmit Shaping Default (Line Speed) +
| R ey C ok ) camesl

Fig. 60: Physical Interfaces -> ADSL Modem -> ADSL Configuration

The Physical Interfaces -> ADSL Modem -> ADSL Configuration menu consists of the
following fields:

Fields in the ADSL Configuration ADSL Port Status menu

Field Description

ADSL Chipset Shows the key of the installed chipset.
Physical Connection Shows the current ADSL operation mode. The value cannot be
changed.

R1xxx/R3xxx/R4xxx
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Possible values:

* Unknown: The ADSL link is not active.

* ANST T1.413:ansiT1dot413

e ADSLI: ADSL classic, G.DMT, ITU G.992.1

e G.Lite: Splitterless ADSL, ITU G.992.2

e ADSL2: G.DMT.Bis, ITU G.992.3

e ADSL2 DELT: ADSL2 Double Ended Line Test

e ADSL2 Plus: ADSL2 Plus, ITU G.992.5

* ADSL2 Plus DELT: ADSL2 Plus Double Ended Line Test
* READSLZ2: Reach Extended ADSL2

e READSLZ2 DELT: Reach Extended ADSL2 Double Ended Line
Test

® ADSL2 ITU-T G.992.3 Annex M

® ADSL2+ ITU-T G.992.5 Annex M

Fields in the ADSL Configuration Current Line Speed menu
Field Description

Downstream Displays the data rate in the receive direction (direction from
CO/DSLAM to CPE/router) in bits per second.
The value cannot be changed.

Upstream Displays the data rate in the send direction (direction from CPE/
router to CO/DSLAM) in bits per second.

The value cannot be changed.

Fields in the ADSL Configuration ADSL Parameters menu

Field Description

ADSL Mode
Define which Annex of ITU-T Recommendation G.991.2 is used

for the connection.

Possible values:

* Annex A: For applications in North America
(provider-dependent) for example.

e Annex B(default value): For applications in Europe
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ADSL SyncType

Transmit Shaping

Maximum Upstream
Bandwidth

(provider-dependent) for example.

Select the ADSL synchronization type.

Possible values:

* Automatic Mode (default value): The ADSL mode is auto-
matically adapted for the remote terminal.

e ADSL1: ADSL1/G.DMT is used.

e ADSL2: ADSL2 / G.992.3 is used.

* ADSL2 Plus: ADSL2 Plus/G.992.5 is used.

e Down : The ADSL interface is not active.

Only for ADSL Mode = Annex A.

* Automatic Mode (Annex-M):The ADSL mode is auto-
matically adapted to the other end with reference to G.992.3
Annex M.

e ADSL2 Plus (Annex-M):ADSL2 Plus/G.992.3 Annex M
is used.

e ANSI TI1.413:ansiT1dot413
Only for ADSL Mode = Annex B.
e ETSI T1.413:ETSIT1.413

Select whether the data rate in the send direction is to be re-
duced. This is only needed in a few cases for special DSLAMSs.

Possible values:
e Default (Line Speed): The data rate in the send direc-
tion is not reduced.

® 128,000 bpsto 2,048,000 bps: The data rate in the send
direction is reduced to a maximum of 128,000 bps to
2,048,000 bps in defined steps.

* User Defined: The data rate is reduced to the value
entered in Maximum Upstream Bandwidth

The default value is befault (Line Speed).

Only if Transmit Shaping = User defined



11 Physical Interfaces

"

o

Funkwerk Enterprise Communications GmbH

I =

Enter the maximum data rate in the send direction in bits per
second.

11.5 SHDSL

11.5.1 SHDSL Configuration

In the SHDSL menu you configure the SHDSL interface of your device.

R3400 and R3800 have an integrated SHDSL mode. The devices support G.SHDSL ac-
cording to ITU-T recommendations G.991.2 Annex A and B and SHDLS.bis according to
G.991.2 Annex F and G. Depending on the device type and configuration the gateway
transmits the data over a pair of wires at up to 5696 kbps, over two pairs of wires at up to
11392 kbps, over three pairs of wires at up to 17088 kbps or over four pairs of wires at up
to 22784 kbps.

Note

Ask your provider about any special features of your SHDSL connection.

Note

Agree the connection conditions for back-to-back connections (campus connect) with
your remote terminal.

The SHDSL interfaces can be configured separately or as a bundle.

Choose the button to edit the predefined SHDSL interfaces. In the ex works state, the
logical SHDSL interfaces Shds1-01o Shds1-3 are each preset with one pair of wires.



Funkwerk Enterprise Communications GmbH 11 Physical Interfaces

ET e Rt i
=] il .
m‘hl”l-ﬁ—"’ Language |English v | Wiew | Standard ~| | Online Help | Logout flll'lh“l‘k@
- n L wr w X

Save configur ation SHDSL Configuration
Assistants -
System Management -
Physical Interfaces - SHDSL Parameters
AUK ATM Interface feca-3-0
Ethernet Ports.
1SDH Ports Device Mode O o (Central Office) © CPE (Customer Premises Equipment)
SHDSL SHOSL Type O annex & @ Annex B
LAN A
Clock Rate OFixed © Adaptive
Routing b
Wire Mode 2 wire b
WAN A
VPN - Minirmum 192« kbps
- Line Speed Interval
sl T Maximum BES5 v kbps
VolP A
Local Services b oK Cancel

Maintenance b

External Reporting -

Monitoring -

Fig. 61: Physical Interfaces -> SHDSL -> SHDSL Configuration->

Fields in the SHDSL SHDSL Parameter menu

= T

ATM Interface Displays the name of the ATM interface.

Device Mode Define the role within the connection.
Possible values:

* CPE (Customer Premises Equipment) (default value):
Mode for the user page of the SHDSL connection.

* CO (Central Office):Mode for the provider page of the
SHDSL connection.

Note: CPE on the one hand and CO on the other hand must al-
ways be set for each SHDSL connection.

SHDSL Type Define which Annex of ITU-T Recommendation G.991.2 is used
for the connection.

Possible values:

e Annex A: For applications in North America
(provider-dependent) for example.

e Annex B(default value): For applications in Europe
(provider-dependent) for example.

Clock Rate Define whether the clock rate should be negotiated.
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Possible values:

e Fixed: The clock rate is predefined.

* Adaptive (default value): The clock rate is negotiated de-
pending on the line quality.

Wire Mode Define the number and combination of wires (depending on the
device type) used for the SHDSL connection.

Only R3400:
Possible values:

* 2 wire (default value): Two wires are used with m-pair bond-
ing for a clock rate of 192 kbps to 5696 kbps.

e 4 wire: Four wires are used with m-pair bonding for a clock
rate of 384 kbps to 11392 kbps. This option supports 4-wire
mode under G991.2 and Globespan Enhanced Mode.

Only R3800:

e 2 wire: Two wires are used with m-pair bonding for a clock
rate of 192 kbps to 5696 kbps.

* 4 wire: Four wires are used with m-pair bonding for a clock
rate of 384 kbps to 11392 kbps. This option supports 4-wire
mode under G991.2 and Globespan Enhanced Mode.

* 4 wire standard: Four wires are used for m-pair bonding
with a clock rate of 384 kbps to 11392 kbps. This option sup-
ports 4-wire mode under G991.2 but not Globespan En-
hanced Mode.

e 4 wire IMA: Four wires are used with IMA for a clock rate of
384 kbps to 11392 kbps.

e 6 wire: Six wires are used with m-pair bonding for a clock
rate of 576 kbps to 17088 kbps.

e 6 wire IMA: Six wires are used with IMA for a clock rate of
576 kbps to 17088 kbps.

* 8 wire: Eight wires are used with m-pair bonding for a clock
rate of 768 kbps to 22784 kbps.

* 8 wire IMA: Eight wires are used with IMA for a clock rate
of 768 kbps to 22784 kbps.
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Additional Wire Pairs Only for Wire Mode = 4 wire, 4 wire standard, 4 wire
IMA, 6 wire, 6 wire IMA.

For Wire Mode = 4 wire, 4 wire standardOr 4 wire
IMA the second pair of wires is defined here.

For Wire Mode = 6 wireor 6 wire IMAthe second and third
pairs of wires are defined here.

Wire pairs already used in defined connections are not available
for selection. If these continue to be used for this SHDSL con-
nection, the existing connection must first be terminated.

Requested Rate Only for Clock Rate = Fi xed.

Select which speed should be used.

Line Speed Interval Only for Clock Rate = Adaptive.

Under Minimum select the minimum clock rate and under Max-
imum select the maximum clock rate for the connection.

11.6 Serial ports

11.6.1 Options

In the Serial Ports menu, configure the serial WAN interface of your gateway.
Your gateway offers an integrated X.21/V.35 interface.

The interface can be operated in accordance with various electrical standards (X.21, V.35,
...). The electrical standard used and the layer 1 operation mode (DTE or DCE) can be de-
tected automatically from the plugged cable. Both of these parameters can also be set
manually. You can purchase a suitable cable from your dealer.

Choose the [ button to edit the configuration of the serial port.
s
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Fig. 62: Physical Interfaces -> Serial Ports -> Options->

The Physical Interfaces -> Serial Ports -> Options-> menu consists of the following
fields:

Fields in the Options Serial Parameters menu

Field Description

Interface Displays the name of the serial interface.

Detection Mode Define whether the interface and connector types used are to
be detected automatically (autodetected) or set manually.

Possible values:
* Tnterface and Connector (default value): The interface
and connector types are detected automatically.

e Interface: Only the interface type is detected automatically.
The connector type must be set manually.

* Connector: Only the connector type is detected automatic-
ally. The interface type must be set manually.

e Manual: Both the interface and connector type must be set
manually.

Interface Type Define the interface type of the port used.

If you select the Detection Mode Tnterface and Connect-
or or Interface, the interface type is detected automatically.
The detected value is displayed, e.g. V.35 (autodetected).
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If you select the Detection Mode Connector or Manual, you
must set the interface type field manually.

Possible values:

* None: The port is not used.

e X.21 with Termination: V.11 on all lines, 120-ohm ter-
minating resistor on critical input lines.

e V7. 35: V.35 on critical lines, V.28 on uncritical lines.
e 7. 36: V.11 on critical lines, V.10 on uncritical lines.
e X.21 bis: V.28 on all lines.

e X.21 without Termination:Unterminated V.11 on all
lines.

* RS-449: V.11 on critical lines, V.10 on uncritical lines (9-pole
or 37-pole sub-D plug).

* RS-530: V.11 on critical lines, V.10 on uncritical lines
(25-pole sub-D plug).

e RS-530a: V.11 on critical lines, V.10 on uncritical lines incl.
DTR and DSR (25-pole sub-D plug).

Connector Type Define the connector type of the port used.

If you select the Detection Mode Tnterface and Connect-
or or Connector, the connector type is detected automatically.
The detected value is displayed, e.g. Unknown
(Autodetected).

If you select the Detection Mode Tnterface or Manual, you
must set the connector type field manually.

Possible values:

* DTE: The pins are assigned as DTE interface. This setting is
necessary, for example, if the router is connected to a public
data network like Datex-P in Germany.

* DCE: The pins are assigned as DCE interface.

Line Speed Only if Connection Type = DCE. Select which speed should be
used.
Layer 2 Mode Define the value of the HDLC address field in the transmitted

command frames (Layer 2).
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Interface Leads

Possible values:

e Automatic (default value): The selection made for connect-
or is applied. You can usually accept this setting, e.g. for ac-
cess to a public data network such as Datex-P.

e DTE: The address field has the value for DTE.

e DCE: The address field has the value for DCE.

Define whether the gateway checks the status of the interface
lines. The same value should be set for both connection part-
ners.

Possible values:

* Enabled: The Layer 1 signalling of the remote terminal is
checked on the signal line (I for X.21, CTS for V.35). The
check correspondingly affects the variable L1State.

* Disabled (default value): The Layer 1 signalling of the re-
mote terminal is not checked, your gateway assumes that the
physical line is always "up". In this setting, you should monitor
the interface line in some other way, e.g. with PPP Keepalive.

11.7 UMTS/HSDPA

11.71 UMTS/HSDPA/HSUPA

In the UMTS / HSDPA / HSUPA menu configure the connection for a UMTS CardBus mo-

dem.
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Fig. 63: Physical Interfaces -> UMTS / HSDPA -> UMTS / HSDPA / HSUPA

The Physical Interfaces -> UMTS / HSDPA -> UMTS / HSDPA / HSUPA menu consists
of the following fields:

Fields in the UMTS / HSDPA / HSUPA Basic Settings menu

UMTS/HSDPA/HSUPA  Select whether or not UMTS/HSDPA/HSUPA is to be enabled
Status on your device.

The function is activated with Enabled.

The function is disabled by default.

Modem Status Shows the status of the UMTS/HSDPA/HSUPA modem.
Possible values:

® Active

® Tnactive

® Tnit

® Called

® Calling

® Connect

® SIM insert required

® PIN input required

R1xxx/R3xxx/R4xxx
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® Errors

®* Disconnected
Network Provider Shows the connected mobile phone provider.

Network Quality Only for UMTS/HSDPA/HSUPA Status = Enabled

Displays the current quality of the UMTS connection. The value
cannot be changed.

Incoming Service Type  Only for UMTS/HSDPA/HSUPA Status = Enabled

Here you select the gateway subsystem to which an incoming
call over the modem is to be assigned.

Possible values:

* ISDN Login(default value): The call is assigned to the ISDN
Login subsystem.

e PPP Dialin: The call is assigned to the PPP subsystem.

e Disabled: No call is accepted.

SIM Card Uses PIN Only for UMTS/HSDPA/HSUPA Status = Init Sequence En-
abled

Enter the PIN for your UMTS modem card.

Note: Entering a wrong PIN blocks communication until the
entry is corrected.

Modem Init Sequence Only for UMTS/HSDPA/HSUPA Status = Enabled

Here you can enter an initialization string for your modem. You
can add other AT commands if required by separating them with
semicolons. The entry is limited to 80 characters.

APN (Access Point Only for UMTS/HSDPA/HSUPA Status = Enabled

Name)
If GPRS/UMTS is to be used, you must enter the so-called Ac-

cess Point Name here that you receive from your provider. A
maximum of 80 characters can be entered.

If no APN or an incorrect APN is entered, a configured GPRS/
UMTS connection will not function.
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Chapter 12 LAN

In this menu, you configure the addresses in your LAN and can structure your local network
using VLANSs.

12.1 IP Configuration

In this menu, you can edit the IP configuration of the LAN and Ethernet interfaces of your
device.

12.1.1 Interfaces

In the LAN -> IP Configuration -> Interfaces menu, the available IP interfaces are listed.
You can edit the IP configuration of the interfaces or create virtual interfaces for special ap-
plications. Here is a list of all of the interfaces (logical Ethernet interfaces and others cre-
ated in the subsystems) configured in the System Management -> Interface Mode /
Bridge Groups -> Interfaces menu.

Use the [ifz] to edit the settings of an existing interface (bridge groups, Ethernet interfaces in
routing mode).

You can use the New button to create virtual interfaces. However, this is only needed in
special applications (e.g. BRRP).

Depending on the option selected, different fields and options are available. All the config-
uration options are listed below.

The default setting for all existing interfaces of your device is routing mode. The interface,
en1-0, is pre-configured with IP address 192.168.0.254 and netmask 255.255.255.0

Example of subnets

If your device is connected to a LAN that consists of two subnets, you should enter a
second IP Address/Netmask.

The first subnet has two hosts with the IP addresses 192.168.42.1 and 192.168.42.2, for
example, and the second subnet has two hosts with the IP addresses 192.168.46.1 and
192.168.46.2. To be able to exchange data packets with the first subnet, your device uses
the IP address 192.168.42.3, for example, and 192.168.46.3 for the second subnet. The
netmasks for both subnets must also be indicated.



12.1.1.1 Edit/New

Choose the @ icon to edit existing entries. Choose the New button to create virtual inter-
faces.
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Fig. 64: LAN -> IP Configuration -> Interfaces -> Edit/New

The LAN -> IP Configuration -> Interfaces -> Edit/New menu consists of the following
fields:

Fields in the Interfaces Basic Parameters menu

Field Description

Based on Ethernet Inter- This field is only displayed if you are editing a virtual routing in-
face terface.

Select the Ethernet interface for which the virtual interface is to
be configured.

Address Mode Select how an IP address is assigned to the interface.
Possible values:

e Static (default value): A static IP address is assigned to the
interface in IP Address/Netmask.

* DHCP: An IP address is assigned to the interface dynamically
via DHCP.

R1xxx/R3xxx/R4xxx



Funkwerk Enterprise Communications GmbH

I =

IP Address/Netmask

Interface Mode

MAC Address

VLAN ID

Only if Address Mode = Static

With Add, add a new address entry and enter the IP Address
and corresponding Netmask

Only for physical interfaces in routing mode.
Select the configuration mode of the interface.

Possible values:

* Manual (default value): The interface is not assigned for a
specific purpose.

* VLAN: This option only applies for routing interfaces.

You use this option to assign the interface to a VLAN. This is
done using the VLAN ID, which is displayed in this mode and
can be configured. In this mode, the definition of a MAC ad-
dress in MAC Address is optional.

Only for virtual interfaces and if Interface Mode = Manual

Enter the MAC address associated with the interface. For virtual
interfaces, you can use the MAC address of the physical inter-
face under which the virtual interface was created, but this is not
necessary. You can also allocate a virtual MAC address. The
first 6 characters of the MAC are preset (but can be changed).

Only if Interface Mode = VZAN.

This option only applies for routing interfaces. Assign the inter-
face to a VLAN by entering the VLAN ID of the relevant VLAN.

Possible values are 1 (default value) to 4094.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu

Field Description

DHCP MAC Address

Only if Address Mode = DHCP

If Use Built-In is activated (default setting), the hardware MAC
address of the Ethernet interface is used. In the case of physical
interfaces, the current MAC address is entered by default.

12 LAN
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DHCP Hostname

Proxy ARP

TCP-MSS Clamping

12.2 VLAN

If you disable Use Built-In, you enter an MAC address for the
virtual interface, e.g. 00:e1:19:06:bf:03.

Some providers use hardware-independent MAC addresses to
allocate their clients IP addresses dynamically. If your provider
has assigned you an MAC address, enter this here.

Only if Address Mode = DHCP

Enter the host name requested by the provider. The maximum
length of the entry is 45 characters.

Select whether your device is to respond to ARP requests from
its own LAN on behalf of defined remote terminals.

The function is enabled by choosing Enabled.

The function is disabled by default.

Select whether your device is to apply MSS Clamping. To pre-
vent IP packets fragmenting, the MSS (Maximum Segment
Size) is automatically decreased by the device to the value set
here.

The function is enabled by choosing Enabled.

The function is disabled by default. Once enabled, the default
value 1350 is entered in the input field.

By implementing VLAN segmentation in accordance with 802.1Q, you can configure
VLANSs on your device. The wireless ports of an access point, in particular, are able to re-
move the VLAN tag of a frame sent to the clients and to tag received frames with a pre-
defined VLAN ID. This functionality makes an access point nothing less than a VLAN-
aware switch with the enhancement of grouping clients into VLAN groups. In general,
VLAN segmenting can be configured with all interfaces.
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Fig. 65: VLAN segmenting

VLAN for Bridging and VLAN for Routing

In the LAN -> VLAN menu, VLANSs (virtual LANs) are configured with interfaces that oper-
ate in bridging mode. Using the VLAN menu, you can make all the settings needed for this
and query their status.

f Caution

For interfaces that operate in Routing mode, you only assign a VLAN ID to the inter-
face. You define this via the parameter Interface Mode = v.aN and the VLAN ID field
in the LAN -> IP Configuration -> Interfaces -> New menu.

R1xxx/R3xxx/R4xxx



12.2.1 VLANs

In this menu, you can display all the VLANSs already configured, edit your settings and cre-
ate new VLANSs. By default, the Management VLAN is available, to which all interfaces are
assigned.

12.2.1.1 Edit/New

Choose the @ icon to edit existing entries. Choose the New button to configure other
VLANS.
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Fig. 66: LAN -> VLAN -> VLANSs -> Edit/New
The LAN -> VLAN -> VLANSs -> Edit/New menu consists of the following fields:
Fields in the VLANs Configure VLAN menu

Field Description

VLAN Identifier Enter the number that identifies the VLAN. In the Edit menu,
you can no longer change this value.

Possible values are 1to 4094.

VLAN Name Enter a unique name for the VLAN. A character string of up to
32 characters is possible.

VLAN Members Select the ports that are to belong to this VLAN. You can use
the Add button to add members.

R1xxx/R3xxx/R4xxx
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For each entry, also select whether the frames to be transmitted
from this port are to be transmitted tagged (i.e. with VLAN in-
formation) or untagged (i.e. without VLAN information).

12.2.2 Port Configuration

In this menu, you can define and view the rules for receiving frames at the VLAN ports.
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Fig. 67: LAN -> VLAN -> Port Configuration

The LAN -> VLAN -> Port Configuration menu consists of the following fields:

Fields in menu Port Configuration

Field Description

Interface

PVID

Drop untagged frames

Shows the port for which you define the PVID and processing
rules.

Assign the selected port the required PVID (Port VLAN Identifi-
er).

If a packet without a VLAN tag reaches this port, it is assigned
this PVID.

If this option is enabled, untagged frames are discarded. If the
option is disabled, untagged frames are tagged with the PVID
defined in this menu.

12 LAN
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Drop non-members If this option is enabled, all tagged frames that are tagged with a
VLAN ID to which the selected port does not belong are dis-
carded.

12.2.3 Administration

In this menu, you make general settings for a VLAN. The options must be configured sep-
arately for each bridge group.
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Fig. 68: LAN -> VLAN -> Administration
The LAN -> VLAN -> Administration menu consists of the following fields:

Fields in the Administration Bridge Group br<ID> VLAN Options menu

Field Description

Enable VLAN Enable or disable the specified bridge group for VLAN.
The function is activated with Enabled.

The function is not activated by default.

Management VID Enter the VLAN ID of the VLAN in which your device is to oper-
ate.
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Chapter 13 Wireless LAN

In the case of wireless LAN (WLAN = Wireless Local Area Network), this relates to the cre-
ation of a network using wireless technology.

Network functions

Like a wired network, a WLAN offers all the main network functions. Access to servers,
files, printers, and the e-mail system is just as reliable as company-wide Internet access.
Because the devices do not require any cables, the great advantage of WLAN is that there
are no building-related restrictions (i.e. the device location does not depend on the position
and number of connections).

Currently applicable standard: IEEE 802.11

In the case of 802.11-WLANSs, all the functions of a wired network are possible. WLAN
transmits inside and outside buildings with a maximum of 100 mW.

IEEE 802.11g is currently the most widespread standard for wireless LANs and offers a
maximum data transmission rate of 54 mbps. This procedure operates in the radio fre-
quency range of 2.4 GHz, which ensures that parts of the building are penetrated as effect-
ively as possible with a low transmission power that poses no health risks.

A 802.11g-compatible standard is 802.11b, which operates in the 2.4 GHz range (2400
MHz - 2485 MHz) and offers a maximum data transmission rate of 11 mbps. 802.11b and
802.11g WLAN systems involve no charge or login.

With 802.11a, bandwidths of up to 54 mbps can be used in the 5150 GHz to 5725 MHz
range. With the higher frequency range, 19 non-overlapping frequencies are available (in
Germany). This frequency range can also be used without a licence in Germany. In
Europe, transmission power of not just 30 mW but 1000 mW can be used with 802.11h, but
only if TPC (TX Power Control, method for controlling transmission power in wireless sys-
tems to reduce interferences) and DFS (Dynamic Frequency Selection) are used. The pur-
pose of TPC and DFS is to ensure that satellite connections and radar devices are not in-
terfered with.

13.1 WLAN

In the Wireless LAN -> WLAN1 menu, you can configure the WLAN module of your
device.



Depending on the model, one or two WLAN modules, WLAN1 and, in certain models,

WLANZ2, available.

13.1.1 Radio Settings

In the Wireless LAN -> WLAN -> Radio Settings menu, an overview of all the configura-
tion options for the WLAN module is shown.
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Fig. 69: Wireless LAN -> WLAN -> Radio Settings

13.1.1.1 Radio Settings -> Edit

In this menu, you change the settings for the wireless module.

Choose the [iz7] button to edit the configuration.

R 1xxx/B3xxx/R4xxx
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Fig. 70: Wireless LAN -> WLAN -> Radio Settings->@|

The Wireless LAN -> WLAN -> Radio Settings ->@ menu consists of the following fields:

Fields in the Radio Settings WLAN Settings menu

Define the mode in which the wireless module of your device is

Operation Mode

to operate.
Possible values:

e off (default value) The radio module is switched off.

* Access Point: Your device is used as an access point in
your network.

e Access Client: Your device serves as an Access Client in
your network.

R1xxx/R3xxx/R4xxx
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Client Mode

Operation Band

Usage Area

Only for Operation Mode = Access Client
Select the client connection mode to the access point.

Possible values:

* Infrastructure (default value): In a network in infrastruc-
ture mode, all clients communicate with each other via ac-
cess points only. There is no direct communication between
the individual clients.

e Ad-Hoc: In ad-hoc mode, an access client can be used as
central interface between a number of terminals. In this way,
devices such as computers and printers can be wirelessly in-
terconnected.

Select the channel to be used.

Select the operation band and usage area of the wireless mod-
ule.

For Operation Mode = Access Point
Possible values:

* 2.4 GHz In/Outdoor (defaultvalue): our device is oper-
ated at 2.4 GHz (mode 802.11b and mode 802.11g), inside
or outside buildings.

* 5 GHz Indoor: Your device is run with 5 GHz (Mode
802.11a/h) inside buildings.
5 GHz Outdoor: Your device is run with 5 GHz (Mode
802.11a/h) outside buildings.

e 5 GHz In/Outdoor: Your device is run with 5 GHz (Mode
802.11a/h) inside or outside buildings.

For Operation Mode = Access Client

Possible values:

® 2.4 and 5 GHz
* 2.4 GHz (default value)

* 5 GHz

Only for Operation Mode = Access Client, Client Mode =
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Infrastructure and Operation Band = 2.4 and 5 GHzor
5 GHz

Choose the location at which the device is operated.

Possible values:

* Tndoor-Outdoor (defaultvalue)
® Indoor

® Outdoor

IEEE 802.11d Compli- Only for Operating Mode = Access Client

ance
Select how the country information is determined.

Possible values:

e Flexible (default value): The system attempts to determine
the country information of the access point, otherwise the
system's own country information is used.

* None: The system's own country information is used.

e Strict: The country information of the access point is used.

Channel The number of channels you can selected depends on the
country setting. Please consult the data sheet for your device.

Access Point mode:

Configuring the network name (SSID) in Access Point mode
means that wireless networks can be logically separated from
each other, but they can still physically interfere with each other
if they are operating on the same or closely adjacent wireless
channels. So if you are operating two or more radio networks
close to each other, it is advisable to allocate the networks to
different channels. Each of these should be spaced at least
four channels apart, as a network also partially occupies the
adjacent channels.

In the case of manual channel selection, please make sure first
that the clients actually support these channels.

Possible values:

e For Operation Band = 2. 4 GHz In/Outdoor
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Antenna Diversity

Transmit Power

Possible values are 1 to 13 and Auto (default value).

* For Operation Band = 5 GHz Indoor

Possible values are 36, 40, 44, 48 and Auto (default value)

* For Operation Band = 5 GHz In/Outdoorand 5 GHz
Outdoor

Only the Auto option is possible here.
Access Client mode:

In Access Client mode you can only select the required channel
in Client Mode = Ad Hoc.

Possible values:
¢ For Operation Band = 2. 4 GHz In/Outdoor

Possible values are 1to 13 and Auto (default value).

e For Operation Band = 5 GHz Indoor

Possible values are 36, 40, 44, 48 and Auto (default value)

e For Operation Band = 5 GHz In/Outdoorand 5 GHz
Outdoor

Only the Auto option is possible here.

Select how many and which antennas are used to send and re-
ceive.

If the function is deactivated, only the main antenna sends and
receives.

If the function is activated, two antennas receive and the better
signal is evaluated.

The function is activated with Enabled.

The function is activated by default.

Select the maximum value for the radiated antenna power. The
actually radiated antenna power may be lower than the maxim-
um value set, depending on the data rate transmitted. The
maximum value for Transmit Power is country-dependent.
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Possible values:

e Max. (default value): The maximum antenna power is used.

* User Defined: Enter the required maximum value in dBm
in the input field.

®* 2 mW 3 dBm
® 5 mW 7 dBm
® 10 mw 10 dBm

®* 40 mW 16 dBm

Fields in the Radio Settings Performance Settings menu
Field Description

Wireless Mode Only for Operation Band = 2. 4 GHz In/Outdoor
Select the wireless technology that the access point is to use.
Possible values:

* 802.11g: The device operates only in accordance with
802.11g. 802.11b clients have no access.

e 802.11b: Your device operates only in accordance with
802.11b and forces all clients to adapt to it.

* 802.11 mixed (b/g) (defaultvalue)/ 802.11 mixed-
short (b/g): Your device adapts to the client technology.
The following applies for mixed-short: The data rates 5.5 and
11 mbps must be supported by all clients (basic rates).

* 802.11 mixed-long (b/g): Your device adapts to the cli-
ent technology. Only a data rate of 1 and 2 mbps needs to be
supported by all clients (basic rates). This mode is also
needed for Centrino clients if connection problems occur.

Max. Transmission Rate Select the transmission speed.
Possible values:
e auto (default value) The transmission speed is determined

automatically.

e <Value>: Depending on the setting for Operation Band,
Bandwidth, Number of spatial streams and Wireless
Mode, different whole values in mbps will be available for se-



13 Wireless LAN Funkwerk Enterprise Communications GmbH

EEC ==

lection.

Nitro Mode Activate this function to increase the transmission speed for
802.11g through frame bursting. As a result, several packets
are sent one after the other without a waiting period. This is par-
ticularly effective in 11b/g mixed operation.

The function is activated with Enabled.
The function is activated by default.

If problems occur with older WLAN hardware, this function
should be deactivated.

Nitro XM The Nitro XM (eXtreme Multimedia) function can increase
throughput by combining Protection (avoids collisions in radio
cells with 11g and 11b clients), Packet Bursting (sending of sev-
eral data packets together; already implemented with the name
Nitro), Compression and Concatenation (combines several
smaller packets into one larger WLAN packet).

Possible values:

e Frame Compression: If this function is activated, sent data
is compressed. This only works in combination with clients
that use Conexant radio cards. The gain in transmission
speed depends to a large extent on the type of transmitted
data.

e Frame Concatenation: If this function is activated, several
small data packets are combined to form larger ones. This
only works in combination with clients that use Conexant radio
cards.

* Piggyback Acknowledge: If this function is activated, the
confirmation for received packets ("ACK") is combined with
other sent packages. This only works in combination with cli-
ents that use Conexant radio cards.

e Direct Link: If "Direct link" is activated, logged-on clients
can exchange data directly, without routing via the access
point. This only works in combination with clients that use
Conexant radio cards.

By default, Frame Concatenation, Piggyback Acknow-
ledge and Direct Link are activated.
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The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu
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Beacon Period

DTIM Period

RTS Threshold

Short Retry Limit

Only if Operation Mode = Access Point Or Access Client
with Client Mode Ad Hoc.

Enter the time in milliseconds between the sending of two
beacons.

This value is transmitted in Beacon and Probe Response
Frames.

Possible values are 1to 65535.

The default value is 100 msec.

Only if Operation Mode = Access Point Or Access Client
with Client Mode Ad Hoc.

Enter the interval for the Delivery Traffic Indication Message
(DTIM).

The DTIM field is a data field in transmitted beacons that in-
forms clients about the window to the next broadcast or multic-
ast transmission. If clients operate in power save mode, they
come alive at the right time and receive the data.

Possible values are 1to 255.

The default value is 2.

Here, you select how the RTS/CTS mechanism is to be
switched on/off.

If you choose User Defined, in the input field you can specify
the data packet length threshold in bytes (1..2346) as of which
the RTS/CTS mechanism is to be used. This makes sense if
several clients that are not in each other's wireless range are
run in one access point. The mechanism can also be switched
on/off independently of the data packet length by selecting the
value Always onor Always off (default value).

Enter the maximum number of attempts to send a frame of
length less than or equal to the value defined in RTS
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Long Retry Limit

Fragmentation
Threshold

ED Threshold

CW Min

CW Max

Max Receive Lifetime

. After this many failed attempts, the packet is discarded.
Possible values are 1to 255.

The default value is 7.

Enter the maximum number of attempts to send a data packet
of length less than or equal to the value defined in RTS
Threshold. After this many failed attempts, the packet is dis-
carded.

Possible values are 1to 255.

The default value is 4.

Enter the maximum size as of which the data packets are to be
fragmented (i.e. split into smaller units). A low value is recom-
mended for this field in areas with poor reception and in the
event of radio interference.

Possible values are 256to 2346.

The default value is 2346 bytes.

Define the Energy Detection threshold for CCA (Clear Channel
Assessment).

Possible values are -21474836481%0 2147483647.

The default value is 0.

Define the maximum size of the contention window.
Possible values are 1to 65535.

The default value is 15.

Define the minimum size of the contention window.

Possible values are 1to 65535.
The default value is 1023.

Enter the time from receipt of the first fragment of a data packet
as of which no further attempts are made. The data packet is
discarded.
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Possible values are 110 4294967295.

The default value is 512 msec.

Max Transmit MSDU Enter the time from sending of the first fragment of a data pack-
Lifetime et as of which no further send attempts are made. The data
packet is discarded.

Possible values are 110 4294967295.

The default value is 512 msec.

If Access Client has been selected for the Operation Mode with Client Mode Tnfra-
structure, the following parameters will also be available under Advanced Settings.

Fields in the Advanced SettingsAccess Client Mode menu
I =

Scan Channels Only for Operation Mode = Access Client

Choose the channels which the WLAN client automatically
scans for available wireless networks.

The function is enabled by default. All channels are scanned. If
the function is disabled, you can define the required channels
under Selected Channels.

Selected Channels Only for Scan channels = disabled

Define the channels which the WLAN client automatically scans
for available wireless networks.

Roaming Profile Select the roaming profile. The options available include typical
roaming functions.

Possible values:

e Fast Roaming: The WLAN client searches for available
wireless networks as soon as the radio signal of the existing
radio connection becomes unsuitable for higher data rates.

* Normal Roaming (default value): Standard roaming.

e Slow Roaming: The WLAN client searches for available
wireless networks as soon as the radio signal of the existing
radio connection becomes weaker.
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Scan Threshold

Scan Interval

Channel Sweep

Min. Time Period for Act-

ive Scan

Max. Time Period for
Active Scan

Min. Time Period for
Passive Scan

Max. Time Period for
Passive Scan

* No Roaming: The WLAN client searches for available wire-
less networks if it is no longer connected to a wireless net-
work.

* Custom Roaming: Specify the individual roaming paramet-
ers.

Indicates the value in dBm above which the system scans for
available wireless networks in the background.

The value can only be changed for Roaming Profile = Custom
Roaming. The default value is -70 dBm.

Indicates the interval in milliseconds after which the system
scans for available wireless networks.

The value can only be changed for Roaming Profile = Custom
Roaming. The default value is 5000 ms.

Indicates how many frequencies are scanned in the back-
ground.

The value can only be changed for Roaming Profile = Custom
Roaming. The default value is 2. The value 0 disables the scan
in the background. The value -1 enables the scan of all avail-
able frequencies.

Indicates the minimum time in milliseconds a frequency is act-
ively scanned.

The value can only be changed for Roaming Profile = Custom
Roaming. The default value is 10 ms.

Indicates the maximum time in milliseconds a frequency is act-
ively scanned.

The value can only be changed for Roaming Profile = Custom
Roaming. The default value is 40 ms.

Indicates the minimum time in milliseconds a frequency is pass-
ively scanned.

The value can only be changed for Roaming Profile = Custom
Roaming. The default value is 20 ms.

Indicates the maximum time in milliseconds a frequency is act-

ively scanned.

The value can only be changed for Roaming Profile = Custom
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RTS Threshold

Short Retry Limit

Long Retry Limit

Fragmentation

Threshold

ED Threshold

Roaming. The default value is 120 ms.

Select how the RTS/CTS mechanism is to be switched on/off.

If you choose User Defined, in the input field you can specify
the data packet length threshold in bytes (1..2346) as of which
the RTS/CTS mechanism is to be used. This makes sense if
several clients that are not in each other's wireless range are
run in one access point. The mechanism can also be switched
on/off independently of the data packet length by selecting the
value Always onor Always off (default value).

Enter the maximum number of attempts to send a frame of
length less than or equal to the value defined in RTS
Threshold. After this many failed attempts, the packet is dis-
carded.

Possible values are 1 to 255.

The default value is 7.

Enter the maximum number of attempts to send a data packet
of length less than or equal to the value defined in RTS
Threshold. After this many failed attempts, the packet is dis-
carded.

Possible values are 1to 255.

The default value is 4.

Enter the maximum size as of which the data packets are to be
fragmented (i.e. split into smaller units). A low value is recom-
mended for this field in areas with poor reception and in the
event of radio interference.

Possible values are 256to 2346.

The default value is 2346 bytes.

Define the Energy Detection threshold for CCA (Clear Channel
Assessment).

Possible values are -21474836481%0 2147483647.

The default value is 0.
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CW Min.

CW Max.

Max. Receive Lifetime

Max. Transmit MSDU
Lifetime

Define the maximum size of the contention window.
Possible values are 1to 65535.

The default value is 15.

Define the minimum size of the contention window.

Possible values are 110 65535.
The default value is 1023.

Enter the time from receipt of the first fragment of a data packet
as of which no further attempts are made. The data packet is
discarded.

Possible values are 110 4294967295.

The default value is 512 msec.

Enter the time from sending of the first fragment of a data pack-
et as of which no further send attempts are made. The data
packet is discarded.

Possible values are 110 4294967295.

The default value is 512 msec.



Funkwerk Enterprise Communications GmbH 13 Wireless LAN

13.1.2 Virtual Service Sets

If you operate your device in access point mode (Wireless LAN -> WLAN -> Wireless
Module Settings ->-> Operation Mode = Access Point), you can set up and edit the

desired wireless networks in the Wireless LAN -> WLAN -> Wireless Networks (VSS) ->

->INew menu.

@ Note

The preconfigured wireless network Funkwerk-EC comes with the following security
settings:

» Security Mode = wPA-PSK
e WPA Mode = WPA and WPA2
* WPA Cipher and WPA2 Cipher = AES and TKIP

¢ A system-internal value is assigned to the Preshared Key which you must change
during configuration.

Setting network names

In contrast to a LAN set up over Ethernet, a wireless LAN does not have any cables for set-
ting up a permanent connection between the server and clients. Access violations or faults
may therefore occur with directly adjacent radio networks. To prevent this, every radio net-
work has a parameter that uniquely identifies the network and is comparable with a domain
name. Only clients with a network configuration that matches that of your device can com-
municate in this WLAN. The corresponding parameter is called the network name. In the
network environment, it is sometimes also referred to as the SSID.

Protection of wireless networks

As data can be transmitted over the air in the WLAN, this data can in theory be intercepted
and read by any attacker with the appropriate resources. Particular attention must therefore
be paid to protecting the wireless connection.

There are three security modes, WEP, WPA-PSK and WPA Enterprise. WPA Enterprise of-
fers the highest level of security, but this security mode is only really suitable for compan-
ies, because it requires a central authentication server. Private users should choose WEP
or preferably WPA-PSK with higher security as their security mode.

WEP
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802.11 defines the WEP security standard (Wired Equivalent Privacy = encryption of data
with 40 bits (Security Mode = wEP 40) or 104 bits (Security Mode = wEP 104). However,
this widely used WEP has proven susceptible to failure. However, a higher degree of se-
curity can only be achieved through hardware-based encryption which required additional
configuration (for example 3DES or AES). This permits even sensitive data from being
transferred via a radio path without fear of it being stolen.

IEEE 802.11i

Standard IEEE 802.11i for wireless systems contains basic security specifications for wire-
less networks, in particular with regard to encryption. It replaces the insecure WEP (Wired
Equivalent Privacy) with WPA (Wi-Fi Protected Access). It also includes the use of the ad-
vanced encryption standard (AES) to encrypt data.

WPA

WPA (Wi-Fi Protected Access) offers additional privacy by means of dynamic keys based
on the Temporal Key Integrity Protocol (TKIP), and offers PSK (preshared keys) or Extens-
ible Authentication Protocol (EAP) via 802.1x (e.g. RADIUS) for user authentication.

Authentication using EAP is usually used in large wireless LAN installations, as an authen-
tication instance in the form of a server (e.g. a RADIUS server) is used in these cases. PSK
(preshared keys) are usually used in smaller networks, such as those seen in SoHo (Small
office, Home office). Therefore, all the wireless LAN subscribers must know the PSK, be-
cause it is used to generate the session key.

WPA2

WPAZ2 is the enhancement of WPA. In WPA2, the 802.11i standard is not only implemen-
ted for the first time in full, but another encryption algorithm AES (Advanced Encryption
Standard) is also used.

Access control

You can control which clients can access your wireless LAN via your device by creating an
Access control list (ACL Mode or MAC Filter). In the Access Control List, you enter the
MAC addresses of the clients that may access your wireless LAN. All other clients have no
access.

Security measures

To protect the data transferred on the WLAN, you may need to carry out the following con-
figuration steps in the Wireless LAN -> WLAN -> Wireless Networks (VSS) ->New->l

menu:
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* Change the access passwords for your device.

¢ Change the default SSID, Network Name (SSID) = Funkwerk-ec , of your access
point. Set Visible = Enabled. This will exclude all WLAN clients that attempt to establish
a connection with the general value for Network Name (SSID) Any and do not know the
SSID settings.

¢ Use the available encryption methods. To do this, select Security Mode = wEpP 40, WEP
104 ,WPA PSK Or WPA Enterprise or both, and enter the relevant key in the access
point under WEP Key1 - 4 or Preshared Key and in the WLAN clients.

* The WEP key should be changed regularly. To do this, change the Data Transfer Key .
Select the longer 104 Bit WEP key.

* For the transfer of highly security-critical information, Security Mode = wra-
Enterprise should be configured with WPA Mode = wpA 2. This method contains
hardware-based encryption and RADIUS authentication of the client. In special cases,
combination with IPSec is possible.

¢ Restrict WLAN access to permitted clients. Enter the MAC addresses of the wireless net-
work cards of these clients in the Permitted Addresses-list in the MAC Filter menu (see
Fields in the menu MAC Filter on page 191).

In the Wireless LAN -> WLAN -> Virtual Service Sets menu, a list of all WLAN networks
shown.

13.1.2.1 Virtual Service Sets -> Edit/New

Choose the [i] icon to edit existing entries. Choose the New button to configure other wire-
less networks.
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Fig. 71: Wireless LAN -> WLAN -> Virtual Service Sets ->/New

The Wireless LAN -> WLAN -> Virtual Service Sets ->->/New menu consists of the
following fields:

Fields in the Virtual Service Sets Service Set Parameters menu
Field Description
Network Name (SSID)  Enter the name of the wireless network (SSID).
Enter an ASCII string with a maximum of 32 characters.

Also select whether the Network Name (SSID) is to be trans-
mitted.

The network name is shown by choosing Visible.

It is visible by default.

Intra-cell Repeating Select whether communication between the WLAN clients is to
be permitted within a radio cell.

The function is enabled by choosing Enabled.

The function is enabled by default.

ARP Processing Select whether the ARP processing function should be enabled.
The ARP data traffic is reduced in the network by the fact that
ARP broadcasts that have been converted to ARP unicasts are
forwarded to IP addresses that are known internally. Unicasts



Funkwerk Enterprise Communications GmbH 13 Wireless LAN

I =

are quicker and clients with an enabled power save function are
not addressed.

The function is enabled by choosing Enabled.
The function is disabled by default.

Make sure that ARP processing cannot be applied in conjunc-
tion with the MAC bridge function.

WMM Select whether voice or video prioritisation via WMM (Wireless
Multimedia) is to be activated for the wireless network so that
optimum transmission quality is always achieved for time-critical
applications. Data prioritisation is supported in accordance with
DSCP (Differentiated Services Code Point) or IEEE802.1d.

The function is enabled by choosing Enabled.

The function is enabled by default.

Max. Clients Enter the maximum number of clients that can be connected to
this wireless network (SSID)

The maximum number of clients that can register with a wire-
less module depends on the specifications of the respective
WLAN module. This number can be shared across all con-
figured wireless networks. If the maximum number of clients is
reached, no more new wireless networks can be created and a
warning message will appear.

Fields in the Virtual Service Sets Security Settings menu
Field Description

Security Mode Select the security mode (encryption and authentication) for the
wireless network.

Possible values:

* Inactive (default value): Neither encryption nor authentica-
tion

e WEP 40: WEP 40 Bit

e WEP 104: WEP 104 Bit

e wPA-PSK: WPA Preshared Key
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Transmit Key

WEP Key 1-4

WPA Mode

WPA Cipher

WPA2 Cipher

e WPA-Enterprise: 802.11i/TKIP

Only if Security Mode = wEP 40, WEP 104

Select one of the keys configured in WEP Key <1 - 4> as the
default key.

The default value is key 1.

Only if Security Mode = WEP 40, WEP 104
Enter the WEP key.

Enter a character string with the right number of characters for
the selected WEP mode. For wEP 40 you need a string of 5
characters, wEP 104 13 characters. For example hello for
WEP 40, funkwerk-wepl for WEP 104.

Only if Security Mode = WPA-PSK and WPA-Enterprise

Select whether you want to use WPA (with TKIP encryption) or
WPA 2 (with AES encryption), or both.

Possible values:

e WPA and WPA 2 (default value): WPA and WPA 2 can be
used.
e wPA : Only WPA is used.

e wPA 2:0Only WPA2 is used.

Only for Security Mode = WPA-PSK and WPA-Enterprise
and for WPA Mode = wPA and WPA and WPA2

Select the type of encryption you want to apply to WPA.

Possible values:

e TKIP (default value): TKIP is used.
e AES: AES is used.

e AES and TKIP: AES or TKIP is used.

Only for Security Mode = wPA-PSK and WPA-Enterprise
and for WPA Mode = wPA2 and WPA and WPAZ2
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Select the type of encryption you want to apply to WPA2.
Possible values:
e AES (default value): AES is used.
e TKIP : TKIP is used.
* AES and TKIP: AES or TKIP is used.
Preshared Key Only if Security Mode = wPA-PSK
Enter the WPA password.
Enter an ASCII string with 8 - 63 characters.

Note: Make sure you change the standard preshared key! As
long as the key remains unchanged, your device is not protec-
ted against unauthorised use.

EAP Preauthentification  Only if Security Mode = WPA-Enterprise

Select whether the EAP preauthentification function is to be ac-
tivated. This function tells your device that WLAN clients, which
are already connected to another access point, can first carry
out 802.1x authentication as soon as they are within range.
Such WLAN clients can then simply connect over the existing
network connection with your device.

The function is enabled by choosing Enabled.

The function is enabled by default.

Fields in the menu MAC VFiIter
Field Description

ACL Mode Select whether only certain clients are to be permitted for this
wireless network.

The function is enabled by choosing Enabled.

The function is disabled by default.

Allowed Addresses Use Add to make entries and enter the MAC addresses (MAC
Address) of the clients to be permitted.
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13.1.3 WDS Links

If you operate your device in access point mode (Wireless LAN -> WLAN -> Radio Set-
tings ->-> Operating Mode = Access Point), you can set up and edit the desired

WDS links in the Wireless LAN -> WLAN -> WDS links ->->lNew menu.

Important

The WDS link can only be configured in the 2.4 GHz band and in the 5 GHz band in-
door if the channel is NOT Auto.

The number of channels you can selected depends on the country setting. Please consult
the data sheet for your device.

WDS links (WDS = Wireless Distribution System) are static links between access points
(AP), which are generally used to connect clients with networks that are not directly ac-
cessible to them e.g. because the distance is too great. The access point sends from one
client to another access point, which then forwards the data to another client.

Important

Note that the data is transferred between the access points in unencrypted form over
the WDS link in the default configuration. You are therefore urgently advised to apply
one of the available security methods (WEP40 or WEP104) to protect data on WDS
links.

WDS links are configured as interfaces with the prefix wds. They behave like VSS interface
and only differ from these with respect to the predefined routing. A WDS link is defined as a
transit network: this relates to a point-to-point connection or point-to-multipoint connection
between two access points that are included in different networks.

13.1.3.1 WDS Links -> New/

Choose the [ icon to edit existing entries. Choose the New button to configure other
WDS links.
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Fig. 72: Wireless LAN -> WLAN -> WDS Links ->->/New

The Wireless LAN -> WLAN -> WDS Links ->->lNew menu consists of the following
fields:

Fields in the WDS Links Basic Parameters menu
I
WDS Description Enter a name for the WDS link.

If the Use default option is activated, the generated name of
the interface is automatically used.

If the option is not activated, you can enter a suitable name in
the input field.

The Use derfault option is enabled by default.

Fields in the WDS Security Settings menu
I

Privacy Select whether an encryption method is to be used for this WDS
link and if so, which one.

Possible values:

e None (default value): Data traffic on this WDS link is not en-
crypted.

» WEP40: Data traffic on this WDS link is encrypted with
WEP40. In WEP Key 1 - 4, enter the key for this WDS link
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Transmit Key

WEP Key 1 - 4

Preshared Key

and in Transmission Key, select the default key.

e wEP104: Data traffic on this WDS link is encrypted with
WEP104. In WEP Key 1 - 4, enter the key for this WDS link
and in Transmission Key, select the default key.

e wPA : Data traffic on this WDS link is encrypted with WPA.
Enter the key for this WDS link in Preshared Key.

e wPA 2 : Data traffic on this WDS link is encrypted with WPA.
Enter the key for this WDS link in Preshared Key.

Only if Privacy = wEP40
, WEP104

Select one of the keys configured in WEP Key <1 - 4> as the
default key.

The default value is key 1.

Only if Privacy = wEP40, WEP104
Enter the WEP key. There are two ways of entering a WEP key:
e Direct entry in hexadecimal form

If the entry starts with 0x, the generator is deactivated. Enter
a hexadecimal string with exactly the right number of charac-
ters for the selected WEP mode. 10 characters for weP40 or
26 characters for WEP104 e.g. WEP40: 0xA0B23574C5,
WEP104: 0x81DC9BDB52D04DC20036DBD831

* Direct entry of ASCII characters

Enter a character string with the right number of characters for
the selected WEP mode. For wEP40 you need a string of 5
characters, WwEP104 13 characters. For example hello for
WEP40, funkwerk-wepl for WEP104.

Only if Privacy = wpA
, WPA 2
Enter the WPA password.

Enter an ASCII string with 8 - 63 characters.



Fields in the Remote Partner menu

Field Description

Remote MAC Address  Enter the MAC address of the WDS partner.

13.1.4 Client Link

If you operate your device in access client mode (Wireless LAN -> WLAN -> Wireless
Module Settings ->@|-> Operating Mode = Access Client), you can setup and edit

the available Client Links in the Wireless LAN -> WLAN -> Client Links ->@-> menu.

Client mode can operate in infrastructure mode or in ad-hoc mode. In a network in infra-
structure mode, all clients communicate with each other exclusively via access points
There is no direct communication between the individual clients.

In ad-hoc mode, an access client can be used as central interface between a number of
terminals. In this way, devices such as computers and printers can be wirelessly intercon-
nected.

13.1.4.1 Client Link ->@|

Choose the @ icon to edit existing entries.

bintec R1200 i Language | English Standard

Radio Settings | Glient Link

Wiew Online Help | Logout

£
g
2

Basic Parameters

Metwork Name (55ID)
Security Settings
Securty Mo

Administration

( 0K ) € Cancel )

Fig. 73: Wireless LAN -> WLAN -> Client Link ->@->

The Wireless LAN -> WLAN -> Client Link ->@-> menu consists of the following fields:

R1xxx/R3xxx/R4xxx
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Fields in the Client Link Basic Parameters menu
g e ]
Network Name (SSID)  Enter the name of the wireless network (SSID).

Enter an ASCII string with a maximum of 32 characters.

Fields in the Client Link Security Settings menu
N =

Security Mode Select the security mode (encryption and authentication) for the
wireless network.

Possible values:

* Tnactive (default value): Neither encryption nor authentica-
tion

e WwEP 40: WEP 40 Bit
e WwEP 104: WEP 104 Bit
e WPA None: Only if Client Mode = Ad Hoc. WPA None:

e wPA-PSK: Only if Client Mode = Tnfrastructure. WPA
Preshared Key

Transmit Key Only if Security Mode = wEP 40, WEP 104

Select one of the keys configured in WEP Key <1 - 4> as the
default key.

The default value is key 1.

WEP Key 1-4 Only if Security Mode = wEP 40, WEP 104
Enter the WEP key.

Enter a character string with the right number of characters for
the selected WEP mode. For wEP 40 you need a string of 5
characters, wEpP 104 13 characters. For example hello for
WEP 40, funkwerk-wepl for WEP 104.

WPA Mode Only if Security Mode = WPA-PSK

Select whether you want to use WPA (with TKIP encryption) or
WPA 2 (with AES encryption), or both.

Possible values:
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e wPA (default value): Only WPA is used.
e wPA 2:0Only WPA2 is used.

Preshared Key Only if Security Mode = wPA-PSK
Enter the WPA password.

Enter an ASCII string with 8 - 63 characters.

WPA Cipher
Only for Security Mode = i7pA-PSk and WPA Mode = wpA

Select which encryption method should be used.
Possible values:

e TKIP (default value): Temporal Key Integrity Protocol.
e AES: Advanced Encryption Standard.

® AES and TKIP

Both encryption methods are rated as secure, with AES offering
better performance.

WPA2 Cipher
Only for Security Mode = wPA-pPSk and WPA Mode = wpaA2

Select which encryption method should be used.
Possible values:

* TKIP (default value): Temporal Key Integrity Protocol.
e AES: Advanced Encryption Standard.

® AES and TKIP

Both encryption methods are rated as secure, with AES offering
better performance.

13.1.4.2 Client Link Scan

After the desired Client Links have been configured, the E icon is shown in the list.

You use this icon to open the Scan menu.
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Fig. 74: Wireless LAN -> WLAN -> Client Link -> Scan

After successful scanning, a selection of potential scan partners is displayed in the scan
list. In the Action column, click [Select] to connect the local clients with this client. If the
partners are connected with one another, the {y icon appears in the Connected column.

The gy icon appears in the Connected column if the connection is active.

The Wireless LAN -> WLAN -> Client Link -> Scan menu consists of the following fields:

Fields in the Client Link Scan menu

e T

Client Link Description

Action

AP MAC Address
Network Name (SSID)
Channel

Mode

Displays the name of the client link you configured.

Start the scan by clicking on Scan.

If the antennas are installed correctly on both sides and LOS is
free, the client finds available clients and displays them in the
following list.

If the partner client cannot be found, check the line of sight and
the antenna installation. Then carry out the Scan again. The
partner should then be found.

Shows the MAC address of the remote client.
Displays the name of the remote client.
Shows the Channel used.

Shows the security mode (encryption and authentication) for the
wireless network.
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Signal Displays the signal strength of the detected client link in dBm.
Connected Displays the status of the link on your client.
Action You can change the status of the client link. The available ac-

tions are displayed in this field.

13.2 Administration

The Wireless LAN -> Administration menu contains basic settings for running your gate-
way as an access point (AP).

13.2.1 Basic Settings

E. ﬁ ! Aaras ] E

3 S 19 { =N ¥

tec R1 JIE S Language |English v | view | Standard ~| | online Help | Logout funlnmrk@
[ W] . = w = = ’ P

Save configuration Basic Settings
Assistants

System Management
Physical Interfaces
LAN

WLAN Administration

Region Germany ~

r BB

Wireless LAN
WLAN oK Cancel
Administration

Routing

WAN

VPN

Firewall

VolP

Local Services
Maintenance

External Reporting

M NN NN

Monitoring
Fig. 75: Wireless LAN -> Administration -> Basic Settings

The Wireless LAN -> Administration -> Basic Settings menu consists of the following
fields:

Field in the Basic Settings WLAN Administration menu

Field Description

Region Select the country in which the access point is to be run.

Possible values are all the countries configured on the gate-
way's wireless module.

The range of channels available for selection (Channel in the



Field Description

WLAN Wireless Modules menu) changes depending on the
country setting.

The default value is Germany.
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Chapter 14 Routing

14.1 Routes

14.1.1 IP Routes

In the Routing -> Routes -> IP Routes menu a list of all configured routes is shown.

14.1.1.1 Edit/New

Choose the @ icon to edit existing entries. Choose the New button to create routes.

bintec R1200 Language English | | Wiew | Standard ~| | OnlireHelp | Logout
Route Class
Extended Route | CEnabled
Route Parameters
Route Type MNetwork Route l§
Destination IP Address | Metmask | a
Metwork Type Direct @
Local IP Address 0.0.0.0
Metric 1 lﬁ
( oK ) ( Cancel )

Fig. 76: Routing -> Routes -> IP Routes-> New with Extended Route = Not activated

If the Extended Route option is selected for Route Class, an extra configuration section
opens.

R1xxx/R3xxx/R4xxx



14 Routing Funkwerk Enterprise Communications GmbH

} I i I = k
‘ N n " -
lec R1 i\ | rguage [English v | View [Standerd ~| | onineHelp | Logout flll'lk“l‘km
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Save configur ation IP Routes Options
Assistants -
System Management -
Physical Iinterfaces - Route Class
LAN 3 Extended Route Enabled
Wireless LAN - Route Parameters
Routing - Route Type Metwork Raoute v
Routes
HAT Destination IP Address [ Netmask
R, Interface MNone hd
Load Balancing
Multicast MNetwork Type Direct »
s T Local IP Address 0.0.00
VPN -
Metric 1>
Firewall -
Extended Route Parameters
VolP -
- Source Interface Mone v
Local Services -
Maintenance - Source IP AddressMetmask 0.0.0.0 ! |D o00.a
External Reporting - Layer 4 Pratocol Any ¥
Monitoris -
———t Source Port Port |—1 to Po|t|-1
Destination Port Port |—1 to Po|t|-1
DSCPITOS Value Ignore E
Mode Dialup and wait hd
oK Cancel

Fig. 77: Routing -> Routes -> IP Routes-> New with Extended Route = Activated
The Routing -> Routes -> IP Routes-> New menu consists of the following fields:
Fields in the IP Routes Route Class menu

Field Description

Extended Route Select whether the route is to be defined with extended para-
meters. If the function is active, a route is created with extended
routing parameters such as source interface and source IP ad-
dress, as well as protocol, source and destination port, type of
service (TOS) and the status of the device interface.

The function is enabled by choosing Enabled.

The function is disabled by default.

Fields in the IP Routes Route Parameters menu

Field Description

Route Type Select the type of route.
Possible values:

* Network Route (default value): Route to a network.
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Destination IP Address /
Netmask

Interface

Network Type

Local IP Address

Gateway

Metric

e Default Route :ls used if no other suitable route is avail-
able.

* Host Route : Route to a single host.
Only if Route Type Host Route Or Network Route
Enter the IP address of the destination host.

If Route Type = Network Route also enter the netmask in the
second field. If no entry is made, your device uses a default net-
mask.

If necessary, enter the interface to be used for this route.

Not for Route Type = Default Route
Also select the network type.

Possible values:

e Direct (default value):
¢ in the LAN: You define another IP address for the interface.
* in the WAN: You define a route without a transit network.
® Tndirect:
¢ in the LAN: You define a gateway route.
* in the WAN: You define a route with a transit network.

Only for Network Type = Direct.

Enter the IP address of the gateway to which your device is to
forward the IP packets.

Only for Network Type = Indirect.

Enter the IP address of the host to which your device is to for-
ward the IP packets.

Select the priority of the route.
The lower the value, the higher the priority of the route.

Value range from 0 to 15, The default value is 1.
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Source Interface

Source IP Address / Net-
mask

Layer 4 Protocol

Source Port

Destination Port

Select the interface over which the data packets are to reach
the device.

The default value is None

Enter the IP address and netmask of the source host or source
network.

Select a protocol.

Possible values: 1cmMpP, TCP, UDP, GRE , ESP, AH, OSPF,
L2TP, Any .

The default value is Any

Only if Layer 4 Protocol = TCP or UDP.
Enter the source port.

First select the port number range.
Possible values:

e Any (default value): The route is valid for all port numbers.

* Single: Enables the entry of a port number.

* Range: Enables the entry of a range of port numbers.

* Privileged: Entry of privileged port numbers: O ... 1023.

e Server: Entry of server port numbers: 5000 ... 32767.

e Clients 1:Entry of client port numbers: 1024 ... 4999.

e Clients 2:Entry of client port numbers: 32768 ... 65535.

* Not privileged: Entry of unprivileged port numbers: 1024
... 65535.

Enter the appropriate values for the individual port or start port
of a range in Port and, for a range, the end port in to Port.

Only if Layer 4 Protocol = TCP or UDP.
Enter the destination port.

First select the port number range.
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DSCP / TOS Value

Mode

Possible values:

* Any (default value): The route is valid for all port numbers.

e Single: Enables the entry of a port number.

* Range: Enables the entry of a range of port numbers.

* Privileged: Entry of privileged port numbers: O ... 1023.

* Server: Entry of server port numbers: 5000 ... 32767.

e Clients 1:Entry of client port numbers: 1024 ... 4999.

e Clients 2:Entry of client port numbers: 32768 ... 65535.

* Not privileged: Entry of unprivileged port numbers: 1024

... 65535.

Enter the appropriate values for the individual port or start port
of a range in Port and, for a range, the end port in to Port.

Select the Type of Service (TOS).

Possible values:

e Tgnore (default value): The type of service is ignored.

¢ DScP: Relates to a Differentiated Services Code Point to RFC
3260.

* TOS Binary Value: The TOS value is specified in binary
format, e.g. 00111111.

e TOS Decimal Value: The TOS value is specified in decimal
format, e.g. 63.

Enter the relevant value for DSCP, TOS Binary Value and
TOS Decimal Value.

Select when the interface defined in Route Parameters -> In-
terface is to be used.

Possible values:

e Dialup and wait (default value): The route can be used if
the interface is "up". If the interface is "dormant", then dial and
wait until the interface is "up".

* Authoritative : The route can always be used.

e Dialup and continue: The route can be used if the inter-
face is "up". If the interface is "dormant”, then select and use
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the alternative route (rerouting) until the interface is "up".

* Never dialup: The route can be used if the interface is

up".

e Always dialup: The route can be used if the interface is
"up". If the interface is "dormant”, then dial and wait until the
interface is "up". In this case, an alternative interface with a
poorer metric is used for routing until the interface is "up".

14.1.2 Options

Back Route Verify

The term Back Route Verify describes a very simple but powerful function. If a check is ac-
tivated for an interface, incoming data packets are only accepted over this interface if out-
going response packets are routed over the same interface. You can therefore prevent the
acceptance of packets with false IP addresses - even without using filters.

‘ 5 s ey ¥ o
" =3 N -

lec R1 JIVEESSS | oguzge [English v | view | Standard ~| | Online Help | Logout flll'lh“l‘k@
[ i x = w w I

Save configuration IP Routes  Options
Assistants -
System Management -
Physical Interfaces hd Back Route Yerify
LAN T O Enable for allinterfaces
Wireless LAN - Mode @ Enable for specific interfaces
Rauting N O pisable for all interfaces
Routes Wiew |20 per page Fitter in | None | equal hd Go.
HAT # Interface Back Route Verity
ar 1 ent-0 Clenabled
Load Balancing 5 o
ent-
Multicast [Ienabled
WAN - 3 ford ClEnabled
Page: 1,ftems: 1-3
VPN b
General
Firewall
Allow deletingiediting all routing entries | [ Enabled
VolP
Local Services b oK Cancel

Maintenance b

External Reporting b

Monitoring =
Fig. 78: Routing -> Routes -> Options

The Routing -> Routes -> Options menu consists of the following fields:
Fields in the Options Back Route Verify menu

Field Description

Mode Select how the interfaces to be activated for Back Route Verify
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are to be specified.
Possible values:

* Enable for all Interfaces: Back Route Verify is activ-
ated for all interfaces.

* Enable for Specific Interfaces (defaultvalue): A
list of all interfaces is displayed in which Back Route Verify is
only enabled for specific interfaces.

* Disable for all Interfaces: Back Route Verify is dis-
abled for all interfaces.

# Only for Mode = Enable for specific interfaces

Displays the serial number of the list entry.

Interface Only for Mode = Enable for specific interfaces

Displays the name of the interface.

Back Route Verify Only for Mode = Enable for specific interfaces

Select whether Return Route Checkingis to be enabled for
this interface.

The function is activated with Enabled.

By default, the function is deactivated for all interfaces.

Fields in the Options General menu
I =

Allow deleting/editing all Define whether all the routes entered on your device can be ed-
routing entries ited and deleted in the Routing -> Routes -> Routes menu.

The function is activated with Enabled.

By default, the function is deactivated for all interfaces.

14.2 NAT



14.2.1 NAT Interfaces

Network Address Translation (NAT) is a function on your device for defined conversion of
source and destination addresses of IP packets. If NAT is activated, IP connections are still
only allowed by default in one direction, outgoing (forward) (= protective function). Excep-
tions to the rule can be configured (in Portforwarding on page 209).

In the Routing -> NAT -> NAT Interfaces menu, a list of all NAT interfaces is shown.

i sl i 3.3
bintec R1 Zﬁo ' Language |English | | View  Stancard ~| | Online Help | Logout
NAT Interfaces | Portforwarding
; Wiew |20 per page Fiter in ‘Nnne V|equal ”'I
_ Interface AT active Silert Deny PPTP Passthrough Partforwerdings
| WielessLan xRS O O O !
5 | LANLENTD 0 ] 0 0
LAN_EN1-4 O [} ] 0
Page: 1,fems: 1-3
Load Balancing ( oK ) cancel )
Multicast

Fig. 79: Routing -> NAT -> NAT Interfaces

For each NAT interface, you can select the options NAT Active, Silent Deny and
PPTP Passthrough.

In addition, Port forwardings displays how many portforwarding rules were configured
for this interface.

Options in the menu NAT Interfaces
Field Description

NAT active Select whether NAT is to be activated for the interface.

The function is disabled by default.

Silent Deny Select whether IP packets are to be silently denied by NAT. If
this function is deactivated, the sender of the denied IP packet
is informed by means of an ICMP or TCP RST message.
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Field Description

The function is disabled by default.

PPTP Passthrough Select whether the setup and operation of several simultan-
eous, outgoing PPTP connections from hosts in the network are
also to be permitted if NAT is activated.

The function is disabled by default.

If PPTP Passthrough is enabled, the device itself cannot be
configured as a tunnel endpoint.

Portforwardings Shows the number of portforwarding rules configured in Rout-

ing -> NAT -> Portforwarding.

14.2.2 Portforwarding

In the Routing -> NAT -> Portforwarding menu, a list of all NAT interfaces is shown for
which portforwarding has been configured.

14.2.2.1 New

Choose the New button to set up portforwarding for other interfaces.

8

bintec R1200 Language English v | View  Standard ~| | Online Help | Logout

NAT Interfaces Portforwarding

Basic Parameters

Interface
Select traffic
Service
Protocol
. Corresponding MAT entry for outgaing connection  []Enabled
- Mulicast | External P Address Auto | |
i Part Al v tol-1
; Remate Network CJEnabled
—; Farward to
g Map to host IP Address V| |255 256,255,250
1 Destination Port Original I-T—
R A ety
Montaring ok O ( cancet

Fig. 80: Routing -> NAT -> Portforwarding -> New

The Routing -> NAT -> Portforwarding -> New menu consists of the following fields:
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Fields in the Portforwarding Basic Parameters menu
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Interface

Select the interface for which portforwarding is to be configured.

Fields in the Portforwarding Select traffic

I =

Service

Protocol

Select the service for which address mapping is defined for in-
coming connections.

Possible values:

e User-defined (default value)
® DNS (UDP)
® DNS (TCP)
® FTP

®* HTTP

® HTTPS

* TMAP

® NNTP

® POP3

® SMTP

® SSH

® TELNET

Only if Service = User-defined.
Select the protocol.

Possible values:

e Any (default value)
* AH

® Chaos

* EGP

* ESP

* GGP

® GRE



Funkwerk Enterprise Communications GmbH

14 Routing

I =

Corresponding NAT
entry for outgoing con-
nection

External IP Address

* HMP

® ICMP

® TGP

® IGRP

© Ip

® TPinIP

® TPv6

® TPX in IP
© ISO=IlE

® Kryptolan
® IL2TP

* OSPH

* PUP

® RDP

® RSVP

® SKIP

O e

o TSP

* UDP

® VRRP

® XNS-IDP

Specify whether a NAT entry is to be created for outgoing con-
nections for portforwarding.

The function is activated with Enabled.

The function is activated by default.

Select the external host or network IP address of the selected
interface.

In default scenarios, only one external IP address is available.
In this case, select the Auto option.

The Auto option is disabled by default, so that you can enter
the IP address manually.
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Port Only if Service = User-defined.

First select whether all connections are to be permitted, or
whether a certain port or port range is to be defined.

Possible values:

e Al1 (default value): No port mapping is carried out. In this
case, the value -1 is entered in the input fields.

* Specify Port :Enables a port number to be entered.

* Specify Port Range :Enables a port number range to be
entered.

Now enter the original destination port or destination port range

(...to...) of the incoming IP connection.

Remote Network
Select whether IP packets are to be forwarded to a remote net-

work.

The function is disabled by default.

The function is activated with Enabled.

Remote IP Address / Only if Remote Network = Enabled.

Netmask
Now enter the remote IP address and netmask for the remote

network.

Fields in the Portforwarding Forward to menu
Field Description
Map to host Enter the IP address of the internal host or network.

You can also select the Local option, in which case the port is
mapped to your device.

Destination Port Enter the new destination port of the incoming IP connection.

Select whether the source port is to be used by enabling the
Original option. In this case, enter the value -1 in the port num-
ber input field. Or disable the Original option and enter a port
number.



14.3 RIP

The entries in the routing table can be defined statically or the routing table can be updated
constantly by dynamic exchange of routing information between several devices. This ex-
change is controlled by a Routing Protocol, e.g. RIP (Routing Information Protocol). By de-
fault, about every 30 seconds (this value can be changed in Update Timer), a device
sends messages to remote networks using information from its own current routing table.
The complete routing table is always exchanged in this process. If triggered RIP is used, in-
formation is only exchanged if the routing information has changed. In this case, only the
changed information is sent.

Observing the information sent by other devices enables new routes and shorter paths for
existing routes to be saved in the routing table. As intermediate routes between networks
can become unreachable, RIP removes routes that are older than 5 minutes (i.e. routes not
verified in the last 300 seconds - Garbage Collection Timer + Route Timeout). Routes
learnt with triggered RIP are not deleted.

Your device supports both version 1 and version 2 of RIP, either individually or together.

14.3.1 RIP Interfaces

In the Routing -> RIP -> RIP Interfaces menu, a list of all RIP interfaces is shown.

bintec R1200 | Language |English v| | Wiew | Standard ~| | Online Help | Logout

RIP Interfaces RIP Filter RIP Options

View |20 per page Fiter in | Nane v|equal v

# Interface Send Yersion Receive Yersion Route &nnounce
1 ent-0 Mone Mone Uponky
2 ent-4 Mone Mone Uponky

]|

3 br0 Mone Mone Up or Dormant
Page: 1, ftems: 1-3

Balancing

Fig. 81: Routing -> RIP -> RIP Interfaces
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14.3.1.1 Edit

For each RIP interface, you can, in the @ menu, select the options Send Version, Re-

ceive Versionand Route Announce.

bintec R1200 Language |English ~| | iew |Standard ~| | Online Help | Logout

RIP Interfaces RIP Filter  RIP Options

RIP Parameters for. ent-0

Recelve Versian
Route Announce Upanly

C oK 0 ( cancel )

Fig. 82: Routing -> RIP -> RIP Interfaces->@|
The Routing -> RIP -> RIP Interfaces->@| menu consists of the following fields:

Fields in the RIP Parameters for <Interface> menu
Field Description

Send Version Decide whether routes are to be propagated via RIP and if so,
select the RIP version for sending RIP packets over the inter-
face in send direction.

Possible values:

* None (default value): RIP is not enabled.

e RIP VI1: Enables sending and receiving of version 1 RIP
packets.

e RIP Vv2: Enables sending and receiving of version 2 RIP
packets.

e RIP V1/Vv2: Enables sending and receiving of both version 1
and version 2 RIP packets.

* RIP V2 Multicast: For sending RIP V2 messages over

R1xxx/R3xxx/R4xxx
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the multicast address 224.0.0.9.

* RIP V1 Triggered: RIP V1 messages are sent, received
and processed as per RFC 2091 (triggered RIP).

e RTP V2 Triggered: RIP V2 messages are sent, received
and processed as per RFC 2091 (triggered RIP).

Receive Version Decide whether routes are to be imported via RIP and if so, se-
lect the RIP version for receiving RIP packets over the interface
in receive direction.

Possible values:

* None (default value): RIP is not enabled.

e RIP VI1: Enables sending and receiving of version 1 RIP
packets.

e RIP V2: Enables sending and receiving of version 2 RIP
packets.

e RIP V1/Vv2: Enables sending and receiving of both version 1
and version 2 RIP packets.

* RIP V1 Triggered: RIP V1 messages are sent, received
and processed as per RFC 2091 (triggered RIP).

* RTP V2 Triggered: RIP V2 messages are sent, received
and processed as per RFC 2091 (triggered RIP).

Route Announce Select this option if you want to set the time at which any activ-
ated routing protocols (e.g. RIP) are to propagate the IP routes
defined for this interface.

Note: This setting does not affect the interface-specific RIP con-
figuration mentioned above.

Possible values:

* Up or Dormant (not for LAN interfaces, interfaces in the
Bridge mode and interfaces for leased lines) : Routes are
propagated if the interface status is up or dormant.

* Up only : Routes are only propagated if the interface status
is up.

e Always: Routes are always propagated independent of oper-
ational status.



14.3.2 RIP Filter

In this menu, you can specify exactly which routes are to be exported or imported.

You can use the following strategies for this:

* You explicitly deactivate the import or export of certain routes. The import or export of all
other routes that are not listed is still allowed.

* You explicitly activate the import or export of certain routes. In this case, you must also
explicitly deactivate the import or export of all other routes. You can do this using a filter
for IP Address = no entry (this corresponds to the IP address 0.0.0.0) with Netmask =
no entry (this corresponds to the netmask 0.0.0.0). To make sure this filter is used last, it
must be placed at the lowest position.

You configure a filter for a default route with the following values:

* |IP Address = no entry (this corresponds to the IP address 0.0.0.0) with Netmask =
255.255.255.255

In the Routing -> RIP -> RIP Filter menu, a list of all RIP filters is shown.

bintec R1200 " Language |English | | iew |Standard ~| | OnlineHelp | Logaut

RIP Interfaces RIP Filter RIP Options

L3 Interface Direction IP Address Metmask Fitter Status

C New ) [ oK 0 cancel )

Load Balancing
Multicast

Fig. 83: Routing -> RIP -> RIP Filter

You can use the Eﬂ button to insert another filter above the list entry. The configuration

menu for creating a new window opens.

You can use the [ button to move the list entry. A dialog box opens, in which you can se-
lect the position to which the filter is to be moved.
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14.3.2.1 New

Choose the New button to set up more RIP filters.

bintee R1200 Language |English | | Wiew |Sandard v| | online Help | Logout

RIP Interfaces RIP Filter RIP Options

Basic Parameters

Interface MNone v

IP Address i Netmask

Direction @Impon OExpon

Metric Offset for Active Interfaces

=] [=
LS

Metric Offset for Inactive Interfaces

€ OK ) € Cancel )

Fig. 84: Routing -> RIP -> RIP Filter -> New
The Routing -> RIP -> RIP Filter -> New menu consists of the following fields:
Fields in the RIP Filter Basic Parameters menu

Interface Select the interface to which the rule to be configured applies.

IP Address/Netmask Enter the IP address and netmask to which the rule is to be ap-
plied. This address can be in the LAN or WAN.

The rules for incoming and outgoing RIP packets (import or ex-
port) for the same IP address must be separately configured.

You can enter individual host addresses or network addresses.

Direction Select whether the filter applies to the export or import of routes.
Possible values:

e Import (default value)

®* Export
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Metric Offset for Active  Select the value to be added to the route metric if the status of
Interfaces the interface is "up". During export, the value is added to the ex-
ported metric if the interface status is "up".

Possible values are -1610 16.

The default value is 0.

Metric Offset for Inactive Select the value to be added to the route metric if the status of
Interfaces the interface is "dormant". During export, the value is added to
the exported metric if the interface status is "dormant".

Possible values are -1610 16.

The default value is 0.

14.3.3 RIP Options

E I ot CES ¥ ]
tec R JIVRBSSS | orguzge [English v | View |Standard ~| | Online Help | Logout flll'lh“l‘k@
- 1 w w w r

Save configuration RIP Interfaces  RIP Filter RIP Options
Assistants -
System Management -
Physical Interfaces hd Global RIP Parameters
Ly hd RIP UDP Part 520
\lieless LA hd Default Route Distribution Enabled
Routing -
Routes Poisoned Reverse CEnabled
HAT RFC 2453 Variable Timer [#/Enabled
RIP
Load Balancing RFC 2081 Variable Timer CJEnabled
Multicast Timer for RIP %2 (RFC 2453)
157 b Update Tirmer 30 Seconds
VPN -
5 Route Timeout 180 Seconds
Firewall -
VolP = Garhage Collection Timer 120 Seconds
Local Services -
Maintenance - el LU

External Reporting

4

Monitoring -
Fig. 85: Routing -> RIP -> RIP Options
The Routing -> RIP -> RIP Options menu consists of the following fields:

Fields in the RIP Options Global RIP Parameters menu

Field Description

RIP UDP Port The setting option UDP Port, which is used for sending and re-
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Default Route Distribu-
tion

Poisoned Reverse

RFC 2453 Variable
Timer

RFC 2091 Variable
Timer

ceiving RIP updates, is only for test purposes. If the setting is
changed, this can mean that your device sends and listens at a
port that no other devices use. The default value 520 should be
retained.

Select whether the default route of your device is to be propag-
ated via RIP updates.

The function is activated with Enabled.

The function is enabled by default.

Select the procedure for preventing routing loops.

With standard RIP, the routes learnt are propagated over all in-
terfaces with RIP SEND activated. With Poisoned Reverse,
however, your device propagates over the interface over which
it learnt the routes, with the metric (Next Hop Count) 16
(=“Network is not reachable®).

The function is activated with Enabled.

The function is disabled by default.

For the timers described in RFC 2453, select whether the same
values that you can configure in the Timer for RIP V2 (RFC
2453) menu.

The function is activated with Enabled.
The function is enabled by default.

If you deactivate the function, the times defined in RFC are re-
tained for the timeouts.

For the timers described in RFC 2091, select whether the same
values that you can configure in the Timer for Triggered RIP
(RFC 2091) menu.

The function is activated with Enabled.
The function is disabled by default.

If the function is not activated, the times defined in RFC are re-
tained for the timeouts.
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Fields in the RIP Options Timer for RIP V2 (RFC 2453) menu
N =

Update Timer Only for RFC 2453 Variable Timer = Enabled
An RIP update is sent on expiry of this period of time.

The default value is 30 (seconds).

Route Timeout Only for RFC 2453 Variable Timer = Enabled
After the last update of a route, the route time is active.

After timeout, the route is deactivated and the Garbage Collec-
tion Timer is started.

The default value is 180 (seconds).

Garbage Collection Only for RFC 2453 Variable Timer = Enabled

Timer
The Garbage Collection Timer is started as soon as the route
timeout has expired.

After this timeout, the invalid route is deleted from the
IPROUTETABLE if no update is carried out for the route.

The default value is 120 (seconds).

Fields in the RIP Options Timer for Triggered RIP (RFC 2091) menu
R ==

Hold Down Timer Only for RFC 2091 Variable Timer = Enabled

The hold down timer is activated as soon as your device re-
ceives an unreachable route (metric 16). The route may deleted
once this period has elapsed.

The default value is 120 (seconds).

Retransmission Timer Only for RFC 2091 Variable Timer = Enabled

After this timeout, update request or update response packets
are sent again until an update flush or update acknowledge
packet arrives.

The default value is 5 (seconds).



14.4 Load Balancing

14.4.1 Load Balancing Groups

The increasing amount of data traffic over the Internet means it is necessary to send data
over different interfaces to increase the total bandwidth available. IP load balancing en-
ables the controlled distribution of data traffic within a particular group of interfaces accord-
ing to the following principles:

* In contrast to Multilink PPP-based solutions, load balancing also functions with accounts
with different providers.

» Session-based load balancing is achieved.

¢ Related (dependent) sessions are always routed over the same interface.

* A decision on distribution is only made for outgoing sessions.

In the Routing -> Load Balancing -> Load Balancing Groups menu a list of all con-
figured load balancing groups is shown.

14.4.1.1 New

Choose the New button to set up new groups.

bintee R1200 | Language |English | | iew |Standard ~| | oniine Help | Logout

Load Balancing Groups

Basic Parameters

Group Description

Distribution Policy Session-Round-Rokin [
Distribution Mode @Always OOnly use active interfaces
Interface Selection for Distriaution
Interface Distribution Ratio

Add

C oK 0 (_ cancel ) [ Back )

Fig. 86: Routing -> Load Balancing -> Load Balancing Groups -> New

The Routing -> Load Balancing -> Load Balancing Groups -> New menu consists of the

R1xxx/R3xxx/R4xxx



14 Routing Funkwerk Enterprise Communications GmbH

following fields:

Fields in the Load Balancing Groups Basic Parameters menu
Field Description

Group Description Enter the desired description of the interface group.

Distribution Policy Select the way the data traffic is to be distributed to the inter-
faces configured for the group.

Possible values:

* Session-Round-Robin (default value): A newly added
session is assigned to one of the group interfaces according
to the percentage assignment of sessions to the interfaces.
The number of sessions is decisive.

* Load-dependent Bandwidth: A newly added session is
assigned to one of the group interfaces according to the share
of the total data rate handled by the interfaces. The current
data rate based on the data traffic is decisive in both the send
and receive direction.

Consider Only for Distribution Policy = Bandwidth, load-de-
pendent

Choose the direction in which the current data rate is to be con-
sidered.

Options:

* Download: Only the data rate in the receive direction is con-
sidered.

* Upload: Only the data rate in the send direction is con-
sidered.

The Download and Upload are deactivated by default.

Distribution Mode Select the state the interfaces in the group may have if they are
to be included in load balancing.

Possible values:

* Always(default value): Also includes idle interfaces.

* Only use active interfaces: Only interfaces in the up
state are included.
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In the Interface Selection for Distribution area, you add and configure interfaces that
match the current group context. You can also delete interfaces.

Use Add to create entries.

Fields in the Load Balancing Groups Interface Selection for Distribution menu
Field Description

Interface Select the interfaces that are to belong to the group from the
available interfaces.

Distribution Ratio Enter the percentage of the data traffic to be assigned to an in-
terface.

The meaning differs according to the Distribution Policy used:

¢ Based on the number of sessions to be distributed for Ses-
sion—-Round-Robin.

e For Bandwidth Load Dependent the data rate is the de-
cisive factor.

14.5 Multicast

What is multicasting?

Many new communication technologies are based on communication from one sender to
several recipients. Therefore, modern telecommunication systems such as voice over IP or
video and audio streaming (e.g. IPTV or Webradio) focus on reducing data traffic, e.g. by
offering TriplePlay (voice, video, data). Multicast is a cost-effective solution for effective use
of bandwidth because the sender of the data packet, which can be received by several re-
cipients, only needs to send the packet once. The packet is sent to a virtual address
defined as a multicast group. Interested recipients register for these groups.

Other areas of use

One classic area in which multicast is used is for conferences (audio/video) with several re-
cipients. The most well-known are probably the MBone Multimedia Audio Tool (VAT),

Video Conferencing Tool (VIC) and Whiteboard (WB). VAT can be used to hold audio con-
ferences. All participants are displayed in a window and the speaker(s) are indicated by a
black box. Other areas of use are of particular interest to companies. Here, multicasting
makes it possible to synchronise the databases of several servers, which is valuable for
multinationals or even companies with just a few locations.
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Address range for multicast

For, IPv4 the IP addresses 224.0.0.0 to 239.255.255.255 (224.0.0.0/4) are reserved for
multicast in the class D network. An IP address from this range represents a multicast
group to which several recipients can log in. The multicast router then forwards the re-
quired packets to all subnets with logged in recipients.

Multicast basics

Multicast is connectionless, which means that any trouble-shooting or flow control needs to
be guaranteed at application level.

At transport level, UDP is used almost exclusively, as, in contrast to TCP, it is not based on
a point-to-point connection.

At IP level, the main difference is therefore that the destination address does not address a
dedicated host, but rather a group, i.e. during the routing of multicast packets, the decisive
factor is whether a recipient is in a logged-in subnet.

In the local network, all hosts are required to accept all multicast packets. For Ethernet or
FDD, this is based on MAC mapping, where the group address is encoded into the destina-
tion MAC address. For routing between several networks, the routers first need to make
themselves known to all potential recipients in the subnet. This is achieved by means of
Membership Management protocols such as IGMP for IPv4 and MLP for IPv6.

Membership Management protocol

In IPv4, IGMP (Internet Group Management Protocol) is a protocol that hosts can use to
provide the router with multicast membership information. IP addresses of the class D ad-
dress range are used for addressing. An IP address in this class represents a group. A
sender (e.g. Internet radio) sends data to this group. The addresses (IP) of the various
senders within a group are called the source (addresses). Several senders (with different
IP addresses) can therefore transmit to the same multicast group, leading to a 1-to-n rela-
tionship between groups and source addresses. This information is forwarded to the router
by means of reports. In the case of incoming multicast data traffic, a router can use this in-
formation to decide whether a host in its subnet wants to receive it. Your device supports
the current version IGMP V3, which is upwardly compatible, which means that both V3 and
V1/V2 hosts can be managed.

Your device supports the following multicast mechanisms:

* Forwarding: This relates to static forwarding, i.e. incoming data traffic for a group is
passed in all cases. This is a useful option if multicast data traffic is to be permanently



passed.

* IGMP: IGMP is used to gather information about the potential recipients in a subnet. In
the case of a hop, incoming multicast data traffic can thus be selected.

@ .

With multicast, the focus is on excluding data traffic from unwanted multicast groups.
Note that if forwarding is combined with IGMP, the packets can be forwarded to the
groups specified in the forwarding request.

14.5.1 Forwarding

In this menu, you specify which multicast groups are always forwarded between the inter-
faces of your device.

14.5.1.1 New

Choose the New button to create forwarding rules for new multicast groups.

bintee R1200 | Language |English ~| | iew Standard ~ | OnlineHelp | Logout

_Save configuration Forwarding IGMP  Options

Basic Parameters

Al Multicast Groups CEnabled

Multicast Group Address l—
Source Interface
Destination Interface

Load Balancing C

Multicast OK 0 ( cancel )

Fig. 87: Routing -> Multicast -> Forwarding ->@/New
The Routing -> Multicast -> Forward ->@|/New menu consists of the following fields:

Fields in the Forwarding Basic Parameters menu

R1xxx/R3xxx/R4xxx
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All Multicast Groups Select whether all multicast groups, i.e. the complete multicast
address range 224.0.0.0/4, are to be forwarded from the defined
Source Interface to the defined Destination Interface To do
this, check Enabled

Disable the option if you only want to forward one defined mul-
ticast group to a particular interface.

The option is deactivated by default.

Multicast Group Address Only for All Multicast-Groups = disabled

Enter here the address of the multicast group you want to for-
ward from a defined Source Interface to a defined Destination
Interface

Source Interface Select the interface on your device to which the selected multic-
ast group is sent.

Destination Interface Select the interface on your device to which the selected multic-
ast group is to be forwarded.

14.5.2 IGMP

IGMP (Internet Group Management Protocol, see RFC 3376) is used to signal the informa-
tion about group (membership) in a subnet. As a result, only the packets explicitly wanted
by a host enter the subnet.

Special mechanisms ensure that the requirements of the individual clients are taken into
consideration. At the moment there are three versions of IGMP (V1 - V3); most current sys-
tems use V3, and less often V2.

Two packet types play a central role in IGMP: queries and reports.

Queries are only transmitted from a router. If several IGMP routers exist in a network, the
router with the lowest IP address is the "querier". We differentiate here between a general
query (sent to 224.0.0.1), a group-specific query (sent to a group address) and the group-
and-source-specific query (sent to a specific group address). Reports are only sent by
hosts to respond to queries.

In this menu, you configure the interfaces on which IGMP is to be enabled.



14.5.2.1 New

Choose the New button to configure IGMP on other interfaces.

bintec R1200 Language |English v| | “iew | Standard v| | Online Help | Logout

Forwarding IGMP Options

IGMP Seftings:

Interface

Query Interal 125 Seconds

Maximurm Response Time lw— Seconds

Robusiness

Last Member Query Interval lW— Seconds

IGMP State Limit lD— Messages per Second
Mode O Host only & Host and Routing

Advanced Settings

IGMP Proxy Enabled
Proxy Interface

C oK 0 ( cancel )

Fig. 88: Routing -> Multicast -> IGMP ->@lNew

The Routing -> Multicast -> IGMP ->@|/New menu consists of the following fields:

Fields in the IGMP IGMP Settings menu
Field ipti

Interface Select the interface on which IGMP is to be enabled, i.e. queries
are sent and responses are accepted.

Query interval Enter the interval in seconds in which IGMP queries are to be
sent.

Possible values are 0to 600.

The default value is 125.

Maximum Response For the sending of queries, enter the time interval in seconds

Time within which hosts must respond. The hosts randomly select a
time delay from this interval before sending the response. This
spreads the load in networks with several hosts, improving per-
formance.

R1xxx/R3xxx/R4xxx
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Possible values are 0to 100.

The default value is 100.

Robustness Select the multiplier for controlling the timer values. A higher
value can e.g. compensate for packet loss in a network suscept-
ible to loss. If the value is too high, however, the time between
logging off and stopping of the data traffic can be increased
(leave latency).

Possible values are 2 to 8.

The default value is 2.

Last Member Query In-  Define the time after a query for which the router waits for an
terval answer.

If you shorten the interval, it will be more quickly detected that
the last member has left a group so that no more packets for
this group should be forwarded to this interface.

Possible values are 0to 255.

The default value is 10.

IGMP State Limit Limit the number of reports/queries per second for the selected
interface.
Mode Specify whether the interface defined here only works in host

mode or in both host mode and routing mode.

Possible values:

* Host and Routing (default value): The interface is oper-
ated in routing mode and in host mode.

* Host only: The interface is only operated in host mode.

IGMP Proxy

IGMP Proxy enables you to simulate several locally connected interfaces as a subnet to an
adjacent router. Queries coming in to the IGMP Proxy interface are forwarded to the local
subnets. Local reports are forwarded on the IPGM Proxy interface.
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bintec r1200w bintec r1200w Multicast-Receiver

Multicast-Sender @ @ @ @

IGMP Proxy Interface
Multicast-Receiver

Fig. 89: IGMP Proxy
The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu

Field Description

IGMP Proxy Select whether your device is to forward the hosts' IGMP mes-
sages in the subnet via its defined Proxy Interface.

Proxy Interface Select the interface on your device via which queries are to be
received and collected.

14.5.3 Options

In this menu, you can enable and disable IGMP on your system. You can also define
whether IGMP is to be used in compatibility mode or only IGMP V3 hosts are to be accep-
ted.
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Save configur ation Forwarding IGMP Options
Assistants -
System Management -
Physical Interfaces - Basic Settings
LAN - IGMP Status Oup Opown @ Ao
Wireless LAN hd Mode @ Compatibility Mode O Version 3 only
Routing i
Maximum Groups B4
Routes
LoF Maximum Sources 64
RIP
Load Balancing IGMP State Limit 0 Messages per Second
Multicast
WAN - oK Cancel
VPN .4

Firewall -
VolP b
Local Services b
Maintenance =7
External Reporting -

Monitaring =
Fig. 90: Routing -> Multicast -> Options

The Routing -> Multicast -> Options menu consists of the following fields:

Fields in the Options Basic Settings menu

g feeme ]
IGMP Status Select the IGMP status.

Possible values:

e auto (default value) Multicast is activated automatically for
hosts if the hosts open applications that use multicast.

e Active: Multicast is always on.

* Down : Multicast is always off.
Mode Only for IGMP Status = Active or Auto
Select Multicast Mode.

Possible values:

* Compatibility Mode (default value): The router uses IG-
MP version 3. If it notices a lower version in the network, it
uses the lowest version it could detect.

* Version 3 only: Only IGMP version 3 is used.

Maximum Groups Enter the maximum number of groups to be permitted, both in-
ternally and in reports.



Field Description

Maximum Sources Enter the maximum number of sources that are specified in ver-
sion 3 reports and the maximum number of internally managed
sources per group.

IGMP State Limit Enter the maximum permitted total number of incoming queries
and messages per second.

The default value is 0, i.e. the number of IGMP status mes-
sages is not limited.

R1xxx/R3xxx/R4xxx
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Chapter 15 WAN

15.1 Internet + Dialup

In this menu, you can set up Internet access or dialup connections.

To enable your device to set up connections to networks or hosts outside your LAN, you
must configure the partners you want to connect to on your device. This applies to outgoing
connections (your device dials its WAN partner) and incoming connections (a remote part-
ner dials the number of your device).

If you want to set up Internet access, you must set up a connection to your Internet Service
Provider (ISP). For broadband Internet access, your device provides the PPP-
over-Ethernet (PPPoE), PPP-over-PPTP and PPP-over-ATM (PPPoA) protocols. You can
also configure Internet access over ISDN.

Note

Note your provider's instructions.

Dialin connections over ISDN are used to establish a connection to networks or hosts out-
side your LANSs.

All the entered connections are displayed in the corresponding list, which contains the De-
scription, the User Name, the Authentication and the current Status.

The Status field can take the following values:

Possible values for Status:

Field Description

(+] connected
@. not connected (dialup connection); connection setup possible
ﬁ not connected (e.g. because of an error during setup of an out-

going connection, a renewed attempt is only possible after a
specified number of seconds)

n administratively set to down (deactivated); connection setup not
possible for leased lines:
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Authentication

When a call is received, the calling party number is always sent over the ISDN D-channel.
This number enables your device to identify the caller (CLID), provided the caller is entered
on your device. After identification with CLID, your device can additionally carry out PPP
authentication with the connection partner before it accepts the call. Your device needs the
necessary data for this, which you should enter here. First establish the type of authentica-
tion process that should be performed, then enter a common password and two codes. You
get this information, for example, from your Internet Service Provider (ISP) or the system
administrator at your head office. If the data you entered on your device is the same as the
caller's data, the call is accepted. The call is rejected if the data is not the same.

Default Route

With a default route, all data is automatically forwarded to one connection if no other suit-
able route is available. If you set up access to the Internet, you must configure the route to
your Internet Service Provider (ISP) as a default route. If, for example, you configure a cor-
porate network connection, only enter the route to the head office or branch office as a de-
fault route if you do not configure Internet access over your device. If, for example, you
configure both Internet access and a corporate network connection, enter a default route to
the ISP and a network route to the head office. You can enter several default routes on
your device, but only one default route can be active at any one time. If you enter several
default routes, you should make sure the values for Metric are different.

Activating NAT

With Network Address Translation (NAT), you conceal your whole network to the outside
world behind one IP address. You should certainly do this for your connection to the Inter-
net Service Provider (ISP).

Only outgoing sessions are allowed initially if NAT is activated. To allow certain connec-
tions from outside to hosts within the LAN, these must be explicitly defined and admitted.

Callback

The callback mechanism can be used for every connection to obtain additional security re-
garding the connection partner or to clearly allocate the costs of connections. A connection
is not set up until the calling party has been clearly identified by calling back. Your device
can answer an incoming call with a callback or request a callback from a connection part-
ner. Identification can be based on the calling party number or PAP/CHAP/MS-CHAP au-
thentication. ldentification is made in the former case without call acceptance, as the calling
party number is transferred over the ISDN D-channel, and in the latter case with call ac-
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ceptance.

Connection Idle Timeout

The connection idle timeout is determined in order to clear the connection automatically if it
is not being used, i.e. if data is no longer being sent, to help you save costs.

Block after Connection Failure

You use this function to set up a waiting time for outgoing connection attempts after which
your device's connection attempt is regarded as having failed.

Channel Bundling

Your device supports dynamic and static channel bundling for dialup connections. Only one
B-channel is initially opened when a connection is set up.

Dynamic

Dynamic channel bundling means that your device connects other ISDN B-channels to in-
crease the throughput for connections if this is required, e.g. for large data rates. If the
amount of data traffic drops, the additional B-channels are closed again.

Static

In static channel bundling, you specify right from the start how many B-channels your
device is to use for connections, regardless of the transferred data rate.

Channel bundling can only be used for ISDN connections for a bandwidth increase or as a
backup. If devices from other manufacturers are to be used at the far end, ensure that
these support dynamic channel bundling for a bandwidth increase or as a backup.

15.1.1 PPPoE
In the WAN -> Internet + Dialup -> PPPoE menu, a list of all PPPoE interfaces is shown.

PPP over Ethernet (PPPOE) is the use of the Point-to-Point Protocol (PPP) network pro-
tocol over an Ethernet connection. Today, PPPoE is used for ADSL connections in Ger-
many. In Austria, the Point To Point Tunnelling Protocol (PPTP) was originally used for AD-
SL access. However, PPPoE is now offered here too by some providers.



15.1.1.1 New

Choose the New button to set up new PPPoE interfaces.

bintec R1200 Language English v | View  Stancard ~| | Online Help | Logout

PPPoE PPTP ISDN AUX IP Pools

Basic Parameters

Description I
PPFoE Mode @ standard O Multilink
PPPOE Ethernet Interface
User Name I
Passwaord I--“uu
Alwways on [Cenavled
Connection Idle Timeout 300 Seconds
IP Made: and Routes
IP Address Mode Ostatic © Get IP Address
Default Route Enabled
Create NAT Palicy [¥IEnabled
Advanced Settings
Block after connection failure far 60 Seconds
Maximum Number of Dialup Retries 5
Authentication PAP v
DNS Negatiation [¥IEnabled
Prioritize TP ACK Packets CEnabled
LCP Alive Check CJenablea

( oK ) ( Cancel )

Fig. 91: WAN -> Internet + Dialup -> PPPOE -> New
The WAN -> Internet + Dialup -> PPPoE -> New menu consists of the following fields:

Fields in the PPPoE Basic Parameters menu
Field Description

Description Enter a name to uniquely identify the PPPoE partner. The first
character in this field must not be a number and no special
characters or umlauts must be used.

PPPoE Mode Select whether you want to use a standard Internet connection
over PPPoE ( standard) or your Internet access is to be set
up over several interfaces ( Multilink). If you choose Mul-
tilink, you can connect several DSL connections from a pro-
vider over PPP as a static bundle in order to obtain more band-
width. Each of these DSL connections should use a separate

R1xxx/R3xxx/R4xxx
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EEC ==

PPPoE Ethernet Inter-
face

PPPoE Interfaces for
Multilink

User Name
Password

Always on

Connection Idle Timeout

Ethernet connection for this. At the moment, many providers are
still in the process of preparing the PPPoE Multilink function.

For PPPoE Multilink, we recommend using your device's Ether-
net switch in Split-Port mode and to use a separate Ethernet in-
terface e.g. en1-1, en1-2 for each PPPoE connection.

If you also want to use an external modem for PPPoE Multilink,
you must run your device's Ethernet switch in Split-Port mode.

Only if PPPoE Mode = Standard

Select the Ethernet interface specified for a standard PPPoE
connection.

If you want to use an external DSL modem, select the Ethernet
port to which the modem is connected.

When using the internal DSL modem, select here the EthoA in-
terface configured in Physical Interfaces -> ATM-> Profiles ->
New.

The default value is Not specified.

Only if PPPoE Mode = Multilink

Select the interfaces you want to use for your Internet connec-
tion. Click the Add button to create new entries.

Enter the user name.
Enter the password.

Select whether the interface should always be activated.
The function is activated with Enabled.
The function is disabled by default.

Only activate this option if you have Internet access with a flat-
rate charge.

Only if Always on is disabled.

Enter the idle time in seconds for static short hold. The static
short hold setting determines how many seconds should pass
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between sending the last traffic data packet and clearing the
connection.

Possible values are 0to 3600 (seconds). 0 deactivates the
short hold.

The default value is 300.

Example: 10 for FTP transmission, 20 for LAN-to-LAN transmis-
sion, 90 for Internet connections.

Fields in the PPPoE IP Mode and Routes menu
Field Description

IP Address Mode Select whether your device is to be assigned a static IP address
or whether it should be assigned this dynamically.

Possible values:

®* Get IP Address (default value): Your device is dynamic-
ally assigned an IP address.

e Static: You enter a static IP address.

Default Route Select whether the route to this connection partner is to be
defined as the default route.

The function is activated with Enabled.

The function is enabled by default.

Create NAT Policy Specify whether Network Address Translation (NAT) is to be ac-
tivated.

The function is activated with Enabled.

The function is enabled by default.

Local IP Address Only if IP Address Mode = Static

Enter the static IP address of the connection partner.

Route Entries Only if IP Address Mode = Static

Define other routing entries for this connection partner.
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Add a new entry with Add.
e Remote IP Address: |P address of the destination host or
network.

* Netmask: Netmask of Remote IP Address. If no entry is
made, your device uses a default netmask.

* Metric: The lower the value, the higher the priority of the
route (possible values 0... 15). The default value is 1.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu
N =

Block after connection Enter the wait time in seconds before the device should try
failure for again after an attempt to set up a connection has failed. The de-
fault value is 60.

Maximum Number of Di- Enter the number of unsuccessful attempts to setup a connec-
alup Retries tion before the interface is blocked.

Possible values are 0to 100.

The default value is 5.

Authentication Select the authentication protocol for this connection partner.
Select the authentication specified by your provider.

Possible values:
e pAP (default value) Only run pPAP (PPP Password Authentica-
tion Protocol); the password is transferred unencrypted.

e CHAP: Only run cHAP (PPP Challenge Handshake Authentic-
ation Protocol as per RFC 1994); the password is transferred
encrypted.

e PAP/CHAP: Primarily run CHAP, otherwise PAP.

* MS-CHAPv1: Only run MS-CHAP version 1 (PPP Microsoft
Challenge Handshake Authentication Protocol).

* PAP/CHAP/MS-CHAP: Primarily run CHAP, on denial then
the authentication protocol required by the connection partner.
(MSCHAP version 1 or 2 possible.)

* MS-CHAPv2: Run MS-CHAP version 2 only.
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DNS Negotiation

Prioritize TCP ACK

Packets

LCP Alive Check

15.1.2 PPTP

* None: some providers do no use authentication. For these se-
lect this option.

Select whether your device receives IP addresses for primary
DNS server and secondary DNS server from the connection
partner or sends these to the connection partner.

The function is activated with Enabled.

The function is enabled by default.

Select whether the TCP download is to be optimised in the
event of intensive TCP upload. This function can be specially
applied for asymmetrical bandwidths (ADSL).

The function is activated with Enabled.

The function is disabled by default.

Check whether the reachability of the remote terminal is to be
checked by sending LCP echo requests or replies. This makes
it possible to switch to a backup connection more quickly in the
event of line faults.

The function is activated with Enabled.

The function is disabled by default.

In the WAN -> Internet + Dialup -> PPTP menu, a list of all PPTP interfaces is shown.

In this menu, you configure an Internet connection that uses the Point Tunnelling Protocol
(PPTP) to set up a connection, e.g. required in Austria.

15.1.2.1 New

Choose the New button to set up new PPTP interfaces.

15 WAN
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Clenablea
Static

10.0.0.140
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Fig. 92: WAN -> Internet + Dialup -> PPTP -> New

The WAN -> Internet + Dialup -> PPTP -> New menu consists of the following fields:

Fields in the PPTP Basic Parameters menu

Field Description

Description

PPTP Interface

Enter a name for uniquely identifying the internet connection.

The first character in this field must not be a number and no

special characters or umlauts must be used.

Select the IP interface over which packets are to be transported
to the remote PPTP terminal.

If you want to use an external DSL modem, select the Ethernet
port to which the modem is connected.

When using the internal DSL modem, select here the EthoA in-
terface, e.g. ethoa50-0, configured for this connection in

R1xxx/R3xxx/R4xxx
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User Name

Password

Always on

Connection Idle Timeout

Physical Interfaces -> ATM-> Profiles -> New.

The default value is Not specified.
Enter the user name.
Enter the password.

Select whether the interface should always be activated.
The function is activated with Enabled.
The function is disabled by default.

Only activate this option if you have Internet access with a flat-
rate charge.

Only if Always on is disabled.

Enter the idle interval in seconds. This determines how many
seconds should pass between sending the last traffic data pack-
et and clearing the connection.

Possible values are 0to 3600 (seconds). 0 deactivates the
timeout.

The default value is 300.

Example: 10 for FTP transmission, 20 for LAN-to-LAN transmis-
sion, 90 for Internet connections.

Fields in the PPTP IP Mode and Routes menu

Field Description

IP Address Mode

Default Route

Select whether your device is to be assigned a static IP address
or whether it should be assigned this dynamically.

Possible values:

* Get IP Address (default value): Your device is automatic-
ally assigned a temporarily valid IP address from the provider.

e Static: You enter a static IP address.

Select whether the route to this connection partner is to be
defined as the default route.

15 WAN
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The function is activated with Enabled.

The function is enabled by default.

Create NAT Policy Specify whether Network Address Translation (NAT) is to be ac-
tivated.

The function is activated with Enabled.

The function is enabled by default.

Local IP Address Only for IP Address Mode = Static

Assign an IP address from your LAN to the PPT interface, which
is to be used as your device's internal source address.

Route Entries Only if IP Address Mode = static
Define other routing entries for this PPTP partner.
Add a new entry with Add.

* Remote IP Address: |IP address of the destination host or
destination network.

* Netmask: Netmask of Remote IP Address. If no entry is
made, your device uses a default netmask.

* Metric: The lower the value, the higher the priority of the
route (possible values 0... 15). The default value is 1.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu
I =

Block after connection Enter the wait time in seconds before the device should try
failure for again after an attempt to set up a connection has failed. The de-
fault value is 60.

Maximum Number of Di- Enter the number of unsuccessful attempts to setup a connec-
alup Retries tion before the interface is blocked.

Possible values are 0to 100.

The default value is 5.
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Authentication

DNS Negotiation

Prioritize TCP ACK
Packets

PPTP Address Mode

Select the authentication protocol for this Internet connection.
Select the authentication specified by your provider.

Possible values:
e pAP (default value) Only run pAp (PPP Password Authentica-

tion Protocol); the password is transferred unencrypted.

e CHAP: Only run cHAP (PPP Challenge Handshake Authentic-
ation Protocol as per RFC 1994); the password is transferred
encrypted.

e PAP/CHAP: Primarily run CHAP, otherwise PAP.

* MS-CHAPv1: Only run MS-CHAP version 1 (PPP Microsoft
Challenge Handshake Authentication Protocol).

* PAP/CHAP/MS-CHAP: Run primarily CHAP, if denied then
the authentication protocol required by the PPTP partner
(MSCHAP version 1 or 2 possible).

e MS-CHAPv2: Run MS-CHAP version 2 only.

* None: some providers do no use authentication. For these se-
lect this option.

Select whether your device receives |IP addresses for primary
DNS server and secondary DNS server from the connection
partner or sends these to the connection partner.

The function is activated with Enabled.

The function is enabled by default.

Select whether the TCP download is to be optimised in the
event of intensive TCP upload. This function can be specially
applied for asymmetrical bandwidths (ADSL).

The function is activated with Enabled.

The function is disabled by default.

Displays the address mode. The value cannot be changed.

Possible values:

e Static: The IP address of the Ethernet port selected in
PPTP Interface will be used.

15 WAN



15 WAN Funkwerk Enterprise Communications GmbH

I =

Local PPTP IP Address Assign the PPTP interface an IP address that is used as the
source address.

The default value is 10.0.0.140.

Remote PPTP IP Ad- Enter the IP address of the PPTP partner.

dress
The default value is 10.0.0.138.

LCP Alive Check Check whether the reachability of the remote terminal is to be
checked by sending LCP echo requests or replies. This makes
it possible to switch to a backup connection more quickly in the
event of line faults.

The function is activated with Enabled.

The function is disabled by default.

15.1.3 PPPoA

In the WAN -> Internet + Dialup -> PPPoA menu, a list of all PPPoA interfaces is shown.

In this menu, you configure a xDSL connection used to set up PPPoA connections. With
PPPoA, the connection is configured so that the PPP data flow is transported directly over
an ATM network (RFC 2364). This is required by some providers. Note your provider's spe-
cifications.

When using the internal DSL modem, select here a PPPoA interface must be configured
for this connection in WAN -> ATM -> Profiles -> New with Client Type = 0n demand.

15.1.3.1 New

Choose the New button to set up new PPPoA interfaces.
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Fig. 93: WAN -> Internet + Dialup -> PPPoA -> New

The WAN -> Internet + Dialup -> PPPoA -> New menu consists of the following fields:

Fields in the PPPoA Basic Parameters menu

Field Description

Description

ATM PVC

User Name

Password

Always on

R1xxx/R3xxx/R4xxx

Enter a name for uniquely identifying the connection partner.
The first character in this field must not be a number and no
special characters or umlauts must be used.

Select an ATM profile created in the ATM -> Profiles menu, in-
dicated by the global identifiers VPI and VCI specified by the

provider.

Enter the user name.

Enter the password for the PPPoA connection.

Select whether the interface should always be activated.

The function is activated with Enabled.
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The function is disabled by default.

Only activate this option if you have Internet access with a flat-
rate charge.

Connection Idle Timeout Only if Always on is disabled.

Enter the idle time in seconds for static short hold. The static
short hold setting determines how many seconds should pass
between sending the last traffic data packet and clearing the
connection.

Possible values are 0to 3600 (seconds). 0 deactivates the
short hold.

The default value is 300.

Example: 10 for FTP transmission, 20 for LAN-to-LAN transmis-
sion, 90 for Internet connections.

Fields in the PPPoA IP Mode and Routes menu
Field Description

IP Address Mode Choose whether your device has a static IP address or is as-
signed one dynamically.

Possible values:

* Get IP Address (default value): Your device is dynamic-
ally assigned an IP address.

e Static: You enter a static IP address.

Default Route Select whether the route to this connection partner is to be
defined as the default route.

The function is activated with Enabled.

The function is enabled by default.

Create NAT Policy Specify whether Network Address Translation (NAT) is to be ac-
tivated.

The function is activated with Enabled.

The function is enabled by default.
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Local IP Address Only for IP Address Mode = static

Enter the static IP address you received from your provider.

Route Entries Only if IP Address Mode = Static
Define other routing entries for this connection partner.

Add a new entry with Add.

e Remote IP Address: |P address of the destination host or
LAN.
e Netmask: Netmask of Remote IP Address.

e Metric: The lower the value, the higher the priority of the
route (possible values 0. . . 15). The default value is 1.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu
I =

Block after connection Enter the wait time in seconds before the device should try
failure for again after an attempt to set up a connection has failed. The de-
fault value is 60.

Maximum Number of Di- Enter the number of unsuccessful attempts to setup a connec-
alup Retries tion before the interface is blocked.

Possible values are 0to 100.

The default value is 5.

Authentication Select the authentication protocol for this Internet connection.
Select the authentication specified by your provider.

Possible values:
e pAP (default value) Only run pAp (PPP Password Authentica-

tion Protocol); the password is transferred unencrypted.

e CHAP: Only run cHAP (PPP Challenge Handshake Authentic-
ation Protocol as per RFC 1994); the password is transferred
encrypted.

e pAP/CHAP: Primarily run CHAP, otherwise PAP.
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e MS-CHAPv1: Only run MS-CHAP version 1 (PPP Microsoft
Challenge Handshake Authentication Protocol).

* PAP/CHAP/MS-CHAP: Primarily run CHAP, on denial, the au-
thentication protocol required by the PPTP partner. (MSCHAP
version 1 or 2 possible.)

* MS-CHAPvZ2: Run MS-CHAP version 2 only.

* None: some providers do no use authentication. For these se-
lect this option.

DNS Negotiation Select whether your device receives IP addresses for primary
domain name server and secondary domain name server
from the connection partner or sends these to the connection
partner.

The function is activated with Enabled.

The function is enabled by default.

Prioritize TCP ACK Select whether the TCP download is to be optimised in the
Packets event of intensive TCP upload. This function can be specially
applied for asymmetrical bandwidths (ADSL).

The function is activated with Enabled.

The function is disabled by default.

LCP Alive Check Check whether the reachability of the remote terminal is to be
checked by sending LCP echo requests or replies. This is re-
commended for leased lines, PPTP and L2TP connections.

The function is activated with Enabled.

The function is disabled by default.

15.1.4 ISDN

In the WAN -> Internet + Dialup -> ISDN menu, a list of all ISDN interfaces is shown.

In this menu, you configure the following ISDN connections:

¢ Internet access over ISDN

¢ LAN-to-LAN connection over ISDN



* Remote (Mobile) Dialin

¢ Use of the ISDN Callback function

15.1.4.1 New

Choose the New button to set up new ISDN interfaces.
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Fig. 94: WAN -> Internet + Dialup -> ISDN -> New

The WAN -> Internet + Dialup -> ISDN -> New menu consists of the following fields:

Fields in the ISDN Basic Parameters menu

R 1xxx/B3xxx/R4xxx
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Description

Connector Type

User Name

Remote User (for Dialin
only)

Password

Always on

Connection Idle Timeout

Enter a name for uniquely identifying the connection partner.

The first character in this field must not be a number and no
special characters or umlauts must be used.

Select which layer 1 protocol your device should use.

This setting applies for outgoing connections to the connection
partner and only for incoming connections from the connection
partner if they could be identified on the basis of the calling
party number.

Possible values:
* ISDN 64kbps: For 64-kbps ISDN data connections.
* ISDN 56kbps: For 56-kbps ISDN data connections.

Enter your device code (local PPP user name).

Enter the code of the remote terminal (remote PPP user name).

Enter the password.

Select whether the interface should always be activated.
The function is activated with Enabled.
The function is disabled by default.

Only activate this option if you have Internet access with a flat-
rate charge.

Enter the idle time in seconds for static short hold. The static
short hold setting determines how many seconds should pass
between sending the last traffic data packet and clearing the
connection.

Possible values are -1 to 3600 (seconds). A value of -1 means
that the connection is set up again immediately after disconnec-
tion and 0 deactivates short hold. The default value is 20.

Fields in the ISDN IP Mode and Routes menu
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IP Address Mode Select whether your device is to be assigned a static IP address
or whether it should be assigned this dynamically.

Possible values:

e Static (default value): You enter a static IP address.

* Provide IP Address: Your device dynamically assigns an
IP address to the remote terminal.

* Get IP Address: Your device is dynamically assigned an
IP address.

Default Route Only if IP Address Mode = Static
and Get IP Address

Select whether the route to this connection partner is to be
defined as the default route.

The function is activated with Enabled.

The function is disabled by default.

Create NAT Policy Only if IP Address Mode = Static
and Get IP Address

When you configure an ISDN Internet connection, specify
whether Network Address Translation (NAT) is to be activated.

The function is activated with Enabled.

The function is disabled by default.

Local IP Address Only if IP Address Mode = static

Assign the IP address from your LAN to the ISDN interface
which is to be used as your device's internal source address.

Route Entries Only if IP Address Mode = Static

Define other routing entries for this connection partner.

* Remote IP Address: |IP address of the destination host or
LAN.

e Netmask: Netmask of Remote IP Address.
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* Metric: The lower the value, the higher the priority of the
route (possible values 0. . . 15). The default value is 1.

IP Assignment Pool Only if IP Address Mode = Provide IP Address

Select an IP pool configured in the WAN -> Internet + Dialup -
> IP Pools menu. If an IP pool has not been configured here
yet, the message Not yet defined appears in this field.

The Advanced Settings menu consists of the following fields:
Fields in the Advanced Settings menu

Field Description

Block after connection Enter the wait time in seconds before the device should try
failure for again after an attempt to set up a connection has failed.

The default value is 300.

Maximum Number of Di- Enter the number of unsuccessful attempts to setup a connec-
alup Retries tion before the interface is blocked.

Possible values are 0to 100.

The default value is 5.

Usage Type If necessary, select a special interface use.
Possible values:

* Standard (default value): No special type is selected.

e Dialin only: The interface is used for incoming dialup
connections and callbacks initiated externally.

e Multi-User (Dialin only) : The interface is defined as
multi-user connection partner, i.e. several clients dial in with
the same user name and password.

Authentication Select the authentication protocol for this PPTP partner.
Possible values:

* PAP/CHAP/MS-CHAP (default value): Primarily run CHAP, on
denial, the authentication protocol required by the PPTP part-
ner. (MSCHAP version 1 or 2 possible.)
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Encryption

Callback Mode

e pAP: Only run PAP (PPP Password Authentication Protocol);
the password is transferred unencrypted.

e CHAP: Only run cHAP (PPP Challenge Handshake Authentic-
ation Protocol as per RFC 1994); the password is transferred
encrypted.

e pPAP/CHAP: Primarily run CHAP, otherwise PAP.

e MS-CHAPv1: Only run MS-CHAP version 1 (PPP Microsoft
Challenge Handshake Authentication Protocol).

e MS-CHAPvZ2: Run MS-CHAP version 2 only.

* None: some providers do no use authentication. For these se-
lect this option.

Only if Authentication = MS-CHAPv2

If necessary, select the type of encryption that should be used
for data traffic to the connection partner. This is only possible if
STAC or MS-STAC compression is not activated for the con-
nection. If Encryption is set, the remote terminal must also sup-
port it, otherwise a connection cannot be set up.

Possible values:

* None (default value): MPP encryption is not used.

* Enabled: MPP encryption V2 with 128 bit is used to RFC
3078.

* Windows compatible: MPP encryption V2 with 128 bit is
used as compatible with Microsoft and Cisco.

Select the Callback Mode function.
Possible values:

e None (default value): Your device does not call back.
* Active: Select one of the following options:

® No PPP Negotiation: Your device calls the connection
partner to request a callback.

* windows Client Mode: Your device calls the connection
partner to request a callback via CBCP (Callback Control
Protocol). Needed for Windows clients.

* Passive: Select one of the following options:
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* Enabled: Your device calls back immediately when re-
quested to do so by the connection partner.

e Wwindows Server Mode : Your device calls back after a
period of time proposed by the Microsoft client (NT: 10
seconds, new systems: 12 seconds. It uses the subscriber
number (Entries-> Number (MSN)) with the Mode outgo-
ing or Both that has been entered for the other party. If no
number is entered, the required number can be reported by
the caller in a PPP negotiation. This setting should be
avoided where possible for security reasons. Currently can-
not be avoided for the connection of mobile Microsoft clients
via DCN.

* Delayed, CLID only : Your device calls back after ap-
prox. four seconds if your device is requested to do so by
the connection partner. Only makes sense for CLID.

® Windows Server Mode, Callback optional : Like

Windows Server Mode but with the option of aborting.
This setting should be avoided for security reasons. The Mi-
crosoft client also has the option of aborting callback and
maintaining the initial connection to your device without call-
back. This only applies if no fixed, outgoing number has
been configured for the connection partner. This is done by
pressing CANCEL to close the dialog box that appears.

Fields in the Advanced Settings Bandwidth on Demand Options menu

Field Description

Channel Bundling Select whether channel bundling is to be used for ISDN connec-
tions with the connection partner, and if so, what type.

Your device supports dynamic and static channel bundling for
dialup connections. Only one B-channel is initially opened when
a connection is set up. Dynamic channel bundling means that
your device connects other ISDN B-channels to increase the
throughput for connections if this is required, e.g. for large data
rates. If the amount of data traffic drops, the additional B-
channels are closed again. In static channel bundling, you spe-
cify right from the start how many B-channels your device is to
use, regardless of the transferred data rate.

Possible values:
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* None (default value): No channel bundling, only one B-
channel is ever available for connections.

* Static: Static channel bundling.
* Dynamic : Dynamic channel bundling.

Number of B Channels  Select how many B channels your device should use.

Fields in the Advanced Settings Dial Numbers menu
I =

Entries Displays the numbers of the connection partner.

Add new entries with Add. Edit existing entries with .

Fields in the Dial Number Configuration Entry: <1> menu (only shown for Entries =
Add)

Field 7 Description

Mode Select whether Subscriber Number (MSN) is to be used for in-
coming or outgoing calls or for both. Possible values:
* Both (default value): For incoming and outgoing calls.

* Incoming : For incoming calls, where your connection part-
ner dials in to your device.

* Outgoing : For outgoing calls, where you dial your connec-
tion partner.

The calling party number of the incoming call is compared with
the number entered under Subscriber Number (MSN).

Number Enter the connection partner's number.

Number of Used Ports Select which ISDN interfaces are used.

Fields in the Advanced Settings IP Options menu

Field Description

OSPF Mode Select whether and how routes are propagated via the interface
and/or OSPF protocol packets are sent.

Possible values:

e Passive (default value) OSPF is not activated for this inter-
face, i.e. no routes are propagated or OSPF protocol packets
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Proxy ARP Mode

DNS Negotiation

sent over this interface. Networks reachable over this inter-
face are, however, included when calculating the routing in-
formation and propagated over active interfaces.

o Active: OSPF is activated for this interface, i.e. routes are
propagated or OSPF protocol packets sent over this interface.

¢ Down : OSPF is disabled for this interface.

Select whether and how ARP requests from your own LAN are
to be responded to for the specified connection partner.

Possible values:

* Tnactive (default value): Deactivates Proxy ARP for this
connection partner.

* Up or Dormant: Your device only responds to an ARP re-
quest if the status of the connection to the connection partner
is Up or Dormant. In the case of Dormant, your device only
responds to the ARP request; the connection is not set up un-
til someone actually wants to use the route.

e Active Only: Your device responds to an ARP request only
if the status of the connection to the connection partner is Up
(active), i.e. a connection already exists to the connection
partner.

Select whether your device receives IP addresses for primary
DNS server, secondary DNS server, primary WINS and sec-
ondary WINS from the connection partner or sends these to the
connection partner.

The function is activated with Enabled.

The function is enabled by default.

15.1.5 GPRS/UMTS

Note

Note that the GPRS/UMTS menu is only available if a UMTS modem card is inserted
in the CardBus slot and is integrated in the system! Not all bintec gateways have a
CardBus interface. Refer to the data sheet to determine whether your gateway has this

interface type.



In the WAN -> Internet + Dialup -> GPRS/UMTS menu, a list of all GPRS/UMTS inter-
faces is shown.

Thanks to its CardBus interface (PCCARD), the bintec gateway supports the integration of
a UMTS CardBus modem in the system. This enables you to set up a connection to the In-
ternet over UMTS.

15.1.5.1 New

Choose the New button to set up additional connections.

bintec R1200 Language |English | | iew |Standard ~| | Online Help | Logout
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Fig. 95: WAN -> Internet + Dialup -> GPRS/UMTS -> New

The WAN -> Internet + Dialup -> GPRS/UMTS -> New menu consists of the following
fields:

Fields in the GPRS/UMTS Basic Parameters menu

Field Description

Description Enter a name for uniquely identifying the internet connection.
The first character in this field must not be a number and no
special characters or umlauts must be used.

R1xxx/R3xxx/R4xxx
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Select the GPRS/UMTS interface.
GPRS/UMTS Interface

User Name Enter the user name.
Password Enter the password.
Always on Select whether the interface should always be activated.

The function is activated with Enabled.
The function is disabled by default.

Only activate this option if you have Internet access with a flat-
rate charge.

Connection Idle Timeout Only if Always on is disabled.

Enter the idle time in seconds for static short hold. The static
short hold setting determines how many seconds should pass
between sending the last traffic data packet and clearing the
connection.

Possible values are 0to 3600 (seconds). 0 deactivates the
short hold.

The default value is 300.
Fields in the GPRS/UMTS IP Mode and Routes menu

Field Description

IP Address Mode Select whether your device is to be assigned a static IP address
or whether it should be assigned this dynamically.

Possible values:

* Get IP Address (default value): Your device is dynamic-
ally assigned an |IP address.

e Static: You enter a static IP address.

Default Route Select whether the route to this connection partner is to be
defined as the default route.

The function is activated with Enabled.

The function is enabled by default.
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Create NAT Policy Specify whether Network Address Translation (NAT) is to be ac-
tivated.

The function is activated with Enabled.

The function is enabled by default.

Local IP Address Only if IP Address Mode = static

Enter the static IP address of the connection partner.

Route Entries Only if IP Address Mode = Static
Define other routing entries for this connection partner.
Add a new entry with Add.

* Remote IP Address: |P address of the destination host or
network.

* Netmask: Netmask of Remote IP Address. If no entry is
made, your device uses a default netmask.

* Metric: The lower the value, the higher the priority of the
route (possible values 0... 15). The default value is 1.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu
Field Description

Block after connection Enter the wait time in seconds before the device should try
failure for again after an attempt to set up a connection has failed. The de-
fault value is 60.

Maximum Number of Di- Enter the number of unsuccessful attempts to setup a connec-
alup Retries tion before the interface is blocked.

Possible values are 0to 100.

The default value is 5.

Authentication Select the authentication protocol for this connection partner.
Select the authentication specified by your provider.

Possible values:
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e pAp (default value) Only run PAP (PPP Password Authentica-
tion Protocol); the password is transferred unencrypted.

e CHAP: Only run cHAP (PPP Challenge Handshake Authentic-
ation Protocol as per RFC 1994); the password is transferred
encrypted.

e pPAP/CHAP: Primarily run CHAP, otherwise PAP.

e MS-CHAPv1: Only run MS-CHAP version 1 (PPP Microsoft
Challenge Handshake Authentication Protocol).

* PAP/CHAP/MS-CHAP: Primarily run CHAP, on denial then
the authentication protocol required by the connection partner.
(MSCHAP version 1 or 2 possible.)

* MS-CHAPvZ2: Run MS-CHAP version 2 only.

* None: some providers do no use authentication. For these se-
lect this option.

DNS Negotiation Select whether your device receives IP addresses for primary
DNS server and secondary DNS server from the connection
partner or sends these to the connection partner.

The function is activated with Enabled.

The function is enabled by default.

Prioritize TCP ACK Select whether the TCP download is to be optimised in the
Packets event of intensive TCP upload. This function can be specially
applied for asymmetrical bandwidths (ADSL).

The function is activated with Enabled.

The function is disabled by default.

LCP Alive Check Check whether the reachability of the remote terminal is to be
checked by sending LCP echo requests or replies. This makes
it possible to switch to a backup connection more quickly in the
event of line faults.

The function is activated with Enabled.

The function is disabled by default.



15.1.6 AUX

In the WAN -> Internet + Dialup -> AUX menu, a list of all AUX interfaces is shown.

You can define various settings for communication between the gateway and modem in
this menu. You require a special cable for the console port of your gateway (e.g. AUX
Backup cable) to connect an external analogue modem to the AUX port on a bintec gate-
way.

15.1.6.1 New

Choose the New button to set up new AUX interfaces.
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Fig. 96: WAN -> Internet + Dialup -> AUX -> New

The WAN -> Internet + Dialup -> AUX -> New menu consists of the following fields:

Fields in the AUX Basic Parameters menu

R1xxx/R3xxx/R4xxx
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Description Enter a name for uniquely identifying the WAN partner. The first
character in this field must not be a number and no special
characters or umlauts must be used.

User Name Enter the user name.
Password Enter the password.
Always on Select whether the interface should always be activated.

The function is activated with Enabled.
The function is disabled by default.

Only activate this option if you have Internet access with a flat-
rate charge.

Connection Idle Timeout Only if Always on is disabled.

Enter the idle time in seconds for static short hold. The static
short hold setting determines how many seconds should pass
between sending the last traffic data packet and clearing the
connection.

Possible values are 0to 3600 (seconds). 0 deactivates the
short hold.

The default value is 600.
Fields in the AUX IP Mode and Routes menu

Field Description

IP Address Mode Select whether your device is to be assigned a static IP address
or whether it should be assigned this dynamically.

Possible values:

* Get IP Address (default value): Your device is dynamic-
ally assigned an |IP address.

e Static: You enter a static IP address.

* Provide IP Address: Your device dynamically assigns an
IP address to the remote terminal.

Default Route Select whether the route to this connection partner is to be
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defined as the default route.
The function is activated with Enabled.

The function is enabled by default.

Create NAT Policy Specify whether Network Address Translation (NAT) is to be ac-
tivated.

The function is activated with Enabled.

The function is enabled by default.

Local IP Address Only if IP Address Mode = Static

Enter the static IP address of the connection partner.

Route Entries Only if IP Address Mode = Static
Define other routing entries for this connection partner.

Add a new entry with Add.
e Remote IP Address: |P address of the destination host or
network.

e Netmask: Netmask of Remote IP Address. If no entry is
made, your device uses a default netmask.

* Metric: The lower the value, the higher the priority of the
route (possible values 0... 15). The default value is 1.

IP Assignment Pool Only if IP Address Mode = Provide IP Address

Select an IP pool configured in the WAN -> Internet + Dialup -
> IP Pools menu. If an IP pool has not been configured here
yet, the message Not yet defined appears in this field.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu
Field Description

Block after connection Enter the wait time in seconds before the device should try
failure for again after an attempt to set up a connection has failed.

The default value is 50.
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Maximum Number of Di- Enter the number of unsuccessful attempts to setup a connec-

alup Retries

Usage Type

Authentication

DNS Negotiation

tion before the interface is blocked.
Possible values are 0to 100.

The default value is 5.

If necessary, select a special interface use.

Possible values:

e Standard (default value): No special type is selected.

* Dialin only: The interface is used for incoming dialup
connections and callbacks initiated externally.

e Multi-User (Dialin only) : The interface is defined as
multi-user connection partner, i.e. several clients dial in with
the same user name and password.

Select the authentication protocol for this PPTP partner.
Possible values:

* PAP/CHAP/MS-CHAP: Primarily run CHAP, on denial, the au-
thentication protocol required by the PPTP partner. (MSCHAP
version 1 or 2 possible.)

e pAP: Only PAP (default value): (PPP Password Authentica-
tion Protocol); the password is transferred in unencrypted
form.

e CHAP: Only run cHAP (PPP Challenge Handshake Authentic-
ation Protocol as per RFC 1994); the password is transferred
encrypted.

e pAP/CHAP: Primarily run CHAP, otherwise PAP.

* MS-CHAPv1: Only run MS-CHAP version 1 (PPP Microsoft
Challenge Handshake Authentication Protocol).

* MS-CHAPv2: Run MS-CHAP version 2 only.

* None: some providers do no use authentication. For these se-
lect this option.

Select whether your device receives IP addresses for primary
DNS server and secondary DNS server from the connection
partner or sends these to the connection partner.
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Prioritize TCP ACK
Packets

LCP Alive Check

Callback Mode

The function is activated with Enabled.

The function is enabled by default.

Select whether the TCP download is to be optimised in the
event of intensive TCP upload. This function can be specially
applied for asymmetrical bandwidths (ADSL).

The function is activated with Enabled.

The function is disabled by default.

Check whether the reachability of the remote terminal is to be
checked by sending LCP echo requests or replies. This makes
it possible to switch to a backup connection more quickly in the
event of line faults.

The function is activated with Enabled.

The function is disabled by default.

Select the Callback Mode function.

Possible values:

* None (default value): Your device does not call back.
* Active: Select one of the following options:

®* No PPP Negotiation: Your device calls the connection
partner to request a callback.

e windows Client Mode: Your device calls the connection
partner to request a callback via CBCP (Callback Control
Protocol). Needed for Windows clients.

* Passive: Select one of the following options:

® PPP Negotiation or CLID: Your device calls back im-
mediately when requested to do so by the connection part-
ner.

e Wwindows Server Mode : Your device calls back after a
period of time proposed by the Microsoft client (NT: 10
seconds, new systems: 12 seconds. It uses the subscriber
number (Entries-> Number (MSN)) with the Mode outgo-
ing or Both that has been entered for the other party. If no
number is entered, the required number can be reported by
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the caller in a PPP negotiation. This setting should be
avoided where possible for security reasons. Currently can-
not be avoided for the connection of mobile Microsoft clients
via DCN.

* Delayed, CLID only : Your device calls back after ap-
prox. four seconds if your device is requested to do so by
the connection partner. Only makes sense for CLID.

® Windows Server Mode, Callback optional : Like
Windows Server Mode but with the option of aborting.
This setting should be avoided for security reasons. The Mi-
crosoft client also has the option of aborting callback and
maintaining the initial connection to your device without call-
back. This only applies if no fixed, outgoing number has
been configured for the connection partner. This is done by
pressing CANCEL to close the dialog box that appears.

Fields in the Advanced Settings Dial Numbers menu

Field Description

Entries Add new entries with Add.

Fields in the Dial Number Configuration Entry: <1> menu (only shown for Entries =
Add)

Field Description

Mode Only if Entries = Add.

Select whether Subscriber Number (MSN) is to be used for in-
coming or outgoing calls or for both. Possible values:
* Both (default value): For incoming and outgoing calls.

* Tncoming : For incoming calls, where your connection part-
ner dials in to your device.

* Outgoing : For outgoing calls, where you dial your connec-
tion partner.
The calling party number of the incoming call is compared with
the number entered under Subscriber Number (MSN).
Subscriber Number Enter the connection partner's numbers.

Port Usage Select which port is used.
Fields in the Advanced Settings IP Options menu
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Proxy ARP Mode Select whether and how ARP requests from your own LAN are
to be responded to for the specified connection partner.

Possible values:

* Tnactive (default value): Deactivates Proxy ARP for this
connection partner.

* Up or Dormant: Your device only responds to an ARP re-
quest if the status of the connection to the connection partner
is Up or Dormant. In the case of Dormant, your device only
responds to the ARP request; the connection is not set up un-
til someone actually wants to use the route.

* Up only: Your device responds to an ARP request only if the
status of the connection to the connection partner is Up
(active), i.e. a connection already exists to the connection
partner.

15.1.7 IP Pools

In the IP Pools menu a list of all IP pools is displayed.

Your device can operate as a dynamic IP address server for PPP connections. You can
use this function by providing one or more pools of IP addresses. These IP addresses can
be assigned to dialling-in connection partners for the duration of the connection.

Any host routes entered always have priority over IP addresses from the address pools.
This means if an incoming call has been authenticated, your device first checks whether a
host route is entered in the routing table for this caller. If not, your device can allocate an IP
address from an address pool (if available). If address pools have more than one IP ad-
dress, you cannot specify which connection partner receives which address. The ad-
dresses are initially assigned in order. If a new dial-in takes place within an interval of one
hour, an attempt is made to allocate the same IP address assigned to this partner the last
time.

Use the Add button to set up new IP pools.
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Fig. 97: WAN -> Internet + Dialup -> IP Pools -> Add

The WAN -> Internet + Dialup -> IP Pools -> Add menu consists of the following fields:

Fields in the Options IP Pools menu

Field Description
IP Pool Name Enter the name of the IP pool.
IP Pool Range In the first field, enter the first IP address of the range.

In the second field, enter the last IP address of the range.

15.2 ATM

15.2.1 Profiles

In the WAN -> ATM -> Profiles menu, a list of all ATM profiles is shown.

If the connection for your Internet access is set up using the internal modem, the ATM con-
nection parameters must be set for this.

By default an ATM profile with the description AUTO-CREATED is preconfigured. Its values
(VPI 1 and VCI 32) are suitable for a Telekom ATM connection, for example.

R1xxx/R3xxx/R4xxx



&1 Note

The ATM encapsulations are described in RFCs 1483 and 2684. You will find the
RFCs on the relevant pages of the IETF (www.ietf.org/rfc.html).

15.2.1.1 New

Choose the New button to set up new ATM profiles.
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Ethernet over ATM Settings
Default Ethernet for PPPoE Interfaces ClEnabled

Address Mode @ static OpHeP

‘ P Address Metmask
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( OK ) ( Cancel )
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Fig. 98: WAN -> ATM -> Profiles -> New
The WAN -> ATM -> Profiles -> New menu consists of the following fields:

Fields in the Profiles ATM Profiles Parameter menu

Field Description

Provider Select one of the preconfigured ATM profiles for your provider
from the list or manually define the profile using - User-
Specified -.

Description Only for Provider = - User-defined -
Enter the desired description for the connection.

Type Only for Provider = - User-defined -

R1xxx/R3xxx/R4xxx
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Virtual Path Identifier
(VPI)

Virtual Channel Identifier
(VCI)

Encapsulation

Select the protocol for the ATM connection.

Possible values:

* Ethernet over ATM (default value): Ethernet over ATM
(EthoA) is used for the ATM connection (Permanent Virtual
Circuit, PVC).

* Routed Protocols over ATM: Routed Protocols over
ATM (RPoA) is used for the ATM connection (Permanent Vir-
tual Circuit, PVC).

e PPP over ATM: PPP over ATM (PPPoA) is used for the ATM
connection (Permanent Virtual Circuit, PVC).

Only for Provider = - User-defined -

Enter the VPI value of the ATM connection. The VPI is the iden-
tification number of the virtual path to be used. Note your pro-
vider's instructions.

Possible values are 0to 255.

The default value is 8.

Only for Provider = - User-defined -

Enter the VCI value of the ATM connection. The VCl is the iden-
tification number of the virtual channel. A virtual channel is the
logical connection for the transport of ATM cells between two or
more points. Note your provider's instructions.

Possible values are 32to 65535.

The default value is 32.

Only for Provider = - User-defined -

Select the encapsulation to be used. Note your provider's in-
structions.

Possible values (in accordance with RFC 2684):

* LILC Bridged no FCS (default value for Ethernet over
ATM): Only shown for Type = Ethernet over ATM.

Bridged Ethernet with LLC/SNAP encapsulation without
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Frame Check Sequence (checksums).

* LILC Bridged FCS:Only shown for Type = Ethernet
over ATM.
Bridged Ethernet with LLC/SNAP encapsulation with Frame
Check Sequence (checksums).

* non ISO (default value for Routed Protocols over ATM):
Only shown for Type = Routed Protocols over ATM.
Encapsulation with LLC/SNAP header, suitable for IP routing.

e L1.C: Only shown for Type = PPP over ATM.

Encapsulation with LLC header.

* VC Multiplexing (default value for PPP over ATM):
Bridged Ethernet without additional encapsulation (Null En-
capsulation) with Frame Check Sequence (checksums).

Fields in the Settings for Ethernet over ATM menu (only shown for Type = Ethernet

over ATM)

I

Default Ethernet for
PPPoE Interfaces

Address Mode

IP Address/Netmask

Only for Type = Ethernet over ATM

Select whether this Ethernet-over-ATM interface is to be used
for all PPPoE connections

The function is activated with Enabled.

The function is disabled by default.

Only for Type = Ethernet over ATM
Select how an IP address is to be assigned to the interface.
Possible values:

e Static (default value): A static IP address is assigned to the
interface in IP Address/Netmask.

* DHCP: An IP address is assigned to the interface dynamically
via DHCP.

Only if Address Mode = Static

15 WAN
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Enter the IP addresses (IP Address) and the corresponding
netmasks (Netmask) of the ATM interfaces. Add new entries
with Add.

MAC Address Enter a MAC address for the internal router interface of ATM
connection, e.g. 00:a0:£9:06:bf:03. An entry is only re-
quired in special cases.

For Internet connections, it is sufficient to select the Use Pre-
configured option (default setting), in which case the MAC ad-
dress of en1-0 is used.

DHCP MAC Address Only if Address Mode = DHCP

Enter the MAC address of the internal router interface of ATM
connection, e.g. 00:e1:£9:06:bf:03.

If your provider has assigned you an MAC address for DHCP,
enter this here.

You can select the Use Pre-configured option (default setting),
in which case the MAC address of en1-0 is used.

DHCP Hostname Only if Address Mode = DHCP

If necessary, enter the host name registered with the provider to
be used by your device for DHCP requests.

The maximum length of the entry is 45 characters.

Fields in the Settings for Routed Protocols over ATM menu (only shown for Type =
Routed Protocols over ATM)

Field 7 Description

IP Address/Netmask Enter the IP addresses (IP Address) and the corresponding
netmasks (Netmask) of the ATM interface. Add new entries

with Add.
Prioritize TCP ACK Select whether the TCP download is to be optimised in the
Packets event of intensive TCP upload. This function can be specially

applied for asymmetrical bandwidths (ADSL).

The function is activated with Enabled.
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The function is disabled by default.

Fields in the PPP over ATM Settings menu (only shown for Type = PPP over ATM),

see also 7
Field Description
Client Type Select whether the PPPoA connection is to be set up perman-

ently or on demand.

Possible values:

* On demand (default value): The PPPoA is only set up on de-
mand, e.g. for Internet access.

15.2.2 Service Categories

In the WAN -> ATM -> Service Categories menu, a list of ATM connections (PVC, Per-
manent Virtual Circuit) already configured with specific assigned data traffic parameters is
shown.

Your device supports QoS (Quality of Service) for ATM interfaces.

f Caution
ATM QoS should only be used if your provider specifies a list of data traffic parameters
(traffic contract).

The configuration of ATM QoS requires extensive knowledge of ATM technology and
the way the bintec devices function. An incorrect configuration can cause consider-
able disruption during operation. If applicable, save the original configuration on your
PC.

15.2.2.1 New

Choose the New button to set up new categories.
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Fig. 99: WAN -> ATM -> Service Categories -> New
The WAN -> ATM -> Service Categories -> New menu consists of the following fields:

Fields in the Service Categories Basic Parameters menu

[ ==

Virtual Channel Connec- Select the already configured ATM connection (displayed by the
tion (VCC) combination of VPI and VCI) for which the service category is to
be defined.

ATM Service Category  Select how the data traffic of the ATM connection is to be con-
trolled.

When you select the ATM service category a priority is implicitly
assigned: from CBR
(highest priority) through VBR.1 /VBR.3 to VBR (lowest priority).

Possible settings:

* Unspecified Bit Rate (UBR) (defaultvalue):
(Unspecified Bit Rate) A particular data rate is not guaranteed
for the connection. The Peak Cell Rate (PCR) defines the lim-
it above which data is discarded. This category is suitable for
non-critical applications.

* Constant Bit Rate (CBR) :(Constant Bit Rate) The con-
nection is assigned a guaranteed data rate determined by the
Peak Cell Rate (PCR) . This category is suitable for critical
(real-time) applications that require a guaranteed data rate.
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Peak Cell Rate (PCR)

Sustained Cell Rate
(SCR)

Maximum Burst Size
(MBS)

®* Variable Bit Rate V.1 (VBR.1) :(Variable Bit Rate)
The connection is assigned a guaranteed data rate (Sus-
tained Cell Rate (SCR)). This may be exceeded by the
volume configured in Maximum Burst Size. Any additional
ATM traffic is discarded. The Peak Cell Rate (PCR) repres-
ents the maximum possible data rate. This category is suit-
able for non-critical applications with burst data traffic.

®* Variable Bit Rate V.3 (VBR.3) :(Variable Bit Rate)
The connection is assigned a guaranteed data rate (Sus-
tained Cell Rate (SCR)). This may be exceeded by the
volume configured in Maximum Burst Size (MBS). Additional
ATM traffic is marked and handled with low priority based on
the utilisation of the destination network, i.e. is discarded if ne-
cessary. The Peak Cell Rate (PCR) represents the maximum
possible data rate. This category is suitable for critical applica-
tions with burst data traffic.

Enter a value for the maximum data rate in bits per second.
Possible values: 0to 10000000.

The default value is 0.

Only for ATM Service Category = Variable Bit Rate V.1
(VBR.1) Or Variable Bit Rate V.3 (VBR.3)

Enter a value for the minimum available, guaranteed data rate
in bits per second.

Possible values: 0to 10000000.

The default value is 0.

Only for ATM Service Category = Variable Bit Rate V.1
(VBR.1) Or Variable Bit Rate V.3 (VBR.3)

Enter a value for the maximum number of bits per second by
which the PCR can be exceeded briefly.

Possible values: 0to 100000.

The default value is 0.

15 WAN



15 WAN Funkwerk Enterprise Communications GmbH

15.2.3 OAM Controlling

OAM is a service for monitoring ATM connections. A total of five hierarchies (flow level F1
to F5) are defined for OAM information flow. The most important information flows for an
ATM connection are F4 and F5. The F4 information flow concerns the virtual path (VP) and
the F5 information flow the virtual channel (VC). The VP is defined by the VPI value, the
VC by VPI and VCI.

@ Note

Generally, monitoring is not carried out by the terminal but is initiated by the ISP. Your
device then only needs to react correctly to the signals received. This is ensured
without a specific OAM configuration for both flow level 4 and flow level 5.

Two mechanisms are available for monitoring the ATM connection: Loopback Tests and
OAM Continuity Check (OAM CC). These can be configured independently of each other.

f Caution

The configuration of OAM requires extensive knowledge of ATM technology and the
way the bintec devices functions. An incorrect configuration can cause considerable
disruption during operation. If applicable, save the original configuration on your PC.

In the WAN -> ATM -> OAM Control menu, a list of all monitored OAM flow levels is
shown.

15.2.3.1 New

Choose the New button to set up monitoring for other flow levels.
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Fig. 100: WAN -> ATM -> OAM Control -> New
The WAN -> ATM -> OAM Control -> New menu consists of the following fields:

Fields in the OAM Control OAM Flow Configuration
Field Description

OAM Flow Level Select the OAM flow level to be monitored.

Possible values:

e F5: (virtual channel level) The OAM settings are used for the
virtual channel (default value).

e 4 : (virtual path level) The OAM settings are used for the vir-
tual path.

Virtual Channel Connec- Only for OAM Flow Level = F5

tion (VCC)
Select the already configured ATM connection to be monitored

(displayed by the combination of VPI and VCI).

Virtual Path Connection
(VPC)

Only for OAM Flow Level = 4

Select the already configured virtual path connection to be mon-
itored (displayed by the VPI).

Fields in the OAM Control Loopback
Field Description

Loopback End-to-End Select whether you activate the loopback test for the connection

15 WAN
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End-to-End Send Inter-
val

End-to-End Pending Re-
quests

Loopback Segment

Segment Send Interval

Segment Pending Re-
quests

between the endpoints of the VCC or VPC.
The function is activated with Enabled.

The function is disabled by default.

Only if Loopback End-to-End is enabled.

Enter the time in seconds after which a loopback cell is to be
sent.

Possible values are 0to 999.

The default value is 5.

Only if Loopback End-to-End is enabled.

Enter the number of directly consecutive loopback cells that
may fail to materialise before the connection is regarded as in-
terrupted ("down"). Possible values are 1 to 99.

The default value is 5.

Select whether you want to activate the loopback test for the
segment connection (segment = connection of the local end-
point to the next connection point) of the VCC or VPC.

The function is activated with Enabled.

The function is disabled by default.

Only if Loopback Segment is enabled.
Enter the time in seconds after which a loopback cell is sent.
Possible values are 0to 999.

The default value is 5.

Only if Loopback Segment is enabled.

Enter the number of directly consecutive loopback cells that
may fail to materialise before the connection is regarded as in-
terrupted ("down").

Possible values are 1to 99.
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The default value is 5.

Fields in the OAM Control CC Activation
Field  Descripton |

Continuity Check (CC)  Select whether you activate the OAM-CC test for the connection
End-to-End between the endpoints of the VCC or VPC.

Possible values:
e Passive (default value) OAM CC requests are responded to

after CC negotiation (CC activation negotiation).

» Active: OAM CC requests are sent after CC negotiation (CC
activation negotiation).

e Both: OAM CC requests are sent and answered after CC ne-
gotiation (CC activation negotiation).

* No negotiation: Depending on the setting in the Direction
field, OAM CC requests are either sent and/or responded to.
There is no CC negotiation.

* None: The function is disabled.

Also select whether the test cells of the OAM CC are to be sent
or received.

Possible values:

* Both (default value): CC data is both received and generated.
* Destination: CC data is received.

* Source: CC data is generated.

Continuity Check (CC)  Select whether you want to activate the OAM-CC test for the
Segment segment connection (segment = connection of the local end-
point to the next connection point) of the VCC or VPC.

Possible values:
e Passive (default value) OAM CC requests are responded to
after CC negotiation (CC activation negotiation).

» Active: OAM CC requests are sent after CC negotiation (CC
activation negotiation).

e Both: OAM CC requests are sent and answered after CC ne-
gotiation (CC activation negotiation).



15 WAN

Funkwerk Enterprise Communications GmbH

I =

* No negotiation: Depending on the setting in the Direction
field, OAM CC requests are either sent and/or responded to.
There is no CC negotiation.

e None: The function is disabled.

Also select whether the test cells of the OAM CC are to be sent
or received.

Possible settings:

e Both (default value): CC data is both received and generated.
e Destination: CC data is received.

* Source: CC data is generated.

15.3 Leased Line

A leased line is a permanent (fixed) connection between two communication partners via a
telecommunications network. Unlike a switched line, the entire transmission channels is al-
ways available. The leased line cannot be set up by the subscriber by dialling and therefore
has no call number. The connection must be set up by the network operator.



15.3.1 Interfaces

In the WAN -> Leased Line -> Interfaces menu, a list of all automatically generated
leased line connections is shown. Automatic generation requires the corresponding ISDN

interface to be configured.
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Fig. 101: WAN -> Leased Line -> Interfaces
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15.3.1.1 Edit

Choose the [i] button to edit the configuration of the corresponding leased line.
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Fig. 102: WAN -> Leased Line -> Interfaces -> Autogenerated from BRI (ISDN-S0) ->

The WAN -> Leased Line -> Interfaces -> Autogenerated from BRI (ISDN-S0) ->
menu consists of the following fields:

Fields in the Leased Line Basic Parameters menu

.

Description Enter the desired description for the connection.

Fields in the Interfaces IP Mode and Routes menu
Field Description

Default Route Select whether the route to this connection partner is to be
defined as the default route.

The function is activated with Enabled.

The function is disabled by default.

Local IP Address Enter the IP address you received from your network operator.
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Route Entries

Define other routing entries for this connection class.

Add a new entry with Add.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu

R T

LCP Alive Check

Prioritize TCP ACK
Packets

Compression

Select whether the availability of the remote terminal is to be
checked.

The function is activated with Enabled.

The function is disabled by default.
Select whether the TCP download is to be optimised in the
event of intensive TCP upload.

The function is activated with Enabled.

The function is disabled by default.

If necessary, select the type of encryption that should be used
for data traffic to the connection partner. If encryption is set, the
remote terminal must also support it, otherwise a connection
cannot be set up.

Possible values:

* None (default value): Encryption is not used.
e STAC
* MS-STAC

e MPPC: Microsoft Point-to-Point Compression

Fields in the Advanced Settings IP Options menu

e T

OSPF Mode

Specify whether OSPF protocol packets are sent over the inter-
face.

Possible values:

e Passive (default value) OSPF is not activated for this inter-
face, i.e. no OSPF protocol packets sent over this interface.

15 WAN
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Proxy ARP Mode

Networks reachable over this interface are, however, included

when calculating the routing information and propagated over

active interfaces.

Active: OSPF is not activated for this interface, i.e. OSPF
protocol packets sent over this interface.

Inactive : OSPF is disabled for this interface.

Select whether and how ARP requests are to be responded to
for the specified connection partner.

Possible values:

Inactive (default value): Deactivates Proxy ARP for this
connection partner.

Up or Dormant: Your device only responds to an ARP re-
quest if the status of the connection to the connection partner
is Up or Dormant. In the case of Dormant, your device only
responds to the ARP request; the connection is not set up un-
til someone actually wants to use the route.

Up only: Your device responds to an ARP request only if the
status of the connection to the connection partner is Up
(active), i.e. a connection already exists to the connection
partner.

Choose the button to edit the configuration of the corresponding leased line for a PRI

interface.
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Fig. 103: WAN -> Leased Line -> Interfaces -> Autogenerated from PRI (ISDN-S2IM) ->

The WAN -> Leased Line -> Interfaces -> Autogenerated from PRI (ISDN-S2M) ->

menu consists of the following fields:

Fields in the Interfaces Basic Parameters menu

Field Description

Enter the desired description for the connection.

Description

Fields in the Interfaces IP Mode and Routes menu

T ==

Default Route

Local IP Address

Route Entries

Select whether the route to this connection partner is to be
defined as the default route.

The function is activated with Enabled.

The function is disabled by default.

Enter the IP address you received from your network operator.

Define other routing entries for this connection class.

Add a new entry with Add.

The Advanced Settings menu consists of the following fields:

15 WAN
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Fields in the Advanced Settings menu

R T

LCP Alive Check
Select whether the availability of the remote terminal is to be

checked.
The function is activated with Enabled.

The function is disabled by default.
Prioritize TCP ACK Select whether the TCP download is to be optimised in the
Packets event of intensive TCP upload.

The function is activated with Enabled.

The function is disabled by default.

Compression
If necessary, select the type of encryption that should be used

for data traffic to the connection partner. If encryption is set, the
remote terminal must also support it, otherwise a connection
cannot be set up.

Possible values:

* None (default value): Encryption is not used.
e STAC
* MS-STAC

e MPPC: Microsoft Point-to-Point Compression

Fields in the Advanced Settings IP Options menu

e T

OSPF Mode
Specify whether OSPF protocol packets are sent over the inter-

face.
Possible values:

e Passive (default value) OSPF is not activated for this inter-
face, i.e. no OSPF protocol packets sent over this interface.
Networks reachable over this interface are, however, included
when calculating the routing information and propagated over
active interfaces.

e Active: OSPF is not activated for this interface, i.e. OSPF
protocol packets sent over this interface.

e DInactive : OSPF is disabled for this interface.
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Proxy ARP Mode

Select whether and how ARP requests are to be responded to
for the specified connection partner.

Possible values:

Inactive (default value): Deactivates Proxy ARP for this
connection partner.

Up or Dormant: Your device only responds to an ARP re-
quest if the status of the connection to the connection partner
is Up or Dormant. In the case of Dormant, your device only
responds to the ARP request; the connection is not set up un-
til someone actually wants to use the route.

Up only: Your device responds to an ARP request only if the

status of the connection to the connection partner is Up
(active), i.e. a connection already exists to the connection

partner.

Choose the [i] button to edit the configuration of the corresponding leased line for a serial

interface.

Save configuration
Assistants -
System Management -
Physical Interfaces -
LAN -
Rowting -
WAN -

Internet + Dialup

Leased Line
Real Time Jitter Control

VPN -
Firewall -
VolP -
Local Services -
Maintenance -
External Reporting -

Monitoring -

e
-

pE-T

Language | English v
1 w wr

Basic: Paramsters
Description
IP Mode and Routes:

Default Route

Local IP Address

Route Entries

LCF Alive Check

Prioritize TP ACK Packets
IP Options

O5PF Mode

Froxy ARP Mode

Wiew | Standard v

Online Help | Logout fllnhvnrk@

Interfaces

[si¢-0

Clenabted

—

Remote IP Address Netmask Metric
I I 1
Add

Advanced Settings
CEnabled
ClEenabled
@passive U Active O Inactive

® Inactive OUp or Dormant OUp only

oK Cancel

Fig. 104: WAN -> Leased Line -> Interfaces -> Autogenerated from Serial ->

The WAN -> Leased Line -> Interfaces -> Autogenerated from Serial ->[i&| menu con-
sists of the following fields:

15 WAN
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Fields in the Interfaces Basic Parameters menu

T =

Description Enter the desired description for the connection.

Fields in the Interfaces IP Mode and Routes menu
Field Description

Default Route Select whether the route to this connection partner is to be
defined as the default route.

The function is activated with Enabled.

The function is disabled by default.
Local IP Address Enter the IP address you received from your network operator.

Route Entries
Define other routing entries for this connection class.

Add a new entry with Add.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu

I =

LCP Alive Check
Select whether the availability of the remote terminal is to be

checked.
The function is activated with Enabled.

The function is disabled by default.
Prioritize TCP ACK Select whether the TCP download is to be optimised in the
Packets event of intensive TCP upload.

The function is activated with Enabled.

The function is disabled by default.

Compression
If necessary, select the type of encryption that should be used
for data traffic to the connection partner. If encryption is set, the
remote terminal must also support it, otherwise a connection
cannot be set up.

Possible values:

* None (default value): Encryption is not used.
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SNSIEAC
® MS-STAC

e MPPC: Microsoft Point-to-Point Compression

Fields in the Advanced Settings IP Options menu

Field Description

OSPF Mode
Specify whether OSPF protocol packets are sent over the inter-

face.

Possible values:

e pPassive (default value) OSPF is not activated for this inter-
face, i.e. no OSPF protocol packets sent over this interface.
Networks reachable over this interface are, however, included
when calculating the routing information and propagated over
active interfaces.

e Active: OSPF is not activated for this interface, i.e. OSPF
protocol packets sent over this interface.
e Tnactive : OSPF is disabled for this interface.
Proxy ARP Mode

Select whether and how ARP requests are to be responded to
for the specified connection partner.

Possible values:

* Tnactive (default value): Deactivates Proxy ARP for this
connection partner.

* Up or Dormant: Your device only responds to an ARP re-
quest if the status of the connection to the connection partner
is Up or Dormant. In the case of Dormant, your device only
responds to the ARP request; the connection is not set up un-
til someone actually wants to use the route.

* Up only: Your device responds to an ARP request only if the
status of the connection to the connection partner is Up
(active), i.e. a connection already exists to the connection
partner.



15.4 Real Time Jitter Control

When telephoning over the Internet, voice data packets normally have the highest priority.
Nevertheless, if the upstream bandwidth is low, noticeable delays in voice transmission can
occur when other packets are routed at the same time.

The real time jitter control function solves this problem. So that the "line" is not blocked for
too long for the voice data packets, the size of the other packets can be reduced, if re-
quired, during a telephone call.

15.4.1 Controlled Interfaces

In the WAN -> Real Time Jitter Control -> Controlled Interfaces menu, a list of all inter-
faces is shown for which the real time jitter control has been configured.

15.4.1.1 New

Click on the New button to set up portforwarding for other interfaces.

bintec R1200 | Language |English ~| | iew |Standard ~| | OnlineHelp | Logout

Controlled Interfaces

Basic Settings

Interface

Control Mode ‘ Controlled RTP Streams only ‘Vl

Maxdimum Upload Speed IU— kbps
Internet + Dialup
Leased Line Lok ) ( cancel )

| Real Time Jitter Control

Fig. 105: WAN -> Real Time Jitter Control -> Controlled Interfaces -> New

The WAN -> Real Time Jitter Control -> Controlled Interfaces -> New menu consists of
the following fields:

Fields in the Controlled Interfaces Basic Settings menu

R1xxx/R3xxx/R4xxx
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Interface Define for which interfaces voice transmission is to be optim-
ised.
Control Mode Select the mode for the optimisation.

Possible values:

Only Controlled RTP Streams(default value): By
means of the data routed via the media gateway, the system
detects voice data traffic and optimises the voice transmis-
sion.

All RTP Streams: All RTP streams are optimised.

Down : Voice data transmission is not optimised.

Always: Voice data transmission is always optimised.

Maximum Upload Speed Enter the maximum available upstream bandwidth in kbps for
the selected interface.



Chapter 16 VPN

16.1 IPSec

IPSec enables secure connections to be set up between two locations (VPN). This enables
sensitive business data to be transferred via an unsecure medium such as the Internet.
The devices used function here as the endpoints of the VPN tunnel. IPSec involves a num-
ber of Internet Engineering Task Force (IETF) standards, which specify mechanisms for the
protection and authentication of IP packets. IPSec offers mechanisms for encrypting and
decrypting the data transferred in the IP packets. The IPSec implementation can also be
smoothly integrated in a Public Key Infrastructure (PKI). The funkwerk IPSec implementa-
tion achieves this firstly by using the Authentication Header (AH) protocol and Encapsu-
lated Security Payload (ESP) protocol, and secondly through the use of cryptographic key
key administration mechanisms like the Internet Key Exchange (IKE) protocol.

16.1.1 IPSec Peers

An endpoint of a communication is defined as peer in a computer network. Each peer of-
fers its services and uses the services of other peers.

In the VPN -> IPSec -> IPSec Peers menu a list of all configured IPSec peers is shown.

bintec R1200 " Language |English | | iew |Standard ~| | OnlineHelp | Logaut

IPSec Peers Phase-1 Profiles Phase-2 Profiles XAUTH Profiles IP Pools Options

wigw |10 perpage || Fiterin [ None v|equal v

Prio  Description Feer Addrsss Feer ID Phass-1 Profile Phass-2 Profile Status
Page: 1

Fig. 106: VPN -> IPSec -> IPSec Peers

R1xxx/R3xxx/R4xxx



Peer Monitoring

The menu for monitoring a peer is called by selecting the @ button for the peer in the peer
list. See Values in the list IPSec Tunnels on page 481.

16.1.1.1 New

Choose the New button to set up more IPSec peers.

bintec R1200

Language |English |

wiew | Standare

~| | OnineHelp | Logout

-l Phase-1 Profiles | Phase-2 Profiles | XAUTH Profiles | IP Pools | Options |

Peer Parameters

Administrative Status @up Obown

Description IPEEH

Peer Address I

FeerID ‘ Fully Qualified Damain Name (FODN) LQ|

|Peer—1

Interface Routes

PPTP .
GRE IP Address Assignment Static @
Certificates. Default Route CEnabled

Lacal IP Address

|

Route Entries

Remote IP Address Metmask

Metric

C Add )

Advanced Settings

Advanced [PSec Options

Phase-1 Profile

Mone (use default profile) v

Phase-2 Profile

MNone (use default profile) @

HAUTH Profile

MNumber of Admitted Connections

@ oneuser O Multiple Users

Start Mode

@ Oon Demand OAIways up

Advanced P Options

Back Route Verify

Cenabled

Proxy ARP

® mactive O Up or Dormant @] Up only

IPSec Callback

Mode

|

€ OK ) ( Cancel )

Fig. 107: VPN -> IPSec -> IPSec Peers -> New

The VPN -> IPSec -> IPSec Peers -> New menu consists of the following fields:

Fields in the IPSec Peers Peer Parameters menu

R1xxx/R3xxx/R4xxx
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Administrative Status

Description

Peer Address

Peer ID

Preshared Key

Select the status to which you wish to set the peer after saving
the peer configuration.

Possible values:

* Up (default value): The peer is available for setting up a tunnel
immediately after saving the configuration.

* Down : The peer is initially not available after the configuration
has been saved.

Enter a description of the peer that identifies it.

The maximum length of the entry is 255 characters.

Enter the official IP address of the peer or its resolvable host
name.

The entry can be omitted in certain configurations, whereby
your device then cannot initiate an IPSec connection.

Select the ID type and enter the peer ID.
This entry is not necessary in certain configurations.
The maximum length of the entry is 255 characters.

Possible ID types:

® Fully Qualified Domain Name (FQDN)
® E-mail Address

® TPV4 Address

® ASN.1-DN (Distinguished Name)

On the peer device, this ID corresponds to the parameter Local
ID Value.

Enter the password agreed with the peer.

The maximum length of the entry is 50 characters. All charac-
ters are possible except for 0x at the start of the entry.

Fields in the IPSec Peers Interface Routes menu
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IP Address Assignment
Select the configuration mode of the interface.

Possible values:

e Static (default value): Enter a static IP address.

* TKE Config Mode Client: Select this option if your gate-
way receives an IP address from the server as IPSec client.

* TKE Config Mode Server: Select this option if your gate-
way assigns an IP address as DHCP server for connecting cli-
ents. This is taken from the selected IP Assignment Pool.

IP Assignment Pool Only if IP Address Assignment = TKE Config Mode Serv-

@

Select an IP pool configured in the VPN -> IP Pools menu. If an
IP pool has not been configured here yet, the message Not
yet defined appears in this field.

Default Route Only for IP Address Assignment = Static

Select whether the route to this IPSec peer is to be defined as
the default route.

The function is activated with Enabled.

The function is disabled by default.

Local IP Address Only if IP Address Assignment = Staticand IKE Config
Mode Server

Enter the WAN IP address of your IPSec tunnel. This can be the
same |IP address as the address configured on your router as
the LAN |P address.

Route Entries Define routing entries for this connection partner.

* Remote IP Address: |IP address of the destination host or
LAN.
e Netmask: Netmask of Remote IP Address.

* Metric: The lower the value, the higher the priority of the
route (possible values 0. . . 15). The default value is 1.

The Advanced Settings menu consists of the following fields:
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Fields in the Advanced Settings Advanced IPSec Options menu
N =

Phase-1 Profile For phase 1, select a profile already configured in the Phase-1
Profiles menu. You can also select the profile marked as the
default in Phase-1 Profiles: None (use Default
Profile).

Phase-2 Profile For phase 2, select a profile already configured in the Phase-2
Profiles menu. You can also select the profile marked as the
default in Phase-2 Profiles: None (use Default
Profile).

XAUTH Profile Select a profile created in VPN -> IPSec -> XAUTH Profiles if
you wish to use this IPSec peer XAuth for authentication.

If XAuth is used together with IKE Config Mode, the transac-
tions for XAuth are carried out before the transactions for IKE
Config Mode.

Number of Admitted Choose how many users can connect using this peer profile.

Connections _
Possible values:

* One User (default value): Only one peer can be connected
with the data defined in this profile.

* Multiple Users: Several peers can be connected with the
data defined in this profile. The peer entry is duplicated for
each connection request with the data defined in this profile.

Start Mode Select how the peer is to be switched to the active state.

Possible values:

* On Demand (default value): The peer is switched to the active
state by a trigger.

e Always up: The peer is always active.

Fields in the Advanced Settings Advanced IP Options menu
N =

Back Route Verify Select whether a check on the back route should be activated
for the interface to the connection partner.
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The function is activated with Enabled.

The function is disabled by default.

Proxy ARP Select whether your device is to respond to ARP requests from
its own LAN on behalf of the specific connection partner.

Possible values:

* Tnactive (default value): Deactivates Proxy ARP for this
IPSec peer.

* Up or Dormant: Your device only responds to an ARP re-
quest if the status of the connection to the IPSec peer is Up
(active) or Dormant. In the case of Dormant, your device
only responds to the ARP request; the connection is not set
up until someone actually wants to use the route.

* Up only: Your device responds to an ARP request only if the
status of the connection to the IPSec peer is Up (active), i.e. a
connection already exists to the IPSec peer.

IPSec Callback

bintec devices support the DynDNS service to enable hosts without fixed IP addresses to
obtain a secure connection over the Internet. This service enables a peer to be identified
using a host name that can be resolved by DNS. You do not need to configure the IP ad-
dress of the peer.

The DynDNS service does not signal whether a peer is actually online and cannot cause a
peer to set up an Internet connection to enable an IPSec tunnel over the Internet. This pos-
sibility is created with IPSec callback: Using a direct ISDN call to a peer, you can signal
that you are online and waiting for the peer to set up an IPSec tunnel over the Internet. If
the called peer currently has no connection to the Internet, the ISDN call causes a connec-
tion to be set up. This ISDN call costs nothing (depending on country), as it does not have
to be accepted by your device. The identification of the caller from his or her ISDN number
is enough information to initiate setting up a tunnel.

Before you can configure this service, you must first configure a number for IPSec callback
on the passive page in the Physical Interfaces -> ISDN Ports -> MSN Configuration ->
New menu. The value IPSec is available for this purpose in the Service field. This entry
ensures that incoming calls for this number are routed to the IPSec service.

If callback is active, the peer is caused to initiate setting up an IPSec tunnel by an ISDN
call as soon as this tunnel is required. With passive callback, the set-up of a tunnel to the
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peer is always initiated if an ISDN call to the corresponding number (MSN in the Physical
Interfaces -> ISDN Ports -> MSN Configuration -> New for Service 1PSec menu) is re-
ceived. This ensures that both peers are reachable and that the connection can be set up
over the Internet. The only case in which callback is not executed is if SAs (Security Asso-
ciations) already exist, i.e. the tunnel to the peer already exists.

Note

If a tunnel is to be set up to a peer, the interface over which the tunnel is to be imple-
mented is activated first by the IPSec Daemon. If IPSec with DynDNS is configured on
the local device, the own IP address is propagated first and then the ISDN call is sent
to the remote device. This ensures that the remote device can actually reach the local
device if it initiates the tunnel setup.

Transfer of IP Address over ISDN

Transferring the IP address of a device over ISDN (in the D channel and/or B channel)
opens up new possibilities for the configuration of IPSec VPNs. This enables restrictions
that occur in IPSec configuration with dynamic IP addresses to be avoided.

Note

To use the IP address transfer over ISDN function, you must obtain a free-of-charge
extra licence.

You can obtain the licence data for extra licences via the online licensing pages in the
support section at www.funkwerk-ec.com . Please follow the online licensing instruc-
tions.

Before System Software Release 7.1.4, IPSec ISDN callback only supported tunnel setup if
the current IP address of the initiator could be determined by indirect means (e.g. via
DynDNS). However, DynDNS has serious disadvantages, such as the latency until the IP
address is actually updated in the database. This can mean that the IP address propagated
via DynDNS is not correct. This problem is avoided by transferring the IP address over
ISDN. This type of transfer of dynamic IP addresses also enables the more secure ID Pro-
tect mode (main mode) to be used for tunnel setup.

Method of operation: Various modes are available for transferring your own IP address to
the peer: The address can be transferred free in the D channel or in the B channel, but
here the call must be accepted by the remote station and therefore incurs costs. If a peer
whose IP address has been assigned dynamically wants to arrange for another peer to set
up an IPSec tunnel, it can transfer its own IP address as per the settings described in
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Fields in the Advanced Settings IPSec Callback menu on page 299. Not all transfer modes
are supported by all telephone companies. If you are not sure, automatic selection by the
device can be used to ensure that all the available possibilities can be used.

@ Note

The callback configuration on the two devices should be the same so your device of
the called peer can identify the IP address information.

The following roles are possible:

¢ One side takes on the active role, the other the passive role.

» Both sides can take on both roles (both).

The IP address transfer and the start of IKE phase 1 negotiation take place in the following
steps:

(1) Peer A (the callback initiator) sets up a connection to the Internet in order to be as-
signed a dynamic IP address and be reachable for peer B over the Internet.

(2) Your device creates a token with a limited validity and saves it together with the cur-
rent IP address in the MIB entry belonging to peer B.

(3) Your device sends the initial ISDN call to peer B, which transfers the IP address of
peer A and the token as per the callback configuration.

(4) Peer B extracts the IP address of peer A and the token from the ISDN call and as-
signs them to peer A based on the calling party number configured (the ISDN number
used by peer A to send the initial call to peer B).

(5) The IPSec Daemon at peer B's device can use the transferred IP address to initiate
phase 1 negotiation with peer A. Here the token is returned to peer A in part of the
payload in IKE negotiation.

(6) Peer A is now able to compare the token returned by peer B with the entries in the
MIB and so identify the peer without knowing its IP address.

As peer A and peer B can now mutually identify each other, negotiations can also be con-
ducted in the ID Protect mode using preshared keys.

@ Note

In some countries (e.g. Switzerland), the call in the D channel can also incur costs. An
incorrect configuration at the called side can mean that the called side opens the B
channel the calling side incurs costs.

Fields in the Advanced Settings IPSec Callback menu
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Mode Select the Callback Mode.

Possible values:

* Inactive (default value): IPSec callback is deactivated. The
local device neither reacts to incoming ISDN calls nor initiates
ISDN calls to the remote device.

* passive: The local device only reacts to incoming ISDN calls
and, if necessary, initiates setting up an IPSec tunnel to the
peer. No ISDN calls are sent to the remote device to cause
this to set up an IPSec tunnel.

e Active: The local device sends an ISDN call to the remote
device to cause this to set up an IPSec tunnel. The device
does not react to incoming ISDN calls.

e Both : Your device can react to incoming ISDN calls and
send ISDN calls to the remote device. The setting up of an
IPSec tunnel is executed (after an incoming ISDN call) and
initiated (by an outgoing ISDN call).

Incoming ISDN Number Only for Mode = Passive or Both.

Enter the ISDN number from which the remote device calls the
local device (calling party number). Wildcards may also be
used.

Outgoing ISDN Number Only for Mode = Active or Both.

Enter the ISDN number with which the local device calls the re-
mote device calls (called party number). Wildcards may also be
used.

Transfer own IP address Select whether the IP address of your own device is to be trans-
over ISDN ferred over ISDN for IPSec callback.

The function is activated with Enabled.

The function is disabled by default.

Transfer Mode Only if Transfer Own IP Address over ISDN = activated

Select the mode in which your device is to attempt to transfer its
IP address to the peer.
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D Channel Mode

Possible values:

e Autodetect Best Mode : Your device automatically de-
termines the most favourable mode. It first tries all D channel
modes before switching to the B channel. (Costs are incurred
for using the B channel.)

* Autodetect only D Channel Modes : Your device auto-
matically determines the most favourable D channel mode.
The use of the B channel is excluded.

* Use specific D Channel Mode : Your device tries to
transfer the IP address in the mode set in the D Channel
Mode field.

® Try specific D Channel Mode, fall back to B
Channel : Your device tries to transfer the IP address in the
mode set in the D Channel Mode field. If this does not suc-
ceed, the IP address is transferred in the B channel. (This in-
curs costs.)

e Use only B Channel Mode : Your device transfers the IP
address in the B channel. This incurs costs.

Only if Transfer Mode = Use specific D Channel Mode
or Try specific D Channel Mode, Fallback to B
Channel

Select the D channel mode in which your device tries to transfer
the IP address.

Possible values:
e LLC (default value): The IP address is transferred in the "LLC
information elements" of the D channel.

* SUBADDR : The IP address is transferred in the subaddress "in-
formation elements" of the D channel.

e LILC and SUBADDR: The IP address is transferred in both
the "LLC" and "subaddress information elements".

16.1.2 Phase-1 Profiles

In the VPN -> IPSec -> Phase-1 Profiles menu a list of all configured IPSec phase-1 pro-

files is shown.

16 VPN



bintec R1200 Language | English | | Wiew |Standard ~| | OnineHelp | Logout

IPSec Peers _l Phase-2 Profiles | XAUTH Profiles | IP Pools | Options |
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Page: 1
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PPTP
GRE
Certificates

Fig. 108: VPN -> IPSec -> Phase-1 Profiles

In the Standard column, you can mark the profile to be used as the default profile.

16.1.2.1 New

Choose the New button to set up new profiles.

R 1xxx/B3xxx/R4xxx
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Fig. 109: VPN -> IPSec -> Phase-1 Profiles -> New

The VPN -> IPSec -> Phase-1 Profiles -> New menu consists of the following fields:

Fields in the Phase-1 Profiles Phase-1 (IKE) Parameters menu

I

Description

Proposals

Enter a description that uniquely defines the type of rule.

In this field, you can select any combination of encryption and
message hash algorithms for IKE phase 1 on your device. The
combination of six encryption algorithms and four message
hash algorithms gives 24 possible values in this field. At least
one proposal must exist. Therefore the first line of the table can-
not be deactivated.

Encryption algorithms (Encryption):

e 3DES (default value): 3DES is an extension of the DES al-
gorithm with an effective key length of 112 bits, which is rated
as secure. It is the slowest algorithm currently supported.

* Twofish: Twofish was a final candidate for the AES
(Advanced Encryption Standard). It is rated as just as secure
as Rijndael (AES), but is slower.
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* Blowfish: Blowfish is a very secure and fast algorithm.
Twofish can be regarded as the successor to Blowfish.

CAST: CAST is also a very secure algorithm, marginally
slower than Blowfish, but faster than 3DES.

* DES: DES is an older encryption algorithm, which is rated as
weak due to its small effective length of 56 bits.

AES: Rijndael has been nominated as AES due to its fast key
setup, low memory requirements, high level of security
against attacks and general speed.

* AES-128: Rijndael has been nominated as AES due to its
fast key setup, low memory requirements, high level of secur-
ity against attacks and general speed. Here, it is used with a
key length of 128 bits.

* AES-192: Rijndael has been nominated as AES due to its
fast key setup, low memory requirements, high level of secur-
ity against attacks and general speed. Here, it is used with a
key length of 192 bits.

* AES-256: Rijndael has been nominated as AES due to its
fast key setup, low memory requirements, high level of secur-
ity against attacks and general speed. Here, it is used with a
key length of 256 bits.

Hash algorithms (Authentication):

* MD5 (default value): MD 5 (Message Digest #5) is an older
hash algorithm. It is used with a 96 bit digest length for IPSec.

e SHAI : SHA1 (Secure Hash Algorithm #1) is a hash algorithm
developed by the NSA (United States National Security Asso-
ciation). It is rated as secure, but is slower than MD5. It is
used with a 96 bit digest length for IPSec.

* RipeMD 160: RipeMD 160 is a 160 bit hash algorithm. It is
used as a secure replacement for MD5 and RipeMD.

* Tigerl92: Tiger 192 is a relatively new and very fast al-
gorithm.

Please note that the description of the encryption and authentic-
ation or the hash algorithms is based on the author’s knowledge
and opinion at the time of creating this User Guide. In particular,
the quality of the algorithms is subject to relative aspects and
may change due to mathematical or cryptographic develop-
ments.
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DH Group

Lifetime

Authentication Method

The Diffie-Hellman group defines the parameter set used as the
basis for the key calculation during phase 1. "MODP" as sup-
ported by bintec devices stands for "modular exponentiation".

Possible values:

e 1 (768-bit): During the Diffie-Hellman key calculation,
modular exponentiation at 768 bits is used to create the en-
cryption material.

* 2 (1024-bit): During the Diffie-Hellman key calculation,
modular exponentiation at 1024 bits is used to create the en-
cryption material.

* 5 (1536-bit): During the Diffie-Hellman key calculation,
modular exponentiation at 1536 bits is used to create the en-
cryption material.

Create a lifetime for phase 1 keys.

As for RFC 2407, the default value is eight hours, which means
the key must be renewed once eight hours have elapsed.

The following options are available for defining the lifetime:

Entry in Seconds: Enter the lifetime for phase 1 key in seconds.
The value can be a whole number from 0 to 2147483647. The
default value is 14400.

Entry in kBytes: Enter the lifetime for phase 1 keys as amount
of data processed in kBytes. The value can be a whole number
from 0 to 2147483647. The default value is 0.

The standard value as per RFC is used 0 seconds and 0
Kbytes are entered.

Select the authentication method.
Possible values:

e Preshared Keys (default value): If you do not use certific-
ates for the authentication, you can select Preshared Keys.
These are configured during peer configuration in the IPSec
Peers menu. The preshared key is the shared password.

* DSA Signature: Phase 1 key calculations are authenticated
using the DSA algorithm.
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Local Certificate

Mode

Local ID Type

Local ID Value

* RSA Signature: Phase 1 key calculations are authenticated
using the RSA algorithm.

* RSA Encryption: In RSA encryption the ID payload is also
encrypted for additional security.

Only if Authentication Method = DSA Signature, RSA Sig-
nature Or RSA Encryption

This field enables you to select one of your own certificates for
authentication. It shows the index number of this certificate and
the name under which it is saved. This field is only shown for
authentication settings based on certificates and indicates that a
certificate is essential.

Select the phase 1 mode.

Possible values:

* Aggressive (default value): The Aggressive Mode is neces-
sary if one of the peers does not have a static IP address and
preshared keys are used for authentication; it requires only
three messages for configuring a secure channel.

e Main Mode (ID Protect) : This mode (also designated
Main Mode) requires six messages for a Diffie-Hellman key
calculation and thus for configuring a secure channel, over
which the IPSec SAs can be negotiated. A condition is that
both peers have static IP addresses if preshared keys are
used for authentication.

Also define whether the selected mode is used exclusively
(Strict), or the peer can also propose another mode.

Select the local ID type.
Possible values:

® Fully Qualified Domain Name (FQDN)
® F-mail Address
® TPV4 Address

® ASN.1-DN (Distinguished Name)

Enter the ID of your device.
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For Authentication Method = DSA Signature, RSA Signa-
ture Or RSA Encryption, the Use Subject Name from cer-
tificate option is shown.

If you enable the Use Subject Name from certificate option,
the first alternative subject name indicated in the certificate is
used, or, if none is specified, the subject name of the certificate
is used.

Note: If you use certificates for authentication and your certific-
ate contains alternative subject names (see Certificates on
page 341), you must make sure your device selects the first al-
ternative subject name by default. Make sure you and your peer
both use the same name, i.e. that your local ID and the peer ID
your partner configures for you are identical.

Alive Check

During communication between two IPSec peers, one of the peers may become unavail-
able, e.g. due to routing problems or a reboot. However, this can only be detected when
the end of the lifetime of the security connection is reached. Up until this point the data
packets are lost. These are various methods of performing an alive check to prevent this
happening. In the Alive Check field you can specify whether a method should be used to
check the availability of a peer.

Two methods are available: Heartbeats and Dead Peer Detection.
The Advanced Settings menu consists of the following fields:
Fields in the Advanced Settings menu

(I == =

Alive Check Select the method to be used to check the functionality of the
IPSec connection.

In addition to the default method Dead Peer Detection (DPD),
the (proprietary) Heartbeat method is implemented. This sends
and receives signals every 5 seconds, depending on the config-
uration. If these signals are not received after 20 seconds, the
SA is discarded as invalid.

Possible values:

* Autodetect (default value): Your device detects and uses
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Block Time

NAT Traversal

the mode supported by the remote terminal.

e Down : Your device sends and expects no heartbeat. Set this
option if you use devices from other manufacturers.

* Heartbeats (Expect only): Your device expects a
heartbeat from the peer but does not send one itself.

* Heartbeats (Send only): Your device expects no heart-
beat from the peer, but sends one itself.

* Heartbeats (send & expect): Your device expects a
heartbeat from the peer and sends one itself.

* Dead Peer Detection: Use DPD (dead peer detection) in
accordance with RFC 3706. DPD uses a request-reply pro-
tocol to check the availability of the remote terminal and can
be configured independently on both sides. This option only
checks the availability of the peer if data is to be sent to it.

* Dead Peer Detection (Idle):Use DPD (dead peer de-
tection) in accordance with RFC 3706. DPD uses a request-
reply protocol to check the availability of the remote terminal
and can be configured independently on both sides. This op-
tion is used to carry out a check at certain intervals depending
on forthcoming data transfers.

Define how long a peer is blocked for tunnel setups after a
phase 1 tunnel setup has failed. This only affects locally initiated
setup attempts.

Possible values are -1 to 86400 (seconds); -1 means the
value in the default profile is used and 0 means that the peer is
never blocked.

The default value is 30.

NAT Traversal (NAT-T) also enables IPSec tunnels to be
opened via one or more devices on which network address
translation (NAT) is activated.

Without NAT-T, incompatibilities may arise between IPSec and
NAT (see RFC 3715, section 2). These primarily prevent the
setup of an IPSec tunnel from a host within a LANs and behind
a NAT device to another host or device. NAT-T enables these
kinds of tunnels without conflicts with NAT device, activated
NAT is automatically detected by the IPSec Daemon and NAT-T



Field Description

is used.
The function is activated with Enabled.

The function is enabled by default.

CA Certificates Only if Authentication Method = DSA Signature, RSA Sig-
nature Ofr RSA Encryption

If you enable the Trust following CA certificates option, you
can select up to three additional CA certificates that are accep-
ted for this profile.

This option can only be configured if certificates are loaded.

16.1.3 Phase-2 Profiles

You can define profiles for phase 2 of the tunnel setup just as for phase 1.

In the VPN -> IPSec -> Phase-2 Profiles menu a list of all configured IPSec phase-2 pro-
files is shown.

" IEE
Language |English v| | view |Standard ~| | Online Help | Logout

IPSec Peers Phase-1 Profiles Phase-2 Profiles XAUTH Profiles IP Pools Options

Wigw |20 per page [<I[] Fier in [Nane ~ | equal VI
Default Descrigtion Proposals PFS Group Lifetime

Page: 1

New ( oK ) ( Cancel )

Fig. 110: VPN -> IPSec -> Phase-2 Profiles
In the Standard column, you can mark the profile to be used as the default profile.

R1xxx/R3xxx/R4xxx
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16.1.3.1 New

Choose the New button to set up new profiles.
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- n - L w X
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Assistants ~7
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Physical Interfaces - Phaszs-2 (PSEC) Parametsrs
LAN r Description Multi-Proposal
Wirel LAN -
HE1ess Encryption Authertication Erablzd
Routing = AES ¥ | MDE W
WAN - Froposals AES | [MD5 v O
VPN -
AES v MDs v O
IPSec
L2IE [Enabled
Use PFE Grou|
PPTP P 2 1(7ea Bit) & 2(1024 Bity O 5(1536 Bit)
GRE
Certificates Lifetime |?2EIU SecomlslU kBytes
Firewall i
v/ Setti
o = Advanced Settings
Local Services o IP Compression [Clenabtea
Malcnance T Alive Check Autodetect v
External Reporting -
— Propagate PMTU [“lenabtea
Monitoring -
oK Cancel

Fig. 111: VPN -> IPSec -> Phase-2 Profiles -> New
The VPN -> IPSec -> Phase-2 Profiles -> New menu consists of the following fields:

Fields in the Phase-2 Profiles Phase-2 (IPSEC) Parameters menu
Field Description

Description Enter a description that uniquely identifies the profile.

The maximum length of the entry is 255 characters.

Proposals In this field, you can select any combination of encryption and
message hash algorithms for IKE phase 2 on your default. The
combination of six encryption algorithms and two message hash
algorithms gives 12 possible values in this field.

Encryption algorithms (Encryption):

e 3DES (default value): 3DES is an extension of the DES al-
gorithm with an effective key length of 112 bits, which is rated
as secure. It is the slowest algorithm currently supported.

e —ALL-: All options can be used.

* AES-128: Rijndael has been nominated as AES due to its
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Use PFS Group

fast key setup, low memory requirements, high level of secur-
ity against attacks and general speed. Here, it is used with a
key length of 128 bits.

AES-192: Rijndael has been nominated as AES due to its
fast key setup, low memory requirements, high level of secur-
ity against attacks and general speed. Here, it is used with a
key length of 192 bits.

AES-256: Rijndael has been nominated as AES due to its
fast key setup, low memory requirements, high level of secur-
ity against attacks and general speed. Here, it is used with a
key length of 256 bits.

Twof i sh: Twofish was a final candidate for the AES
(Advanced Encryption Standard). It is rated as just as secure
as Rijndael (AES), but is slower.

Blowfish: Blowfish is a very secure and fast algorithm.
Twofish can be regarded as the successor to Blowfish.

CAST: CAST is also a very secure algorithm, marginally
slower than Blowfish, but faster than 3DES.

DES: DES is an older encryption algorithm, which is rated as
weak due to its small effective length of 56 bits.

Hash algorithms (Authentication):

MD 5 (default value): MD 5 (Message Digest #5) is an older
hash algorithm. It is used with a 96 bit digest length for IPSec.

-ALL-: All options can be used.

SHA 1 :SHAT1 (Secure Hash Algorithm #1) is a hash al-
gorithm developed by the NSA (United States National Secur-
ity Association). It is rated as secure, but is slower than MD5.
It is used with a 96 bit digest length for IPSec.

Note that RipeMD 160 and Tiger 192 are not available for mes-
sage hashing in phase 2.

As PFS (Perfect Forward Secrecy) requires another Diffie-
Hellman key calculation to create new encryption material, you
must select the exponentiation features. If you enable PFS ( En-
abled), the options are the same as for the configuration in
Phase 1: Group. PFS is used to protect the keys of a renewed
phase 2 SA, even if the keys of the phase 1 SA have become
known.
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The field has the following options:

e 1 (768-bit): During the Diffie-Hellman key calculation,
modular exponentiation at 768 bits is used to create the en-
cryption material.

* 2 (1024 Bit) (default value): During the Diffie-Hellman key
calculation, modular exponentiation at 1024 bits is used to
create the encryption material.

* 5 (1536-bit): During the Diffie-Hellman key calculation,
modular exponentiation at 1536 bits is used to create the en-
cryption material.

Lifetime Define how the lifetime is defined that will expire before phase 2
SAs need to be renewed.

The new SAs are negotiated shortly before expiry of the current
SAs. As for RFC 2407, the default value is eight hours, which
means the key must be renewed once eight hours have
elapsed.

The following options are available for defining the lifetime:

Entry in Seconds: Enter the lifetime for phase 2 key in seconds.
The value can be a whole number from 0to 2147483647 . The
default value is 7200.

Entry in kBytes: Enter the lifetime for phase 2 keys as amount
of data processed in Kbytes. The value can be a whole number
from 0to 2147483647 . The default value is 0.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu
I =

IP Compression Select whether compression is to be activated before data en-
cryption. If data is compressed effectively, this can result in
higher performance and a lower volume of data to be trans-
ferred. In the case of fast lines or data that cannot be com-
pressed, you are advised against using this option as the per-
formance can be significantly affected by the increased effort
during compression.
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Alive Check

Propagate PMTU

The function is activated with Enabled.

The function is disabled by default.

Select whether and how IPSec heartbeats are used.

A bintec IPSec heartbeat is implemented to determine whether
or not a Security Association (SA) is still valid. This function
sends and receives signals every 5 seconds, depending on the
configuration. If these signals are not received after 20 seconds,
the SA is discarded as invalid.

Possible values:
* Down : Your device sends and expects no heartbeat. Set this
option if you use devices from other manufacturers.

* Heartbeats (Expect only): Your device expects a
heartbeat from the peer but does not send one itself.

* Heartbheats (Send only): Your device expects no heart-
beat from the peer, but sends one itself.

* Heartbeats (send & expect): Your device expects a
heartbeat from the peer and sends one itself.

* Autodetect: Automatic detection of whether the remote ter-
minal is a bintec device. If it is, Heartbeat Both (for a remote
terminal with bintec) or None (for a remote terminal without
bintec) is set.

Select whether the PMTU (Path Maximum Transfer Unit) is to
be propagated during phase 2.

The function is activated with Enabled.

The function is enabled by default.

16.1.4 XAUTH Profiles

In the XAUTH Profiles menu a list of all XAuth users is displayed.

Extended Authentication for IPSec (XAuth) is an additional authentication method for IPSec

tunnel users.

The gateway can take on two different roles when using XAuth as it can act as a server or



as a client:

* As a server the gateway requires a proof of authorisation.

* As a client the gateway provides proof of authorisation.

In server mode multiple users can obtain authentication via XAuth, e.g. users of Apple
iPhones. Authorisation is verified either on the basis of a list or via a Radius Server. If using
a one time password (OTP), the password check can be carried out by a token server (e.g.
SecOVID from Kobil), which is installed behind the Radius Server. If a company's
headquarters is connected to several branches via IPSec, several peers can be configured.
A specific user can then use the IPSec tunnel over various peers depending on the assign-
ment of various profiles. This is useful, for example, if an employee works alternately in dif-
ferent branches, if each peer represents a branch and if the employee wishes to have on-
site access to the tunnel.

XAuth is carried out once IPSec IKE (Phase 1) has been completed successfully and be-
fore IKE (Phase 2) begins.

If XAuth is used together with IKE Config Mode, the transactions for XAuth are carried out
before the transactions for IKE Config Mode.

16.1.4.1 New

Choose the New button to set up new profiles.

bintec R1200 | Language |English | | iew |Standard ~| | Online Help | Logout

IPSec Peers Phase-1 Profiles Phase-2 Profiles XAUTH Profiles IP Pools Options

Basic Parameters

Description

Rale
woge

RADIUS Server Group D No Radius Server configured for XAUTH

€ oK ) ( Cancel )

GRE
Certificates

Fig. 112: VPN -> IPSec -> XAUTH Profiles -> New

The VPN -> IPSec -> XAUTH Profiles -> New menu consists of the following fields:

R1xxx/R3xxx/R4xxx
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Fields in the XAUTH Profiles Basic Parameters menu
Field  [Descripton |

Description Enter a description for this XAuth profile.
Role Select the role of the gateway for XAuth authentication.
Possible values:

» Server (default value): The gateway requires a proof of au-
thorisation.

e Client: The gateway provides proof of authorisation.
Mode Only if Role = Server

Select how authentication is carried out.

Possible values:

* RADIUS (default value): Authentication is carried out via a Ra-
dius server. This is configured in the System Management ->
Remote Authentication -> RADIUS menu and selected in
the RADIUS Server Group ID field.

* Local: Authentication is carried out via a local list.

Name Only if Role = Client

Enter the authentication name of the client.

Password Only if Role = Client

Enter the authentication password.

RADIUS Server Group  Only if Role = Server

ID
Select the desired RADIUS group configured in System Man-
agement -> Remote Authentication -> RADIUS.

Users Only if Role = Server and Mode = Local

If your gateway is configured as an XAuth server, the clients
can be authenticated via a locally configured user list. Define
the members of the user group of this XAUTH profile here by
entering the authentication name of the client (Name) and the
authentication password (Password). Add new members with



Field Description

Add.

16.1.5 IP Pools

In the IP Pools menu a list of all IP pools for your configured IPSec connections is dis-
played.

If have set IP Address Assignment TKE Config Mode Server for an IPSec peer, you
must define the IP pools from which the IP addresses are assigned.

Use the Add button to set up new IP pools.

ks |

_ i : i N
bintec R1200 Language |English | | wiew | Standard ~| | Online Help | Logout
IPSec Peers Phase-1 Profiles Phase-2 Profiles XAUTH Profiles IP Pools Options
Wiew |20 per page EDFmerln MNone | equal V| ':G:o]
IP Pl Pame: IF Pool Range
| -[onoo i
Page: 1, hems: 1 -1
( Add ) C oK 0 cancel )

Fig. 113: VPN -> IPSec -> IP Pools -> Add
The VPN -> IPSec -> IP Pools -> Add menu consists of the following fields:

Fields in the Options IP Pools menu

IP Pool Name Enter the name of the IP pool.

IP Pool Range In the first field, enter the first IP address of the range.

In the second field, enter the last IP address of the range.

R1xxx/R3xxx/R4xxx
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Language |English | | iew |Standard ~| | Online Help | Logout

IPSec Peers Phase-1 Profiles  Phase-2 Profiles XAUTH Profiles IP Pools Options

Global Options
Enable IPSec Cenabled
Delete complete IPSec configuration i
IPSec Debug Level
Advanced Settings
Send Initial Contact Message [ Enabled
Sync SAs with ISP interface state Cenabled
Use Zero Cookies Clenabled
Dynamic RADIUS Authentication [Jenabled

PHI Handling Options

lgnore Cerificate Request Payloads Cenabled
Send Cerificate Request Payloads [ Enabled
Send Certificate Chains [ Enabled
gend CRLs CEnabled
Send Key Hash Payloads [ Enabled

€ oK ) ( Cancel )

Fig. 114: VPN -> IPSec -> Options

The VPN -> IPSec -> Options menu consists of the following fields:

Fields in the Options Global Options menu

Field Description

Enable IPSec Select whether you want to activate IPSec.
The function is activated with Enabled.

The function is active as soon as an IPSec Peer is configured.

Delete complete IPsec  If you click the icon, delete the complete IPSec configuration
configuration of your device.

This cancels all settings made during the IPSec configuration.
Once the configuration is deleted, you can start with a com-
pletely new IPSec configuration.

You can only delete the configuration if Enable IPSec = Not
activated.

R1xxx/R3xxx/R4xxx
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IPSec Debug Level Select the priority of the syslog messages of the IPSec subsys-
tem to be recorded internally.

Possible values:

* Emergency (highest priority)

e Alert

® Critical

® Errors

® Warning

* Alert

® Information

* Debug (default value, lowest priority)

Syslog messages are only recorded internally if they have a

higher or identical priority to that indicated, i.e. all messages
generated are recorded at syslog level debug.

The Advanced Settings menu is for adapting certain functions and features to the special
requirements of your environment, i.e. mostly interoperability flags are set. The default val-
ues are globally valid and enable your system to work correctly to other bintec devices, so
that you only need to change these values if the remote terminal is a third-party product or
you know special settings are necessary. These may be needed, for example, if the remote
end operates with older IPSec implementations.

The Advanced Settings menu consists of the following fields:

Fields in the Options Advanced Settings menu
Foa oo

Send Initial Contact Select whether IKE Initial Contact messages are to be sent dur-
Message ing IKE (phase 1) if no SAs with a peer exist.

The function is activated with Enabled.

The function is enabled by default.

Sync SAs with ISP inter- Select whether all SAs are to be deleted whose data traffic was
face state routed via an interface on which the status has changed from
Upto Down, Dormant Or Blocked.

The function is activated with Enabled.
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Use Zero Cookies

Zero Cookie Size

Dynamic RADIUS Au-
thentication

The function is disabled by default.

Select whether zeroed ISAKMP Cookies are to be sent.

These are equivalent to the SPI (Security Parameter Index) in
IKE proposals; as they are redundant, they are normally set to
the value of the negotiation currently in progress. Alternatively,
your device can use zeroes for all values of the cookie. In this
case choose Enabled.

Only if Use Zero Cookies = activated.

Enter the length in bytes of the zeroed SPI used in IKE propos-
als.

The default value is 32.

Select whether RADIUS authentication is to be activated via
IPSec.

The function is activated with Enabled.

The function is disabled by default.

Fields in the Advanced Settings PKI Handling Options menu

T ==

Ignore Certificate Re-
quest Payloads

Send Certificate Re-
quest Payloads

Send Certificate Chains

Select whether certificate requests received from the remote
end during IKE (phase 1) are to be ignored.

The function is activated with Enabled.

The function is disabled by default.

Select whether certificate requests are to be sent during IKE
(phase 1).

The function is activated with Enabled.

The function is enabled by default.

Select whether complete certificate chains are to be sent during
IKE (phase 1).

The function is activated with Enabled.

16 VPN
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The function is enabled by default.

Deactivate this function if you do not wish to send the peer the
certificates of all levels (from your level to the CA level).

Send CRLs Select whether CRLs are to be sent during IKE (phase 1).
The function is activated with Enabled.

The function is disabled by default.

Send Key Hash Pay- Select whether key hash payloads are to be sent during IKE
loads (phase 1).

In the default setting, the public key hash of the remote end is
sent together with the other authentication data. Only applies for
RSA encryption; activate this function with Enabled to sup-
press this behaviour.

16.2 L2TP

The layer 2 tunnel protocol (L2TP) enables PPP connections to be tunnelled via a UDP
connection.

Your bintec device supports the following two modes:

e L2TP LNS Mode (L2TP Network Server): for incoming connections only
e L2TP LAC Mode (L2TP Access Concentrator): for outgoing connections only

Note the following when configuring the server and client: An L2TP tunnel profile must be
created on each of the two sides (LAC and LNS). The corresponding L2TP tunnel profile is
used on the initiator side (LAC) to set up the connection. The L2TP tunnel profile is needed
on the responder side (LNS) to accept the connection.

16.2.1 Tunnel Profiles

In the VPN -> L2TP -> Tunnel Profiles menu a list of all configured tunnel profiles is
shown.

16.2.1.1 New

Choose the New button to set up new tunnel profiles.
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Fig. 115: VPN -> L2TP -> Tunnel Profiles -> New
The VPN -> L2TP -> Tunnel Profiles -> New menu consists of the following fields:

Fields in the Tunnel Profiles Basic Parameters menu
Field  [Descripton |

Description Enter a description for the current profile.
The device automatically names the profiles L2TP

and numbers them, but the value can be changed.

Enter the host name for LNS or LAC.
Local Hosthame

* LAC: The Local Hostname is used in outgoing tunnel setup
messages to identify this device and is associated with the
Remote Hosthame of a tunnel profile configured on the LNS.
These tunnel setup messages are SCCRQs (Start Control
Connection Request) sent from the LAC and SCCRPs (Start
Control Connection Reply) sent from the LNS.

¢ LNS: Is the same as the value for Remote Hostname of the
incoming tunnel setup message from the LAC.
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Enter the host name of the LNS or LAC.
Remote Hostname

* LAC: Defines the value for Local Hostname of the LNS
(contained in the SCCRQs received from the LNS and the
SCCRPs received from the LAC). The Local Hostname con-
figured in the LAC must match the Remote Hostname con-
figured for the intended profile in the LNS and vice versa.

¢ LNS: Defines the Local Hostname of the LAC. If the Remote
Hostname field remains empty on the LNS, the related profile
qualifies as the standard entry and is used for all incoming
calls for which a profile with a matching Remote Hostname
can be found.

Password Enter the password to be used for tunnel authentication. Au-
thentication between LAC and LNS takes place in both direc-
tions, i.e. the LNS checks the Local Hostname and the Pass-
word contained in the SCCRQ of the LAC and compares them
with those specified in the relevant profile. The LAC does the
same with the fields of the SCCRP of the LNS.

If this field remains empty, authentication data in the tunnel
setup messages are not sent and are ignored.

Fields in the Tunnel Proﬁles LAC Mode Parameters menu
Field Description

Remote IP Address Enter the fixed |IP address of the LNS used as the destination
address for connections based on this profile.

The destination must be a device that can behave like an LNS.

UDP Source Port Enter how the port number to be used as the source port for all
outgoing L2TP connections based on this profile is to be be de-
termined.

By default, the Fixed option is disabled, which means that ports
are dynamically assigned to the connections that use this pro-
file.

If you want to enter a fixed port, enable the Fixed option. Select
this option if you encounter problems with the firewall or NAT.

The available values are 0to 65535.
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UDP Destination Port

Enter the destination port number to be used for all calls based
on this profile. The remote LNS that receives the call must mon-
itor this port on L2TP connections.

Possible values are 0 ... 65535.

The default value is 1701 (RFC 2661).

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu
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Local IP Address

Hello Interval

Minimum Time between
Retries

Maximum Time between
Retries

Maximum Retries

Enter the IP address to be used as the source address for all
L2TP connections based on this profile.

If this field is left empty, your device uses the IP address of the
interface used to reach Remote IP Address by the L2TP tun-
nel.

Enter the interval (in seconds) between the sending of two L2TP
HELLO messages. These messages are used to keep the tun-
nel open.

The available values are 0to 255, the default value is 30. The
value 0 means that no L2TP HELLO messages are sent.

Enter the minimum time (in seconds) that your device waits be-
fore resending a L2TP control packet for which it received no re-
sponse.

The wait time is dynamically extended until it reaches the Max-
imum Time between Retries. The available values are 1 to
255, the default value is 1.

Enter the maximum time (in seconds) that your device waits be-
fore resending a L2TP control packet for which it received no re-
sponse.

The available values are 8to 255, the default value is 16.

Enter the maximum number of times your device is to try to re-
send the L2TP control packet for which is received no response.

16 VPN



Field Description

The available values are 8to 255, the default value is 5.

Data Packets Sequence Select whether your device is to use sequence numbers for
Numbers data packets sent through a tunnel on the basis of this profile.

The function is not currently used.
The function is activated with Enabled.

The function is disabled by default.
16.2.2 Users
In the VPN -> L2TP -> Users menu a list of all configured L2TP partners is shown.

16.2.2.1 New

Choose the New button to set up new L2TP partners.

R1xxx/R3xxx/R4xxx
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Fig. 116: VPN -> L2TP -> Users -> New

The VPN -> L2TP -> Users -> New menu consists of the following fields:

Fields in the Users Basic Parameters menu

Field Description

Description

Connector Type

Enter a name for uniquely identifying the L2TP partner.

The first character in this field must not be a number and no
special characters or umlauts must be used. The maximum
length of the entry is 25 characters.

Select whether the L2TP partner is to take on the role of the
L2TP network server (LNS) or the functions of a L2TP access
concentrator client (LAC client).
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Possible values:

e INS (default value): If you select this option, the L2TP partner
is configured so that it accepts L2TP tunnels and restores the
encapsulated PPP traffic flow.

e LAC: If you select this option, the L2TP partner is configured
so that it encapsulates a PPP traffic flow in L2TP and sets up
a L2TP tunnel to a remote LNS.

Tunnel Profile Only for Connection Type = LAC

Select a profile created in the Tunnel Profiles menu for the
connection to this L2TP partner.

User Name Enter the code of your device.
Password Enter the password.
Always on Select whether the interface should always be activated.

The function is activated with Enabled.

The function is disabled by default.

Connection Idle Timeout Only if Always on is disabled.

Enter the idle time in seconds for static short hold. The static
short hold setting determines how many seconds should pass
between sending the last traffic data packet and clearing the
connection.

Possible values are 0to 3600 (seconds). 0 deactivates the
short hold. The default value is 300.

Fields in the Users IP Mode and Routes menu

Field Description

IP Address Mode Select whether your device is to be assigned a static IP address
or whether it should be assigned this dynamically.

Possible values:

e Static (default value): You enter a static IP address.

* Provide IP Address: Only for Connection Type = LNS
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Default Route

Create NAT Policy

IP Assignment Pool
(IPCP)

Local IP Address

Route Entries

Your device dynamically assigns an IP address to the remote
terminal.

* Get IP Address: Only for Connection Type = LAC Your
device is dynamically assigned an IP address.

Only if IP Address Mode = Get IP Address
and Static

Select whether the route to this connection partner is to be
defined as the default route.

The function is activated with Enabled.

The function is disabled by default.

Only if IP Address Mode = Get IP Address
and Static

Specify whether Network Address Translation (NAT) is to be ac-
tivated for this connection.

The function is activated with Enabled.

The function is disabled by default.

Only if IP Address Mode = Provide IP Address

Select an IP pool configured in the WAN -> Internet + Dialup -
> IP Pools menu.

Only for IP Address Mode = Static

Enter the WAN IP address of your device.

Only for IP Address Mode = Static

Enter the Remote IP Address and Netmask of the L2TP part-
ner LAN and the corresponding Metric. Add new entries with
Add.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu
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Block after connection Enter the wait time in seconds before the device should try
failure for again after an attempt to set up a connection has failed. The de-
fault value is 300.

Authentication Select the authentication protocol for this L2TP partner.
Possible values:

* PAP/CHAP/MS-CHAP (default value): Primarily run CHAP, on
denial, the authentication protocol required by the PPTP part-
ner. (MSCHAP version 1 or 2 possible.)

e pPAP: Only run PAP (PPP Password Authentication Protocol);
the password is transferred unencrypted.

e CHAP: Only run cHAP (PPP Challenge Handshake Authentic-
ation Protocol as per RFC 1994); the password is transferred
encrypted.

e PAP/CHAP: Primarily run CHAP, otherwise PAP.

e MS-CHAPvI1: Only run MS-CHAP version 1 (PPP Microsoft
Challenge Handshake Authentication Protocol).

* MS-CHAPv2: Run MS-CHAP version 2 only.

Encryption If necessary, select the type of encryption that should be used
for data traffic to the L2TP partner. This is only possible if STAC
or MS-STAC compression is not activated for the connection. If
Encryption is set, the remote terminal must also support it, oth-
erwise a connection cannot be set up.

Possible values:

* None: MPP encryption is not used.

* Enabled (default value): MPP encryption V2 with 128 bit is
used to RFC 3078.

* windows compatible: MPP encryption V2 with 128 bit is
used as compatible with Microsoft and Cisco.

LCP Alive Check Check whether the reachability of the remote terminal is to be
checked by sending LCP echo requests or replies. This is re-
commended for leased lines, PPTP and L2TP connections.

The function is activated with Enabled.

The function is disabled by default.
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Prioritize TCP ACK Select whether the TCP download is to be optimised in the
Packets event of intensive TCP upload. This function can be specially
applied for asymmetrical bandwidths (ADSL).

The function is activated with Enabled.

The function is disabled by default.

Fields in the Advanced Settings IP Options menu
N =

OSPF Mode Select whether and how routes are propagated via the interface
and/or OSPF protocol packets are to be sent.

Possible values:

e Passive (default value) OSPF is not activated for this inter-
face, i.e. no routes are propagated or OSPF protocol packets
sent over this interface. Networks reachable over this inter-
face are, however, included when calculating the routing in-
formation and propagated over active interfaces.

e Active: OSPF is activated for this interface, i.e. routes are
propagated or OSPF protocol packets sent over this interface.

e Tnactive : OSPF is disabled for this interface.

Proxy ARP Mode Select whether your device is to respond to ARP requests from
its own LAN on behalf of the specific L2TP partner.

Possible values:

e Tnactive (default value): Deactivates Proxy ARP for this
L2TP partner.

* Up or Dormant: Your device only responds to an ARP re-
quest if the status of the connection to the L2TP partner is Up
(active) or Dormant. In the case of Dormant, your device
only responds to the ARP request; the connection is not set
up until someone actually wants to use the route.

* Up only: Your device responds to an ARP request only if the
status of the connection to the L2TP partner is Up (active), i.e.
a connection already exists to the L2TP partner.

DNS Negotiation Select whether your device receives IP addresses for primary
DNS server, secondary DNS server, primary WINS and sec-
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ondary WINS from the L2TP partner or sends these to the
L2TP partner.

The function is activated with Enabled.

The function is enabled by default.

16.2.3 Options

R T E s T
tec R JIVRBSSS | orguzge [English v | View |Standard ~| | Online Help | Logout flll'lh“l‘k@
- 1 w w w r
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UDF Source Port Selection Fixed
Rowting -
WAN M oK Cancel
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IPSec
L2TP
PPTP
GRE
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Firewall
VolP
Local Services
Maintenance

External Reporting

TR

Monitoring

Fig. 117: VPN -> L2TP -> Options
The VPN -> L2TP -> Options menu consists of the following fields:

Fields in the Options Global Options menu
Field Description

UDP Destination Port Enter the port to be monitored by the LNS on incoming L2TP
tunnel connections.

Available values are all whole numbers from 1 to 65535, the
default value is 1701, as specified in RFC 2661.

UDP Source Port Selec- Select whether the LNS should only use the monitored port
tion (UDP destination port) as the local source port for the L2TP
connection.

The function is activated with Fixed.
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The function is disabled by default.

16.3 PPTP

The Point-to-Point Tunnelling Protocol (=PPTP) can be used to set up an encrypted PPTP
tunnel to provide security for data traffic over an existing IP connection.

First a connection to an ISP (=Internet Service Provider) is set up at both sites. Once these
connections are available, a tunnel is set up to the PPTP partner over the Internet using
PPTP.

The PPTP subsystem sets up a control connection between the endpoints of the tunnel.
This is used to send control data to set up, keep alive and terminate the connection
between the two PPTP tunnel end-points. As soon as this control connection is set up, the
PPTP transfers the traffic data packed in GRE packets (GRE = Generic Routing Encapsu-
lation).

16.3.1 PPTP Tunnel

In the PPTP Tunnel menu, a list of all PPTP tunnels is shown.



16.3.1.1 New

Click on New to set up further PPTP partners.

bintec R1200 Language |English | | View |Standard ~| | Online Help | Logout

PPTP Tunnels Options

© warning: Not supported changes by Setup Tool:

PPTP Partner Parameters
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Passwaord [eennance
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Route Entries | I
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Fig. 118: VPN -> PPTP -> PPTP Tunnel -> New
The VPN -> PPTP -> PPTP Tunnel -> New menu consists of the following fields:

Fields in the menu, PPTP Tunnel PPTP Partner Parameter
Field Description

Description Enter a unique name for the tunnel.

The first character in this field must not be a number and no
special characters or umlauts must be used.

PPTP Mode Enter the role to be assigned to the PPTP interface.

R1xxx/R3xxx/R4xxx
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User Name
Password

Always on

Connection Idle Timeout

Remote PPTP IP Ad-
dress

Remote PPTP IP Ad-
dress/Hostname

Possible values:
* PNS (default value): this assigns the PPTP interface the role
of PPTP server.

e Wwindows Client Mode: this assigns the PPTP interface the
role of PPTP client.

Enter the user name.

Enter the password.
Select whether the interface should always be activated.

The function is activated with Enabled.

The function is disabled by default.

Only if Always up is disabled.

Enter the idle interval in seconds. This determines how many
seconds should pass between sending the last traffic data pack-
et and clearing the connection.

Possible values are 0to 3600 (seconds). 0 deactivates the
timeout.

The default value is 300.

Example: 10 for FTP transmission, 20 for LAN-to-LAN transmis-
sion, 90 for Internet connections.

Only for PPTP Mode = pPNSEnter the IP address of the PPTP
partner.

Only for PPTP Mode = windows Client ModeEnterthe IP
address of the PPTP partner.

Fields in the PPTP Tunnel IP Mode and Routes menu

Field 7 Description

IP Address Mode

Select whether your device is to be assigned a static IP address
or whether it should be assigned this dynamically.

Possible values:

e Static (default value): You enter a static IP address.

* Provide IP Address: Only if PPTP Mode = pnsYour

16 VPN
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device dynamically assigns an IP address to the remote ter-
minal.

* Get IP Address: Only if PPTP Mode = Windows Client
ModeYour device is dynamically assigned an IP address.

Default Route Only if IP Address Mode = static

Select whether the route to this connection partner is to be
defined as the default route.

The function is activated with Enabled.

The function is disabled by default.

Create NAT Policy
Only if IP Address Mode = Static

When you configure an ISDN connection, specify whether Net-
work Address Translation (NAT) is to be enabled.

The function is activated with Enabled.

The function is disabled by default.

Local IP Address Only for IP Address Mode = Static
Assign the IP address from your LAN to the ISDN interface
which is to be used as your device's internal source address.

Route Entries
Only if IP Address Mode = Static

Define routing entries for this connection partner.

* Remote IP Address: IP address of the destination host or
LAN.

* Netmask: Netmask of Remote IP Address.

* Metric: The lower the value, the higher the priority of the
route (possible values 0. . . 15). The default value is 1.

IP Assignment Pool
(IPCP) Only if IP Address Mode = Provide IP Address

Select an IP pool configured in the WAN -> Internet + Dialup -
> IP Pools menu. If an IP pool has not been configured here
yet, the message Not yet defined appears in this field.

The Advanced Settings menu consists of the following fields:
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Fields in the Advanced Settings menu
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Block after connection
failure for

Authentication

Encryption

LCP Alive Check

Enter the wait time in seconds before the device should try
again after an attempt to set up a connection has failed.

The default value is 300.

Select the authentication protocol for this PPTP partner.

Possible values:
e PAP: Only run PAP (PPP Password Authentication Protocol);
the password is transferred unencrypted.

e CHAP: Only run cHAP (PPP Challenge Handshake Authentic-
ation Protocol as per RFC 1994); the password is transferred
encrypted.

e pAP/CHAP: Primarily run CHAP, otherwise PAP.

* MS-CHAPv1: Only run MS-CHAP version 1 (PPP Microsoft
Challenge Handshake Authentication Protocol).

* PAP/CHAP/MS-CHAP: Give priority to CHAP, if refused use
the authentication protocol requested by the PPTP partner.
(MSCHAP version 1 or 2 possible.)

* MS-CHAPvZ2(default value): Run MS-CHAP version 2 only.

If necessary, select the type of encryption that should be used
for data traffic to the connection partner. If Encryption is set,
the remote terminal must also support it, otherwise a connection
cannot be set up.

Possible values:

* None: MPP encryption is not used.

* Enabled (default value): MPP encryption V2 with 128 bit is
used to RFC 3078.

* windows compatible: MPP encryption V2 with 128 bit is
used as compatible with Microsoft and Cisco.

Check whether the reachability of the remote terminal is to be
checked by sending LCP echo requests or replies. This is re-
commended for leased lines, PPTP and L2TP connections.

The function is activated with Enabled.
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The function is enabled by default.

Fields in the Advanced Settings IP Options menu
N =

OSPF Mode Select whether and how routes are propagated via the interface
and/or OSPF protocol packets are to be sent.

Possible values:

e Passive (default value) OSPF is not activated for this inter-
face, i.e. no routes are propagated or OSPF protocol packets
sent over this interface. Networks reachable over this inter-
face are, however, included when calculating the routing in-
formation and propagated over active interfaces.

e Active: OSPF is activated for this interface, i.e. routes are
propagated or OSPF protocol packets sent over this interface.

e Tnactive : OSPF is disabled for this interface.

Proxy ARP Mode Select whether your device is to answer APR requests from
your LAN on behalf of the specific PPTP partner.

Possible values:

e Tnactive (default value): Disables Proxy-ARP (Address
Resolution Protocol) for this PPTP partner.

* Up or Dormant: Your device answers an APR request only
if the status of the connection to the PPTP partner is Active
or Idle. In the case of Dormant, your device only responds
to the ARP request; the connection is not set up until
someone actually wants to use the route.

* Up only: Your device answers an APR request only if the
status of the connection to the PPTP partner is Active, i.e. if
a connection to the PPTP partner has already been estab-
lished.

DNS Negotiation Select whether your device should obtain IP addresses for
Primary DNS client, Secondary DNS client from the PPTP
partner or should send these to the PPTP partner.

The function is activated with Enabled.

The function is enabled by default.



Funkwerk Enterprise Communications GmbH

Fields in the Advanced Settings PPTP Callback menu

= =

Callback

Incoming ISDN Number

Outgoing ISDN Number

Enables a PPTP tunnel through the Internet to be set up with a
PPTP partner, even if the partner is currently inaccessible. As a
rule, the PPTP partner will be requested by means of an ISDN
call to go online and set up a PPTP connection.

The function is activated with Enabled.
The function is disabled by default.

Note that you must activate the relevant option on the gateways
of both partners. An ISDN connection is usually required for this
function. Without ISDN, callback is only to be activated in spe-
cial applications.

Only if Callback is enabled.

Enter the ISDN number from which the remote device calls the
local device (calling party number).

Only if Callback is enabled.

Enter the ISDN number with which the local device calls the re-
mote device calls (called party number).

Fields in the Advanced Settings Dial Port Selection (only if callback = enabled) menu

Field Description

Selected Ports

Specific Ports

Enter the ISDN port over which callback is carried out.
Possible values:
e A1l Ports: The callback is routed over an available ISDN

port.

* Specify ports: You can select the required ISDN port un-
der Specific Ports.

Only if Selected Ports = Specify ports can you use Add to
select further ports.

16 VPN



16 VPN

16.3.2 Options
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In this menu, you can make general settings of the global PPTP profile.
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Fig. 119: VPN -> PPTP -> Options

The menu, VPN -> PPTP -> Options consists of the following fields:

Fields in the Options Global Options menu
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GRE Window Adaption

GRE Window Size

Select whether the GRE Window Adaptation is to be enabled.

This adaptation only becomes necessary if you have down-
loaded service pack 1 from the Microsoft Windows XP page and
installed it. Since, in SP 1, Microsoft has changed the confirma-
tion algorithm in the GRE protocol, the automatic window adapt-
ation for GRE must be turned off on the funkwerk side.

The function is activated with Enabled.

The function is enabled by default.

Enter the maximum number of GRE packets that can be sent
without confirmation.

Windows XP uses a higher initial reception window in the GRE,
which is why the maximum send window size on the funkwerk
side must be adjusted here via the value, GRE Window Size.



Field Description

Possible values are 0to 256.

Default value is 0.

16.4 GRE

Generic Routing Encapsulation (GRE) is a network protocol that encapsulates other proto-
cols and transports them in the form of IP tunnels to the specified recipients.

The specification of the GRE protocol is available in two versions:

* GRE V.1 for use in PPTP connections (RFC 2637, configuration in the PPTP menu)
* GRE V.0 (RFC 2784) for general encapsulation using GRE

In this menu you can configure a virtual interface for using GRE V.0. The data traffic routed
over this interface is then encapsulated using GRE and sent to the specified recipient.

16.4.1 GRE Tunnels

In the VPN -> GRE -> GRE Tunnels menu, a list of all configured GRE tunnels is shown.

16.4.1.1 New

Choose the New button to set up new GRE tunnels.

bintec R1200 Language English v | ‘iew  Stancard ~| | Online Help | Logout

GRE Tunnels

Basic Parameters

Description I

Local GRE IP Address |

Remots GRE IP Address |

Default Route CEnabled
Local IP Address l—
Remote P Address Metmask Metric
Route Entries I |
Add
MTU [iso0
Use key Clenabled

( oK ) ( Cancel )

Fig. 120: VPN -> GRE -> GRE Tunnels
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Fields in the GRE Tunnels Basic Parameters menu
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Description Enter a description for the GRE tunnel.

Local GRE IP Address
Enter the source IP address of the GRE packets to the GRE
partner.

If no IP address is given (this corresponds to IP address
0.0.0.0), the source IP address of the GRE packets is selected
automatically from one of the addresses of the interface via
which the GRE partner is reached.

Remote GRE IP Ad- Specify the destination IP address of the host or network to
dress which the packets are to be sent through the GRE tunnel.

Default Route
If you enable the Default Route, all data is automatically routed

to one connection.

The function is disabled by default.

Local IP Address
Enter the IP address to be used as the source address for this

GRE connection.

Route Entries
Define other routing entries for this connection partner.

Add a new entry with Add.
e Remote IP Address: |P address of the destination host or
network.

* Netmask: Netmask of Remote IP Address. If no entry is
made, your device uses a default netmask.

* Metric: The lower the value, the higher the priority of the
route (possible values 0... 15). The default value is 1.

MTU
Enter the maximum packet size (Maximum Transfer Unit, MTU)
in bytes that is allowed for the GRE connection between the
partners.
Possible values are 1to 8192.
The default value is 1500.

Use key

Enable the key input for the GRE connection, which makes it
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possible to distinguish between several parallel GRE connec-
tions between two GRE partners (see RFC 1701).

The key is activated with Enable.

The function is disabled by default.

Key Value
Only if Use Key is enabled.

Enter the GRE connection key.
Possible values are 0to 2147483647.

The default value is 0.

16.5 Certificates

16.5.1 Certificate List

In the VPN -> Certificates -> Certificate List menu a list of all available certificates is
shown.

16.5.1.1 Edit

Click the icon to display the content of the selected object (key, certificate, or request).
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Fig. 121: VPN -> Certificates -> Certificate List->

The certificates and keys themselves cannot be changed, but a few external attributes can
be changed, depending on the type of the selected entry.

The VPN -> Certificates -> Certificate List -> menu consists of the following fields:

Fields in the menu
Field Description

Description Shows the name of the certificate, key, or request.

Certificate is CA Certific- Mark the certificate as a certificate from a trustworthy certifica-
ate tion authority (CA).

Certificates issued by this CA are accepted during authentica-
tion (unless specified otherwise under "Phase-1 Profiles").

The function is activated with True.

The function is disabled by default.

Certificate Revocation Only for Certificate is a CA certificate = True.
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List (CRL) Checking Define the extent to which certificate revocation lists (CRLs) are
to be included in the validation of certificates issued by the own-
er of this certificate.

Possible settings:

e Disabled: No checking of CRLs.
e Always: CRLs are always checked.

® Only if a CRL Distribution Point 1is present
(default value): A check is only carried out if a CRL Distribu-
tion Point entry is included in the certificate. This can be de-
termined under "View Details" in the certificate content.

* Use Settings from superior certificate: The set-
tings of the higher level certificate are used, if one exists. It is
does not, the same procedure is used as that described under
"Only if a CRL Distribution Point is present".

Force certificate to be Define that this certificate is to be accepted as the user certific-
trusted ate without further checks during authentication.

The function is activated with True.

The function is disabled by default.

f Caution
It is extremely important for VPN security that the integrity of all certificates manually
marked as trustworthy (certification authority and user certificates) is ensured. The dis-
played "fingerprints" can be used to check this integrity: Compare the displayed values
with the fingerprints specified by the issuer of the certificate (e.g. on the Internet). It is
sufficient to check one of the two values.

16.5.1.2 Request

Registration authority certificates in SCEP
If SCEP is used, your device also supports separate registration authority certificates.

Registration authority certificates are used by some Certificate Authorities (CAs) to handle
certain tasks (signature and encryption) during SCEP communication with separate keys,
and to delegate the operation to separate registration authorities, if applicable.



When a certificate is downloaded automatically, i.e. if CA Certificates = -Download- is
selected, all the certificates needed for the operation are loaded automatically.

If all the necessary certificates are already available in the system, these can also be selec-
ted manually.

Select the Request button to request or import more certificates.

4
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Fig. 122: VPN -> Certificates -> Certificate List -> Request

The VPN -> Certificates -> Certificate List -> Request menu consists of the following
fields:

Fields in the Certificate List Certificate Request menu

Field Description

Certificate Request De-  Enter a unique description for the certificate.
scription

Mode Select the way in which you want to request the certificate.

R1xxx/R3xxx/R4xxx
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Generate Private Key

SCEP URL

CA Certificate

Possible settings:

e Manual (default value): Your device generates a PKCS#10
for the key. This file can then be uploaded directly in the
browser or copied in the Edit menu using the View Details
field. This file must be provided to the CA and the received
certificate must then be imported manually to your device.

* SCEP: The key is requested from a CA using the Simple Cer-
tificate Enrolment Protocol.

Only if Mode = Manual.

Select an algorithm for key creation.

RSA (default value) and DSA are available.

Also select the length of the key to be created.
Possible values: 512, 768, 1024, 1536, 2048, 4096.

Please note that a key with a length of 512 bits could be rated
as unsecure, whereas a key of 4096 bits not only needs a lot of
time to create, but also occupies a major share of the resources
during IPSec processing. A value of 768 or more is, however,
recommended and the default value is 1024 bits.

Only if Mode = SCEP.

Enter the URL of the SCEP server, e.g. ht-
tp://scep.funkwerk.de:8080/scep/scep.dll

Your CA administrator can provide you with the necessary data.

Only if Mode = SCEP.

Select the CA certificate.

e -Download-: In CA Name, enter the name of the CA certific-
ate of the certification authority (CA) from which you wish to
request your certificate, e.g. cawindows. Your CA adminis-
trator can provide you with the necessary data.

If no CA certificates are available, the device will first down-
load the CA certificate of the relevant CA. It then continues
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with the enrolment process, provided no more important para-
meters are missing. In this case, it returns to the Generate
Certificate Request menu.

If the CA certificate does not contain a CRL distribution point
(Certificate Revocation List, CRL), and a certificate server is
not configured on the device, the validity of certificates from
this CA is not checked.

* <name of an existing certificate>: If all the necessary certific-
ates are already available in the system, you select these
manually.

RA Sign Certificate Only if Mode = SCEP.
Only if CA Certificates is not = -Download-.
Select a certificate for signing SCEP communication.

The default value is ~-Use CA Certificate-,i.e.the CA cer-
tificate is used.

RA Encrypt Certificate ~ Only if Mode = SCEP.
Only if RA Sign Certificate is not = -Use CA Certificate-.

If you use one of your own certificates to sign communication
with the RA, you can select another one here to encrypt com-
munication.

The default value is -Use RA Sign Certificate-,i.e.the
same certificate is used as for signing.

Password Only if Mode = SCEP.

You may need a password from the certification authority to ob-
tain certificates for your keys. Enter the password you received
from the certification authority here.

Fields in the Certificate List Subject Name menu
Field Description

Custom Select whether you want to enter the name components of the
subject name individually as specified by the CA or want to
enter a special subject name.
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Summary

Common Name

E-mail

Organisational Unit

Organisation

Locality

State/Province

Country

If Enabled is selected, a subject name can be given in Con-
densed with attributes that are not offered in the list. Example:
"CN=VPNServer, DC=mydomain, DC=com, c=DE".

If the field is not marked, enter the name components in Gener-
al name, e-mail, Organisational Unit, Organisation, Locality,
State/Province and Country.

The function is disabled by default.

Only for Custom = enabled.
Enter a subject name with attributes not offered in the list.

Example: "CN=VPNServer, DC=mydomain, DC=com, c=DE".

Only for Custom = disabled.

Enter the name according to CA.

Only for Custom = disabled.

Enter the e-mail address according to CA.

Only for Custom = disabled.

Enter the organisational unit according to CA.

Only for Custom = disabled.

Enter the organisation according to CA.

Only for Custom = disabled.

Enter the location according to CA.

Only for Custom = disabled.

Enter the state/province according to CA.

Only for Custom = disabled.

Enter the country according to CA.

The Advanced Settings menu consists of the following fields:
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#1, #2, #3 For each entry, define the type of name and enter additional
subject names.

Possible values:

¢ None (default value): No additional name is entered.
e 7P: An IP address is entered.

e DNS: A DNS name is entered.

* Email: An e-mail address is entered.

* URI: A uniform resource identifier is entered.

* DN: A distinguished name (DN) name is entered.

* RID: A registered identity (RID) is entered.

Fields in the Advanced Settings Options menu

Field Description

Autosave Mode Select whether your device automatically stores the various
steps of the enrolment internally. This is an advantage if enrol-
ment cannot be concluded immediately. If the status has not
been saved, the incomplete registration cannot be completed.
As soon as the enrolment is completed and the certificate has
been downloaded from the CA server, it is automatically saved
in the device configuration.

The function is activated with Enabled.

The function is enabled by default.

16.5.1.3 Import

Choose the Import button to import other certificates.
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Fig. 123: VPN -> Certificates -> Certificate List -> Import

The VPN -> Certificates -> Certificate List -> Import menu consists of the following
fields:

Fields in the Certificate List Import menu

Field Description

External Filename Enter the file path and name of the certificate to be imported, or
use Browse... to select it from the file browser.

Local Certificate De- Enter a unique description for the certificate.

scription

File Encoding Select the type of coding so that your device can decode the
certificate.

Possible values:

* auto (default value) Activates automatic code recognition. If
downloading the certificate in auto mode fails, try with a cer-
tain type of encoding.

® Baseb64
® Binary
Password You may need a password to obtain certificates for your keys.

Enter the password here.

R1xxx/R3xxx/R4xxx



16.5.2 CRLs

In the VPN -> Certificates -> CRLs menu a list of all CRLs is shown.

16.5.2.1 Import

Choose the Import button to import other CRLs.

bintec R120 Language |English | | Wiew |Sandard v| | Online Help | Logout

= Certificate List CRLs Certificate Servers

CRL Import

External Filename | Browse

Lacal Cerificate Description |

File Encoding

Password I
IPSec
LT C oK 0 ( cancel )

GRE

Certificates

nfig

Fig. 124: VPN -> Certificates -> CRLs-> Import
The VPN -> Certificates -> CRLs -> Import menu consists of the following fields:

Fields in the CRLs CRL Import menu
Field Description

External Filename Enter the file path and name of the CRL to be imported, or use
Browse... to select it from the file browser.

Enter a unique description for the CRL.
Local Certificate De-

scription

File Encoding Select the type of encoding, so that your device can decode the
CRL.

Possible values:

* auto (default value) Activates automatic code recognition. If

R1xxx/R3xxx/R4xxx



Field Description

downloading the CRL in auto mode fails, try with a certain
type of encoding.

® Baseb64

® Binary

Password Enter the password to be used for the import.

16.5.3 Certificate Servers

In the VPN -> Certificates -> Certificate Servers menu a list of all certificate servers is
shown.

16.5.3.1 New

Choose the New button to set up new certificate servers.

Language |English | | ‘iew |Standard ~| | Online Help | Logout

Certificate List CRLs Certificate Servers

Basic Parameters

Cescription I

LDAF URL Fath =

( oK O cancel )

Fig. 125: VPN -> Certificates -> Certificate Servers -> New

The VPN -> Certificates -> Certificate Servers -> New menu consists of the following
fields:

Fields in the Certificate Servers Basic Parameters menu
Field Description

Description Enter a unique description for the certificate server.

R1xxx/R3xxx/R4xxx



Field Description

LDAP URL Path Enter the LDAP URL of the server.

R1xxx/R3xxx/R4xxx
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Chapter 17 Firewall

The Stateful Inspection Firewall (SIF) provided for bintec gateways is a powerful security
feature.

The SIF with dynamic packet filtering has a decisive advantage over static packet filtering:
The decision whether or not to send a packet cannot be made solely on the basis of source
and destination addresses or ports but also using dynamic packet filtering based on the
state of the connection to a partner.

This means packets that belong to an already active connection can also be forwarded.
The SIF also accepts packets that belong to an "affiliated connection". The negotiation of
an FTP connection takes place over port 21, for example, but the actual data exchange can
take place over a completely different port.

SIF and other security features

bintec’s Stateful Inspection Firewall fits into the existing security architecture of bintec
device very well due to its simple configuration. The configuration work for the SIF is com-
paratively straightforward with systems like Network Address Translation (NAT) and IP Ac-
cess Lists (IPAL).

As SIF, NAT and IPAL are active in the system simultaneously, attention must be given to
possible interaction: If any packet is rejected by one of the security instances, this is done
immediately. This is irrelevant whether another instance would accept it or not. Your need
for security features should therefore be accurately analysed.

The essential difference between SIF and NAT/IPAL is that the rules for the SIF are gener-
ally applied globally, i.e. not restricted to one interface.

In principle, the same filter criteria are applied to the data traffic as those used in NAT and
IPAL:

¢ Source and destination address of the packet (with an associated netmask)

» Service (preconfigured, e.g. Echo, FTP, HTTP)

¢ Protocol

* Port number(s)

To illustrate the differences in packet filtering, a list of the individual security instances and
their method of operation is given below:
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NAT

One of the basic functions of NAT is the translation of the local IP addresses of your LAN
into the global IP addresses you are assigned by your ISP and vice versa. All connections
initiated externally are first blocked, i.e. every packet your device cannot assign to an exist-
ing connection is rejected. This means that a connection can only be set up from inside to
outside. Without explicit permission, NAT rejects every access from the WAN to the LAN.

IP Access Lists

Here packets are permitted or rejected exclusively on the basis of the criteria listed above,
i.e. the state of the connection is not considered (except where Services = tcp).

SIF

The SIF sorts out all packets that are not explicitly or implicitly allowed. The result can be a
"deny", in which case no error message is sent to the sender of the rejected packet, or a
"reject", where the sender is informed of the packet rejection.

The incoming packets are processed as follows:

* The SIF first checks if an incoming packet can be assigned to an existing connection. If
so, it is forwarded. If the packet cannot be assigned to an existing connection, a check is
made to see if a suitable connection is expected (e.g. as affiliated connection of an exist-
ing connection). If so, the packet is also accepted.

* |f the packet cannot be assigned to any existing or expected connection, the SIF filter
rules are applied: If a deny rule matches the packet, the packet is rejected without send-
ing an error message to the sender of the packet; if a reject rule matches, the packet is
rejected and an ICMP Host Unreachable message sent to the sender of the packet. The
packet is only forwarded if an accept rule matches.

* All packets without matching rules are rejected without sending an error message to the
sender when all the existing rules have been checked (=default behaviour).

171 Policies



17.1.1 Filter Rules

The default behavior with Action = Access consists of two implicit filter rules: If an incom-
ing packet can be assigned to an existing connection and if a suitable connection is expec-
ted (e.g. such as an affiliated connection of an existing connection), the packet is allowed.

The sequence of filter rules in the list is relevant: The filter rules are applied to each packet
in succession until a rule matches. If overlapping occurs, i.e. more than one filter rule
matches a packet, only the first rule is executed. This means that if the first rule denies a
packet, whereas a later rule allows it, the packet is rejected. A deny rule also has no effect
if a relevant packet has previously been allowed by another filter rule.

In the Firewall -> Policies -> Filter Rules menu, a list of all configured filter rules is
shown. Select the show administrative access rules option to display existing filter rules for
administrative access to your device (see System Management -> Administrative Ac-
cess -> Access). These rules can also be edited here.

bintec R1200 ; Language English v | ‘iew |Standard ~| | Online Help | Logout

Filter Rules QoS Options

wiew |20 per page Fmerun MNone | equal V|

Orter | Source Destination Service Action Tratfic Priority Folicy active
Page: 1

Show administrative access rules (|

C New ) oK 0 ( cancel )

Fig. 126: Firewall -> Policies -> Filter Rules

You can use the Eﬂ button to insert another policy above the list entry. The configuration
menu for creating a new policy opens.

You can use the [ button to move the list entry. A dialog box opens, in which you can se-
lect the position to which the policy is to be moved.

Moreover, the overview provides the option to show the firewall rules of the underlying set-
tings made in the System Management -> Administrative Access -> Access menu. To
do this, enable the Show administrative access rules option.

R1xxx/R3xxx/R4xxx
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171.1.1 New
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Fig. 127: Firewall -> Policies -> Filter Rules -> New

The Firewall -> Policies -

Fields in the Filter Rules

> Filter Rules -> New menu consists of the following fields:

Basic Parameters menu

I =

Source

Destination

Select one of the preconfigured aliases for the source of the
packet.

The list includes all WAN-/LAN interfaces, interface groups (see
Firewall -> Interfaces -> Groups), addresses (see Firewall ->
Addresses -> Address List) and address groups (see Firewall
-> Addresses -> Groups) for selection.

The value Any means that neither the source interface nor the
source address is checked.

Select one of the preconfigured aliases for the destination of the
packet.

The list includes all WAN-/LAN interfaces, interface groups (see
Firewall -> Interfaces -> Groups), addresses (see Firewall ->
Addresses -> Address List) and address groups (see Firewall
-> Addresses -> Groups) for selection.
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The value Any means that neither the destination interface nor
the destination address is checked.

Service Select one of the preconfigured services to which the packet to
be filtered must be assigned.

The extensive range of services configured ex works includes
the following:

* FTP

® TELNET

® SMTP

® DNS

® HTTP

® NNTP

® Internet

®* Netmeeting

Other services are set up in Firewall -> Services -> Service
List.

In addition, the service groups configured in Firewall -> Ser-
vices -> Groups can be selected.

Action Select the action to be applied to a filtered packet.
Possible values:

e Access (default value): The packets are forwarded on the
basis of the entries.

* Deny : The packets are rejected.

* Reject : The packets are rejected. An error message is is-
sued to the sender of the packet.

Apply QoS Only for Action = Access

Select whether you want to enable QoS for this policy with the
priority selected in Data Traffic Priority

The function is activated with Enabled.

The option is deactivated by default.
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If QoS is not activated for this policy, bear in mind that the data
cannot be prioritised on the sender side either.

A policy for which QoS has been enabled is also set for the fire-
wall. Make sure therefore that data traffic that has not been ex-
pressly authorised if blocked by the firewall!

Traffic Priority Only for Apply QoS = enabled

Select the priority with which the data specified by the policy is
handled on the send side.

Possible values:

* None (default value): No priority.

* Low Latency: Low Latency Transmission (LTT), i.e. hand-
ling of data with the lowest possible latency, e.g. suitable for
VolIP data.

®* High
® Medium

* Low

17.1.2 QoS

More and more applications need increasingly larger bandwidths, which are not always
available. Quality of Service (QoS) makes it possible to distribute the available bandwidths
effectively and intelligently. Certain applications can be given preference and bandwidth re-
served for them.

In the Firewall -> Policies -> QoS menu, a list of all QoS rules is shown.

171.2.1 New

Choose the New button to set up new QoS rules.
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Fig. 128: Firewall -> Policies -> QoS -> New
The Firewall -> Policies -> QoS -> New menu consists of the following fields:

Fields in the QoS Configure QoS Interface menu

TR T

Interface Select the interface on which bandwidth management is to be
carried out.
Traffic Shaping Select whether you want to activate bandwidth management for

the selected interface.
The function is activated with Enabled.

The function is disabled by default.

Specify bandwidth Only for Traffic Shaping = Enabled.
Enter the maximum available bandwidth in kbps for the selected
interface.

Filter Rules This field contains a list of all configured firewall policies for

which QoS was enabled (Apply QoS = Enabled). The follow-
ing options are available for each list entry:

e Use: Select whether this entry should be assigned to the QoS
interface. The option is deactivated by default.

¢ Bandwidth: Enter the maximum available bandwidth in Bps
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for the service specified under Services. 0 is entered by de-
fault.

* Fixed: Select whether the bandwidth defined in Bandwidth
can be exceeded in the longer term. By activating this field,
you specify that it cannot be exceeded. If the option is deac-
tivated, the bandwidth can be exceeded and the excess data
rate is handled in accordance with the priority defined in the
firewall policy. The option is deactivated by default.

17.1.3 Options
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Fig. 129: Firewall -> Policies -> Options
The Firewall -> Policies -> Options menu consists of the following fields:

Fields in the Options Global Firewall Options menu
I =

Firewall Status Enable or disable the firewall function.
The function is activated with Enabled.

The function is enabled by default.

Logged Actions Select the firewall syslog level.
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The messages are output together with messages from other
subsystems.

Possible values:

e Al1 (default value): All firewall activities are displayed.
* Deny : Only reject and deny events are shown, see "Action".
e Accept : Only accept events are shown.

* None: Syslog messages are not generated.

Fields in the Options Session Timer menu
I =

UDP Inactivity Enter the inactivity time after which a UDP session is to be re-
garded as expired (in seconds).

Possible values are 30to 86400.

The default value is 180.

TCP Inactivity Enter the inactivity time after which a TCP session is to be re-
garded as expired (in seconds).

Possible values are 30to 86400.

The default value is 3600.

PPTP Inactivity Enter the inactivity time after which a PPTP session is to be re-
garded as expired (in seconds).

Possible values are 30to 86400.

The default value is 86400.

Other Inactivity Enter the inactivity time after which a session of another type is
to be regarded as expired (in seconds).

Possible values are 30to 86400.

The default value is 30.

17.2 Interfaces



172.1 Groups

In the Firewall -> Interfaces -> Groups menu, a list of all configured interface groups is
shown.

You can group together the interfaces of your device. This makes it easier to configure fire-
wall rules.

17.2.1.1 New

Choose the New button to set up new interface groups.
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Fig. 130: Firewall -> Interfaces -> Groups -> New
The Firewall -> Interfaces -> Groups -> New menu consists of the following fields:

Fields in the Groups Basic Parameters menu

Field Description
Description Enter the desired description of the interface group.
Members Select the members of the group from the available interfaces.

To do this, enable the field in the Members column.

17.3 Addresses

R1xxx/R3xxx/R4xxx



17.3.1 Address List

In the Firewall -> Addresses -> Address List menu, a list of all configured addresses is
shown.

17.3.1.1 New

Choose the New button to set up new addresses.
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Fig. 131: Firewall -> Addresses -> Address List -> New
The Firewall -> Addresses -> Address List -> New menu consists of the following fields:

Fields in the Address List Basic Parameters menu

Field Description
Description Enter the desired description of the address.
Address Type Select the type of address you want to specify.

Possible values:

* Address / Subnet (default value): Enter an IP address
with subnet mask.

* Address Range: Enter an IP address range with a start and
end address.

Address / Subnet Only if Address Type = Address / Subnet

R1xxx/R3xxx/R4xxx



Field Description

Enter the IP address of the host or a network address and the
related netmask.

The default value is 0.0.0. 0.

Address Range Only if Address Type = Address Range

Enter the start and end IP address of the range.

17.3.2 Groups

In the Firewall -> Addresses -> Groups menu, a list of all configured address groups is
shown.

You can group together addresses. This makes it easier to configure firewall rules.

17.3.2.1 New

Choose the New button to set up new address groups.

bintec R1200 ; Language English v | ‘iew |Standard ~| | Online Help | Logout

Address List| Groups

Basic: Parameters

Description

) Addresses | Selection
Selection ANY ]

( OK ) ( Cancel )

Fig. 132: Firewall -> Addresses -> Groups -> New
The Firewall -> Addresses -> Groups -> New menu consists of the following fields:

Fields in the Groups Basic Parameters menu
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Description

Selection

Enter the desired description of the address group.

Select the members of the group from the available Addresses.
To do this, enable the field in the Selection column.

174 Services

174.1 Service List

In the Firewall -> Services -> Service List menu, a list of all available services is shown.

174.1.1 New

Choose the New button to set up new services.

o leind

-
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Mk]"lll | Language |En | | view [Swndard v| | Online Help | Logout f‘_l_l:l_k“l‘k@
T | - Ta" w T '

Save configur ation
Assistants -
System Management -
Physical Interfaces -
LAN -
Wireless LAN -
Routing -
WAN b
VPN -

Firewall -
Policies
Interfaces
Addresses
Services

VolP -
Local Services -
Maintenance -
External Reporting -

Monitoring -

Service List Groups

Basic Parameters

Cescription
Protocal Ay ~
0K Cancel

Fig. 133: Firewall -> Services -> Service List -> New

The Firewall -> Services -> Service List -> New menu consists of the following fields:

Fields in the Service List Basic Parameters menu

Field Description

Description

Protocol

Enter an alias for the service you want to configure.

Select the protocol on which the service is to be based. The
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Destination Port Range

Source Port Range

Type

most important protocols are available for selection.

Only if Protocol = TCP, UDP/TCP or UDP

In the first field, enter the destination port via which the service
is to run.

If a port number range is specified, in the second field enter the
last port of the port range. By default the field does not contain
an entry. If a value is displayed, this means that the previously
specified port number is verified. If a port range is to be
checked, enter the upper limit here.

Possible values are 1to 65535.

Only if Protocol = TCP, UDP/TCP or UDP

In the first field, enter the source port to be checked, if applic-
able.

If a port number range is specified, in the second field enter the
last port of the port range. By default the field does not contain
an entry. If a value is displayed, this means that the previously
specified port number is verified. If a port range is to be
checked, enter the upper limit here.

Possible values are 1to 65535.

Only if Protocol = 7cmP

The Type field shows the class of ICMP messages, the Code
field specifies the type of message in greater detail.

Possible values:

e Any (default value)

® Echo Replay

® Destination Unreachable
® Source Quench

® Redirect

® Echo

* Time Exceeded
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® Parameter Problem

* Timestamp

® Timestamp Reply

® Information Request
® Information Reply

¢ Address Mask Request

® Address Mask Reply

Code ICMP code options can only be selected if Type = Destina-
tion Unreachable.

Possible values:

e Any (default value)

® Net Unreachable

® Host Unreachable

® Protocol Unreachable
® Port Unreachable

®* Fragmentation Needed

® Communication with Destination Network is Ad-
ministratively Prohibited

® Communication with Destination Host is Admin-

istratively Prohibited

174.2 Groups

In the Firewall -> Services -> Groups menu, a list of all configured service groups is
shown.

You can group together services. This makes it easier to configure firewall rules.

174.2.1 New

Choose the New button to set up new service groups.
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Fig. 134: Firewall -> Services ->Groups -> New
The Firewall -> Services-> Groups -> New menu consists of the following fields:

Fields in the Groups Basic Parameters menu

Field Descriptio
Description Enter the desired description of the service group.
Members Select the members of the group from the available service ali-

ases. To do this, enable the field in the Members column.
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Chapter 18 VolP

Voice over IP (VolP) uses the IP protocol for voice and video transmission.

The main difference compared with conventional telephony is that the voice information is
not transmitted over a switched connection in a telephone network, but divided into data
packets by the Internet protocol and these packets are then passed to the destination over
undefined paths in a network. This technology uses the existing network infrastructure for
voice transmission and shares this with other communication services.

18.1 Application Level Gateway

To enable IP telephones to connect by SIP to a VoIP Provider your device has an Applica-
tion Level Gateway (ALG), i.e. an appropriate proxy that implements the necessary NAPT
and firewall releases.

&1 Note

The Application Level Gateway must always be used if NAT is enabled on the inter-
face that makes the connection to the Internet.

18.1.1 SIP Proxies

Here you can view a list of application level gateway entries that have already been con-
figured. These entries enable the ALG. Each entry defines a particular TCP or UDP destin-
ation port that is to be supervised by the ALG. In the ex works state, there are two entries
configured for the SIP Ports TCP 5060 and UDP 5060 in accordance with the IANA defini-
tion.

R1xxx/R3xxx/R4xxx
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18.1.1.1 Edit/New

Choose the [i] icon to edit existing entries. Choose the Newbutton to create application
level gateway entries.

E L g P i
| IS SNESER ¥ n
tec R1 J"l-hﬁ—" Language |English »| | “iew |Standard ~| | online Help | Logout ﬁll'lk“l‘k@
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LAN h Description
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Rowting -

Protacal UDP v | Destination Port|0
WAN b
VPN - Session Timeaut 7200 sec
Firewall = Low Latency Transmission Clenabled
VolP -
Application Level Gateway OK Cancel

Local Services
Maintenance

External Reporting

Ml W

Monitoring

Fig. 135: VoIP -> Application Level Gateway -> SIP Proxies -> Edit/New
The VoIP -> Application Level Gateway -> SIP Proxies -> Edit/New menu, consists of
the following fields:

Fields in the SIP Proxies Basic Parameters menu
Field Description

Description Enter the name of the application level gateway.

Administrative Status Select whether the SIP proxy should be enabled or disabled.
The function is enabled by choosing Enabled.

The function is enabled by default.

Protocol Select the protocol to be used.
Possible values: UDP (default value) or TCP.

Under Destination Port enter the port to be supervised by the
proxy.

or each destination port to which VolIP clients from the LAN can
connect, you must configure a proxy.

The ports can be provider-specific.
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Session Timeout Enter the time in seconds for which a session stays up if no
data packets are sent or received.

This value must be greater than the SIP Expire Time of the con-
nected SIP client (SIP telephone, terminal adapter etc.)

The default value is 1800.

Low Latency Transmis-  Specify whether a mechanism should be used to minimise the
sion transit time of VolP data packets between two subscribers. This
guarantees good voice quality with high line load.

Note that low latency transmission only has to be enabled for
calls that are not established via the connections configured in
VoIP -> Media Gateway.

The function is enabled by choosing Enabled.

The function is disabled by default.

18.1.2 SIP Endpoints

Shows the sessions that are currently being managed by ALG.

This includes static entries to make internal SIP servers/proxies (e.g. internal Asterisk serv-
er) accessible from the WAN (Internet) by NAPT. In addition, internal SIP clients without re-
gistration can be made accessible using a static entry. All active SIP sessions that have
been initiated from internal SIP terminals are recognised dynamically and listed here.
These are only displayed for monitoring and administration and cannot be edited.

&n Note

All automatically created entries that are not used for longer than 24 hours are auto-
matically deleted from the table.

18.1.2.1 Edit/New

Choose the New button to add static entries for SIP terminals in the LAN that are to be ac-
cessible by terminals from the WAN across the NAPT barrier. Choose the icon to edit

existing static entries.
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@ Note

Entries created dynamically for active sessions cannot be edited. These entries can
only be removed resulting in the immediate termination of the corresponding SIP con-
nection.

E E o wletaae o1 gl B ¥
| IR NS o
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[ @l | = w ur x

Save configuration SIP Proxies SIP Endpoints
Assistants

System Management

Physical Iinterfaces Basic Parameters

LAN hd Type of Endpaint @ client O Server
Wireless LAN = Frotocal UDP »
Routing =
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WAN =
VPN - Remuote Port 0
Firewall - External Port 0
VolP =

Application Level Gateway oK Cancel

Local Services
Maintenance

External Reporting

Ml W

Monitoring

Fig. 136: VoIP -> Application Level Gateway -> SIP Endpoints -> Edit/New
The VoIP -> Application Level Gateway -> SIP Endpoints -> Edit/New menu, consists of
the following fields:

Fields in the SIP Endpoints Basic Parameters menu
Field Description
Type of Endpoint Select the role for the SIP endpoint in the LAN.

Possible values:

e Client (default value): The internal SIP endpoint is a SIP cli-
ent (e.g. telephone).

* Server: The internal SIP endpoint is a SIP server into which
the SIP endpoint can login externally.

Protocol Select the protocol to be used for data transmission.
Possible values: UDP (default value) or TCP.

If a protocol has been automatically recognised, it should not be
changed.
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Internal IP Address Specify the IP address for the internal SIP endpoint in the LAN.

Remote Port Only for Type of Endpoint = Client.

Enter the port of the removed SIP terminal (in the WAN).

Internal Port Only for Type of Endpoint = Server.

Enter the port for the internal SIP endpoint in the LAN.

External Port Specify the port on the WAN site of the gateway that is used for
access through the NAPT barriers to a SIP endpoint in the LAN.

For clients, the external port is recognised automatically and
should not be changed.

18.2 Media Gateway

A media gateway serves as a translation instance between different telecommunications
networks, e.g between the plain old phone network and the next generation networks (IP
networks).

With the Funkwerk Media Gateway, a company equipped with an automatic PBX on a
wired telephone network can be connected to a SIP Trunking Service Provider on the Inter-
net in order to use IP telephony.

The Funkwerk Media Gateway supports the binding of several SIP Provider Accounts. With
this gateway, you can set up extensions, create an extension number plan and configure
exchange functions and optimise voice data transmission for low bandwidth of the upload
connection.

&n Note

Your device must be fitted with a DSP module to be able to use the media gateway
functions. Information on building in the DSP module is provided in the installation in-
structions included with the module.



18.2.1 Subscriber

Here you can configure the numbers of the terminal devices (=Extensions) connected to
the media gateway, i.e. the numbers of the SIP terminals and the numbers of the ISDN ter-
minals, depending on the available interfaces.

In the VoIP -> Media Gateway -> Extensions menu, a list of all existing extensions is
shown.

18.2.1.1 Edit/New

Choose the @ icon to edit existing entries. Select the New button to create new exten-
sions.

bintec R4100 Language |English | | iew |Standard ~| | online Help | Logout

-l $IP Accounts | Call Routing | CLID Translation | Call Translation | ISDN Trunks | Options |
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Fig. 137: VoIP -> Media Gateway -> Extensions -> Edit/New

The VoIP -> Media Gateway -> Extensions -> Edit/New menu consists of the following
fields:

Fields in the Extensions Basic Parameters menu
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Description

Extension / User Name

Interface Type

Select ISDN interface

Registration

Expire Time

Enter the name of the extension.

ISDN terminals: Enter the subscriber number the extension.
SIP terminals: Enter the user name.

A maximum of 40 characters can be entered.

Select the interface type to be used.
The selection depends on the interfaces available.

Possible values:

e 51P: a SIP terminal device is used for the call.

e 7SDN: an ISDN terminal device is used for the call. Can only
be selected if ISDN interfaces configured with Euro ISDN
point-to-multipoint (NT mode) are available.

Only for Interface Type = 1SDN.

Select an ISDN interface. The ISDN interfaces you can select
depends on the device used.

Only for Interface Type = STP.

Specify whether the registration mechanism is to be used by
SIP REGISTER. Normally, every SIP client (user) sends its cur-
rent position to a REGISTRAR server by means of a RE-
GISTER message. This information about the user and his cur-
rent address is held by the REGISTRAR server and queried by
other proxies to find the user.

The function is activated with Enabled.
The function is enabled by default.

Apart from this standard procedure, the relevant data can also
be sent to a particular IP address that is already known to the
correspondent. Registration and authentication are not then
needed and the Registration function is disabled. An example
of this method is Microsoft Exchange SIP.

Only if Registration is enabled.
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SIP Endpoint IP Address

Authentication ID

Password

Protocol

Port

Enter the time in seconds after which the current registration be-
comes invalid and a new registration request is therefore sent.

For clients, the external port is recognised automatically and
should not be changed.

Possible values are 0to 3600.

The default value is 60.

Only if Registration is disabled.

For configurations with no registration (e.g. connection to a Mi-
crosoft Exchange Communication Server) the connection can
be set up as a static host. This requires you to specify the static
IP address of the terminal.

Only for Interface Type = S1P
Enter a name that is to be used for authentication.
A maximum of 20 characters can be entered.

The name given here must also be entered on the SIP tele-
phone.

If you do not enter a name, the name in the Extension / User
Name field is used.

Only for Interface Type = S1P
Enter a password here.
A maximum of 20 characters can be entered.

The password given here must also be entered on the SIP tele-
phone.

Select the protocol to be used for data transmission.
Possible values: UDP (default value) or TCP.

If a protocol has been automatically recognised, it should not be
changed.

Enter the number of the UDP or TCP port to be used for the
connection to the server or proxy.
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Possible values are 01to 65535.

The default value is 5060.

Fields in the Advanced Settings Codec Settings menu
N =

Codec Proposal Se- Choose the order in which the codecs are offered for use by the
quence media gateway. If the first codec cannot be used, the second is
tried and so on.

Possible values:
e Default (default value): the codec in the first position in the
menu will be used if possible.

* Quality: the codecs are sorted by quality. If possible, the
codec with the best quality is used.

* Lowest: the codecs are sorted by required bandwidth. If pos-
sible, the codec with the lowest bandwidth requirement is
used.

* Highest: the codecs are sorted by required bandwidth. If
possible, the codec with the highest bandwidth requirement is
used.

Sort Order Select the codecs to be proposed for the connection. The co-
decs chosen here are proposed in a certain order depending on
the setting in the Codec Proposal Sequence field.

Possible values:

* G.711 uLaw: ISDN codec with US law

* G.711 aLaw: ISDN codec with EU law

* G0.729: Compressed from 31 to 8 kbps; good voice quality
* G.726-40: Compressed from 63 to 40 kbps

e G.726-32: Compressed from 55 to 32 kbps

* G.726-24: Compressed from 47 to 24 kbps

* G.726-16: Compressed from 39 to 16 kbps

* DTMF Outband: DTMF Outband. First the system attempts to
use RFC 2833. If the remote terminal does not use this stand-
ard, SIP Info is used.
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e T.38 Fax: Allows the transmission of fax messages over
data networks.

G.711 ulLaw, G.711 aLawand G. 729 are enabled by default.

The codecs actually used are the intersect of the codecs
defined here and those signalled by the provider. For outgoing
calls, any remaining codecs are dropped from the list that would
require more than the available bandwidth.

Fields in the Advanced Settings Voice Quality Settings menu

I == =

Echo Cancellation Select whether echo cancellation should be used.

Echo cancellation is a technique to suppress echo feedback in
voice communication on full duplex lines.

The function is activated with Enabled.

The function is enabled by default.

Comfort Noise Genera-  Specify whether Comfort Noise Generation should be used.

tion (CNG)
For digital voice transmission, this function introduces a low

level of background noise to avoid the impression that, during
pauses at the other end, the connection is lost.

The function is activated with Enabled.

The function is enabled by default.

Packet Size Specify how many milliseconds of voice an RTP data packet
should contain.

Possible values are 5to 500.

The default value is 20.

18.2.2 SIP Accounts

If your want your device to connect to other SIP servers (e.g. servers of Internet SIP Ser-
vice providers), you can configure the necessary entries here. In this case, the media gate-
way acts as a SIP client.



Furthermore, you can configure the entries for SIP trunking scenarios here. In this case,
the media gateway acts as a SIP server for other SIP servers. An example for this is the
connection of a SIP PBX (e.g. Asterisk) to the media gateway.

This means that not only all SIP provider accounts are configured here but also direct dial-
in PBXs connected with the media gateway.

&1 Note

In no case should you use this menu to configure SIP extensions, i.e. for SIP clients or
PSTN clients such as SIP telephones, terminal adapters or ISDN telephones

SIP extensions can be configured in the VolIP ->Extensions menu.

In the VoIP -> Media Gateway -> SIP Accounts menu, a list of all existing SIP accounts
(SIP client mode and SIP server mode) is shown.

18.2.2.1 Edit/New

Select the New button to create new SIP accounts. Choose the @ icon to edit existing

entries. In this menu SIP accounts are configured in SIP client mode as well as in SIP serv-
er mode.
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Fig. 138: VoIP -> Media Gateway -> SIP Accounts -> Edit/New

The VoIP -> Media Gateway -> SIP Accounts -> Edit/New menu consists of the following
fields:

Fields in the SIP Accounts Basic Parameters menu
Field Description

Description Enter the name of the SIP account.

Administrative Status Select whether the SIP account should be enabled or disabled.
The function is activated with Enabled.

The function is enabled by default.

Trunk Mode Select whether and in which trunk mode the SIP account should
be operated.

R1xxx/R3xxx/R4xxx
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Registrar

SIP Endpoint IP Address

Outbound Proxy

Trunk mode (DDI, Direct Dial In) allows an incoming call to be
assigned correctly to a terminal (DDI). For an outgoing call, the
caller can be indicated to the called party.

The setting that you can use depends on the provider.

Possible values:
e off (default value) Trunk mode is not used. The SIP account
has only one number.

e Client: the media gateway is operated as DDI client. It is as-
signed a DDI.

* Server: The media gateway is operated as a DDI server so
that DDI clients can connect.

e gw-trunk :the media gateway is operated as DDI client, but
used as a trunk. This setting is used to connect a software-
based IP PBX from Swyx.

Only for Trunk-Modus = Off, Client and gw-trunk

Enter the IP address or domain name (FQDN) of the SIP regis-
trar or the SIP proxy server. The maximum number of charac-
ters is 40.

Entries with spaces are not allowed.

Only if Trunk Mode = Server und Registration deakt-

iviert

Enter the IP address or domain name (FQDN) of the SIP proxy
server.

Only if Trunk Mode = Off, Client Or gw-trunk.
Enter the name or IP address of the SIP outbound proxy server.
A maximum of 32 characters can be entered.

Here you must make an entry only if, for all SIP sessions, the
communication is not to be direct but via a further proxy.

In SIP client mode: Enter a name or IP address only if this is ex-
plicitly specified by the provider.
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Realm

Protocol

User Name

Authentication ID

Password

Registration

Enter a new domain name or a new IP address for the SIP
proxy server.

If you do not make an entry, the entry in the Registrar field is
used.

In SIP client mode: Enter a name or IP address only if this is ex-
plicitly specified by the provider.

Select the protocol to be used for data transport.
Possible values: UDP (default value) or TCP.

Enter the Port via which the data is to be transported.
The default value is 5060.

In SIP client mode: The ports can be provider-specific.

In SIP client mode: Enter the username for authentication if your
VolP provider has assigned one for you.

In SIP server mode: You must define the user name.

A maximum of 40 characters can be entered.

Enter a name that is to be used for authentication with the out-
bound proxy.

If you do not enter a name, the name in the User Name field is
used.

In SIP client mode: Enter a name only if this is explicitly spe-
cified by the provider.

In SIP client mode: The VolIP provider gives you a PIN or pass-
word for authentication. You must enter this value here.

In SIP server mode: Define a PIN or a password.

A maximum of 40 characters can be entered.

Specify whether the registration mechanism is to be used by
SIP REGISTER. Normally, every SIP client (user) sends its cur-
rent position to a REGISTRAR server by means of a RE-
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GISTER message. This information about the user and his cur-
rent address is held by the REGISTRAR server and queried by
other proxies to find the user.

The function is activated with Enabled.
The function is enabled by default.

Apart from this standard procedure, the relevant data can also
be sent to a particular IP address that is already known to the
correspondent. Registration and authentication are not then
needed and the Registration function is disabled. An example
of this method is Microsoft Exchange SIP.

Expire Time Only if Registration is enabled.

Enter the time in seconds after which the current registration be-
comes invalid and a new registration request is therefore sent.

Possible values are 0to 38400.
The default value is 600.

In answer to a REGISTER request, a server can set another Ex-
pire Time which overwrites the setting here.

Fields in the SIP Accounts Trunk Settings menu
Field Description

SIP Header Field(s) for ~ Only if Trunk Mode = Client, Server or gw-trunk.

Caller Address
Select the position of the sender ID (e.g. subscriber number) in

the SIP header for outgoing calls. (For incoming calls, the sub-
scriber number is taken automatically from the SIP header.)

Possible values:

* Disabled (default value): the sender ID is not sent.

* Display and User Name:the sender ID is placed in both
"Display" and "User" fields of the SIP header.

* Display only: the sender ID is placed in the "Display" field
of the SIP header.

e User only:the sender ID is placed in the "User" field of the
SIP header.
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e p-Preferred: The so-called "p-preferred-identity" field is ad-
ded to the SIP header and contains the sender ID.

e p-Asserted: The so-called "p-asserted-identity" field is ad-
ded to the SIP header and contains the sender ID.

Subscriber Number Only for Trunk Mode = Server.

You can set a number that is added as a prefix for outgoing
calls to the sender's number and is removed from the destina-
tion number for incoming calls. This corresponds to the trunk
(exchange) number of an exchange.

Fields in the Advanced Settings Codec Settings menu
Field Description

Codec Proposal Se- Choose the order in which the codecs are offered for use by the
quence media gateway. If the first codec cannot be used, the second is
tried and so on.

Possible values:
e Default (default value): the codec in the first position in the
menu will be used if possible.

* Quality: the codecs are sorted by quality. If possible, the
codec with the best quality is used.

* Low Bandwidth: the codecs are sorted by required band-
width. If possible, the codec with the lowest bandwidth re-
quirement is used.

e High Bandwidth: the codecs are sorted by required band-
width. If possible, the codec with the highest bandwidth re-
quirement is used.

Sort Order Select the codecs to be proposed for the connection. The co-
decs chosen here are proposed in a certain order depending on
the setting in the Codec Proposal Sequence field.

Possible values:

* G.711 uLaw:ISDN codec with US law

* G.711 aLaw:ISDN codec with EU law

* G0.729: Compressed from 31 to 8 kbps; good voice quality
* G.726-40: Compressed from 63 to 40 kbps
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e G.726-32: Compressed from 55 to 32 kbps
* G.726-24: Compressed from 47 to 24 kbps
* G.726-16: Compressed from 39 to 16 kbps

* DTMF Outband: DTMF Outband. First the system attempts to
use RFC 2833. If the remote terminal does not use this stand-
ard, SIP Info is used.

e T.38 Fax: Allows the transmission of fax messages over
data networks.

G.711 ulLaw, G.711 aLawand G. 729 are enabled by default.

The codecs actually used are the intersect of the codecs
defined here and those signalled by the provider. For outgoing
calls, any remaining codecs are dropped from the list that would
require more than the available bandwidth.

Fields in the Advanced Settings Voice Quality Settings menu
Field Description

Echo Cancellation Select whether echo cancellation should be used.

Echo cancellation is a technique to suppress echo feedback in
voice communication on full duplex lines.

The function is activated with Enabled.

The function is enabled by default.

Comfort Noise Genera-  Specify whether Comfort Noise Generation should be used.

tion (CNG)
For digital voice transmission, this function introduces a low

level of background noise to avoid the impression that, during
pauses at the other end, the connection is lost.

The function is activated with Enabled.

The function is enabled by default.

Packet Size Specify how many milliseconds of voice an RTP data packet
should contain.

Possible values are 5to 500.

The default value is 20.



18.2.3 Call Routing

Here you can define the conditions for the routing of calls. Define a list with rules or rule
chains that are used to manipulate the indicated destination numbers.

In the VoIP -> Media Gateway -> Call Routing menu, a list of all existing entries is shown.

18.2.3.1 Edit/New

Choose the @ icon to edit existing entries. Select the New button to create new entries.

Wiew | Standard b Online Help

Extensions SIP Accounts Call Routing CLID Translation Call Translation ISDN Trunks Options

Basic Parameters

Description
Administrative Status [Enable
Tyoe
Calling Line
Calling Address
—
calten Foress
; Friority Line Called Address Translation Status Action
: : o 50 T
Rauting Rule
Priority 1
Administrative Status [FlEnable
Cutbound Line
Called Address Translation

( oK ) ( Cancel )
Fig. 139: VoIP -> Media Gateway -> Call Routing -> Edit/New

The VoIP -> Media Gateway -> Call Routing -> Edit/New menu consists of the following
fields:

Fields in the Call Routing Basic Parameters menu
Field Description

Description Enter the name of the entry.

Administrative Status Select whether the entry should be activated.

The function is activated with Enabled.

R1xxx/R3xxx/R4xxx
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Type

Calling Line

Calling Address

Called Address

The function is enabled by default.

Specify how calls are to be routed.
Possible values:

* External (default value): For calls that are to be routed as
outgoing, external calls. This can be done using standard SIP
accounts or SIP trunking accounts in DDI client mode.

e Trunk: For calls forwarded by the media gateway to a PBX or
an ISDN TE connector or a SIP DDI client. For this, the follow-
ing can be used: PRI interfaces in NT mode, BRI interfaces in
NT mode, SIP accounts in trunk mode (server mode).

e Deny : For calls that are not to be routed (to be blocked).

You can restrict the application of the entry to the line on which
the call comes in.

The selection depends on the interfaces available and on the
SIP accounts that have been created.

Possible values:
* pri<Interface Index>: restricts the routing entry to the
selected PRI interface.

e bri<Interface Index>: restricts the routing entry to the
selected BRI interface.

* <SIP Account>: restricts the routing entry to the selected
SIP account.

* Any: No restriction of the entry.

You can restrict the application of the entry to a particular caller.
To do this, you must specify the subscriber number exactly (no
wildcards).

Enter the called address to which the rule is to be applied.

To do this, enter an address numerically (e.g. a subscriber num-
ber) or alphanumerically (e.g. for a trunk) that is to be compared
with a dialled address.

The following wildcards can be used:
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e * means that at the end of a character string any number of
characters may follow,

e ?is a placeholder for an arbitrary character.

If the configured address agrees with the signalled address, the
entry is used.

In the Routing Rules menu you can define rules to determine how the subscriber number
is manipulated before it is used for dialling.

Use Add to create entries.

Fields in the Call Routing Routing Rules menu (only if Type = External)
Field Description

Priority Enter a whole number starting with 1 in ascending order to
define the order of filter rules.

The rules are worked through in the order given in the list.

If a line or SIP account is not available, the next rule is automat-
ically used.

Administrative Status Select whether the rule should be activated.
The rule is activated with Enabled.

The rule is active by default.

Outbound Line Choose the ISDN line (PRI, BRI) or SIP account used for the
outgoing call.

Called Address Transla- Enter how the subscriber number is manipulated before it is
tion used for dialling.

Notation: <a:b>, i.e. a is replaced by b. A number of rules can
be chained together using semicolons as separators, e.g.
<a:b>;<c:d>;<e:f>. After confirmation of entry, the rule chain is
automatically sorted by the "best match" method.

Numerical and alphanumerical values are permissible.

? is a placeholder for an arbitrary character.
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Example 18.1. Example of a rule

* Rule: <:+49911>
* number dialled: 96731234
* manipulated number: +4991196731234

Fields in the Call Routing Routing Rules menu (only if Type = Trunk)

Field

Trunk Line

Called Address Transla-
tion

Description
Select the line to be used for the outgoing call.

Enter how the subscriber number is manipulated before it is
used for dialling.

Notation: <a:b>, i.e. a is replaced by b. A number of rules can
be chained together using semicolons as separators, e.g.
<a:b>;<c:d>;<e:f>. After confirmation of entry, the rule chain is
automatically sorted by the "best match" method.

Numerical and alphanumerical values are permissible.

? is a placeholder for an arbitrary character.

Example 18.2. Example of a rule

¢ Rule: <:+49911>
e number dialled: 96731234
* manipulated number: +4991196731234

18.2.4 CLID Translation

Here you define the processing of the calling party number for incoming calls. You can, for
example, add a prefix to a received call number in order to route corresponding outgoing
calls via a particular SIP account.

In the VoIP -> Media Gateway -> CLID Translation menu, a list of all existing entries is
shown on which the received number is edited.



18.2.4.1 Edit/New

Choose the @ icon to edit existing entries. Select the New button to create entries for

CLID translation.

Standard

Wiew Online Help

Extensions SIP Accounts Call Routing CLID Translation <Call Translation [SDN Trunks

Options

Basic Parameters

Cescription
Calling Line briz-0 (v
Called Line

Called Address

Calling Address Translation

Application Level Gateway
Media Gateway

€ OK ) € Cancel )

Fig. 140: VoIP -> Media Gateway -> CLID Translation -> Edit/New

The VoIP -> Media Gateway -> CLID Translation -> Edit/New menu consists of the fol-
lowing fields:

Fields in the CLID Translation Basic Parameters menu
Field Description

Description Enter the name of the entry.

Subscriber Number Select the ISDN line or SIP account from which the call comes.

The selection depends on the interfaces available and on the
SIP accounts that have been created.

Possible values:
e pri<Interface Index>: Restricts the entry to the selec-
ted PRI interface.

* bri<Interface Index>: Restricts the entry to the selec-
ted BRI interface.

* <STP Account>: restricts the entry to the selected SIP ac-
count.

e AI11: No restriction of the entry.

R1xxx/R3xxx/R4xxx
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Called Line

Called Address

Calling Address Transla-
tion

Here you have the option of entering the destination line of the
call.

Possible values:
* pri<Interface Index>: Restricts the entry to the selec-

ted PRI interface.

* bri<Interface Index>: Restricts the entry to the selec-
ted BRI interface.

* <STP Account>: restricts the entry to the selected SIP ac-
count.

e Any: No restriction of the entry.
Enter Called Line or Called Address.

If a value other than Any is chosen, the Called Address should
not be used. If you set Called Line = Any and Called Address
is not used, all calls on the Calling Line are processed.

Here you have the option of entering the destination address of
the call.

Enter Called Line or Called Address. If the Called Address is
used, Called Line = Any should be set.

Enter the transformation rule applied to the call numbers.

Notation: <a:b>, i.e. a is replaced by b. A number of rules can
be chained together using semicolons as separators, e.g.
<a:b>;<c:d>;<e:f>. After confirmation of entry, the rule chain is
automatically sorted by the "best match" method.

? is a placeholder for an arbitrary digit.

Example 18.3. Example of a rule

e Rule: <:+49911>
* number dialled: 96731234
* manipulated number: +4991196731234




18.2.5 Call Translation

You can create a list for the translation of subscriber numbers, i.e. this list associates in-
ternal and external numbers.

&1 Note

Which number (called party number or calling party number) is translated depends on
the direction (incoming or outgoing) of the call in question. For incoming calls it is the
called party number, for outgoing calls the calling party number that is translated.

For example, the internal number 340 can be shown externally as 09119673900 or a call
from outside for the number 09119673200 can be routed internally to the number 340.

In the VoIP -> Media Gateway -> Call Translation menu, a list of all existing translations
is shown.

18.2.5.1 Edit/New

Choose the @ icon to edit existing entries. Select the New button to create entries for call

translation.

bintec R4100 | Language |English | | Wiew |Standard ~| | online Help | Logout

Extensions | SIP Accounts Call Routing CLID Translation Call Translation ISDN Trunks Options

Basic Parameters

Description l—
Direction
Associated Line
Local Address I
External Address I
Lok ) (_ cancel )

Fig. 141: VoIP -> Media Gateway -> Call Translation -> Edit/New

The VoIP ->Media Gateway -> Call Translation -> Edit/New menu consists of the follow-
ing fields:

Fields in the Call Translation Basic Parameters menu

R1xxx/R3xxx/R4xxx
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Description

Direction

Associated Line

Local Address

External Address

Enter the name of the call translation.

Select the direction for the entry.
Possible values:

* Both (default value): For incoming and outgoing calls
(bidirectional).

* Tncoming : For incoming calls.

* Outgoing : For outgoing calls.

Select the ISDN line or SIP account via which the calls are to be
routed.

Possible values:

e pri<Interface Index>: Restricts the call to the selected
PRI interface.

e bri<Interface Index>: Restricts the call to the selected
BRI interface.

e <SIP Account>; restricts the call to the selected SIP ac-
count.

Enter the internal number (e.g. extension or PABX number). For
incoming calls, the signalled Called Party Number (corresponds
in the menu to the External Address field) is translated to the
Local Address. For outgoing calls, the signalled Calling Party
Number (corresponds in the menu to the Local Address field)
is translated to the External Address.

Numerical and alphanumerical characters are permissible.
? is a placeholder for an arbitrary digit.

Note Local Address and External Address must contain the
same number of wildcards.

Enter the external number (e.g. ISDN MSN or SIP account sub-
scriber number). For incoming calls, the signalled Called Party
Number (corresponds in the menu to the External Address
field) is translated to the Local Address. For outgoing calls, the
signalled Calling Party Number (corresponds in the menu to the
Local Address field) is translated to the External Address.



Field Description

The External Address is not shown if the field Associated
Line = <SIP Account>. In this case, theUser Name of the se-
lected SIP account is used as the External Address.

18.2.6 ISDN Trunks

The ISDN Trunks menu is only displayed if you device has at least two ISDN connections
in point-to-point mode (BRI or PRI), which are configured as TE (party line) or NT.

&1 Note

Note that, for BRI connections, the connection mode (NT mode or TE mode) must be
set by jumper in the device.

In this menu, the ISDN party lines (bundles) are defined.

18.2.6.1 Edit/New

Choose the @ icon to edit existing entries. Select the New button to create a new party

line.

View | Standard v

Online Help | Logout

bintec R4100 | = FEFT T

ES
2
2

Extensions | SIP Accounts Call Routing CLID Translation Call Translation ISDN Trunks Options

Basic Parameters

Description
ISON Wods

Criz-o

( oK ) € Cancel )

Application Level Gateway
Wedia Gateway

Fig. 142: VoIP -> Media Gateway -> ISDN Trunks
The VolIP -> Media Gateway -> ISDN Trunks menu consists of the following fields:

Fields in the ISDN Trunks Basic Parameters menu

R1xxx/R3xxx/R4xxx



Field Description

Description
Enter the name of the party line.
The maximum number of characters is 40.
ISDN Mode
Select the mode in which the party line is to be operated.
Possible values:
* External (default value): Point-to-Point TE connection
(telecom party line)
* TrunkPoint-to-Point NT connection (for connection of a
PABX).
Members Select the desired ISDN interfaces to be included with this party
line.

18.2.7 Options

In the VoIP -> Media Gateway -> Options menu, you can make global settings for the me-
dia gateway.

wiew | Standard v| | oniine Help

bintee R4100" " & NE TR

CLID Translation | Call Translation ISDN Trunks Options

Extensions SIP Accounts  Call Routing

R e
| BN s,
R R e —
1 Media Gateway Status Clenablea
; Session Border Controller Mode
; Media Stream Termination [“IEnablea
] —
I Default Drop Extension

Dial Latency 5 Seconds

Application Level Gateway
Wedia Gateway

Advanced Settings

| Shortcut Replacement
| Mawtanance x| soeciaing
- C oK 0 cancel )

Fig. 143: VoIP -> Media Gateway -> Options
The VoIP -> Media Gateway -> Options menu consists of the following fields:

Fields in the Options Basic Parameters menu

R1xxx/R3xxx/R4xxx
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Media Gateway Status

Session Border Control-
ler Mode

Media Stream Termina-
tion

Select whether the media gateway function should be enabled.
The function is activated with Enabled.

The function is disabled by default.

Specify how the media gateway should behave in conjunction
with a session border controller mode.

Possible values:

* auto (default value) for all extensions that exactly agree with
an existing SIP account, the call routing is handled by the ses-
sion border controller, i.e. all SIP messages configured for the
corresponding SIP account are forwarded to the session bor-
der controller. For all other extensions, the call routing is
handled by the media gateway in accordance with the entries
configured under Call Routing. Note that the call routing is
handled by the media gateway if the provider is not available
(backup).

e orf: Call routing is handled exclusively by the media gateway
in accordance with the entries configured under Call Routing
and the local extensions. For calls that are to be routed via a
particular provider (SIP account), you must configure a cor-
responding call routing entry. Internal calls (from internal ex-
tension to internal extension) that are only to be routed intern-
ally do not require an additional call routing entry.

* <STP Trunk>: Select a SIP trunk account configured under
VoIP -> Media Gateway -> SIP Accounts. In this case, the
call routing for all extensions is handled by the session border
controller, all SIP messages are forwarded to the session bor-
der controller. Note that the call routing is handled by the me-
dia gateway if the provider is not available (backup).

Note: Entries in Call Routing have priority ahead of the session
border controller configuration!

Choose how RTP sessions are controlled by the system.

If the function is enabled, RTP sessions are terminated on the
media gateway, i.e. all RTP streams are controlled by the media
gateway and routed via the media gateway. The participating
terminal devices (e.g. SIP telephones) are not connected dir-
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ectly with one another. Note that, for VoIP to VolP connections,
there is no code translation for different VolP terminal codecs.
The codecs of media gateway and VolP terminals must there-
fore agree.

If the function is disabled, RTP sessions are not terminated on
the media gateway, i.e. all RTP streams are routed by the me-
dia gateway without termination. The RTP data packets can be
routed in complex networks and thus also via other gateways.

The function is activated with Enabled.

The function is enabled by default.

Default Drop Extension  You can specify an extension to which incoming calls are for-
warded if they cannot be assigned to an extension or connected
PABX.

Dial Latency Enter the maximum delay time before the system assumes the
call number entered is complete and starts the SIP dialling pro-
cess (sends the SIP INVITE message). This timeout is reset
each time that a button is pressed.

Possible values are 0to 15.
The default value is 5.

If you terminate the number entered with #, dialling is immedi-
ate.

Fields in the Advanced Settings menu

Field Description

Speed Dialing Define short sequences of numbers that can be dialled instead
of the entire number.

Click Add to configure new speeddial numbers.

Enter the desired speeddial number for the user, e.g. 123 under
Shortcut.

Enter the subscriber number to be dialled in place of the speed-
dial number, e.g. 09119673 under Replacement.

In the example above, if a user types in *123, the device dials



Field Description

09119673.

If the user wishes to call extension 111, he typesin *123111.
The device dials 09119673111.

A period at the end of the number indicates a complete number.
This is dialled immediately the period is recognised.

If you want to use a speeddial number from this list, you must dial * followed by the speed-
dial number.

R1xxx/R3xxx/R4xxx
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Chapter 19 Local Services

19.1 DNS

Each device in a TCP/IP network is usually located by its IP address. Because host names
are often used in networks to reach different devices, it is necessary for the associated IP
address to be known. This task can be performed by a DNS server, which resolves the
host names into IP addresses. Alternatively, name resolution can also take place over the
HOSTS file, which is available on all PCs.

Your device offers the following options for name resolution:

* DNS Proxy, for forwarding DNS requests sent to your device to a suitable DNS server.
This also includes specific forwarding of defined domains (Forwarded Domains).

* DNS cache, for saving the positive and negative results of DNS requests.

* Static entries (Static Hosts), for manually defining or preventing assignments of IP ad-
dresses to names.

* DNS monitoring, for providing an overview of DNS requests on your device.

Global Name Server

The IP addresses of global name servers that are queried if your device is unable to an-
swer requests itself or by forwarding entries are entered in Local Services -> DNS ->
Global Settings -> Basic Parameters.

For local applications, the IP address of your device or the general loopback address
(127.0.0.1) can be entered as the global name server.

Your device can also receive the global name servers dynamically and transfer them dy-
namically if necessary.

Strategy for name resolution on your device

A DNS request is handled by your device as follows:

(1) If possible, the request is answered directly from the static or dynamic cache with IP
address or negative response.

(2) Otherwise, if a suitable forwarding entry exists, the relevant DNS server is asked, de-
pending on the configuration of the Internet or dialin connections, if necessary by set-
ting up a WAN connection at extra cost. If the DNS server can resolve the name, the
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information is forwarded and a dynamic entry created in the cache.

Otherwise, if global name servers are entered, the primary DNS server then the sec-
ondary DNS server are asked. If the IP address of your device or the loopback ad-
dress is entered for local applications, these are ignored here. If one of the DNS serv-
ers can resolve the name, the information is forwarded and a dynamic entry created in
the cache.

Otherwise, if a suitable Internet or dialin connection is selected as the standard inter-
face, the relevant DNS server is asked, depending on the configuration of the Internet
or dialin connections, if necessary by setting up a WAN connection at extra cost. If
one of the DNS servers can resolve the name, the information is forwarded and a dy-
namic entry created in the cache.

Otherwise, if overwriting the addresses of the global name servers is allowed (DNS
Server Configuration = Dynamic), a connection is set up — in some cases at extra
cost — that is configured to enable DNS server addresses to be requested from DNS
servers (DNS Negotiation = Enabled), if this has not been attempted previously. If
name server negotiation is successful, these are entered as global name servers and
are therefore available for further requests.

Otherwise the initial request is answered with a server error.

If one of the DNS servers answers with non-existent domain, the initial request is im-
mediately answered accordingly and a corresponding negative entry is made in the DNS
cache of your device.



19.1.1 Global Settings

bintec R1200 Language | English | | View |Standard v| | oniine Help
—..Save configu — = Global Settings ' Static Hosts  Domain Forwarding | Cache | Statistics
T | oomeiname |
; DNS Server Configuration @ pynamic O Static
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DynDHS Client MNegative Cache [¥] Enabled

DHCP Server lmn— )
— webFiter | Cache Size Entries

AR g Maximum TTL for Positive Cache Enries 86400 Seconds

Scheduling

Sul Maximurn TTL for Megative Cache Entries BE400 Seconds

15D]
| P T——— Fallback interface to get DMS senver

Funkwerk Discovery

UPHP
ERiL As DHCP Server O nNone @ 0wn IP Address O Global DNS Setting

HotSpot Gateway IF address to use for DNSMWING server assignment

As IPCF Server ONone O 0wn P Address © Glohal DNS Setting
( 0K ) cancel )

Fig. 144: Local Services -> DNS -> Global Settings
The menu Lokale Dienste -> DNS -> Global Settings consists of the following fields:
Fields in the Global Settings Basic Parameters menu

Domain Name Enter the standard domain name of your device.

DNS Server Configura-  Select whether the addresses of the global name server on your
tion device can be overwritten by transferred name server ad-
dresses.

Possible values:

e Dynamic (default value) The name server addresses can be
automatically overwritten.

e Static: The name server addresses are not overwritten.

DNS Server Only for DNS Server Configuration = Static

Primary Enter the IP address of the first and, if necessary, second global

R1xxx/R3xxx/R4xxx
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Secondary DNS server.

WINS Server Enter the IP address of the first and, if necessary, alternative
' global Windows Internet Name Server (=WINS) or NetBIOS

Primary Name Server (=NBNS).

Secondary

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu
Field Description

Positive Cache Select whether the positive dynamic cache is to be activated,
i.e. successfully resolved names and IP addresses are to be
stored in the cache.

The function is enabled by choosing Enabled.

The function is enabled by default.

Negative Cache Select whether the negative dynamic cache is to be activated,
i.e. whether queried names for which a DNS server has sent a
negative response are stored as negative entries in the cache.

The function is enabled by choosing Enabled.

The function is enabled by default.

Cache Size Enter the maximum total number of static and dynamic entries.

Once this value is reached, the dynamic entry not requested for
the longest period of time is deleted when a new entry is added.
If the Cache Size is reduced by the user, dynamic entries are
deleted if necessary. Static entries are not deleted. Cache Size
cannot be set to smaller than the current number of static
entries.

Possible values: 0.. 1000.

The default value is 100.

Maximum TTL for Posit- Enter the value to which the TTL is to be set for a positive dy-
ive Cache Entries namic DNS entry in the cache if its TTL is 0 orits TTL exceeds
the value for Maximum TTL for Positive Cache Entries.
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Maximum TTL for Neg-
ative Cache Entries

Fallback interface to get
DNS server

IP address to use for
DNS/WINS server as-
signment

The default value is 86400.

Enter the value set to which the TTL is to be set in the case of a
negative dynamic entry in the cache.

The default value is 86400.

Only if DNS Server Configuration = DynamicSelect the inter-
face to which a connection is set up for name server negotiation
if other name resolution attempts were not successful.

The default value is Automatic i.e. a one-time connection is
set up to the first suitable connection partner configured in the
system.

As DHCP Server

Select which name server addresses are sent to the DHCP cli-
ent if your device is used as DHCP server.

Possible values:

e None: No name server address is sent.

* Own IP Address (default value): The address of your
device is transferred as the name server address.

* Global DNS Setting: The addresses of the global name
servers entered on your device are sent.

As IPCP Server

Select which name server addresses are to be transmitted by
your device in the event of dynamic server name negotiation if
your device is used as the IPCP server for PPP connections.

Possible values:

e None: No name server address is sent.

* Own IP Address: The address of your device is transferred
as the name server address.

* Global DNS Setting (default value): The addresses of the
global name servers entered on your device are sent.



19.1.2 Static Hosts

In the Local Services -> DNS -> Static Hosts menu, a list of all configured static hosts is
shown.

19.1.2.1 New

Choose the New button to set up new static hosts.

bintec R1200 Language |English v| | view |Standard ~| | online Help | Logout

Global Settings = Static Hosts Domain Forwarding Cache Statistics

€ oK ) ( Cancel )

hessaws v

Eop s —

_ DKS Hosthame l—
; Response
g IP Address IDDDD—
en - T [sa00 seconas
|

Fig. 145: Local Services -> DNS -> Static Hosts -> New
The Local Services -> DNS -> Static Hosts -> New menu consists of the following fields:

Fields in the Static Hosts Basic Parameters menu
Field Description

DNS Hostname Enter the host name to which the IP Address defined in this
menu is to be assigned if a positive response is received to a
DNS request. If a negative response is received to a DNS re-
quest, no address is specified.

The entry can also start with the wildcard *, e.g. *.funkwerk.de.

If a name is entered without a dot, this is completed with

R1xxx/R3xxx/R4xxx
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Response

IP Address

TTL

<Name>. after confirming with OK " " is added.

Entries with spaces are not allowed.

In this entry, select the type of response to DNS requests.

Possible values:

* Negative : A DNS request for Name is answered with a
negative response.

* Positive (default value): A DNS request for Name is
answered with the associated IP Address.

e None: A DNS request is ignored; no answer is given.
Only if Response = Positive.

Enter the IP address assigned to Name.

Enter the the time for which the assignment of Name to IP Ad-
dress is to be valid in seconds (only relevant if Response =
Positive) thatis transferred to requesting hosts.

The default value is 86400 (= 24 h).

19.1.3 Domain Forwarding

In the Local Services -> DNS -> Domain Forwarding menu, a list of all configured for-
warding for defined domains is shown.

19.1.3.1 New

Choose the New button to set up new forwardings.
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Fig. 146: Local Services -> DNS -> Domain Forwarding -> New

The Local Services -> DNS -> Domain Forwarding -> New menu consists of the follow-
ing fields:

Fields in the Domain Forwarding Forwarding Parameters menu
Field Description

Forward Select whether a host or domain is to be forwarded.
Possible values:

* Host (default value)

® Domain

Host Only for Forward = Host
Enter the name of the host to be forwarded.

The entry can also start with the wildcard *, e.g. *.funkwerk.com.
If a name is entered without a full stop, once you confirm with
OK " <Default Domain>. " " is added.

Domain Only for Forward = Domain

Enter the name of the domain to be forwarded.

R1xxx/R3xxx/R4xxx
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The entry can also start with the wildcard *, e.g. *.funkwerk.com.
If a name is entered without a full stop, once you confirm with
OK " <Default Domain>. " " is added.

Forward to Select the forwarding destination requests to the name defined
in Host or Domain.

Possible values:

* Interface (default setting) The request is forwarded to the
defined Interface.

* DNS Server: The request is forwarded to the defined DNS
server.

Interface Only for Forward to = Tnterface

Select the interface via which the requests for the defined Do-
main are to be received and forwarded to the DNS server.

DNS Server Only for Forward to = DNS server

Enter the IP address of the primary and secondary DNS server.

19.1.4 Cache

In the Local Services -> DNS -> Cache menu, a list of all available cache entries is
shown.
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Fig. 147: Local Services -> DNS -> Cache

You can select individual entries using the checkbox in the corresponding line, or select
them all using the Select All button.

A dynamic entry can be converted to a static entry by marking the entry and confirming with
Set to Static. This entry then disappears from the list and is included in the list in the Stat-
ic Hosts menu. The TTL is transferred in this operation.
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19.1.5 Statistics

Online Help | Logout

Global Settings | Static Hosts  Domain Forwarding Cache Statistics

Automatic Refresh Interval |E0 Seconds Apply )
DS Statistics

Received DNS Packets
Invalid DMNS Packets
DNS Reguests

Cache Hits

Forwarded Requests
Cache Hitrate (%)

Successiully Answered Queries
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Server Failures

DI Theft Protection
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Fig. 148: Local Services -> DNS -> Statistics

In the menu Local Services -> DNS -> Statistics, the following statistical values are
shown:

Fields in the Statistics DNS Statistics menu
Field Description

Received DNS Packets Shows the number of received DNS packets addressed direct to
your device, including the response packets for forwarded re-

quests.

Invalid DNS Packets Shows the number of invalid DNS packets received and ad-
dressed direct to your device.

DNS Requests Shows the number of valid DNS requests received and ad-
dressed direct to your device.

Cache Hits Shows the number of requests that were answered with static or
dynamic entries from the cache.

Forwarded Requests Shows the number of requests forwarded to other name serv-
ers.

Cache Hitrate (%) Displays the number of Cache Hits per DNS Request in %.
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Successfully Answered  Shows the number of successfully answered requests (positive
Queries and negative).

Server Failures Shows the number of requests that were not answered by any
name server (either positively or negatively).

19.2 DynDNS Client

The use of dynamic IP addresses has the disadvantage that a host in the network can no
longer be found once its IP address has changed. DynDNS ensures that your device can
still be reached after a change to the IP address.

The following configuration steps are necessary:

* Registration of a host name at a DynDNS provider

» Configuration of your device

Registration

The registration of a host name means that you define an individual user name for the
DynDNS service, e.g. dyn client. The service providers offer various domain names for
this, so that a unique host name results for your device , e.g.

dyn _client.provider.com. The DynDNS provider relieves you of the task of answer-
ing all DNS requests concerning the host dyn _client.provider. com with the dynamic
IP address of your device.

To ensure that the provider always knows the current IP address of your device, your
device contacts the provider when setting up a new connection and propagates its present
IP address.

19.2.1 DynDNS Update

In the Local Services -> DynDNS Client -> DynDNS Update menu, a list of all configured
DynDNS registrations is shown that are to be updated.

19.2.1.1 New

Choose the New button to set up further DynDNS registrations to be updated.
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Fig. 149: Local Services -> DynDNS Client -> DynDNS Update -> New

19 Local Services

The Local Services -> DynDNS Client -> DynDNS Update -> New menu consists of the

following fields:

Fields in the DynDNS Update Basic Parameters menu

Field Description

Host Name Enter the complete host name as registered with the DynDNS
provider.
Interface Select the WAN interface whose IP address is to be propagated

over the DynDNS service (e.g. the interface of the Internet Ser-
vice Provider).

User Name Enter the user name as registered with the DynDNS provider.

Password Enter the password as registered with the DynDNS provider.

Provider Select the DynDNS provider with which the above data is re-
gistered.

A choice of DynDNS providers is already available in the uncon-
figured state and their protocols are supported.
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Other DynDNS providers can be configured in the Local Ser-
vices -> DynDNS Client -> DynDNS Providers menu.

The default value is DynDNS .

Enable update Select whether the DynDNS entry configured here is to be activ-
ated.

The function is enabled by choosing Enabled.

The function is disabled by default.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu

Field Description

Mail Exchanger (MX) Enter the full host name of a mail server to which e-mails are to
be forwarded if the host currently configured is not to receive
mail.

Ask your provider about this forwarding service and make sure
e-mails can be received from the host entered as MX.

Wildcard Select whether the forwarding of all subdomains of the Host
Name are to be enabled for the current IP address of the Inter-
face (advanced name resolution).

The function is enabled by choosing Enabled.

The function is disabled by default.

19.2.2 DynDNS Provider

In the Local Services -> DynDNS Client -> DynDNS Provider menu, a list of all con-
figured DynDNS providers is shown.

19.2.2.1 New

Choose the New button to set up new DynDNS providers.
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Fig. 150: Local Services -> DynDNS Client -> DynDNS Provider -> New

The Local Services -> DynDNS Client -> DynDNS Provider -> New menu consists of the
following fields:

Fields in the DynDNS Provider Basic Parameters menu

Field Description
Provider Name Enter a name for this entry.
Server Enter the host name or IP address of the server on which the

provider's DynDNS service runs.

Update Path Enter enter the path on the provider’s server that contains the
script for managing the IP address of your device.

Ask your provider for the path to be used.

Port Enter the port at which your device is to reach your provider’s
server.

Ask your provider for the relevant port.

The default value is 80.
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Protocol Select one of the protocols implemented.

Possible values:

e DynDNS (default value)
® Static DynDNS

* ODS

* HN

* DYNS

® GnuDIP-HTML

® GnuDIP-TCP

® Custom DynDNS

Update Interval Enter the minimum time (in seconds) that your device must wait
before it is allowed to propagate its current IP address to the
DynDNS provider again.

The default value is 300 seconds.

19.3 DHCP Server

You can configure your device as a DHCP (Dynamic Host Configuration Protocol) server.

Your device and each PC in your LAN requires its own IP address. One option for allocat-
ing IP addresses in your LAN is the Dynamic Host Configuration Protocol (DHCP). If you
configure your device as a DHCP server, the device automatically assigns IP addresses to
requesting PCs in the LAN from a predefined IP address pool. A PC sends out an ARP re-
quest and in turn receives its IP address assigned by your device. You therefore do not
need to allocate fixed IP addresses to PCs, which reduces the amount of configuration
work in your network. To do this, you set up a pool of IP addresses, from which your device
assigns IP addresses to hosts in the LAN for a defined period of time. A DHCP server also
transfers the addresses of the domain name server entered statically or by PPP negotiation
(DNS), NetBIOS name server (WINS) and default gateway.

19.3.1 DHCP Pool

To activate your device as a DHCP server, you must first define IP address pools from
which the IP addresses are distributed to the requesting clients.

In the Local Services -> DHCP Server -> DHCP Pool menu, a list of all configured IP ad-



dress pools is shown.

In the list, for each entry, you have the possibility under Pool of enabling or disabling the
configured DHCP pools.

19.3.1.1 New

Choose the New button to set up new IP address pools. Choose the @ icon to edit exist-
ing entries.

Wiew | Standard ~| | Online Help | Logout

DHCP Pool IP/MAC Binding  DHCP Relay Settings

Basic Parameters

Interface
IP Address Range I I
Paol Usage
Advanced Settings:
; Gateway Use router as gateway v
Lease Time 120 Minutes
DHS ’—|
= Option~ Valus
IYnOHE Ciierit DHCF Options
HEP Server
e Filter
CAPI Server ( oK ) ( cancel )

cheduling
urveillance
DN Theft Protection
unkwerk Discovery
PnP
otSpot Gateway

Fig. 151: Local Services -> DHCP Server -> DHCP Pool -> New

The Local Services -> DHCP Server -> DHCP Pool -> New menu consists of the follow-
ing fields:

Fields in the DHCP Pool Basic Parameters menu
Field Description

Interface Select the interface over which the addresses defined in IP
Range are to be assigned to DHCP clients.

When a DHCP request is received over this Interface, one of
the addresses from the address pool is assigned.

IP Address Range Enter the first (first field) and last (second field) IP address of

R1xxx/R3xxx/R4xxx
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the IP address pool.

Pool Usage Specify whether the IP pool is used for DHCP requests in the
same subnet or for DHCP requests that have been forwarded to
your device from another subnet. In this case it is possible to
define IP addresses from another network.

Possible values:

* Local (default value): The DHCP pool is only used for DHCP
requests in the same subnet.

* Local/Relay: The DHCP pool is used for DHCP requests in
the same subnet and from other subnets.

* Relay: The DHCP pool is only used for DHCP requests for-
warded from other subnets.

The Advanced Settings menu consists of the following fields:
Fields in the Advanced Settings menu

I == =

Gateway Select which IP address is to be transferred to the DHCP client
as gateway.

Possible values:

* No gateway (default value): No IP address is sent.

e Use router as gateway: Ihe IP address defined for the
Interface is transferred.

* Specify: Enter the corresponding IP address.

Lease Time Enter the length of time (in minutes) for which an address from
the pool is to be assigned to a host.

After the Lease Time (Minutes) expires, the address can be re-
assigned by the server.

The default value is 120.

DHCP Options Specify which additional data is forwarded to the DHCP client.
Possible values for Option:

e Time Server (default value): Enter the IP address of the
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time server to be sent to the client.

e DNS Server: Enter the IP address of the DNS server to be
sent to the client.

* DNS Domain Name: Enter the DNS domain to be sent to the
client.

* WINS/NBNS Server: Enter the IP address of the WINS/
NBNS server to be sent to the client.

* WINS/NBT Node Type: Enter the type of the WINS/NBT
node to be sent to the client.

e TFTP Server:. Enter the IP address of the TFTP server to be
sent to the client.

Several entries are possible. Add new entries with the Add but-
ton.

19.3.2 IP/MAC Binding

In the Local Services -> DHCP Server -> IP/MAC Binding menu a list is shown of all cli-
ents that have received an IP address from your device via DHCP.

You can now allocate an IP address from a defined IP address pool to specific MAC ad-
dresses. You can do this by selecting the Static Binding option in the list to convert a list
entry as a fixed binding, or you manually create a fixed IP/MAC binding by configuring this
in the New sub-menu.

@ Note

You can only create new static IP/MAC bindings if IP address ranges have been con-
figured in Local Services -> DHCP Server -> DHCP Pool.

19.3.2.1 New

Choose the New button to set up new IP/MAC bindings.
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Fig. 152: Local Services -> DHCP Server -> IP/MAC Binding -> New

The Local Services -> DHCP Server -> DHCP Binding -> New menu consists of the fol-
lowing fields:

Fields in the IP/MAC Binding Basic Parameters menu
Field Description

Description Enter the name of the host to the MAC Address of which the IP
Address is to be bound.

A character string of up to 256 characters is possible.

IP Address Enter the IP address to be assigned to the MAC address spe-
cified in MAC Address.

MAC Address Enter the MAC address to which the IP address specified in IP
Address is to be assigned.
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19.3.3 DHCP Relay Settings

If your device for the local network does not distribute any IP addresses to the clients by
DHCP, it can still forward the DHCP requests on behalf of the local network to a remote
DHCP server. The DHCP server then assigns the your device an IP address from its pool,
which in turn sends this to the client in the local network.

i

bintec. R1200 " Language |English | | View [Standard v| | oniine Help

DHCP Pool IP/MAC Binding DHCP Relay Settings

Basic Parameters

Primary DHCP Sener 0.0.0.0
Secondary DHCP Server 00.0.0

C oK 0 ( cancel )

DHS

DynDHS Client

DHCP Server

‘Web Filter

CAPI Server
Scheduling
Surveillance

ISDH Theft Protection
Funkwerk Discovery
UPnP

Fig. 153: Local Services -> DHCP Server -> DHCP Relay Settings

The Local Services -> DHCP Server -> DHCP Relay Settings menu consists of the fol-
lowing fields:

Fields in the DHCP Relay Settings Basic Parameters menu

Field Description

Primary DHCP Server  Enter the IP address of a server to which BootP or DHCP re-
quests are to be forwarded.

Secondary DHCP Serv- Enter the IP address of an alternative BootP or DHCP server.
er
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19.4 Web Filter

In the Local Services -> Web Filter menu, you can configure a URL-based Web filter ser-
vice, which accesses the Proventia Web Filter from the company Internet Security Systems
(www.iss.net) and checks how a requested Internet page is categorised by the Proventia
Web Filter. The action resulting from the classification is configured on your device.

19.4.1 Gilobal Settings

This menu contains the configuration of basic parameters for using the Proventia Web Fil-
ter.

bintec. R1200 Language | English | | View |Standard v| | oniine Help
AVE Global Settings Filter List Black / White List History

EL W Filter Stalus Enabled
g Filtered Input Interface(s):
_ Maimurm Murnber of Histary Entries 64
; Action if server not reachable @ Attow all O Block all O'Log all
; Action if license nat registered @ Altow all OBlock all O'Log all

DHS . .

DHCP Server ) )
E—— Licence Key B1BT [Activate 30 days demo licence]

Web Filter

CAPI Server Licence Status

Sched:

Su ce

ISDH Theft Protection

Funkwerk Discovery

UPnP

HotSpot Gateway

License valid until Not activated

Fig. 154: Local Services -> Web Filter -> Global Settings

The menu Local Services -> Web Filter -> Global Settings consists of the following
fields:

Fields in the Global Settings Web Filter Options menu

Web Filter Status Activate or deactivate the filter.
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The function is enabled by choosing Enabled.

The function is disabled by default.

Filtered Input Inter- Select for which of the existing Ethernet interfaces web filtering
face(s) is to be activated.

Press the Add button to add more interfaces. The requests from
http Internet pages that reach your device via these interfaces
are then monitored by web filtering.

Maximum Number of Define the number of entries to be saved in the web filtering his-
History Entries tory (History menu).

Possible values are 1to 512.

The default value is 64.

URL Path Depth Select the path length to which a URL is to be checked by the
Cobion Orange Filter.

Action if server not Select which is to be done with URL requests if the web filtering
reachable server cannot be reached.

Possible values:

* Allow all (default value): The download is permitted.
* Block all: The download of the requested page is blocked.

* Log all: The download is permitted, but logged.

Action if license not re-  Select what is to be done with URL requests if the licence key
gistered status is Not Valid.

Possible values:

e Allow all (defaultvalue): The download is permitted.
* Block all: The download of the requested page is blocked.

* Log all: The download is permitted, but logged.

The License Information menu consists of the following fields:

Fields in the Global Settings License Information menu
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Licence Key Enter the number of your Proventia Web Filter licence. The pre-
set code assigned by ISS designates the device type.

In the ex works state, you can activate a 30-day demo version
of the Proventia Web Filter. Click here on the link [Activate
30-day demo license]

Licence Status Shows the result of the last validity check of the licence. The
validity of the licence is checked every 23 hours.

License valid until This shows the expiry date of the licence (relative to the time set
on your device) and cannot be edited.

19.4.2 Filter List

In the Local Services -> Web Filters -> Filter List menu, configure which categories of In-
ternet pages are to be handled and how.

You configure the relevant filters for this purpose. A list of filters already configured is dis-
played.

There are basically different approaches for configuring the filters:

¢ First a filter list can be created that only contains entries for those addresses that are to
be blocked. In this case it is necessary to make an entry at the end of the filter list that al-
lows all accesses that do not match a filter. (Setting for this: Category = Default Be-
haviour, Action = Permit or Permit and Log)

* If you only create entries for those addresses that are to be allowed or logged, it is not
necessary to change the default behaviour (= all other calls are blocked).



19.4.2.1 New

Choose the New button to set up new filters.

( oK ) ( Cancel )
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Fig. 155: Local Services -> Web Filters -> Filter List -> New

The Local Services -> Web Filter -> Filter List -> New menu consists of the following
fields:

Fields in the Filter List Filter Parameters menu

Field Description
Category Select which category of addresses/URLs the filter is to be used
on.

The options are first the standard categories of the Proventia
Web Filter (default value: Anonymous Proxies). Actions can
also be defined for the following special cases, e.g.:

* Default behaviour: This category applies to all Internet
addresses.

* Other Category: Some addresses are already known to
the Proventia Web Filter, but not yet classified. The action as-
sociated with this category is used for such addresses.

* Unknown URL: If an address is not known to the Proventia

R1xxx/R3xxx/R4xxx
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Day

Schedule (Start / Stop
Time)

Action

Web Filter, the action associated with this category is used.

Select the days on which the filter is to be active.

Possible settings:

e Daily (default value): The filter is used every day of the
week.

* <Weekday>: The filter is used on a certain day of the week.
Only one day can be selected per filter; several filters must be
configured if several individual days are to be covered.

* Monday-Friday: The filter is used from Monday to Friday.
The default value is Daily.

In from, enter from which time the the filter is to be activated.
The time is entered in the form hh:mm. Enter the time at which
the filter is to be deactivated after the to in the field. The time is
entered in the form hh:mm. The default value is 00:00 to 23:59.

Select the action to be executed if the filter matches a call.

Possible values:
* Block and Log (default value): The call of the requested
page is prevented and logged.

e Allow and Log: The download is permitted, but logged.
The events log can be viewed in the Local Services -> Web
Filters -> Filter List menu.

* Allow: The call is allowed and not logged.

19.4.3 Black/ White List

The menu Local Services -> Web Filter -> Black / White List contains a list of URLs and
IP addresses that can be downloaded even if they were blocked as a result of the filter con-
figuration and classification in the Proventia Web Filter (no entries are contained in the de-

fault configuration).



19.4.3.1 Add

Use the Add button to add further URLs or IP addresses to the list.

d | d
bintec R1200 ; Language |English | | ‘iew |Standard ~| | Online Help | Logout
Global Settings = Filter List Black / White List History
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Fig. 156: Local Services -> Web Filter -> Black / White List -> Add

The Local Services -> Web Filter -> Black / White List -> Add menu consists of the fol-
lowing fields:

Fields in the Black / White List menu

Field Description

URL / IP Address You enter a URL or IP address. The length of the entry is limited
to 60 characters.

Blacklisted You can select whether a URL or IP address can always ( in
the white List)ornever( in the Black List)be
Whitelisted downloaded.

whitelisted is enabled by default.

Addresses listed in the White List are allowed automatically. It is
not necessary to configure a suitable filter.
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19.4.4 History

In the Local Services -> Web Filter -> History menu, you can view the recorded history of
the web filter. The history logs all requests that are marked for logging by a relevant filter
(Action = Log), likewise all rejected requests.

bintee R1200 " Language |English v| | ‘iew |Standard ~| | Online Help | Logout
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Fig. 157: Local Services -> Web Filter -> History

19.5 CAPI Server

You can use the CAPI Server function to assign user names and passwords to users of the
CAPI applications on your device. This makes sure that only authorised users can receive
incoming calls and make outgoing calls via CAPI.

The CAPI service allows connection of incoming and outgoing data and voice calls to com-
munications applications on hosts in the LAN that access the Remote CAPI interface of
your device. This enables, for example, hosts connected to your device to receive and
send faxes.
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&n Note

Ex works, a user with the user name default and no password is always entered for
the CAPI subsystem. All calls to the CAPI are offered to all CAPI applications in the
LAN.

Use the Settings menu to distribute incoming calls for the CAPI subsystem to defined
users with password. You should then delete the user default without password.

19.5.1 Users

In the Local Services -> CAPI Server -> User menu, a list of all configured CAPI users is
shown.

19.5.1.1 New

Choose the New button to set up new CAPI users.

bintec R1200 | Language |English v| | Wiew Standard ~| | online Help | Logout
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Fig. 158: Local Services -> CAPI Server -> User -> New
The Local Services -> CAPI Server -> User -> New menu consists of the following fields:

Fields in the User Basic Parameters menu
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Field Description

User Name Enter the user name for which access to the CAPI service is to
be allowed or denied.

Password Enter the password with which the user User Name has to use
for identification purposes to gain access to the CAPI service.

Access Select whether access to the CAPI service is to be permitted or
denied for the user.

The function is enabled by choosing Enabled.

The function is enabled by default.

19.5.2 Options

bintec. R1200 ; Language | English v | View |Standard v| | Online Help | Logout
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Fig. 159: Local Services -> CAPI Server -> Options
The Local Services -> CAPI Server -> Options menu consists of the following fields:

Fields in the Options Basic Parameters menu
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Enable server Select whether your device is to be enabled as a CAPI server.
The function is enabled by choosing Enabled.

The function is enabled by default.

Faxheader Select whether the fax header should be printed at the top of
outgoing faxes.

The function is enabled by choosing Enabled.

The function is disabled by default.

CAPI Server TCP Port  The field can only be edited if Enable Server is enabled.
Enter the TCP port number for remote CAPI connections.

The default value is 2662.

19.6 Scheduling

Your device has a event scheduler, which enables certain standard actions (activation or
deactivation of interfaces) to be carried out on a time-dependent basis.

&n Note

To run the event scheduler, the date configured on your device must be 1.1.2000 or
later.

19.6.1 Schedule

In the Local Services -> Scheduling -> Time Schedule menu, a list of all scheduled tasks
is shown.

19.6.1.1 New

Choose the New button to set up new tasks.
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Fig. 160: Local Services -> Scheduling -> Time Schedule -> New

The Local Services -> Scheduling -> Time Schedule -> New menu consists of the fol-
lowing fields:

Fields in the Time Schedule Basic Parameters menu

Field Description

Description Enter the desired name for the scheduled task.

Fields in the Time Schedule Action menu
Field Description

Select action Select the desired action.
Possible values:

* Reboot Device (default value): Your device is rebooted.

e Activate Interface : The interface defined in the Select
Interface field is activated.

* Deactivate Interface : The interface defined in the Se-
lect Interface field is deactivated.

e Activate WLAN: The WLAN interface defined in the Select
Interface field is activated.
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Select radio

Select interface

Source Location

Update URL

TFTP Server

* Deactivate WLAN: The WLAN interface defined in the Se-
lect Interface field is deactivated.

® Tnitiate 5 GHz WLAN Bandscan: The wireless module
selected in Select Wireless Module is scanned in the 5-GHz
frequency band. During the scan, all wireless connections are
interrupted.

* Trigger software update: A software update is initiated.

e Trigger configuration backup: The backup of the
device configuration to a TFTP server is initiated.

Only if Select Action = Tnitiate 5 GHz WLAN Bandscan

Select the wireless module to be used for the scan.

Only if Select Action = Activate Interface Or Deactiv-—
ate Interface

or if
Select Action = Activate WLAN Or Deactivate WLAN

Select which interface is to be activated or deactivated.

Only if Select action = Trigger software update
Select the desired source.
Possible values:

® Current software from Funkwerk server: The latest
software will be downloaded from the Funkwerk server.

e HTTP server: The latest software will be downloaded from
an HTTP server that you define in Update URL.

Only if Select Action = Trigger software update and
Source = HTTP Server

Enter the name of the HTTP server from which you wish to
download a configuration file.

Only if Select action = Trigger configuration backup

Enter the IP address of the TFTP server to which you wish to
transfer a configuration file.
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TFTP File Name Only if Select action = Trigger configuration backup

Enter the name with which configuration file is to be transferred
to the TFTP server.

Fields in the Time Schedule Select time interval menu
Field Description

Time Condition First select the type of time entry in Condition Type.
Possible values:

* eekday: In Condition Settings , select a weekday.

* Periods (default setting): In Condition Settings , select a
particular period.

* Day of Month: In Condition Settings , select a particular
day of the month.

Possible values for Condition Settings with Condition Type =
Weekday:

Monday (default value) ... Sunday.

Possible values for Condition Settings with Condition Type =
Periods:

* Daily: The initiator becomes active daily (default value).

* Monday-Friday: The initiator becomes active daily from
Monday to Friday.

* Monday-Saturday : The initiator becomes active daily from
Monday to Saturday.

e Saturday - Sunday : The initiator becomes active on Sat-
urdays and Sundays.

Possible values for Condition Settings with Condition Type =
Day of the month:

I...31.

Start Time Enter the time from which the initiator is to be activated. Activa-
tion is carried on the next scheduling interval. the default value
of this interval is 55 seconds.
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Stop Time Not if Select Action = Reboot Device

Enter the time from which the initiator is to be deactivated. De-
activation is carried on the next scheduling interval. If you do not
enter a Stop Time or set Stop Time = Start Time, the initiator
is activated and deactivated after 10 seconds.

19.6.2 Options

In the Local Services -> Scheduling -> Options menu, you configure the schedule inter-
val.
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Fig. 161: Local Services -> Scheduling -> Options
The Local Services -> Scheduling -> Options menu consists of the following fields:

Fields in the Options Scheduling Options menu

Field Description

Schedule Interval Select whether the schedule interval is to be enabled for the in-
terface.

Enter the interval in seconds during which the system checks
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whether there are planned tasks.
Possible values are 0to 65535.

The value 300 is recommended (5 minute accuracy). Values
lower than 60 are generally pointless and are an unnecessary
use of system resources.

The field is not activated by default.

19.7 Surveillance

In this menu, you can configure an automatic availability check for hosts or interfaces and
automatic ping tests.

Note

This function cannot be configured on your device for connections that are authentic-
ated via a RADIUS server.

19.7.1 Hosts

In the Local Services -> Surveillance -> Hosts menu, a list of all monitored hosts is
shown.

19.7.1.1 Edit/New

Choose the icon to edit existing entries. Choose the New button to set up new surveil-
lance tasks servers.
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Fig. 162: Local Services -> Surveillance -> Hosts -> New

The Local Services -> Surveillance -> Hosts -> New menu consists of the following
fields:

Fields in the Hosts Host Parameters menu

I ==

Group ID Select an ID for the group of hosts whose availability is to be
monitored by your device.

The group IDs are automatically created from 0to 255. If an
entry has not yet been created, a new group is created using
the New ID option. If entries have been created, you can select
one from the list of created groups.

Each host to be monitored must be assigned to a group.

The action configured in Interface Action is only executed if no
other group member can be reached.

Fields in the Hosts Trigger menu

Field Description

Monitored IP Address Enter the IP address of the host to be monitored.
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Source IP Address

Interval

Trials

Controlled Interfaces

19.7.2 Interfaces

Select how the IP address is to be determined that your device
uses as the source address of the packet sent to the host to be
monitored.

Possible values:

e Automatic (default value): The IP address is determined
automatically.

* Specific: Enter the IP address in the adjacent input field.

Enter the time interval (in seconds) to be used for checking the
availability of hosts.

Possible values are 1to 65536.
The default value is 10.

The smallest Interval of the group members is used within a
group.

Enter the number of pings that must remain unanswered for the
host to be regarded as unavailable.

Possible values are 110 65536.

The default value is 3.

Select the interface(s) for which the action defined in Interface
Action is to be performed.

All physical and virtual interfaces can be selected.

Each interface, select whether each interface is to be activated (
Enable) or deactivated ( Disable, default value).

In the Local Services -> Surveillance -> Interfaces menu, a list of all monitored Inter-

faces is shown.



19.72.1 Edit/New

Choose the @ icon to edit existing entries. Choose the New button to set up monitoring for

other interfaces.

C oK 0 ( cancel )
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Fig. 163: Local Services -> Surveillance -> Interfaces -> New

The Local Services -> Surveillance -> Interfaces -> New menu consists of the following
fields:

Fields in the Interfaces Basic Parameters menu

Field Description
Monitored Interface Select the interface on your device that is to be monitored.
Trigger Select the state or state transition of Monitored Interfaces that

is to trigger a particular Interface Action.
Possible values:
* Interface goes up (default setting)

® Interface goes down

Interface Action Select the action that is to follow the state or state transition

R1xxx/R3xxx/R4xxx
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defined in Trigger.
The action is applied to the Interface(s) selected in Interface.

Possible values:

* Enable (default value): Activation of interface(s)

e Disable: Deactivation of interface(s)

Interface Select the interface(s) for which the action defined in Interface
Action is to be performed.

All the physical and virtual interfaces and the options A11 PPP
Interfacesand A11 IPSec Interfaces can be selected.
19.7.3 Ping Generator

In the Local Services -> Surveillance -> Ping Generator menu, a list is shown of all
pings configured for automatic generation.

19.7.3.1 Edit/New

Choose the icon to edit existing entries. Choose the New button to set up further pings.
2
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Fig. 164: Local Services -> Surveillance -> Ping Generator -> New

The Local Services -> Surveillance -> Ping Generator -> New menu consists of the fol-
lowing fields:

Fields in the Ping Generator Basic Parameters menu
Field Description

Destination IP Address  Enter the IP address to which the ping is automatically sent.

Source IP Address Enter the source IP address of the outgoing ICMP echo request
packets.

Possible values:

* Automatic: The IP address is determined automatically.

* Specific (default value): Enter the IP address in the adja-
cent input field e.g. to test a particular extended route.

Interval Enter the interval is seconds during which the ping is to be sent
to the target IP address specified in Target IP Address.

Possible values are 1to 65536.

The default value is 10.




19.8 ISDN Theft Protection

With the ISDN theft protection function, you can prevent a thief who has stolen a gateway
from gaining access to the gateway owner's LAN. (Without theft protection, he could dial in-
to the LAN by ISDN if, under WAN -> Internet + Dialup -> ISDN ->@|, the field Always on

is enabled.)

19.8.1 Options

All interfaces for which the theft protection is enabled are administratively set to "down"
when the gateway boots.

The gateway then calls itself by ISDN and checks its location. If the configured ISDN call
numbers differ from the numbers dialled, the interfaces remain disabled.

If the numbers agree, the device assumes that it is at the original location and the inter-
faces are administratively set to "up".

To reduce cost, the function uses the ISDN D channel.

@ Note

Note that the ISDN theft protection function is not available for Ethernet interfaces.

R1xxx/R3xxx/R4xxx
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Fig. 165: Local Services -> ISDN Theft Protection -> Options

The menu Local Services -> ISDN Theft Protection -> Options consists of the following
fields:

Fields in the Options Basic Parameters menu

I ==

ISDN Theft Protection Enable or disable the ISDN theft protection function.

Service
The function is activated with Enabled.
The function is disabled by default.
Dialling Number Only if ISDN Theft Protection Service is enabled.
Enter the subscriber number that the gateway dials to call itself.
Incoming Number Only if ISDN Theft Protection Service is enabled.
Enter the subscriber number to be compared with the current
calling party number.
Outgoing Number Only if ISDN Theft Protection Service is enabled.

Enter the subscriber number to be set as calling party number.
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Monitored interfaces Only if ISDN Theft Protection Service is enabled.
Use Add to add a new interface to the list.

Select from the available interfaces those to which the ISDN
theft protection function is to be applied.

Fields in the Advanced Settings menu

Field Description

Number of Dialling Re-  Enter the number of dial attempts that the gateway is to make to
tries call itself by ISDN after a reboot.

Possible values are 1to 255.

The default value is 3.

Timeout Enter the time in seconds that the gateway is to wait before try-
ing again after an unsuccessful attempt to call itself.

Possible values are 2to 20.

The default value is 5.

19.9 Funkwerk Discovery

19.9.1 Device Discovery

The funkwerk Discovery protocol is used to identify and configure bintec access points that
are in the same wired network as your device. Once an access point has been discovered,
certain basic parameters (node name, IP address, netmask, and device address) can be
configured on the access point (provided you know the administrator password).

&. Note

Any bintec access points that exist are determined by means of a multicast. The IP
address of the access point is therefore irrelevant.

Please note that the discovered bintec access points are not stored in the flash, which
means discovery must be repeated after you reboot your device.



In the Local Services -> Funkwerk Discovery -> Device Discovery menu, under Res-
ults a list is shown of all access points found on the network. In the Interface field, select
the interface of your device via which access point discovery is to be carried out. You use
the -A11- option to query all interfaces.

The current discovery status is displayed for each individual interface under Discovery
Status. None means that discovery is not active. Discovery is displayed when discovery
is currently being carried out.

This discovery function also enables your device to be discovered and configured by other
access points with a discovery function. You configure this in the Options sub-menu.

19.9.1.1 Discover

Choose the Discover button to start bintec access point discovery.
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Fig. 166: Local Services -> Funkwerk Discovery -> Device Discovery

If access points were discovered in the network, they are displayed in the list. You use the
@ button to go to the configuration menu for the access point.

R1xxx/R3xxx/R4xxx
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Fig. 167: Local Services -> Funkwerk Discovery -> Device Discovery->@|

The Local Services -> Funkwerk Discovery -> Device Discovery->@ menu consists of

the following fields:

Fields in the Funkwerk Discovery Basic Parameters menu

Interface

MAC Address

Node Name
IP Address
Subnet Mask

Gateway

Description

The value of this field can only be read.

Shows the interface of your device on which discovery is carried

out.

The value of this field can only be read.

Shows the MAC address of the discovered access point.

You can change the name of the discovered access point.

You can change the IP address of the discovered access point.

You can change the related netmask.

You can change the gateway address of the discovered access

point.

R1xxx/R3xxx/R4xxx
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Authentication Password You must enter the administrator password for the access point,
otherwise you cannot carry out the configuration operation.

Last Write Result

The value of this field can only be read.

Displays the result of the last configuration operation.

Possible values:

No Error: The access point reported a successful operation
or a configuration change has not yet been made with OK.

No Response: The access point has not responded.

Access Denied: The access point reported an authorisation
error. Check the authentication password.

Invalid IP Parameters: There is a problem with the in-
tended IP parameters (IP address, netmask, or gateway ad-
dress).

Destination Unreachable: The access point cannot be
reached for internal reasons (e.g. the interface to which the
access point is connected is down). A configuration request
cannot be sent to the access point.

Other AP Error: The access point responds to the config-
uration request with an unexpected or non-specific error.

Internal Error: An internal device problem prevented the
configuration option from being carried out.



19.9.2 Options

In this menu, you can grant permission for your device to be discovered by other bintec
devices using the funkwerk Discovery protocol and to be configured by means of this.

i
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Fig. 168: Local Services -> Funkwerk Discovery -> Options

The Local Services -> Funkwerk Discovery -> Options menu consists of the following
fields:

Fields in the Options Discovery Server Options menu
Field Description

Enable Discovery Server Select whether your device is to be discovered and configured
by other bintec devices in the network.

The function is activated with Enabled.

The function is disabled by default.

R1xxx/R3xxx/R4xxx
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19.10 UPnP

Universal Plug and Play (UPnP) makes it possible to use current messenger services (e.g.
real time video/audio conferencing) as peer-to-peer communication where one of the peers
lies behind a NAT-enabled gateway.

UPnP enables (mostly) Windows-based operating systems to take control of other devices
with UPnP functionality on the local network. These include gateways, access points and
print servers. No special device drivers are needed as known common protocols are used,
such as TCP/IP, HTTP and XML.

Your gateway makes it possible to use the subsystem of the Internet Gateway Device
(IGD) from the UPnP function range.

In a network behind a NAT-enabled gateway, the UPnP-configured computers act as LAN
UPnP clients. To do this, the UPnP function on the PC must be enabled.

The pre-configured port used for UPnP communication between LAN UPnP clients and the
gateway is 5678. The LAN UPnP client acts as a so-called service control point, i.e. it re-
cognizes and controls the UPnP devices on the network.

The ports assigned dynamically by, for example, MSN Messenger, lie in the range from
5004 1o 65535. The ports are released internally to the gateway on demand, i.e. when an
audio/video transfer is started in Messenger. When the application is closed, the ports are
immediately closed again.

The peer-to-peer-communication is initiated via public SIP servers with only the information
from the two clients being forwarded. The clients then communicate directly with one an-
other.

For further information about UPnP, see www.upnp.org.

19.10.1 Interfaces

In this menu, you configure the UPnP settings individually for each interface of your gate-
way.

You can determine whether UPnP requests from clients are accepted by each interface (for
requests from the local network) and/or whether the interface can be controlled via UPnP
requests.


http://www.upnp.org
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Fig. 169: Local Services -> UPnP -> Interfaces
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The menu Local Services -> UPnP-> Interfaces consists of the following fields:

Fields in the Interfaces menu
Field Description

Answer to client request Determine whether UPnP requests from clients are to be
answered via the particular interface (from the local network).

Interface is UPnP con-

trolled

The function is activated with Enabled.

The function is disabled by default.

Determine whether the NAT configuration of this interface is

controlled by UPnP.

The function is activated with Enabled.

The function is enabled by default.

19.10.2 Global Settings

In this menu, you make the basic UPnP settings.

R1xxx/R3xxx/R4xxx
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Fig. 170: Local Services -> UPnP -> Global Settings
The menu Local Services -> UPnP -> Global Settings consists of the following fields:
Fields in the Global Settings menu

UPnP Status Decide how the gateway processes UPnP requests from the
LAN.

The function is activated with Enabled. The gateway proceeds
with UPnP releases in accordance with the parameters con-
tained in the request from the LAN UPnP client, independently
of the IP address of the requesting LAN UPnP client.

The function is disabled by default. The gateway rejects UPnP
requests, NAT releases are not made.

UPnP TCP Port Enter the number of the port on which the gateway listens for
UPnP requests.

The possible values are 1 to 65535, the default value is 5678.

R1xxx/R3xxx/R4xxx
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19.11 HotSpot Gateway

The bintec HotSpot Solution allows provision of public Internet accesses (using WLAN or
wired Ethernet). The solution is adapted to setup of smaller and larger HotSpot solutions
for cafes, hotels, companies, communal residences, campgrounds, etc.

The bintec HotSpot Solution consists of a bintec gateway installed onsite (with its own
WLAN access point or additional connected WLAN device or wired LAN) and of the Hot-
Spot server, centrally located at a computing centre. The operator account is administered
on the server via an administration terminal (e.g., a hotel reception PC); this includes func-
tions such as registration entry, generating tickets, statistical analysis, etc.

Login sequence at the HotSpot server
* When a new user connects with the HotSpot, he/she is automatically assigned an IP ad-
dress via DHCP.

¢ As soon as he attempts to access any Internet site with a browser, the user is redirected
to the home/login page.

¢ After the user has entered the registration data (user/password), these are sent to the
central RADIUS server (HotSpot server) as RADIUS registration.

* Following successful registration, the gateway opens Internet access.

* For each user, the gateway sends regular additional information to the RADIUS server
for recording accounting data.

* When the ticket expires, the user is automatically logged off and again redirected to the
home/login page.

Requirements

To operate a HotSpot, the customer requires:

* A bintec device as a HotSpot gateway with an active internet access and configured Hot-
Spot server Entries for login and accounting (see menu System Management -> Re-
mote Authentication -> RADIUS -> New with Group Description Standard Group
0)

* bintec HotSpot hosting (article number 5510000198)
* Access data
* Documentation

* Software licensing

Please note that you must first activate the licence.
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- Go to www.funkwerk-ec.com then Service/Support -> Services -> Online Services.

- Enter the required data (please note the relevant explanations on the license sheet),
and follow the instructions of the online licensing.

- You then receive the HotSpot server's login data.

&n Note

Activation may require 2-3 business days.

Access data for gateway configuration

RADIUS Server IP 62.245.165.180

RADIUS Server Password Set by Funkwerk Enterprise Communications
GmbH

Domain Individually set for customers by customer/dealer

Walled Garden Network Individually set for customers by customer/dealer

Walled Garden Server URL Individually set for customers by customer/dealer

Terms & Conditions URL Individually set for customers by customer/dealer

Access data for configuration of the HotSpot server

Admin URL https://HotSpot.funkwerk-ec.com/
Username Individually set by FEC
Password Individually set by FEC

@ Note

Also refer to the WLAN HotSpot Workshop that is available to download from
www.funkwerk-ec.com .

19.11.1 HotSpot Gateway

In the HotSpot Gateway menu you can configure the bintec gateway installed onsite for
the bintec HotSpot Solution.


http://www.funkwerk-ec.com
http://www.funkwerk-ec.com

In the Local Services -> HotSpot Gateway -> HotSpot Gateway menu, a list of all con-
figured HotSpot networks is shown.
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Fig. 171: Local Services -> HotSpot Gateway -> HotSpot Gateway ->

You can use the Enabled option to enable or disable the corresponding entry.

19.11.1.1 Edit/New

In the Local Services -> HotSpot Gateway -> HotSpot Gateway ->@ menu, you config-
ure the HotSpot networks. Choose the New button to set up additional HotSpot networks.
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Fig. 172: Local Services -> HotSpot Gateway -> HotSpot Gateway ->

The Local Services -> HotSpot Gateway -> HotSpot Gateway -> menu consists of the

following fields:

Fields in the HotSpot Gateway Basic Parameters menu

R

Interface

Choose the interface to which the HotSpot LAN or WLAN is
connected. When operating over LAN, enter the Ethernet inter-
face here (e.g. en1-0). If operating over WLAN, the WLAN inter-
face to which the access point is connected must be selected.

Caution

A\

For security reasons you cannot configure your device over
an interface that is configured for the HotSpot. Therefore
take care when selecting the interface you want to use for
the HotSpot.

If you select the interface over which the current configura-
tion session is running, the current connection will be lost.
You must then log in again over a reachable interface that
is not configured for the HotSpot to configure your device.



19 Local Services Funkwerk Enterprise Communications GmbH

I =

Domain at the HotSpot  Enter the domain name that you used when setting up the Hot-

Server Spot server for this customer. The domain name is required so
that the HotSpot server can distinguish between the different cli-
ents (customers).

Walled Garden
Enabile this function if you want to define a limited and free area
of websites (intranet).

The function is not activated by default.

Walled Network / Net-

mask Only if Walled Garden is enabled.

Enter the network address of the Walled Network and the cor-
responding Netmask of the intranet server.

For the address range resulting from Walled Network / Net-
mask, clients require no authentication.

Example: Enter 192.168.0.0 / 255.255.255.0, if all IP addresses
from 192.168.0.0 to 19.168.0.255 are free. Enter 192.168.0.1 /
255.255.255.255, if only the IP address 192.168.0.1 is free.

Walled Garden URL
Only if Walled Garden is enabled.

Enter the Walled Garden URL of the intranet server. Freely ac-
cessible websites must be reachable over this address.

Terms & Conditions
Only if Walled Garden is enabled.

In the General Terms and Conditions input field enter the ad-
dress of the general terms and conditions on the intranet server,
or public server, e.g., http://www.webserver.de/agb.htm. The
page must lie within the address range of the walled garden net-
work.

The function is not activated by default.

The Advanced Settings menu consists of the following fields:

Fields in the Advanced Settings menu

Field Description

Ticket Type
Select the ticket type.

Possible values:



Field Description

* Voucher : Only the user name must be entered. Define a de-
fault password in the input field.

* Username/Password(default value): User name and pass-
word must be entered.

Allowed HotSpot Client
Here you can define which type of users can log in to the Hot-

Spot.
Possible values:

e A11: All clients are approved.

e DHCP Client: Prevents users who have not received an IP
address from DHCP from logging in.

19.11.1.2 Options

In the Local Services -> HotSpot Gateway -> Options menu, you configure general set-
tings for the HotSpot.

| el
Wiew | Standard v| | online Help

HotSpot Gateway Options

Basic Parameters

Language for login window English L
Haost for multiple locations

€ oK ) ( Cancel )

| DHCPServer |

eh Filter

| camisever |
cheduling
urveillance
DI Theft Protection
unkwerk Discovery
PnP

otSpot Gateway

Fig. 173: Local Services -> HotSpot Gateway -> Options

The Local Services -> HotSpot Gateway -> Options menu consists of the following
fields:
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Fields in the Options Basic Parameters menu

I =

Language for login win-
Here you can choose the language for the start/login page.

dow
The following languages are supported: English, German,
Italian, French, Spanishand Portuguese.
The language can be changed on the start/login page at any
time.
Host for multiple loca- If several locations (branches) are set up on the HotSpot server,
tions enter the value of the NAS identifier (RADIUS server parameter)

that has been registered for this location on the HotSpot server.



Chapter 20 Maintenance

This menu provides you with numerous functions for maintaining your device. It firstly
provides a menu for testing availability within the network. You can manage your system
configuration files. If more recent system software is available, you can use this menu to in-
stall it. If you need other languages for the configuration interface, you can import these.
You can also trigger a system reboot in this menu.

20.1 Diagnostics

In the Maintenance -> Diagnostics menu, you can test the accessibility of individual
hosts, the resolution of domain names and certain routes.

20.1.1 Ping Test

bintec R1200 " Language |English v| | iew |Standard ~| | OnlineHelp | Logaut

Ping Test DNS Test| Traceroute Test

Fing Test

Test Ping Address

Output

Diagnostics
Software & Configuration

| Reboot

Fig. 174: Maintenance -> Diagnostics -> Ping Test

You can use the ping test to check whether a certain host in the LAN or an internet address
can be reached. The Output field shows the ping test messages. The ping test is started
by entering the IP address to be tested in Send Ping Request to Address and clicking on
the Go button.
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20.1.2 DNS Test

bintec R1200 ; Language English | | Wiew | Standard ~| | Online Help | Lagaut
_save configuration Ping Test - Traceroute Test
DS Test
DNS Address |
Output
Diagnostics
Software & C i
hoot ( Go )

Fig. 175: Maintenance -> Diagnostics -> DNS Test

The DNS test is used to check whether the domain name of a particular host is correctly re-
solved. The Output field shows the DNS test messages. The DNS test is started by enter-
ing the domain name to be tested in DNS Address and clicking on the Go button.

20.1.3 Traceroute Test

binteec R1200 f Language |English | | Wiew |Sandard ~| | onlire Help | Logaut
Save contiguation__ Ping Test | DNS Test | Traceroute Test
Traceroute Test
Traceroute Address |
Output
Diagnostics
( Go )

Fig. 176: Maintenance -> Diagnostics -> Traceroute Test
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You use the traceroute test to display the route to a particular address (IP address or do-
main name), if this can be reached. The Output field shows the traceroute test messages.
The traceroute test is started by entering the address to be tested in Traceroute Address
and clicking on the Go button.

20.2 Software & Configuration

20.2.1 Options

You can use this menu to manage the software version of your device, your configuration
files and the language of the Funkwerk Configuration Interface.

Your device contains the version of the system software available at the time of production.
More recent versions may have since been released. You may therefore need to carry out
a software update.

Every new system software includes new features, better performance and any necessary
bugfixes from the previous version. You can find the current system software at
www.funkwerk-ec.com. The current documentation is also available here.

f Important

If you want to update your software, make sure you consider the corresponding re-
lease notes. These describe the changes implemented in the new system software.

The result of an interrupted update (e.g. power failure during the update) could be that
your gateway no longer boots. Do not turn your device off during the update.

An update of BOOTmonitor and/or Logic is recommended in a few cases. In this case,
the release notes refer expressly to this fact. Only update BOOTmonitor or Logic if
Funkwerk Enterprise Communications GmbH explicitly recommends this.

Flash

Your device saves its configuration in configuration files in the flash EEPROM (Electrically
Erasable Programmable Read Only Memory). The data even remains stored in the flash
when your device is switched off.

RAM

The current configuration and all changes you set on your device during operation are
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stored in the working memory (RAM). The contents of the RAM are lost if the device is
switched off. So if you modify your configuration and want to keep these changes for the
next time you start your device, you must save the modified configuration in the flash
memory before switching off: Save Configuration button in the Funkwerk Configuration
Interface navigation area. This configuration is then saved in the flash in a file with the
name boot. When you start your device, the boot configuration file is used by default.

Operations

The files in the flash memory can be copied, moved, erased and newly created. It is also
possible to transfer configuration files between your device and a host via HTTP.

E TR IR
tec R1 Jw-n‘—'- Language |English | | Wiew |Sandard v| | onineHelp | Logout | funkowerk:
R guage |Eng p g

[ ] .| - L s w x

Save configuration Options
Assistants
System Management

Physical Interfaces Currertly Installed Software

LAN BOSE V.7.9 Rev. 1 IPSec from 2009/11/09 00:00:00
Wireless LAN Systern Logic 1.2

Routing Software and Configuration Options

WAN Action MNo Action ~

VPN
Firewall
VolP

Local Services

rE R

Maintenance
Diagnostics
Software & Configuration
Reboot

External Reporting -

Monitoring -
Fig. 177: Maintenance -> Software & Configuration -> Options

The Maintenance -> Software & Configuration -> Options menu consists of the follow-
ing fields:

Fields in the menu Options Currently Installed Software
I =

BOSS Shows the current software version loaded on your device.

Shows the current system logic loaded on your device.
System Logic

SHDSL Logic
Shows the current version of the SHDSL logic loaded on your
device.

ADSL Logic
Shows the current version of the ADSL logic loaded on your
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device.

Fields in the Options Software and Configuration Options menu

I =

Action
Select the action you wish to execute.

After each task, a window is displayed showing the other steps
that are required.

Possible values:

* No action (default value):

* Import configuration: Under Filename select a config-
uration file you want to import. Note: Click Go to load the file
under the name boot in the flash memory for the device.
You must restart the device to enable it.

* Import language: You can import other language versions
of the Funkwerk Configuration Interface into your device.
You can download the files to your PC from the download
area at www.funkwerk-ec.com and from there import them to
your device.

* Update system software:you can start an update of the
system software, the ADSL logic and the BOOTmonitor.

* Export configuration: The configuration file Current fi-
lename in flash memory is transferred to your local host. If
you click on the Go button, a dialog box is shown, in which
you can select the storage location on your PC and enter the
desired file name.

® Export configuration with status information:
The active configuration from the RAM is transferred to your
local host. If you click on the Go button, a dialog box is
shown, in which you can select the storage location on your
PC and enter the desired file name.

* Copy: The configuration file in the Source File Name field is
saved as Destination file name.

* Rename: The configuration file in the Select File field is re-
named as New Filename.

* Delete Configuration: The configuration file in the Se-
lect File field is deleted.
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e Delete File: The file in the Select File field is deleted.
Configuration Encryption

Only for Action = Import configuration, Export con-

figuration, Export configuration with status in-

formation. Define whether the data of the selected Action

are to be encrypted..

The function is enabled by choosing Enabled.
The function is disabled by default.

If the function is active, you can enter the Password in the text
field.

Filename
Only for Action = Import configuration, Import lan-
guage, Update system software. Enter the path and name
of the file or select the file with Browse... via the explorer/finder.

Source Location
Only for Action = Update system software

Select the source for the update.
Possible values:

* Local File (default value): The system software file is
stored locally on your PC.

e ATTP server: The file is stored on a remote server specified
in the URL.

®* Current software from Funkwerk server: The fileis
on the official Funkwerk update server.

URL Only for Source = HTTP server
Enter the URL of the update server from which the system soft-
ware file is loaded.

Current File Name in

Flash For Action = Export configuration Choose the configura-
tion file to be exported.

Include certificates and

keys For Action = Export configuration, Export configur-—
ation with status information, select whether the se-
lected Action is also to apply for certificates and keys.

The function is enabled by choosing Enabled.
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The function is enabled by default.

Source File Name
Only for Action = CopySelect the source file to be copied.

Destination File Name
Only for Action = CopyEnter the name of the copy.

Select File
Only if Action = Rename, Delete configuration Of De—
lete fileChoose the file or configuration to be renamed or
deleted.

New File Name
Only for Action = RenameEnter the new name of the configura-
tion file.

20.3 Reboot

20.3.1 System Reboot

In this menu, you can trigger an immediate reboot of your device. Once your system has
restarted, you must call the Funkwerk Configuration Interface again and log in.

Pay attention to the LEDs on your device. For information on the meaning of the LEDs, see
the Technical Data chapter of the manual.

@ Note

Before a reboot, make sure you confirm your configuration changes by clicking the
Save Configuration button, so that these are not lost when you reboot.



bintec R1200 Language |English | | View |Standare v| | online Help | Logout

Co you really want to reboot the system now?

Fig. 178: Maintenance -> Reboot -> System Reboot

If you want to restart your device, click on the OK button. The device will reboot.
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Chapter 21 External Reporting

21.1 Syslog

Events in various subsystems of your device (e.g. PPP) are logged in the form of syslog
messages (system logging messages). The number of messages visible depends on the
level set (eight levels from Emergency and Information to Debug).

In addition to the data logged internally on your device, all information can and should also
be passed to one or more external PCs for storage and processing, e.g. to the system ad-
ministrator’s PC. The syslog messages saved internally on your device are lost when you
reboot.

f Warning
Make sure you only pass syslog messages to a safe computer. Check the data regu-
larly and ensure that there is always enough spare capacity available on the hard disk
of your PC.

Syslog Daemon

All Unix operating systems support the recording of syslog messages. For Windows PCs,
the Syslog Demon included in the DIME Tools can record the data and distribute to various
files depending on the contents (see BRICKware for Windows, which can be accessed at
www.funkwerk-ec.com).

21.1.1 Syslog Servers

Configure your device as a syslog server so that defined system messages can be sent to
suitable hosts in the LAN.

In this menu, you define which messages are sent to which hosts and with which condi-
tions.

In the External Reporting -> Syslog -> Syslog Servers menu, a list of all configured sys-
tem log servers is shown.
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21.1.1.1 New

Choose the New button to set up new syslog servers.

bintec R1200 ; Language English v | View  Stancard ~| | Online Help | Logout

Syslog Servers

( oK ) ( Cancel )

Syslog
IP Accounting
ail Alert

SHMP
Activity Monitor

Fig. 179: External Reporting -> Syslog -> Syslog Servers -> New

]

= ]

| Pisicalimertaces v | | bk prantes

I | | easess

WirelessLaW
1 Timestamp @None OTime ODate & Time
; Pratocol @upp OTcp
; Type of Messages O system O ing & System &
el

Maimenance v

The External Reporting -> Syslog -> Syslog Servers -> New menu consists of the fol-
lowing fields:

Fields in the Syslog Servers Basic Parameters menu

Field Description

IP Address Enter the IP address of the host to which syslog messages are
passed.

Level Select the priority of the syslog messages that are to be sent to
the host.

Possible values:

* Emergency (highest priority)
® Alert

® Critical

® Errors

® Warning

® Alert

R1xxx/R3xxx/R4xxx



Funkwerk Enterprise Communications GmbH

21 External Reporting

I =

Facility

Timestamp

Protocol

Type of Messages

* Tnformation (default value)

* Debug (lowest priority)

Syslog messages are only sent to the host if they have a higher
or identical priority to that indicated, i.e. all messages generated
are recorded at syslog level Debug.

Enter the syslog facility on the host.
This is only required if the Log Host is a Unix computer.

Possible values: 1ocal0o - 7

The default value is 1ocalo.

Select the format of the time stamp in the syslog.

Possible values:

* None (default value): No system time indicated.
e Time : System time without date.

* Date & Time :System time with date.

Select the protocol for the transfer of syslog messages. Note
that the syslog server must support the protocol.

Possible values:

* UDP (default value)

O TP

Select the message type.

Possible values:

e System & Accounting (default value)
® System

® Accounting



21.2 IP Accounting

In modern networks, information about the type and number of data packets sent and re-
ceived over the network connections is often collected for commercial reasons. This inform-
ation is extremely important for Internet Service Providers that bill their customers by data
volume.

However, there are also non-commercial reasons for detailed network accounting. If, for
example, you manage a server that provides different kinds of network services, it is useful
for you to know how much data is generated by the individual services.

Your device contains the IP Accounting function, which enables you to collect a lot of useful
information about the IP network traffic (each individual IP session).

21.2.1 Interfaces

In this menu, you can configure the IP Accounting function individually for each interface.

bintec R1200 | Language |English ~| | ‘iew |Standard ~| | Online Help | Logout

Interfaces Options

Wiew |20 per page Fiter in | None v | equal V|
IP Accounting

& Ol Select all| Deselect all

1 ent-0 F

2 enl-4 F

Page: 1,tems: 1-2

€ oK ) ( Cancel )

Syslog
IP Accounting
_mail Alert

Fig. 180: External Reporting -> IP Accounting -> Interfaces

In the External Reporting -> IP Accounting -> Interfaces menu, a list of all interfaces
configured on your device is shown. For each entry, you can activate IP Accounting by set-
ting the checkmark. In the IP Accounting column, you do not need to click each entry indi-
vidually. Using the options Select All and Disable All, you can enable or disable the IP ac-
counting function for all interfaces simultaneously.
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21.2.2 Options

In this menu, you configure general settings for IP Accounting.

Language |English | | wiew | Standard ~| | Online Help | Logout

Interfaces Options

Log Format INET: %ad %st %6 #6c %0 %erf%af -> %ol 2 Py%F %p %o %P %0 [*%s]

€ oK ) ( Cancel )

E-mail Alert
SHMP
Activity Monitor

Fig. 181: External Reporting -> IP Accounting-> Options

In the External Reporting -> IP Accounting -> Options menu you can set the Log
Format of the IP accounting messages. The messages can contain character strings in
any order, sequences separated by a slash, e.g. \t or \n or defined tags.

Possible format tags:

Format tags for IP Accounting messages

Field Description

%d Date of the session start in the format DD.MM.YY
Yot Time of the session start in the format HH:MM:SS
Y%oa Duration of the session in seconds

%6C Protocol

Yoi Source IP Address

Yor Source Port

Yof Source interface index

%ol Destination IP Address

%R Destination Port

% F Destination interface index
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Field Description

Yop Packets sent

%0 Octets sent

%P Packets received

%0 Octets received

%S Serial number for accounting message
%% %

By default, the following format instructions are entered in the Log Format field. INET:
$det%asc8i:sr/%f -> $I:%R/%F%p%0%PSO[%s]

21.3 E-mail Alert
It was previously possible to send syslog messages from the router to any syslog host. De-

pending on the configuration, E-mails are sent to the administrator as soon as relevant sys-
log messages occur.

21.3.1 E-mail Alert Server

The E-mail Alert Server menu consists of the following fields:

C oK 0 ( cancel )

bintec R1 Zﬁn 8 Language [English | | wiew | Standard ~| | Online Help | Logout
= (] - E-mail Alert Server E-mail Alert Recipient
g . =
Sender E-Mail Address I
g Maximum Messages per Minute
SMTP Seftings
g SHTP Sereer I
; SWTP Authentication @None OESMTP O SMTP after POP

Syslog
IP Accounting

ail Alert

SHMP

Activity Monitor

Fig. 182: External Reporting -> E-mail Alert -> E-mail Alert Server

The External Reporting -> E-mail Alert -> E-mail Alert Server menu consists of the fol-
lowing fields:

0] R1xxx/R3xxx/R4xxx



Funkwerk Enterprise Communications GmbH 21 External Reporting

Fields in the E-mail Alert Server Basic Parameters menu

I =

Alert Service Enable or disable the function.

Sender E-Mail Address  Enter the mail address to be entered in the sender field of the E-
mail.

Maximum Messages per

Minute Limit the number of outgoing mails per minute. Possible values

are 1 to 15, the default value is 6.

Fields in the E-mail Alert Server SMTP Settings menu

Field ' Description

SMTP Server
Enter the address (IP address or valid DNS name) of the mail

server to be used for sending the mails.

The entry is limited to 40 characters.

SMTP Authentication
Forward the incoming E-mails.
Possible values:
* None (default value): The E-mails are not forwarded.
e SMTP: The E-mails are forwarded to the destination over
SMTP.
e SMTP arfter POP: The E-mails are collected by the provider
with POP and are forwarded to the destination over SMTP.
User Name
Only if SMTP Authentication = ESMTP or SMTP after POP.
Enter the name of the user.
Password
Only if SMTP Authentication = ESMTP or SMTP after POP.
Enter the password of the user.
POP3 Server
Only if SMTP Authentication = SMTP after POP.
Enter the address of the server from which the mails are to be
retrieved.
Appropriate POP3 server software must be installed so that the
mailserver can answer the requests via POP3.
POP3 Timeout

Only if SMTP Authentication = SMTP after POP.
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Enter how long the router must wait after a relevant event be-
fore it is forced to send the alert mail.

The default value is 600 seconds.

21.3.2 E-mail Alert Recipient

In the E-mail Alert Recipient menu, a list of syslog messages is displayed.

21.3.2.1 New

Choose the New button to create new e-mail alert receivers.

k = ¥ :
__I% " -
201 I-h —- Language English v | | view |Standard ~| | Online Help | Logout flll'lhll'l‘k@
- ! wr x :

Save configur ation

E-mail Alert Server E-mail Alert Recipient

Assistants -
System Management -
Physical Interfaces N Adlel § Eclt E-mail Alert Recipient
LAN x Recipient |
Wireless LAN - )
Matching String | (Wildcards allowed)
Rowting -
v
WAN - Severity Emergency
VPN - Message Timeout B0
Firewall d Mumber of Messages 1
VolP -
Message Compression [¥] Enable
Local Services -
Monitored Subsystems
Maintenance b
Subsystem
External Reportin, -
e Add
Syslog
IP Accounting
E-mail Alert OK Cancel
SHMP
Activity Monitor
Monitoring -

Fig. 183: External Reporting -> E-mail Alert -> E-mail Alert Recipient

The External Reporting -> E-mail Alert -> E-mail Alert Recipient menu consists of the
following fields:

Fields in the E-mail Alert Recipient Add / Edit E-mail Alert Recipient menu

I =

Recipient Enter the E-mail address of the recipient. The entry is limited to
40 characters.

Matching String
You must enter a "Matching String". This must occur in a syslog
message as a necessary condition for triggering an alert.
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The entry is limited to 55 characters. Bear in mind that without
the use of wildcards (e.g. "*"), only those strings that correspond
exactly to the entry fulfil the condition. The "Matching String"
entered therefore usually contains wildcards. To be informed of
all syslog messages of the selected level, just enter "*".

Y Select the severity at which the string configured in the Match-
ing String field must occur to trigger an E-mail alert.

Possible values:

Emergency (default value), Alert, Critical, Error, Warn-
ing, Notice, Information, Debug

Message Timeout
Enter how long the router must wait after a relevant event be-
fore it is forced to send the alert mail.

Possible values are 0to 8§6400. The value 0 disables the
timeout.

Number of Messages
Enter the number of syslog messages that must be reached be-
fore an E-mail can be sent for this case. If timeout is configured,
the mail is sent when this expires, even if the number of mes-
sages has not been reached.

Possible values are 0to 99; the default value is 1.

Message Compression
Select whether the text in the alert E-mail is to be shortened.

The e-mail then contains the syslog message only once plus the
number of relevant events.

Enable or disable the field.

The function is enabled by default.

Fields in the E-mail Alert Recipient Monitored Subsystems menu

R

Subsystem
Select the subsystems to be monitored.

Add a new system with Add.



21.4 SNMP

SNMP (Simple Network Management Protocol) is a protocol from the IP protocol family for
transporting management information about network components.

Every SNMP management system contains an MIB. SNMP can be used to configure, con-
trol and administrate various network components from one system. Such an SNMP tool is
included on your device: the Configuration Manager. As SNMP is a standard protocol, you
can use any other SNMP managers, e.g. HPOpenView.

For more information on the SNMP versions, see the relevant RFCs and drafts:

* SNMP V. 1: RFC 1157
* SNMP V. 2¢: RFC 1901 - 1908
* SNMP V. 3: RFC 3410 - 3418

21.4.1 SNMP Trap Options

In the event of errors, a message - known as a trap packet - is sent unrequested to monitor
the system.

In the External Reporting -> SNMP -> SNMP Trap Options menu, you can configure the
sending of traps.

binteec R1200 | Language |English v| | Wiew | Standard ~| | onlre Help | Logaut

__Save configuration SNMP Trap Options SNMP Trap Hosts

Basic Parameters

SMMP Trap Broadcasting ClEnabled

( oK ) ( Cancel )

Syslog
IP Accounting

Fig. 184: External Reporting -> SNMP -> SNMP Trap Options
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The External Reporting -> SNMP -> SNMP Trap Options menu consists of the following
fields:

Fields in the SNMP Trap Options Basic Parameters menu
Field Description

SNMP Trap Broadcast-  Select whether the transfer of SNMP traps is to be activated.
ing
Your device then sends SNMP traps to the LAN's broadcast ad-
dress.
The function is enabled by choosing Enabled.

The function is disabled by default.

SNMP Trap UDP Port Only if SNMP Trap Broadcasting is enabled.

Enter the number of the UDP port to which your device is to
send SNMP traps.

Any whole number is possible.

The default value is 162.

SNMP Trap Community Only if SNMP Trap Broadcasting is enabled.

Enter a new SNMP code. This must be sent by the SNMP Man-
ager with every SNMP request so that this is accepted by your
device.

A character string of between 0 and 255 characters is possible
here.

The default value is SNMP Trap.

21.4.2 SNMP Trap Hosts

In this menu, you specify the IP addresses to which your device is to send the SNMP traps.

In the External Reporting -> SNMP -> SNMP Trap Hosts menu, a list of all configured
SNMP trap hosts is shown.

21.4.2.1 New

Choose the New button to set up new SNMP trap hosts.



bintec R1200 " Language |English v| | View |Standard ~| | Online Help | Logout
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Fig. 185: External Reporting -> SNMP -> SNMP Trap Hosts -> New

The External Reporting -> SNMP -> SNMP Trap Hosts -> New menu consists of the fol-
lowing fields:

Fields in the SNMP Trap Hosts Basic Parameters menu

Field Description

IP Address Enter the IP address of the SNMP trap host.

21.5 Activity Monitor

This menu contains the settings needed to monitor your device with the Windows tool
Activity Monitor (part of BRICKware for Windows).
Purpose

The Activity Monitor enables Windows users to monitor the activities of your device. Im-
portant information about the status of physical interfaces (e.g. ISDN line) and virtual inter-
faces is easily obtained with one tool. A permanent overview of the utilisation of your
device is possible.

Method of operation

A Status Daemon collects information about your device and transfers it as UDP packets to
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the broadcast address of the first LAN interface (default setting) or to an explicitly entered
IP address. One packet is sent per time interval, which can be adjusted individually to val-
ues from 1 - 60 seconds. Up to 100 physical and virtual interfaces can be monitored,
provided the packet size of 4096 bytes is not exceeded. The Activity Monitor on your PC
receives the packets and can display the information contained in them in various ways ac-
cording to the configuration.

Activate the Activity Monitor as follows:

* configure the relevant device(s) to be monitored.

 Start and configure the Windows application on your PC (you can download BRICKware
for Windows to your PC from the download area at www.funkwerk-ec.com and from
there import it to your device).

21.5.1 Options

} i o |
bintec R12ﬁ,0 Language |English | | ‘iew |Standard ~| | Online Help | Logout
optione
; Monitored Interfaces & None O Physical O Physical WANAVPN
i Send information to [ AP Addresses Broadoas) v
; Update Interval 13 Seconds
1 UDP Destination Port 2107
e S -

Syslog
IP Accounting

IN

Fig. 186: External Reporting -> Activity Monitor -> Options

The External Reporting -> Activity Monitor -> Options menu consists of the following
fields:

Fields in the Options Basic Parameters menu

Field Description

Monitored Interfaces Select the type of information to be sent in the UDP packets to
the Windows application.

R1xxx/R3xxx/R4xxx
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Possible values:

e None (default value): Deactivates the sending of information
to the Activity Monitor.

* Physical: Only information about the physical interfaces is
sent.

* Physical/WAN/VPN: Information about physical and virtual
interfaces is sent

Send Information to Select where your device sends the UDP packets.
Possible values:

* Al]l IP Addresses (broadcast) (defaultvalue): The de-
fault value 255.255.255. 255 means that the broadcast ad-
dress of the first LAN interface is used.

* Single Host: The UDP packets are sent to the IP address
entered in the adjacent input field.

Update Interval Enter the update interval (in seconds).
Possible values are 0to 60.

The default value is 5.

UDP Destination Port Enter the port number for the Windows application Activity
Monitor.

The default value is 2107 (registered by IANA - Internet As-
signed Numbers Authority).

Password Enter the password for the Activity Monitor.



Chapter 22 Monitoring

This menu contains information that enable you to locate problems in your network and
monitor activities, e.g. at your device's WAN interface.

22.1 Internal Log

22.1.1 System Messages

In the Monitoring -> Internal Log -> System Messages menu, a list of all internally stored
system messages is shown. Above the table you will find the configured Maximum Num-
ber of Syslog Entries and the configured Maximum Message Level of Syslog Entries.
These values can be changed in the System Management -> Global Settings -> System
menu.

bintee R1200 " Language |English v | “iew |Standard ~| | onine Help | Logout

System Messages

Seconds ( Apply )

Maxdmum Number of Syslog Entries 50

Automatic Refresh Interval |50

Maximum Message Level of Syslog Entries Information

Wiew |20 per page @Fmerm Mone v | equal _VI
Date Time: Level Subsystem  Message
2008-01-19 01:24:51 Information INET APDISCD: 3 access points found oninterface 1000
2006-01-19 01:24:41 Infarmation INET APDISCD: discovery initiated an interface 1000

*

1

2

3 200B-01-18 00:07:10 Information TTY

4 12006-01-19 00:07:10 Information TTY

5 2006-01-18 00:06:50 Information YolP
B 200B-01-18 00:06:48 Information IPSec
7 /2006-01-19 00:06:48 Information | IPSec

Log on to GSM Provider 'Limited Service' (AcT = GSM)

awailable APN[ 1] ‘internet’

PABXD: Adminstatus is disabled, all PABX features will be disabled
init: starting

BinTec ipsecd wversion 3.0 Copyright () 1996-2003 by Funkwerk Enterprise
Communications GmbH

init: running
sshd: pid 57 - listening on 0.0.0.0 port 22

en1-0: add multicast 01:00:5e AT efef
en1-0: add multicast 01:00:5e:00:00:01
eni-0: add multicast 01:00:5e:00:00:02

Internal Log 8 2006-01-19 00:06:48 Information IPSec
PSec 9 | 2006-01-19 00:06:48 Information INET
ISDHModem 10 2006-01-19 00:06:48 Information Configuration system r1200 started at Thu Jan 19 0:06:48 2006
Interfaces 11 2006-01-19 00:06:47 Debug  Ethemet
LAl 12 2006-01-19 00:06:47 | Debug Ethernet
= _HotSpot Gateway 13|2006-01-19|00:06:47 | Debug  |Ethernet
14 2006-01-19 00:06:47 Debug  Ethemet

15 2006-01-19 00:06:47 Debug HTTF
16 2008-01-19 00:06:47 | Debug HTTP
17 2006-01-19 00:06:46 Debug
18 2008-01-19 00:06:48 Debug
19 2006-01-19 00:06:46 Debug
20 2006-01-19 00:06:46 Debug
Page: 1,tems: 1- 20, total tems: 47

33|33

en1-0: add multicast 01:00:5e:00:00:18

hittpd[24]: perm: unable to read key file

hitpd[25]: using default cerificate

Modem-Model: GlobeTrotter 3G+

Modem-FwRew. 3.17.0Hd (Cate: Apr 11 2006, Time: 13:19:33)
Modem-SerialMo: 359942002805380,NF2873G04N

Modem answer to <AT+CPIN?= is unknown +GME ERROR: 522'in state |8

Fig. 187: Monitoring -> Internal Log -> System Messages

Values in the list System Messages

R1xxx/R3xxx/R4xxx
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# Displays the serial number of the system message.

Date Displays the date of the record.

Time Displays the time of the record.

Level Displays the hierarchy level of the message.

Subsystem Displays which subsystem of the device generated the mes-
sage.

Message Displays the message text.

22.2 IPSec

22.2.1 IPSec Tunnels

In the Monitoring -> IPSec -> IPSec Tunnels menu, a list of all configured IPSec peers is
shown.

|l o+ ol 3 ¥ |
L EENENAN Y Y . K
“" Language |English ~| | Wiew |Standard ~| | Onling Help | Logout fl.ll'lhll.l‘k@
| v s
1 - Tmr - z 1
Save configuration IPSec Tunnels | [PSec Statistics
Assistants -
System Management -
Aingicalineracas hd Automatic Refrash Intsrval |50 Secands Apply
LAN A
Wigwe |20 per page Fitter in | None ~ | equal ~ Go
Wireless LAN ~
#  Description Remate P Remate Netwaorks Security Algorithm Status Action
Routing n 1 Peert - CJ 313 =l
WAN - Page: 1, tems: 1-1
VPN A
Firewall hd
VolP -
Local Services e
Maintenance -
External Reporting -
Monitoring -
Internal Log
IPSec
1SDHiModem
Interfaces
WLAN
HotSpot Gateway

Fig. 188: Monitoring -> IPSec -> IPSec Tunnels

Values in the list IPSec Tunnels

Field Description

# Displays the serial number of the IPSec tunnel.

Description Displays the name of the IPSec tunnel.
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Remote IP Address Displays the IP address of the remote |IPSec Peers.

Remote Networks Displays the currently negotiated subnets of the remote termin-
al.

Security Algorithm Displays the encryption algorithm of the IPSec tunnel.

State Displays the operating status of the IPSec tunnel.

Action Enables you to change the status of the IPSec tunnel as dis-
played.

Details Opens a detailed statistics window.

You change the status of the IPSec tunnel by pressing the |I| button or E button in the
Action column.

By pressing the @ button, you display detailed statistics on the IPSec connection.

E L el g L ¥ ]
tec R Jr-|--‘—h Language |English v | | Wiew |Standard ~| | Online Help | Logout flll'lh“l‘km
a | ,ﬁ- | erberoeie pamumkabisrs
A - u w r

Save configur ation IPSec Tunnels |IPSec Statistics
Assistants -
System Management -
Physical iterfaces hd Automatic Refresh Interval |60 Secands Apply
LAN -
General
A T Description Peer-1
Gouting - Local IP Address 0.0.0.0
wan = Remote [P Address 0.0.00
7 - Local ID
Firewall = Remote ID
VolP - Megotiation Type
Local Services - Authentication Method
Maintenance - il 118
Alive Check
External Reporting -
Statistics In out
Monitoring - Packets 0 0
Internal Log Bytes 0 0
JbSer Errars o o
1SDiModem
Messages ( 0)
Interfaces
WLAH
HotSpot Gateway

Fig. 189: Monitoring -> IPSec -> IPSec Tunnels ->|E|

Values in the list IPSec Tunnels

Description Shows the description of the peer.
Local IP Address Shows the WAN IP address of your device.
Remote IP Address Shows the WAN IP address of the connection partner.

Local ID Shows the ID of your device for this IPSec tunnel.
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Remote ID Shows the ID of the peer.

Negotiation Type Shows the exchange type.

Authentication Method ~ Shows the authentication method.

MTU Shows the current MTU (Maximum Transfer Unit).

Alive Check Shows the method for checking that the peer is reachable.
NAT Detection Displays the NAT detection method.

Local Port Shows the local port.

Remote Port Shows the remote port.

Packets Shows the total number of incoming and outgoing packets.
Bytes Shows the total number of incoming and outgoing bytes.
Errors Shows the total number of errors.

IKE (Phase 1) SAs (x)  The parameters of the IKE (Phase 1) SAs are displayed here.

Role / Algorithm / Life-
time remaining / State

IPSec (Phase 2) SAs (x) Shows the parameters of the IPSec (Phase 2) SAs.

Role / Algorithm / Local /
Remote / Lifetime re-
maining / State

Messages The system messages for this IPSec tunnel are displayed here.

22.2.2 IPSec Statistics

In the Monitoring -> IPSec -> IPSec Statistics menu, statistical values for all IPSec con-
nections are shown.
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; s | letains ol i g P ¢
|~ jEa SN R Arrew o -
tec R EJ“.I;‘—" Language |English | | View  Standard ~| | online Help | Logout ﬁll'lk“l‘k@
i x = w = I [E i
SRS SShpee IPSec Tunnels IPSec Statistics
Assistants -
System Management -
BinEicaliteraces T Automatic Retresh Irterval [0 Seconds Apply
A - Licences In Use Mazimum
Wireless LAN - IPSec Tunnels o Ll
Routing = Feers Up Going up Blocked Dormant Configured
Status o 0 o 1 1
WAN -
Shs Establisher! Total
i - IKE (Phase-1) 0 0
Firewall = IPSec (Phase-2) i} 0
ValP - Packet Statistics In Qut
Local Services - [Lots) &) X
Passed 34 87
Maintenance -
Dropped a a
External Reporting - Encrypted 0 0
Monitoring & Errors 0 0
Internal Log
IPSec
1SDiModem
Interfaces
WLAN

HotSpot Gateway

Fig. 190: Monitoring -> IPSec -> IPSec Statistics
The Monitoring -> IPSec -> IPSec Statistics menu consists of the following fields:

Field in the IPSec Statistics Licenses menu
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IPSec Tunnels Shows the IPSec licenses currently in use (In use) and the
maximum number of licenses usable (Maximum).

Field in the IPSec Statistics Peers menu
I =
Status Displays the number of IPSec tunnels by their current status.

* Active: Currently active IPSec tunnels.

Enable: IPSec tunnels currently in the tunnel setup phase.

Blocked: IPSec tunnels that are blocked.
e Dormant: Currently inactive IPSec tunnels.

» Configured: Configured IPSec tunnels.

Field in the IPSec Statistics SAs menu

Field Description

IKE (Phase1) Shows the number of active phase-1 SAs (Established) from
the total number of phase-1 SAs (Total).

IPSec (Phase2) Shows the number of active phase-2 SAs (Established) from

22 Monitoring
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the total number of phase-2 SAs (Total).

Field in the IPSec Statistics Packet Statistics menu

Field 7 Description

Total Shows the number of all processed incoming (Incoming) or
outgoing (Outgoing) packets.

Passed Shows the number of incoming (Incoming) or outgoing (Outgo-
ing) packets forwarded in plain text.

Dropped Shows the number of rejected incoming (Incoming) or outgoing
(Outgoing) packets.

Encrypted Shows the number of IPSec protected incoming (Incoming) or
outgoing (Outgoing) packets.

Errors Shows the number of incoming (Incoming) or outgoing (Outgo-
ing) packets for which the processing led to errors.

22.3 ISDN/Modem

22.3.1 Current Calls

In the Monitoring -> ISDN/Modem -> Current Calls menu, a list of the existing ISDN con-
nections (incoming and outgoing) is shown.



~f 8 3 )

bintec R1200 Language | English v | View |Standard ~| | online Help | Logout

Current Calls ' Call History

Automatic Refresh Interval |50 Seconds (_ Apply )
wigw |20 per page [T piter in |Nune Vl equal VI @'

#  Service Remote Number Intertace Direction Chargs Duration Stack  Channel Status
Page: 1

Internal Log

IPSec

SO Modem

nterfaces
WLAN
HotSpot Gateway

Fig. 191: Monitoring -> ISDN/Modem -> Current Calls

Values in the list Current Calls

Field Description

# Displays the serial number of the ISDN connection entry.

Service Displays the service to or from which the call is connected: PPP,
IPSEC, X.25, POTS.

Remote Number Displays the number that was dialled (in the case of outgoing
calls) or from which the call was made (in the case of incoming
calls).

Interface Displays additional information for PPP connections.

Direction Displays the send direction: Tncoming, Outgoing.

Charge Displays the costs of the current connection.

Duration Displays the duration of the current connection.

Stack Displays the related ISDN port (STACK).

Channel Displays the number of the ISDN B channel.

Status Displays the state of the connection: null, c-initiated,

ovl-send, oc-procd, c-deliverd, c-present, c-recvd,
ic-procd, up, discon-req, discon-ind, suspd-req, re—
sum-req, ovl-recv.
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22.3.2 Call History

In the Monitoring -> ISDN/Modem -> Call History menu, a list of the last 20 ISDN con-
nections (incoming and outgoing) made since the last system boot is shown.

Standard

bintec R12 Language |English | | wiew Online Help | Logout

Current Calls Call History

Automatic Refresh Interval [0 Seconds ( Apply )
View |20 per page Fier in | Nane v|equal v

#  Service Remote Number Intertace Direction Charge Start Time Durstion
Fage: 1

Internal Log
IPSec

~ ISDHModem
Interfaces
WLAN
HotSpot Gateway

Fig. 192: Monitoring -> ISDN/Modem -> Call History

Values in the list Call History

Field Description

# Displays the serial number of the ISDN connection.

Service Displays the service to or from which the call was connected:
PPP, IPSEC, X.25, POTS.

Remote Number Displays the number that was dialled (in the case of outgoing
calls) or from which the call was made (in the case of incoming
calls).

Interface Displays additional information for PPP connections.

Direction Displays the send direction: Tncoming, Outgoing.

Charge Displays the costs of the connection.

Start Time Displays the time at which the call was made or received.

Duration Displays the duration of the connection.

22.4 Interfaces
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22.4.1 Statistics

In the Monitoring -> Interfaces -> Statistics menu, the current values and activities of all
device interfaces are shown.

Online Help

Statistics

Show | Transter Totals | Automatic Refresh Interval IED Secands { Apply )

Wigw lED_ per page D Fitter in | None ~ | equal VI

# Descripion  Type TzPackets  TxBytes TxErrors RxPackets RxBytes RxErrors  Status  Unchanged for Action

1 ent-0 Ethemst (710 566.55K |0 568 98.66K |0 [+] 0d 2h 8m 135 2l
7 enl-4 Ethernet |0 i 0 0 0 0 [+] od2hamiss  ([A[¥] [H
3 Peer Turnel 0 0 0 0 0 0 @ tdohdmiis  [#]#] |[O]

Page: 1,tems: 1-3

Internal Log
IPSec

ISDHModem
Interfaces

WLAN
HotSpot Gateway

Fig. 193: Monitoring -> Interfaces -> Statistics

You change the state of the interface by pressing the E| button or E button in the Action
column. Press the @ button to display the statistical data for the individual interfaces in de-
tail.

Values in the list Statistics

# Shows the serial number of the interface.
Description Displays the name of the interface.

Type Displays the interface text.

Tx Packets Shows the total number of packets sent.

Tx Bytes Displays the total number of octets sent.

Tx Errors Shows the total number of errors sent.

Rx Packets Shows the total number of packets received.

Rx Bytes Displays the total number of bytes received.

Rx Errors Shows the total number of errors received.

Status Shows the operating status of the selected interface.
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22 Monitoring Funkwerk Enterprise Communications GmbH

e ]

Unchanged for Shows the length of time for which the operating status of the
interface has not changed.

Action Enables you to change the status of the interface as displayed.

22.5 WLAN

22.5.1 WLANT1

In the Monitoring -> WLAN -> WLAN1 menu, the current values and activities of the first
interface are shown.

k Tatie o+ ¥ =
S 8 —19 o hd
201 lll —"" Language Enghs v| | wview |Standard ~| | online Help | Logout ﬁll'lk“l‘k@
] - w’ w x )

Save configuration WLAN1 VSS WDS Client Links
Assistants

System Management

BinEicaliteraces Automatic Refrash Intsrval |50 Seconds Apply

WLAN  Statistics
mbps T:
54 0
42 0
36 0
24 0
12 o
12 0
1 o
0
1}
a
0
a
0

LAN

Wireless LAN % Packets % Packets
Routing

WAN

VPN

Firewall

VolP

Local Services
El
B
515
2
Internal Log ]
IPSec
ISDHModem

Maintenance

External Reporting

NN Ny

FR:
o
o
o
o
o
o
o
o
1}
o
Monitoring il
o
Total o

Interfaces
WLAN Advanced

HotSpot Gateway

Fig. 194: Monitoring -> WLAN -> WLAN1

Values in the list WLAN1
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mbps Displays the possible data rates on this wireless module.

Tx Packets Shows the total number of packets sent for the data rate shown
in mbps.

Rx Packets Shows the total number of packets received for the data rate

shown in mbps.

You can choose the Advanced button to go to an overview of more details.
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- Tt LG RN n-
tec R1 2( 'll-“" Language |English | | “iew |Standard ~| | Onling Help | Logout fl.ll'lhll.l‘k@
[ ] 1 = w! w I
Save confiipration, WLAN1 VSS WDS || Client Links
Assistanis -
System Management -
Aingicalineracas hd Automatic Refrash Intsrval |50 Secands Apply
LAN T # Descrigtion Yalue
Wireless LAN ~ 1 Unicast MSDUs transmitted successfully 1}
Routing - 2 Multicast MSDUs transmitted successiully 0
WAN - 3 Transmitted MPDUS 0
4 Multicast MSDUs received successfully o
VPN -
g Unicast MPDUs received successully a
EliExigl hd 5 MSDUs that could not be transrmitted 0
VolP = 7 Frame transmissions without ACK received 0
Local Services - 8 Duplicate received MSDUs 0
Maintenance - 2] CTS frames received in response to an RTS a
= 10 Received MPDUs that couldn't be decrypted a
External Reporting -
" RTS frames with no CTS received i}
Monitoring — 12 Cormupt Frames Received a
Internal Log
IPSec Back
1SDHiModem
Interfaces
WLAN
HotSpot Gateway

Fig. 195: Monitoring -> WLAN -> WLAN1 -> Advanced

Values in the list Advanced

Field

Description

#
Description

Value

Displays the serial number of the list entry.
Displays the description of the displayed value.

Displays the statistical value.

Meaning of the list entries

Description

Unicast MSDUs trans-

mitted successfully

Multicast MSDUSs trans-

mitted successfully
Transmitted MPDUs

Multicast MSDUs re-
ceived successfully

Unicast MPDUs re-
ceived successfully

MSDUs that could not
be transmitted

Frame transmissions

Meaning

Displays the number of MSDUs successfully sent to unicast ad-
dresses since the last reset. An acknowledgement was received
for each of these packets.

Displays the number of MSDUs successfully sent to multicast
addresses (including the broadcast MAC address).

Displays the number of MPDUs received successfully.

Displays the number of successfully received MSDUs that were
sent with a multicast address.

Displays the number of successfully received MSDUs that were
sent with a unicast address.

Displays the number of MSDUs that could not be sent.

Displays the number of sent frames which which an acknow-
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without ACK received ledgement frame was not received.

Duplicate received MS-  Displays the number of MSDUs received in duplicate.

DUs

CTS frames received in  Displays the number of received CTS (clear to send) frames
response to an RTS that were received as a response to RTS (request to send).

Received MPDUs that Displays the number of received MSDUs that could not be en-
couldn't be decrypted crypted. One reason for this could be that a suitable key was
not entered.

RTS frames with no CTS Displays the number of RTS frames for which no CTS was re-

received ceived.

Corrupt Frames Re- Displays the number of frames received incompletely or with er-
ceived rors.

22.5.2 VSS

In the Monitoring -> WLAN -> VSS menu, the current values and activities of the con-
figured wireless networks are shown.

E ¥ i pllera ik bty i :
] - B -8
Yl i VRSN | oo [English @) | Wiew [Stendard ~| | online Help | Logout flll'lhll.l‘k@
‘-. ertarpriss cammunicatiz e

] ] - = w X

Save configur ation WLAN1 VSS WDS ClientLinks
Assistants ~7

System Management -

Ainsicaliniegaces, T Automatic: Refresh Interval |300 Seconds Apply

Lan - Client Nac Table

Wireless LAN - Signal dBm

MAC Address P Address  Up Time TxPackets  Rx Packets (RSSI1, RSSI2, RSS13) Moise dBm  Data Rate mbps

Routing -
Funkwerk-ec (vss1-0]
AN - 0000067550 0000  0Days) 0047 |3 2 -44(0,0,0) .92 12
VPN n
Firewall >
VolP -
Local Services hd
Maintenance -
External Reporting -
Monitoring -
Internal Log
IPSec
1SDHModem
Interfaces
WwLAN
HotSpot Gateway

Fig. 196: Monitoring -> WLAN -> VSS

Values in the list VSS
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MAC Address Shows the MAC address of the associated client.
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IP Address Shows the IP address of the client.

Up Time Shows the time in hours, minutes and seconds for which the cli-
ent is logged in.

Tx Packets Shows the total number of packets sent.

Rx Packets Shows the total number of packets received.

Signal dBm Shows the received signal strength in dBm.

Noise dBm Shows the received noise strength in dBm.

Data Rate mbps Shows the current transmission rate of data received by this cli-
ent in mbps.

The following clock rates are possible: IEEE 802.11b: 11, 5.5, 2
and 1 mbps; IEEE 802.11g/a: 54, 48, 36, 24, 18, 12, 9, 6 mbps.

If the 5 GHz frequency band is used, the indication of 11, 5.5, 2
and 1 mbps is suppressed for IEEE 802.11b.

VSS - Details for Connected Clients

In the Monitoring -> WLAN -> VSS-><Connected cIient>->|E| menu, the current values
and activities of a connected client are shown.

E 1 4 . wletaee oI gl ¥
R 5 -8
tec R1 J"l“" Language |English ~| | View |Standard ~| | Ornling Help | Logout fl.ll'lhll.l‘k@
- | = wr 4 x

T WLAN1 | VSS WDS  client Links
Assistants -
System Management -
Physical Interfaces = Automatic Retresh Interval |300 Seconds Apply
LAN - Cliert MAC Addiress P Address Up Time (Ségsnsaw‘wdggsu R Poise dBm SNRHB  Data Rate mbps
Wireless LAN - 00:00:10:67 5573 0.0.0.0 0 Day(s) 0:1:13 -44(0,0,0) 92 48 12
Routing - Rte Tx Packets Fx Packets
WAN - a4 0 0
18 0 0
VPN -
36 a 0
Firewall - 24 0 a
VoIP - 18 0 0
Local Services - 12 2 2
Maintenance - 1 0 o
9 0 0
External Reporting -
— [ 0 0
Monitoring - 55 0 0
Internal Log 2 0 f
IPSec p . =
1SDHModem
Interfaces Total 3 2
WLAN
HotSpot Gateway Back

Fig. 197: Monitoring -> WLAN -> VSS-><Connected cIient>->|E|

Values in the list VSS <Connected client>
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Client MAC Address Shows the MAC address of the associated client.
IP Address Shows the IP address of the client.

Up Time Shows the time in hours, minutes and seconds for which the cli-
ent is logged in.

Signal dBm Shows the received signal strength in dBm.
Noise dBm Shows the received noise strength in dBm.
SNR dB Signal-to-Noise Ratio in dB is an indicator of the quality of the

wireless connection.

Values:

* > 25 dB excellent

* 15 - 25 dB good

e 2 - 15 dB borderline
e 0-2dB bad.

Data Rate mbps Shows the current transmission rate of data received by this cli-
ent in mbps. The following clock rates are possible: IEEE
802.11b: 11, 5.5, 2 and 1 mbps; IEEE 802.11g/a: 54, 48, 36, 24,
18, 12, 9.6 mbps. If the 5-GHz frequency band is used, the in-
dication of 11, 5.5, 2 and 1 mbps is suppressed for IEEE

802.11b.
Rate Displays the possible data rates on this wireless module.
Tx Packets Shows the number of sent packets for the data rate.
Rx Packets Shows the number of received packets for the data rate.

22.5.3 WDS

In the Monitoring -> WLAN -> WDS menu, the current values and activities of the con-
figured WDS links are shown.



bintec. R1200 i Language |English | | Wiew |Sandard Online Help

wiaNt | vss | WDS | client Links

Automatic Refresh Interval |50 Seconds | Apply )

WDS Table
WDS Descrigtion  Remote MAC Up Time: TxPackels Rx Packets Signal dBm (RSSH, RSSI2, RSSIZ)  Moise dBm  Dala Rate mbps
wds1-0 00:00:00:00:00:00 0d OhOm s 0 o 0¢0,0,00 0 0 @

Internal Log
IPSec

| ISDModem
Interfaces
WLAN

| HotSpot Gateway

Fig. 198: Monitoring -> WLAN -> WDS

Values in the list WDS

Field Description

WDS description Shows the name of the WDS link.

Remote MAC Shows the MAC address of the WDS link partner.

Up Time Shows the time in hours, minutes and seconds for which the
WDS link in question is active.

Tx Packets Shows the total number of packets sent.

Rx Packets Shows the total number of packets received.

Signal dBm Shows the received signal strength in dBm.

Noise dBm Shows the received noise strength in dBm.

Data Rate mbps
Shows the current transmission rate of data received on this

WDS link in mbit/s.

If required, the Test link can be used to start a link test. The test is only available for funk-
werk devices and only if the WDS link is active.

The link test provides all the data necessary for checking the quality of the WDS link. The
link test also helps you to align the antennas. This option is only displayed if the link state is
Enabled.

WDS Link Details
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You use the @ icon to open an overview of further details for the WDS links.

Wiew | Standard hd

Online Help | Logout

VSS WDS Client Links

Autometic Refresh Interval |80 Secands ( Apply )
WDS Dsscription | Remote MAC Up Time Tx Packets  Rx Packets  Signsl dBm (RSSI1, RSSI2,RS513)  Woise dBm  Data Rats mbps
wds1-0 00:00:00:00:00:00 | 0d Oh Om 475 |0 0 0(0,0,0) 0 0

Rate Tx Packets Rx Packets

54 0 0

42
36
24
12
12
1
g
4
515
2
q

o o oo oooooooo
o o oo ocooc oo o oo

Total

Fig. 199: Monitoring -> WLAN -> WDS—>|E|

Values in the list WDS

Field Description

WDS Description Shows the name of the WDS link.

Remote MAC Shows the MAC address of the WDS link partner.

Up Time Shows the time in hours, minutes and seconds for which the
WDS link in question is active.

Tx Packets Shows the total number of packets sent.

Rx Packets Shows the total number of packets received.

Signal dBm Shows the received signal strength in dBm.

Noise dBm Shows the received noise strength in dBm.

Data Rate mbps
Shows the current transmission rate of data received on this

WDS link in mbit/s.

Rate Shows separately, for each of the stated data rates, the values
for Tx Packets and Rx Packets.
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22.5.4 Client Links

In the Monitoring -> WLAN -> Client Links menu, the current values and activities of the
client links are shown.

Standlard Online Help

Wiew Logout

VSS WDS Client Links

Automatic Refresh Interval |60 Secands Apply )

Cliert Link Table

Cliert Link Description AP MAC Address Up Time Tz Packets Rz Packets Signal dBm (RSS1, RSSI2 RESI3)  Moise dBm  Data Rate mbps
WILANT ()

stal-0 0d 0h 38m 285 |0 0 0(0,0,09 0 0 2l

Fig. 200: Monitoring -> WLAN -> Client Links

Values in the Client Links list

Field Description

Client Link Description ~ Shows the name of the client link.

AP MAC Address Shows the MAC address of the client link partner.

Up Time Shows the time in hours, minutes and seconds for which the cli-
ent link in question is active.

Tx Packets Shows the total number of packets sent.

Rx Packets Shows the total number of packets received.

Signal dBm Shows the received signal strength in dBm.

Noise dBm Shows the received noise strength in dBm.

Data Rate mbps Shows the current transmission rate of data received on this cli-

ent link in mbit/s.

Client Link Details

You can use the @ icon to open a summary of further details of the client links.

R1xxx/R3xxx/R4xxx
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Fig. 201: Monitoring -> WLAN -> Client Links->|E|

Values in the Client Links list

Field Description

AP MAC Address
Up Time

Signal dBm
Noise dBm
SNR dB

Data Rate mbps

Rate

22.6 Bridges

Shows the MAC address of the client link partner.

Shows the time in hours, minutes and seconds for which the cli-
ent link in question is active.

Shows the received signal strength in dBm.
Shows the received noise strength in dBm.
Shows the signal quality in dB.

Shows the current transmission rate of data received on this cli-
ent link in mbit/s.

Shows separately, for each of the stated data rates, the values
for Tx Packets and Rx Packets.
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22.6.1 br<x>

In the Monitoring -> Bridges -> br<x> menu, the current values of the configured bridges
are shown.

bintec R1200 | Language |English v| | Wiew  Standard ~| | onlineHelp | Logout

bro  stal-d

Automatic Refresh Interval |60 Secands Apply )

MAC Address Port
00:a0:13:00:08:38 ent-0

Internal Log

Fig. 202: Monitoring -> Bridges

Values in the br<x> list
Field Description

MAC Address Shows the MAC addresses of the associated bridge.

Port Shows the port on which the bridge is active.
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22.6.2 sta<x>

In the Monitoring -> Bridges -> sta<x> menu, the current values of the bridges to the con-
figured WLAN clients are shown.
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Fig. 203: Monitoring -> Bridges
Values in the sta<x> list

Field Description

Current Wildcard MAC  Shows the current configured wildcard MAC address.

Address

IP Address Shows the IP address of the host associated with this WLAN cli-
ent link.

MAC Address Shows the MAC address of the host associated with this WLAN
client link.

Port Shows the port on which the bridge is active.

22.7 HotSpot Gateway

R1xxx/R3xxx/R4xxx



22.71 HotSpot Gateway

In the Monitoring -> HotSpot Gateway -> HotSpot Gateway menu, a list of all connected
hosts is shown.

bintec R1200 Language |English | | iew |Standard ~| | Online Help | Logout

HotSpot Gateway

Autometic Refresh Interval |60 Seconds | Apply )
Autherticated HotSpot User

LUzer Mame IP Address Physical Address Logon Interface

Internal Log

1SDiModem
Interfaces
WLAN
Bridges

Fig. 204: Monitoring -> HotSpot Gateway -> HotSpot Gateway

Values in the list HotSpot Gateway

Field Description
User Name Displays the user's name.
IP Address Shows the IP address of the user.

Physical Address
Shows the physical address of the user.

Logon Shows the login time.

Interface Shows the interface used.

R1xxx/R3xxx/R4xxx
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Glossary

Announcement If you want to call your employees or family members to a meeting
or the dinner table, you could call each one of them individually or
simply use the announcement function. With just one call, you reach
all the announcement-enabled telephones without the subscribers
having to pick up the receiver.

Announcement func-Performance feature of a PBX. On suitable telephones (e.g. system
tion telephones), announcements can be made as on an intercom.

Bit Binary digit. Smallest unit of information in computer technology.
Signals are represented in the logical states "0" and "1".

Bundle The external connections of larger PBXs can be grouped into
bundles. When an external call is initiated by the exchange code or
in the event of automatic external line access a bundle released for
this subscriber is used to establish the connection. If a subscriber
has authorisation for several bundles, the connection is established
using the first released bundle. If one bundle is occupied, the next
released bundle is used. If all the released bundles are occupied,
the subscriber hears the engaged tone.

Busy On Busy Call to engaged team subscriber. If one subscriber in a team has
taken the receiver off the hook or is on the telephone, you can de-
cide whether other calls are to be signalled for this team. The setting
for reaching a subscriber can be toggled between "Standard" and
"Busy On Busy". In the basic configuration, it is set to Standard. If
Busy on Busy is set for a team, other callers hear the engaged tone.

DECT Digital European Cordless Telecommunication. European standard
for wireless telephones and wireless PBXs. Internal calls can be
made free of charge between several handheld units. Another ad-
vantage is the higher degree of interception protection (GAP).

Digital exchange Allows computer-controlled crossbar switches to set up a connection
quickly, and special features such as inquiries, call waiting, three-
party conference and call forwarding to be activated. All T-Com ex-
changes have been digital since January 1998.

Digital voice trans- As a result of the internationally standardised Pulse Code Modula-

mission tion (PCM), analogue voice signals are converted to a digital pulse
flow of 64 kbps. Advantages: Better voice quality and less suscept-
ibility to faults during analogue voice transmission.
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Direct Call

DISA

Download

DSL and ISDN con-
nections

DSL modem

DSL splitter

Services

Glossary

You are not at home. However, there is someone at home who
needs to be able to reach you quickly and easily by telephone if ne-
cessary (e.g. children or grandparents). As you can set up the Direct
Call function for one or more telephones, the receiver of the tele-
phone simply needs to be lifted. After five seconds, the PBX auto-
matically calls the defined direct call number, if you do not start dial-
ling another number first. You can enter up to 12 destination num-
bers when you configure Direct Call. A direct call number can only
be used by one subscriber. If you want to change an entered direct
call number, you can simply enter the new direct call number without
having to delete the old direct call number. The old number is auto-
matically overwritten when the new configuration is transferred to
the PBX.

Direct Inward System Access

Data transfer during online connections, where files are "loaded"
from a PC or data network server to the user's own PC, PBX or ter-
minal, so that they can be used there.

Data is transferred between the Internet and your PBX over ISDN or
T-DSL. The PBX determines the remote terminal to which a data
packet is to be sent. For a connection to be selected and set up,
parameters must be defined for all the required connections. These
parameters are stored in lists which together permit the right con-
nection to be set up. The PBX uses the PPP (Point-to-Point Pro-
tocol) for ISDN access, and PPPoE (Point-to-Point Protocol over
Ethernet) for access over T-DSL. The traffic on these two Internet
connections is monitored separately by the PBX.

Special modem for data transmission using DSL access technology.

A DSL splitter is a device that splits the data or frequencies of vari-
ous applications that run via a subscriber line or distribution point,
and provides this via separate connections.

Euro ISDN contains service indicates with defined names. Some of
these have only historical meaning. In general, you should choose
the "Telephony" service for "real" telephone calls. If this selection
does not work (depends on network operator), you can try "speech”,
"audio 3k1Hz" or "telephony 3k1Hz". The same applies for faxing.
Here, too, there is the collective term "Fax" plus a couple of more
specific cases. From a purely technical point of view, the services
are bits in a data word evaluated by means of a mask. If you include
several bits in the mask, all these services are approved for activa-
tion, while in the case of just one bit, it is just the one selected ser-
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vice.

Three-party confer- A three-way telephone call. Performance feature in T-Net, T-ISDN
ence and your PBX.

10 Base 2 Thin Ethernet connection. Network connection for 10-mbps net-
works with BNC connector. T-connectors are used for the connec-
tion of equipment with BNC sockets.

100Base-T Twisted pair connection, Fast Ethernet. Network connection for
100-mbps networks.

10Base-T Twisted pair connection. Network connection for 10-mbps networks
with RJ45 connector.

1TR6 D channel protocol used in the German ISDN. Today the more com-
mon protocol is DSSH1.

3DES (Triple DES)  See DES.

802.11al/g Specified data rates of 54, 48, 36, 24, 18, 12, 9 and 6 mbps and a
working frequency in the range of 5 GHz (for IEEE802.11a) or 2.4
GHz (for IEEE802.11g). IEEE802.11 g can be configured to run in
compliance with 11b or 11b and 11 as well.

802.11b/g One of the IEEE standards for wireless network hardware. Products
that meet the same IEEE standard can communicate with each oth-
er, even if they come from different hardware manufacturers. The
IEEE802.11b standard specifies the data rates of 1, 2, 5.5 and 11
mbps, a working frequency in the range of 2.4 to 2.4835 GHz and
WEP encryption. IEEE802.11 wireless networks are also known as
Wi-Fi networks.

A-subscriber The A-subscriber is the caller.

a/b interface For connection of an analogue terminal. In the case of an ISDN ter-
minal (terminal adapter) with a/b interface, the connected analogue
terminal is able to use the supported T-ISDN performance features.

AAA Authentication, Authorisation, Accounting
Access code PIN or password
Access list A rule that defines a set of packets that should or should not be

transmitted by the device.

Access point An active component of a network consisting of wireless parts and
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Analogue terminals

Analogue voice
transmission

Answering machine

Glossary

optionally also of wired parts. Several WLAN clients (terminals) can
log in to an access point (AP) and communicate via the AP data. If
the optional wired Ethernet is connected, the signals between the
two physical media, the wireless interface and wired interface, are
bridged (bridging).

Filters can be used to prevent external persons from accessing the
data on the computers in your LAN. These filters are a basic func-
tion of a firewall.

Recording of connection data, e.g. date, time, connection duration,
charging information and number of data packets transferred.

Active probing takes advantage of the fact that as standard, access
points are to respond to client requests. Clients therefore send
"probe requests" on all channels and wait for responses from an ac-
cess point in the vicinity. The response packet then contains the
SSID of the wireless LAN and information on whether WEP encryp-
tion is used.

An ad hoc network refers to a number of computers that form an in-
dependent 802.11 WLAN each with a wireless adapter. Ad hoc net-
works work independently without an access point on a peer-to-peer
basis. Ad hoc mode is also known as IBSS mode (Independent Ba-
sic Service Set) and makes sense for the smallest networks, e.g. if
two notebooks are to be linked to each other without an access
point.

Asymmetric digital subscriber line
Authentication header

Display unit e.g. for T-Concept PX722 system telephone, able to
display letters and other characters as well as digits.

For the connection of analogue terminals such as telephone, fax
and answering machine.

Terminals that transmit voice and other information analogously,
e.g. telephone, fax machine, answering machine and modem.

To transmit voice via the telephone, acoustic oscillations are conver-
ted to continuous electrical signals, which are transmitted via a net-
work of lines (digital voice transmission).

You configure an analogue answering machine under "Terminal
Type".
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AOC-D
AOC-D/E
AOC-E
ARP

Assignment

Asynchronous

ATM

Attention tone

Authentication

Authorisation

Automatic callback

Automatic callback
on busy

Automatic callback
on busy (CCBS)
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Display during and at end of connection.
Advice of charge-during/end.

Display only at end of connection.
Address Resolution Protocol

An external call can be signalled to internal subscribers. The entries
in the "Day" option and "Night" option can be different.

A method of data transmission in which the time intervals between
transmitted characters can vary in length. This allows computers
and peripheral devices to intercommunicate without being synchron-
ised by clock signals. The beginning and end of the transmitted
characters must be marked by start and stop bits — in contrast to
synchronous transmission.

Asynchronous transfer mode

Superimposing of an acoustic signal during a telephone call e.g. for
call waiting.

Check on the user's identify.

Based on the identity (authentication), the user can access certain
services and resources.

Special feature on telephones: By pressing a key or code, the caller
requests a call back from the engaged terminal. If the subscriber
you want is not at their desk or cannot take the call, they are auto-
matically connected with the caller as soon as they have used the
telephone again and replaced the receiver.

This function can only be used on telephones that permit suffix dial-
ling. An automatic callback from an inquiry connection is not pos-
sible.

You urgently need to contact a business partner or internal sub-
scriber. However, when you call, you always hear the engaged tone.
If you were to receive notification that the subscriber had ended the
call, your chance of reaching them would be very good. With "Call-
back on Busy" you can reach the engaged subscriber once they
have replaced the receiver at the end of the call. Your telephone
rings. When you lift the receiver, a connection to the required sub-
scriber is set up automatically. An internal "Callback on Busy" is de-
leted automatically after 30 minutes. The external "Callback on
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Busy" is deleted after a period specified by the exchange (approx.
45 minutes). Manual deletion before this period has elapsed is also
possible.

You urgently need to contact a business partner or internal sub-
scriber. When you call them, you always hear the ringing tone, but
your business partner is not close to the telephone and does not
pick up. With "Callback on no reply", you can reach the subscriber
as soon as they have completed a call or lifted and replaced the re-
ceiver of their telephone. Your telephone rings. When you lift the re-
ceiver, a connection to the required subscriber is established auto-
matically.

You can activate ShortHold. When you do so, you define the time
after which an existing connection is cleared if data transfer is no
longer taking place. If you enter a time of 0, ShortHold is deactiv-
ated.

After the receiver of a telephone is lifted, the telephone number of
the external subscriber can be dialled immediately.

Performance feature of a terminal. If the line is busy, several redial
attempts are made.

Corresponds to a telephone line in T-Net. In T-ISDN, the basic con-
nection contains two B channels, each with a data transmission rate
of 64 kbps.

Bearer channel of an ISDN Basic Rate Interface or a Primary Rate
Interface for the transmission of traffic (voice, data). An ISDN Basic
Rate Interface consists of two B channels and one D channel. A B
channel has a data transmission rate of 64 kbps. The data transmis-
sion rate of an ISDN Basic Rate Interface with your gateway can be
increased to up to 128 kbps using channel bundling.

Bandwidth Allocation Control Protocols (BACP/BAP in accordance
with RFC 2125)

Central unit of wireless telephone devices. There are two different
types: The simple base station is used to charge the handheld unit.
For special-feature telephones, the base station can also be used as
a telephone, the handheld unit is charged using separate charging
stations.

ISDN connection that includes two basic channels (B channels)
each with 64 kbps and one control and signalling channel (D chan-
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nel) with 16 kbps. The two basic channels can be used independ-

ently of each other for each service offered in the T-ISDN. You can
therefore telephone and fax at the same time. T-Com offers the Ba-
sic Rate Interface as a point-to-multipoint or point-to-point connec-
tion.

Blacklist (dialling You can define a restriction on external dialling for individual sub-

ranges) scribers. The telephone numbers entered in the blacklist table can-
not be called by the terminals subject to dialling control, e.g. entry
0190 would block all connections to expensive service providers.

Block Cipher Modes Block-based encryption algorithm

Blowfish An algorithm developed by Bruce Schneier. It relates to a block
cipher with a block size of 64 bit and a key of variable length (up to
448 bits).

Bluetooth Bluetooth is a wireless transfer technology that can connect up dif-

ferent devices. Bluetooth replaces cables to connect various devices
e.g. Notebook, PC, PDA, etc. Thanks to Bluetooth, these devices
can exchange data with each other without a fixed connection. For
example, PCs, notebooks or a PDA can access the Internet or a loc-
al network. The appointments on a PDA can be synchronised with
the appointments on the PC without the need for a cable connec-
tion. Because of the many different application areas for the
Bluetooth technology, the different types of connections between the
devices are divided into profiles. A profile determines the service
(function) that the individual Bluetooth clients can use among each

other.
BOD Bandwidth on Demand
BootP Bootstrap protocol
Bps Bits per second. A unit of measure for the transmission rate.
Break-in In a PBX, the option of breaking in to an existing call. This is sig-

nalled acoustically by an attention tone.
BRI Basic Rate Interface

Bridge Network component for connecting homogeneous networks. As op-
posed to a gateway, bridges operate at layer 2 of the OSI model,
are independent of higher-level protocols and transmit data packets
using MAC addresses. Data transmission is transparent, which
means the information contained in the data packets is not inter-
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preted.

Broadcasts (data packages) are sent to all devices in a network in
order to exchange information. Generally, there is a certain address
(broadcast address) in the network that allows all devices to inter-
pret a message as a broadcast.

Brokering makes it possible to switch between two external or in-
ternal subscribers without the waiting subscriber being able to hear
the other conversation.

Program for displaying content on the Internet or World Wide Web.

A data transmission medium for use by all the devices connected to
a network. Data is forwarded over the entire bus and received by all
devices on the bus.

Certificate Authority

By allocating a calendar, you switch between Day and Night call as-
signment. For each day of the week, you can select any day/night
switching time. A calendar has four switch times, which can be spe-
cifically assigned to each individual day of the week.

In a PBX, calls can be assigned to certain terminals.

You can set up a "call costs account" for a subscriber here. The
maximum available number of units, in the form of a limit, can be as-
signed to each subscriber on their personal "call costs account". The
"cost limit" is to be activated so that units can be booked. Once the
units have been used up, no further external calls are possible. In-
ternal calls can still be made at any time. The units are booked to
the account each time a call is ended.

Also known as call forwarding. An incoming call is diverted to a spe-
cified telephone, Internet or wireless connection.

Performance feature e.g. of the T-Concept PX722 system tele-
phone, special-feature telephones or answering machines. The call
is only signalled in the case of certain previously defined telephone
numbers.

You can only use the options of call forwarding in the exchange via
the keypad if certain services are activated for your connection. You
can receive more information on this from your T-Com advisor. The
exchange connects the calling subscriber with an external sub-
scriber you have specified.
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Call forwarding in  The call forwarding (CF) performance feature of the PBX enables

the PBX you to be reached even if you are not in the vicinity of your tele-
phone. You achieve this by automatically forwarding your calls to
the required internal or external telephone number. You can use the
configuration program to define whether call forwarding should be
carried out in the PBX or the exchange. You should use call for-
warding in the exchange if certain services are activated for your
connection. You can receive more information on this from your T-
Com advisor.

Call option day/night Option of changing the call allocation on a PBX using a calendar.
Calls received after office hours are forwarded to a telephone still
manned, or to the answering machine or fax.

Call pickup Performance feature of a PBX. Calls can be received on an internal
terminal that is not part of active call allocation.

Call pickup An external call is only signalled for your colleague. As you belong
to several different teams, this is not surprising. You can now form
various groups of subscribers in which call pickup is possible. A call
can only be picked up by subscribers/terminals in the same pickup
group. The assignment of subscribers in pickup groups is not de-
pendent on the settings in the Day and Night team call assignment.

Call Relay on Busy Reject

Call Through Call Through is a dial-in via an external connection to the PBX with
the call put through from the PBX via another external connection.

Call to engaged sub- Busy on busy
scriber

Call waiting The "Call Waiting" performance feature means that other people can
contact you during a telephone call. If another subscriber calls while
you are on the telephone, you hear your telephone's call waiting
tone. You can then decide whether to continue with your first call or
speak to the person whose call is waiting.

Call waiting protec- If you do not want to use the call waiting feature, you switch on call
tion waiting protection. If you are taking a call, a second caller hears the
engaged tone.

Callback on Busy Performance feature in T-ISDN, PBXs and T-Net. A connection is
set up automatically as soon as the Busy status on the destination
connection ends. When the connection is free, this is signalled to
the caller. As soon as the caller lifts the receiver, the connection is
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set up automatically. However, Callback must first be activated by
the caller on his or her terminal.

Callback on no reply You call a subscriber, who does not pick up. With "Callback on no

reply", this is not a problem for you, because with this special fea-
ture, you can set up the connection without having to redial. If you
are not on the telephone yourself, a new connection with the sub-
scriber is set up - for a maximum of 180 minutes.

Called party number Number of the terminal called.

Caller list

Special-feature telephones such as the T-Concept PX722 system
telephone enable call requests to be stored during absence.

Calling party numberNumber of the calling terminal.

CAPI

CAST

CBC
CCITT

CD (Call Deflection)

Central speeddial
memory

Certificate
Channel Bundling
CHAP

Checksum field

CLID

Common ISDN Application Programming Interface

A 128-bit encryption algorithm with similar functionality to DES. See
Block Cipher Modes.

Cipher Block Chaining
Consultative Committee for International Telegraphy and Telephony

The forwarding of calls. This performance feature enables you to
forward a call without having to take it yourself. If you forward a call
to an external subscriber, you bear any connection costs from your
connection to the destination of the forwarded call. This feature can
therefore be used by system telephones and ISDN telephones that
support this function (see user's guide for terminals). For more in-
formation on using this performance feature with the telephone,
please see the user's guide.

Performance feature of a PBX. Telephone numbers are stored in a
PBX and can be called from every connected telephone using a key
combination.

Certificate

Channel bundling

Challenge Handshake Authentication Protocol
Frame Check Sequence (FCS)

Calling Line Identification

Glossary



Glossary Funkwerk Enterprise Communications GmbH

Client A client uses the services provided by a server. Clients are usually
workstations.

CLIP Abbreviation for Calling Line Identification Presentation. Telephone
number display of calling party.

CLIR Abbreviation for Calling Line Identification Restriction. Temporary
suppression of the transmission of the calling party's telephone
number.

COLR Connected Line Identification Restriction (suppress B telephone

number). This performance feature permits or suppresses the dis-
play of the called subscriber's telephone number. If display of the B
telephone number is suppressed, your telephone number is not
transmitted to the caller when you take a call. Example: You have
set up call diversion to another terminal. If this terminal has activ-
ated suppression of the B telephone number, the calling party does
not see a telephone number on the terminal display.

Combination device If an analogue terminal connection of the PBX is set up as a "multi-
functional port" for combination devices, all calls are received, re-
gardless of the service. In the case of trunk prefixes using codes,
the service ID "Analogue Telephony" or "Telefax Group 3" can also
be transmitted, regardless of the configuration of the analogue con-
nection. If 0 is dialled, the service ID "Analogue Telephony" is also
transmitted.

Conference call Performance feature of a PBX: Several internal subscribers can
telephone simultaneously. Three-party conferences are also pos-
sible with external subscribers.

Configuration Man- Windows application (similar to the Windows Explorer), which uses

ager SNMP commands to request and carry out the settings of your gate-
way. The application was called the DIME Browser before BRICK-
ware version 5.1.3.

Configuration of the One important prerequisite for the transfer of your configuration to
PBX with the PC the PBX is that you have set up a connection between the PC and
PBX. You can do this using the LAN Ethernet connection.

Configuration of the With some restrictions, you can also program your PBX using the
PBX with the tele- telephone. For information on programming your PBX using the tele-
phone phone, please see the accompanying user's guide.

Connection of ana- The performance features for analogue terminals can only be used
logue terminals with terminals that use the MFC dialling method and that have an R
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or flash key.

The internal telephone number of the connection, and not the ex-
ternal number (multiple subscriber number) must be entered as the
MSN in the ISDN terminal connected to the internal ISDN bus. See
the user's guide for the ISDN terminals: Enter MSN. Please note
that not all the ISDN terminals available on the market can use the
performance features provided by the PBX via their key interface.

Cyclic Redundancy Check

Computer Telephony Integration. Term for connection between a
PBX and server. CTl enables PBX functions to be controlled and
evaluated by a PC.

Control and signalling channel of an ISDN Basic Rate Interface or
Primary Rate Interface. The D channel has a data transmission rate
of 16 kbps. In addition to the D channel, each ISDN BRI has two B
channels.

A process for reducing the amount of data transmitted. This enables
higher throughput to be achieved in the same transmission time. Ex-
amples of this technique include STAC, VJHC and MPPC.

(DLL)

A data packet is used for information transfer. Each data packet
contains a prescribed number of characters (information and control
characters).

The data transmission rate specifies the number of information units
for each time interval transferred between sender and recipient.

A self-contained data packet that is forwarded in the network with
minimum protocol overhead and without an acknowledgement
mechanism.

Abbreviation for Data Exchange Jedermann, the T-Online access
platform. Local dial-in node in every local network. Some German
cities offer additional high-speed access over T-Net/T-Net-ISDN.

If you want to transfer important calls made after office hours to your
home office to an answering machine, so that you are not disturbed,
you can use call assignment. You can allocate each subscriber two
different call allocations (call assignment Day and call assignment
Night). With call assignments, it is also possible to forward the call to
an external subscriber, so that you can be contacted at all times.
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Day/Night/Calendar
DCE
DCN

Default gateway
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With call assignment Day/Night, therefore, you define which internal
terminals are to ring in the event of an external call. Call assignment
Day/Night is achieved using a table in which all the incoming calls
are assigned to internal subscribers.

You define switching of call variant Day/Night.
Data Circuit-Terminating Equipment
Data communications network

Describes the address of the gateway to which all traffic not
destined for its own network is sent.

Denial-Of-Service At-A Denial-of-Service (DoS) attack is an attempt to flood a gateway or

tack

DES

Destination number
memory

DHCP

Dial preparation

Dial-in parameters

Dialling control

Dialup connection

DIME
DIME Browser

Direct dial-in

Direct dialling range

Display and output
of connection data

host in a LAN with fake requests so that it is completely overloaded.
This means the system or a certain service can no longer be run.

Data Encryption Standard

Speeddial memory

Dynamic Host Configuration Protocol

On some telephones with a display, you can first enter a telephone,
check it first, and then dial it.

Define the dial-in parameters i.e. you enter the provider's dial-in
number and specify:

In the configuration for certain terminals, you can define restrictions
for external dialling.

A connection is set up when required by dialling an extension num-
ber, in contrast to a leased line.

Desktop Internetworking Management Environment
Old name for Configuration Manager.

Performance feature of larger PBXs at the point-to-point connection:
The extensions can be called directly from outside.

See Extension numbers range

In the configuration, it is possible to define storage of data records
for specific terminals or all terminals. In the ex works setting, all in-
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Display of caller's
number

DLCI

DMz

DNS

Do not disturb
DOl

Domain

Door intercom

Door intercom on

Glossary

coming external connections and all external calls you make are
stored.

A suitable telephone is a prerequisite for this feature. Transmission
of the telephone number must be permitted by the caller.

In a Frame Relay network, a DLCI uniquely describes a virtual con-
nection. Note that a DLCI is only relevant for the local end of the
point-to-point connection.

Demilitarised Zone
Domain Name System
Station guarding
Domain of Interpretation

A domain refers to a logical group of devices in a network. On the
Internet, this is part of a naming hierarchy (e.g. bintec.de).

Door intercom device. It can be connected to various PBXs. A tele-
phone can be used to take an intercom call and open the door.

An analogue connection can be set up for connected of function

analogue connectionmodule M06 to connect a DoorLine intercom system.

Door terminal ad-
apter

Dotted Decimal
Notation

Downstream

DSA (DSS)

The function module can be installed on an analogue connection of
your PBX. If a door intercom (DoorLine) is connected to your PBX
via a function module, you can speak with a visitor at the door via
every authorised telephone. You can assign particular telephones to
each ring button. These phones then ring if the ring button is
pressed. On analogue telephones, the signal on the telephone
matches the intercom call. In place of the internal telephones, an ex-
ternal telephone can also be configured as the call destination for
the ring button. Your door intercom can have up to 4 ring buttons.
The door opener can be pressed during an intercom call. It is not
possible activate the door opener if an intercom call is not taking
place.

The syntactic representation of a 32-bit whole number, written in
four 8-bit numbers in decimal form and subdivided by a point. It is
used to represent IP addresses on the Internet, e.g. 192.67.67.20

Data transmission rate from the ISP to the customer.

Digital Signature Algorithm (Digital Signature Standard).
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DSL/xDSL
DSS1

DSSS

DTE
DTMF

Dynamic IP address

E1/T1

ECB

ECT

Email
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Digital Subscriber Line
Digital Subscriber Signalling System

Direct Sequence Spread Spectrum is a wireless technology that was
originally developed for the military and offers a high level of protec-
tion against faults because the wanted signal is spread over a wide
area. The signal is spread by means of a spread sequence or chip-
ping code consisting of 11 chips across 22 MHz. Even if there is a
fault on one or more of the chips during transfer, the information can
still be obtained reliably from the remaining chips.

Data Terminal Equipment
Dual Tone Multi Frequency (tone dialling system)

In contrast to a static IP address, a dynamic IP address is assigned
temporarily by DHCP. Network components such as the web server
or printer usually have static IP address, while clients such as note-
books or workstations usually have dynamic IP addresses.

E1: European variant of the 2.048 mbps ISDN Primary Rate Inter-
face, which is also called the E1 system.

Electronic Code Book mode

Explicit Call Transfer. This performance feature allows two external
connections to be transferred without blocking the two B channels of
the exchange connection.

Electronic mail

Emergency numbers You urgently need to contact the policy, fire brigade or another tele-

Encapsulation

phone number. To make things worse, all the connections are busy.
However, you have informed your PBX of the telephone numbers
that need to be contactable in an emergency. If you now dial one of
these numbers, it is recognised by the PBX and a B channel of the
T-ISDN is automatically freed up for your emergency call. Emer-
gency calls are not subject to configuration restrictions. If "Calling
with prefix plus code number" is set for a a connection, the internal
connection is busy. To make an external call, first dial 0 and then
the required emergency number.

Encapsulation of data packets in a certain protocol for transmitting
the packets over a network that the original protocol does not dir-
ectly support (e.g. NetBIOS over TCP/IP).
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Encryption
Entry of external

connection data

ESP

ESS

Ethernet

Ethernet connec-
tions

Eumex Recovery

Euro ISDN

Eurofile transfer

Exchange

Exchange access
right

Extended redialling

Extension

Glossary

Refers to the encryption of data, e.g. MPPE.

In the ex works setting, all external connections made and received
via your PBX are recorded and stored in the form of connection data
records.

Encapsulating Security Payload

The Extended Service Set describes several BSS (several access
points) that form a single, logical wireless network.

A local network that connects all devices in the network (PC, print-
ers, etc.) via a twisted pair or coaxial cable.

The 4 connections are led equally through an internal switch. Net-
work clients can be directly connected to the connection sockets.
The ports are designed as 100/BaseT full-duplex, autosensing, auto
MDIX upwardly compatible to 10/Base T. Up to 4 SIP telephones or
IP softclients with SIP standard can be directly connected to PCs
with a network card.

If the power supply to the PBX cuts out while new firmware is being
loaded, the PBX functions are deleted.

Harmonised ISDN standardised within Europe, based on signalling
protocol DSS1, the introduction of which network operators in over
20 European countries have committed to. Euro-ISDN has been in-
troduced in Germany, replacing the previous national system 1 TR6.

Communication protocol for the exchange of files between two PCs
over ISDN using an ISDN card (file transfer) or telephones or PBXs
configured for this.

Node in the public telecommunication network. We differentiate
between local exchanges and remote exchanges.

PBXs differentiate between the following "exchange access rights".
These can be set up differently for each subscriber in the configura-
tion.

A selected telephone number is "parked" in the telephone's memory.
It can be redialled later, even if you have called other numbers in the
meantime.

For PBXs, describes the terminal (e.g. telephone) connected to the
exchange. Each extension can access PBX services and commu-
nicate with other extensions.
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Extension number An extension is an internal number for a terminal or subsystem. In
point-to-point ISDN accesses, the extension is usually a number
from the extension numbers range assigned by the telephone pro-
vider. In point-to-multipoint connections, it can be the MSN or a part
of the MSN.

Extension numbers (direct dialling range)
range

Fall Back: Priority of The priority of the Internet provider entries is defined by the se-

the Internet provider quence in which they are entered in the list. The first entry of a DSL

entries connection is the standard access. If a connection cannot be set up
via the standard access after a predefined number of attempts,
setup is attempted using the second entry then subsequent entries.
If the final entry in the list does not enable a connection to be set up
successfully, the operation is terminated until a new request is
made. When fall back occurs and all other ISPs can only be reached
by dialup connections, both B channels may be occupied. If channel
bundling is used, you cannot be reached for the duration of this con-
nection.

Fax Abbreviation of telefax.

FHSS, Frequency In a FHSS system, the frequency spread is achieved through con-

Hopping Spread stantly changing frequencies based on certain hopping patterns. In

Spectrum contrast to DSSS systems, hopping patterns are configured, not the
frequency. The frequency changes very frequently in one second.

File transfer Data transmission from one computer to another, e.g. based on the
Eurofile transfer standard.

Filter A filter comprises a number of criteria (e.g. protocol, port number,
source and destination address). These criteria can be used to se-
lect a packet from the traffic flow. Such a packet can then be
handled in a specific way. For this purpose, a certain action is asso-
ciated with the filter, which creates a filter rule.

Firewall Describes the whole range of mechanisms to protect the local net-
work against external access. Your gateway provides protection
mechanisms such as NAT, CLID, PAP/CHAP, access lists, etc.

Firmware Software code containing all a device's functions. This code is writ-
ten to a PROM (programmable read only memory) and is retained
there, even after the device is switched off. Firmware can be up-
dated by the user when a new software version is available
(firmware upgrade).
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First-level domain

Flash key

Follow-me

Fragmentation

Frame

Frame relay

Freecall

FTP

Full duplex

Function keys

G.991.1
G.991.2

G.992.1

G.992.1 Annex A

G.992.1 Annex B

G.SHDSL

Glossary

Describes the last part of a name on the Internet. For
www.t-com.de, the first-level domain is de and in this case stands
for Germany.

The flash key on a telephone is the R button. R stands for
Ruckfrage (inquiry). The key interrupts the line briefly to start certain
functions such as inquiries via the PBX.

Performance feature of a PBX for diverting calls on the destination
telephone.

Process by which an IP datagram is divided into small parts in order
to meet the requirements of a physical network. The reverse pro-
cess is known as reassembly.

Unit of information sent via a data connection.

A packet switching method that contains smaller packets and fewer
error checks than traditional packet switching methods such as
X.25. Because of its properties, frame relay is used for fast WAN
connections with a high density of traffic.

Telephone number. Previous service 0130. These telephone num-
bers have been switched to freecall 0800 since January 1, 1998.

File Transfer Protocol

Operating mode in which both communication partners can commu-
nicate bidirectionally at the same time.

Keys on the telephone that can be assigned telephone numbers or
network functions.

Data transmission recommendation for HDSL
Data transmission recommendation for SHDSL

Data transmission recommendation for ADSL. See also G.992.1 An-
nex A and G.992.1 Annex B.

Data transmission recommendation for ADSL: ITU-T G.992.1 Annex
A

Data transmission recommendation for ADSL: ITU-T G.992.1 Annex
B

See G.991.2.
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Gateway

Half duplex

Handheld unit

Hands free

Hashing

HDLC
HDSL
HDSL2

Headset

HMAC

HMAC-MD5

HMAC-SHA1

Holding a call

Holding in the PBX
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Entrance and exit, transition point

Bidirectional communication method in which it is only possible to
either send or receive at a particular point in time. Also known as
Simplex.

Mobile component of wireless telephone units. In the event of digital
transmission, it is also possible to make telephone calls between the
handheld units (DECT).

If the telephone has a microphone and speaker installed, you can
conduct a call without using your hands. As a result, other people in
the room can also participate in the call.

The process of deriving a number (hash) from a character string. A
hash is generally far shorter than the text flow it was derived from.
The hashing algorithm is designed so that there is a relatively low
probability of generating a hash that is the same as another hash
generated from a text sequence with a different meaning. Encryption
methods use hashing to make sure that intruders cannot change
transmitted messages.

High Level Data Link Control
High Bit Rate DSL
High Bit Rate DSL, version 2

Combination of headphones and microphone as a useful aid for
anyone who makes a lot of telephone calls and wants to keep hands
free for making notes.

Hashed Message Authentication Code

Hashed Message Authentication Code - uses Message Digest Al-
gorithm Version 5.

Hashed Message Authentication Code - uses Secure Hash Al-
gorithm Version 1.

A telephone call is put on hold without breaking the connection
(inquiry/brokering).

Both B channels of the ISDN connection are needed for the per-
formance features "Call another person during a call" and "Speak al-
ternately with two people" (brokering). As a result, you cannot be
reached from outside or make external calls via your PBX's second
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Hook flash

Host name

HTTP

Hub

IAE
ICMP
ICV

Identify malicious
callers (intercept)

IEEE

IETF

Index

Infrastructure mode

Glossary

B channel. With this setting, an external caller put on hold hears the
PBX's on-hold music.

The use of the inquiry, brokerage and three-party conference spe-
cial features in T-Net and certain performance features of some
PBXs is only possible with the hook flash function (long flash) of the
signal key on the telephone. On modern telephones, this key is in-
dicated with an "R".

A name used in IP networks instead of the corresponding address.
A host name consists of an ASCII string that uniquely identifies the
host computer.

HyperText Transfer Protocol

Network component used to connect several network components
together to form a local network (star-shaped).

ISDN connection unit, ISDN connection socket.
Internet Control Message Protocol
Integrity Check Value

You have to request this performance feature from T-Com. The
company will provide you with further information on the procedure.
If you enter code 77 during a call or after the caller has ended a call
(you hear the engaged tone from the exchange), the caller's tele-
phone number is stored in the exchange. ISDN telephones can also
use separate functions for this performance feature. For more in-
formation on this function, please see your user's guide.

The Institute of Electrical and Electronics Engineers (IEEE). A large,
global association of engineers, which continuously works on stand-
ards in order to ensure different devices can work together.

Internet Engineering Task Force

The index from 0...9 is fixed. Every external multiple subscriber
number entered is assigned to an index. You need this index when
configuring performance features using the telephone's codes, e.g.
configuring "Call forwarding in the exchange" or "Define telephone
number for the next external call".

A network in infrastructure mode is a network that contains at least
one access point as the central point of communication and control.
In a network in infrastructure mode, all clients communicate with
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each other via access points only. There is no direct communication
between the individual clients. A network of this kind is also known

as a BSS (basic service set), and a network that consists of several
BSS is known as an ESS (extended service set). Most wireless net-
works operate in infrastructure mode to establish a connection with

the wired network.

Inquiry Makes it possible to put the first call on hold in the event of a call
waiting and take a new call.

Internal call tone Special signal on a PBX to differentiate between internal and extern-
al calls.

Internal calls Free-of-charge connection between terminals in a PBX.

Internal telephone  Your PBX has a fixed internal telephone number plan.

numbers

Internet The Internet consists of a number of regional, local and university
networks. The IP protocol is used for data transmission on the Inter-
net.

Internet time sharing Allows several users to surf the Internet simultaneously over an
ISDN connection. The information is requested by the individual
computers with a time delay.

Intranet Local computer network within a company based on Internet techno-
logy providing the same Internet services, e.g. homepages and
sending email.

IP Internet Protocol

IP Address The first part of the address by which a device is identified in an IP
network, e.g. 192.168.1.254. See also netmask.

IPComP IP payload compression

IPCONFIG A tool used on Windows computers to check or change its own IP
settings.

IPoA IP over ATM

ISDN Integrated Services Digital Network

ISDN address The address of an ISDN device that consists of an ISDN number fol-

lowed by further numbers that relate to a specific terminal, e.g.
47117.
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ISDN Basic Rate In-
terface

ISDN card

ISDN Login

ISDN number

ISDN router

ISDN-BRI

ISDN-Dynamic

ISDN-Intern-
al/External

ISDN-PRI
ISO
ISP
ITU

Key Escrow

LAN

Glossary

ISDN subscriber connection. The Basic Rate Interface consists of
two B channels and one D channel. In addition to the Basic Rate In-
terface, there is the Primary Rate Interface. The interface to the sub-
scriber is provided by an So bus.

Adapter for connecting a PC to the ISDN Basic Rate Interface. From
a technical perspective, we differentiate between active and passive
cards. Active ISDN cards have their own processor, which handles
communication operations independently of the PC processor and
therefore does not require any resources. A passive ISDN card, on
the other hand, uses the PC's resources.

Function of your gateway. Your gateway can be configured and ad-
ministrated remotely using ISDN Login. ISDN Login operates on
gateways in the ex works state as soon they are connected to an
ISDN connection and therefore reachable via an extension number.

The network address of the ISDN interface, e.g. 4711.

A router that does not have network connections but provides the
same functions between PC, ISDN and the Internet.

ISDN Basic Rate Interface

This performance feature requires the installation of the T-ISDN
Speedmanager. If you are surfing the Internet and use two B chan-
nels for downloading, you cannot be reached by telephone from out-
side. As a further call is signalled over the D channel, your PBX can,
depending on the setting, specifically shut down a B channel so that
you can take the call.

Alternative name for the So bus.

ISDN Primary Rate Interface

International Standardization Organization
Internet Service Provider

International Telecommunication Union

Stored keys can be viewed by the government. The US government,
in particular, requires key storages to prevent crimes being covered
up through data encryption.

Local Area Network
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LAPB

Last access

Layer 1

LCD

LCP
LDAP

Lease Time

Leased Line
LLC

Local exchange

Loudspeaker

MAC Address

Man-in-the-Middle
Attack

MD5
MFC
MIB

Microphone mute
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Link Access Procedure Balanced

The last access by T-Service is stored and displayed in the configur-
ation.

Layer 1 of the ISO OSI Model, the bit transfer layer.

Liquid Crystal Display, a screen in which special liquid crystal is
used to display information.

Link Control Protocol
Lightweight Directory Access Protocol

The "Lease Time" is the time a computer keeps the IP address as-
signed to it without having to "talk" to the DHCP server.

Leased line
Link Layer Control

Switching node of a public local telephone network that supports the
connection of end systems.

Function on telephones with an integrated loudspeaker: You can
press a button so that the people present in the room can also hear
the telephone call.

Every device in the network is defined by a fixed hardware address
(MAC address). The network card of a device defines this interna-
tionally unique address.

Encryption using public keys requires the public keys to be ex-
changed first. During this exchange, the unprotected keys can be in-
tercepted easily, making a "man-in-the-middle" attack possible. The
attacker can set a key at an early stage so that a key known to the
"man-in-the-middle" is used instead of the intended key from the
real communication partner.

See HMAC-MD5
Multifrequency code dialling method
Management Information Base

Switch for turning off the microphone. The subscriber on the tele-
phone cannot hear the discussions in the room.



Funkwerk Enterprise Communications GmbH

Mixed mode

MLPPP

Modem

MPDU

MPPC

MPPE

MSDU

MSN

MSSID

MTU

Multicast

Multiple subscriber

number

Multiprotocol gate-

way

Glossary

The access point accepts WPA and WPA2.
Multilink PPP
Modulator/Demodulator

MAC Protocol Data Unit - every information packet exchanged on
the wireless medium includes management frames and fragmented
MSDUs.

Microsoft Point-to-Point Compression
Microsoft Point-to-Point Encryption

MAC Service Data Unit - a data packet that ignores fragmentation in
the WLAN.

Multiple subscriber number
See SSID
Maximum Transmission Unit

A specific form of broadcast in which a message is simultaneously
transmitted to a defined user group.

Multiple subscriber number

A gateway that can route several protocols, e.g. IP, X.25, etc.

Music on hold (MoH) Your PBX has two internal music-on-hold melodies. On delivery, in-

ternal melody 1 is active. You can choose between melody 1 or 2, or
deactivate the music on hold.

Music on hold (MoH) Performance feature of a PBX. During an inquiry or call forwarding,

Mwi

NAT

NDIS WAN

a melody is played that the waiting subscriber hears. On your PBX,
you can choose between two internal melodies.

Transmission of a voice message from a mailbox e.g. T-NetBox or
MailBox to a terminal. The receipt of the message on the terminal is
signalled e.g. by a LED.

Network Address Translation

NDIS WAN is a Microsoft enhancement of this standards in relation
to wide area networking (WAN). The NDIS WAN CAPI driver per-
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mits the use of the ISDN controller as a WAN card. The NDIS WAN
driver enables the use of a DCN network on Windows. NDIS is the
abbreviation for Network Device Interface Specification and is a
standard for the connection of network cards (hardware) to network
protocols (software).

Net surfing A "journey of discovery" for interesting information in wide-ranging
data networks such as T-Online. Known mainly from the Internet.

NetBIOS Network Basic Input Output System

Netmask The second part of an address in an IP network, used for identifica-
tion of a device, e.g. 255.255.255.0. See also IP address.

Network Your PBX has a DSL router so that one or more PCs can surf the In-
ternet and download information.

Network address A network address designates the address of a complete local net-
work.

Network termination In telecommunications, the network termination is the point at which
(NTBA) access to a communication network is provided to the terminal.

Netz-Direkt (keypad You can use the "Netz-Direkt" (keypad) function (automatic external

functions) line access) to enter a key sequence from your ISDN or analogue
telephone to use current T-ISDN functions. For more information on
this, consult your T-Com client advisor and request the necessary
codes (e.qg. call forwarding in the exchange).

NMS Network Management Station

Notebook function During a telephone call, a telephone number can be entered in the
telephone's buffer so that it can be dialled at a later point in time.

NT Network Termination

NTBA Network Termination for Basic Access

NTP Network Time Protocol

OAM Operation and Maintenance

Offline Without connection. Connectionless operating state e.g. of the PCs.
Online With connection. For example the state of a connection between a

PC and data network or for data exchange between two PCs.

Online banking Term for electronic banking e.g. using T-Online.
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Online Pass

Online services

OSI model
OSPF

Outgoing extension
number signal

Outgoing telephone
number

Packet switching
PAP

Parking

PBX

PBX

PBX
PBX

PBX number

Glossary

Part of the T-Com certification services for the Internet. Digital pass
for the Internet. With the Online Pass, an Internet user can be au-
thenticated as a customer in a company.

Services available around the clock via communication services
such as T-Online and the Internet.

OSI = Open Systems Interconnection
Open Shortest Path First

The "outgoing extension number signal” is intended for internal con-
nections on the point-to-point to which an explicit extension number
was not assigned. When an external call is made, the extension
number entered under Outgoing Extension Number Signal is also
transmitted.

If you have not suppressed transmission of your telephone number,
and the telephone of the person you are calling supports the CLIP
function, the person you are calling can see the telephone number
of the connection you are calling from on their telephone display.
This telephone number transmitted during an external call is called
the outgoing telephone number.

Packet switching
Password Authentication Protocol

The call is held temporarily in the exchange. The main difference to
on hold: The call is interrupted, the receiver can be replaced. Can
be used for brokering. Possible in T-Net, T-ISDN and PBXs. The ter-
minal must have MFC and the R key.

Private Branch Exchange

The features offered by a PBX are manufacturer-specific and enable
operation of exchanges, free internal calls, callback on busy, and
conference calls, among other things. PBXs are used e.g. for office
communication (voice, text and data transfer).

Private Branch Exchange (PBX)
Private Automatic Branch Exchange

A point-to-point ISDN access includes a PBX number and an exten-
sion numbers range. The PBX number is used to reach the PBX. A
certain terminal of the PBX is then dialled via one of the extension
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numbers of the extension numbers range.

PCMCIA The PCMCIA (Personal Computer Memory Card International Asso-
ciation) is an industry association founded in 1989 that represents
credit card-sized 1/O cards such as WLAN cards.

PDM Abbreviation for pulse dialling method. Conventional dialling proced-
ure in the telephone network. Dialled numbers are represented by a
defined number of dc impulses. The pulse dialling method is being
replaced by the multifrequency code method (MFC) .

PGP Pretty Good Privacy
PH Packet handler
Phone book The PBX has an internal phone book. You can store up to 300 tele-

phone numbers and the associated names. You can access the
PBX's phone book with the funkwerk devices (for example CS 410).
You add entries to the phone book using the configuration interface.

PIN Personal identification number
Ping Packet Internet Groper
PKCS Public Key Cryptography Standards

Point-to-multipoint  Point-to-multipoint connection

Point-to-multipoint Basic connection in T-ISDN with three telephone numbers and two
lines as standard. The ISDN terminals are connected directly on the
network termination (NTBA) or ISDN internet connection of a PBX.

Point-to-multipoint  Point-to-multipoint

Point-to-multipoint  You enter the multiple subscriber numbers received from T-Com

connection for the  with the order confirmation in the table fields defined for them in the

PBX configuration. As a rule, you receive three multiple subscriber num-
bers, but can apply for up to 10 telephone numbers for each con-
nection. When you enter the telephone numbers, they are assigned
to an "index" and also to a team. Note that initially, all telephone
numbers are assigned to team 00. The internal telephone numbers
10, 11 and 20 are entered in team 00 ex works. External calls are
therefore signalled with the internal telephone numbers 10, 11 and
20 for the connections entered in team 00.

Point-to-point Point-to-point
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Point-to-point ISDN
access

Polling

Port
POTS
PPP

PPP authentication

PPPoA
PPPOE
PRI

Primary Rate Inter-
face (PRI)

Protocol

Proxy ARP
PSN

PSTN
PVID

R key

RADIUS
RADSL

RAS

Glossary

Point-to-point

Fax machine function that "fetches" documents provided by other
fax machines or fax databases.

Input/output

Plain Old Telephone System

Point-to-Point Protocol

Security mechanism. A method of authentication using passwords in
PPP.

Point to Point Protocol over ATM
Point to Point Protocol over Ethernet
Primary Rate Interface

ISDN subscriber connection. The PRI consists of one D channel and
30 B channels (in Europe). (In America: 23 B channels and one D
channel.) There is also the ISDN Basic Rate Interface.

Protocols are used to define the manner and means of information
exchange between two systems. Protocols control and rule the
course of data communication at various levels (decoding, address-
ing, network routing, control procedures, etc.).

ARP = Address Resolution Protocol
Packet Switched Network

Public Switched Telephone Network
Port VLAN ID

Telephones that have a R key (inquiry key) can also be connected
to a PBX. In modern telephones, the R key triggers the hook flash
function. This is required for use of performance features in T-Net
such as inquiry/brokering and three-party conference.

Remote Authentication Dial In User Service
Rate-Adaptive Digital Subscriber Line

Remote access service
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Real Time Clock Hardware clock with buffer battery
(RTC)
Receiver volume Function for controlling the volume in the telephone receiver.

Reconnection on the For a point-to-multipoint connection, enables the terminal connec-
bus (parking) tion to be reconnected to another ISDN socket during the telephone
call.

Recording telephone Performance feature of an answering machine. Enables a conversa-

calls tion to be recorded during the telephone call.
Remote Remote, as opposed to local.

Remote access Opposite to local access, see Remote.
Remote CAPI bintec's own interface for CAPI.

Remote diagnosis/re-Some terminals and PBXs are supported and maintained by T-
mote maintenance Service support offices over the telephone line, which often means a
service engineer does not have to visit the site.

Remote query Answering machine function. Involves listening to messages re-
motely, usually in connection with other options such as deleting
messages or changing recorded messages.

Repeater A device that transmits electrical signals from one cable connection
to another without making routing decisions or carrying out packet
filtering. See Bridge and Router.

Reset Resetting the PBX enables you to return your system to a pre-
defined initial state. This may be necessary if you have made incor-
rect configuration settings or the PBX is to be reprogrammed.

RFC Specifications, proposals, ideas and guidelines relating to the Inter-
net are published in the form of RFCs (request for comments).

Rijndael (AES) Rijndael (AES) was selected as AES due to its fast key generation,
low memory requirements and high level of security against attacks.
For more information on AES, see ht-
tp://csrc.nist.gov/encryption/aes.

RIP Routing Information Protocol

RipeMD 160 RipeMD 160 is a cryptographic hash function with 160 bits. It is re-
garded as a secure replacement for MD5 and RipeMD.
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Room monitoring
(acoustic)

Room monitoring
from external tele-
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from internal tele-
phones
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RSA

RTSP
S2M interface

SAD

SDSL

Server

Glossary

Plug or socket for maximum eight wires. Connection for digital ter-
minals.

In a multicell WLAN, clients can move freely and log off from one ac-
cess point and log on to another when moving through cells, without
the user noticing this. This is known as roaming.

To use the "Room Monitoring" performance feature, the telephone
must be activated in the room to be monitored by means of a code,
and the receiver must be lifted or "Hands-free" switched on. If you
replace the telephone receiver or turn off "Hands-free", room mon-
itored ends and the performance feature is switched off.

This function can be used to monitor rooms from an external tele-
phone.

You can acoustically monitor a room from an internal telephone in
your PBX. This is set up using the telephone procedures described
in the user's guide. Please read the information on the described
functions in the user's guide.

A device that connects different networks at layer 3 of the OSI mod-
el and routes information from one network to the other.

The RSA algorithm (named after its inventors Rivest, Shamir, Adle-
man) is based on the problem of factoring large integers. It therefore
takes a large amount of data processing capacity and time to derive
a RSA key.

Real-Time Streaming Protocol
See Primary Rate Interface.

The SAD (=Security Association Database) contains information on
security agreements such as AH or ESP algorithms and keys, se-
quence numbers, protocol modes and SA life. For outgoing IPSec
connections, an SPD entry refers to an entry in the SAD i.e. the
SPD defines which SA is to be applied. For incoming IPSec connec-
tions, the SAD is queried to determine how the packet is to be pro-
cessed.

Symmetric Digital Subscriber Line

A server offers services used by clients. Often refers to a certain
computer in the LAN, e.g. DHCP server.
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ServerPass Part of the T-Com certification services for the Internet. Digital pass
for a company. With the ServerPass, T-Com confirms that a server
on the Internet belongs to a particular company and that this was
verified through the presentation of an excerpt from the business re-
gister.

Service 0190 Additional voice service from T-Com for the commercial distribution
of private information services. The T-Com services are limited to
providing the technical infrastructure and collection processing for
the information providers. The provided information is accessed us-
ing the telephone number 0190 which is uniform across Germany
plus a 6-digit telephone number. Information offering: Entertainment,
weather, finance, sport, health, support and service hotlines.

Service 0700 Additional voice service from T-Com. Allows calls to be received via
a location-independent telephone number uniform across Germany,
starting with the numbers 0700. Free-of-charge routing to national
fixed network. Enhancement with Vanity possible.

Service 0900 Additional voice service from T-Com. Replaces Service 0190.

Service number 0180 Additional voice service 0180call from T-Com to receive calls from a
location-dependent telephone number uniform across Germany,
starting with the numbers 0180.

Setup Tool Menu-driven tool for the configuration of your gateway. The Setup
Tool can be used as soon as the gateway has been accessed
(serial, ISDN Login, LAN).

SHA1 See HMAC-SHA.
SHDSL Single-Pair High-Speed
Short hold Is the defined amount of time after which a connection is cleared if

no more data is transmitted. Short hold can be set to static (fixed
amount of time) or dynamic (according to charging information).

Signalling Simultaneous signalling: All assigned terminals are called simultan-
eously. If a telephone is busy, call waiting can be used.

Simplex operation  This connection can only be used for an ISDN telephone (only T-

(ISDN subscribers  Concept PX722 system telephones) with a simplex function. If you

only) call an ISDN telephone with a simplex function, this automatically
activates the Loudspeaker function so that a conversation can take
place immediately. Please see the information on the telephone
user's guide on the simplex operation function.
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SMS receipt

SMS server tele-
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SNMP
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So connection
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Session Initiation Protocol
Short Message Service

If you have connected an SMS-enabled terminal, you can decide
whether SMS receipt is to be permitted for the connection. The ex
works setting is no SMS receipt. To receive an SMS with your SMS-
enabled terminal, you must register once with the T-Com SMS Ser-
vice. One-time registration is free. You simply send an SMS contain-
ing ANMELD to the destination call number 8888. You then receive
a free-of-charge confirmation of registration from the T-Com SMS
Service. You can deregister your device or telephone number by
sending an SMS containing ABMELD to the destination number
8888. Incoming SMS are then read out. Information on which tele-
phones are SMS-enabled can be obtained from T-Punkt, our cus-
tomer hotline 0800 330 1000 or on the Internet at ht-
tp://www.t-com.de.

You can connect SMS-enabled telephones to your PBX and thus
use the SMS performance feature in the T-Com fixed network.
SMSs are forwarded to the recipient via the T-Com SMS server. To
send an SMS with an SMS-enabled terminal, the telephone number
0193010 of the SMS server must be prefixed to the recipient num-
ber. This telephone number is already stored in your PBX, so manu-
al input of the server telephone is not necessary and does not need
to be sent from the telephone. To receive an SMS with your SMS-
enabled fixed-network telephone, you must register once with the
Deutsche Telekom SMS Service. Charges are made for sending
SMSs. There are no costs for receiving SMSs.

Simple Network Management Protocol
Input level for SNMP commands.

All ISDN sockets and the NTBA of an ISDN point-to-multipoint con-
nection. All So buses consist of a four-wire cable. The lines transmit
digital ISDN signals. The So bus is terminated with a terminating
resistor after the last ISDN socket. The So bus starts at the NTBA
and can be up to 150 m long. Any ISDN devices can be operated on
this bus. However, only two devices can use the So bus at any one
time, as only two B channels are available.

See ISDN Basic Rate Interface

Internationally standardised interface for ISDN systems. This inter-
face is provided on the network side by the NTBA . On the user
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side, the interface is intended for connecting a PBX (point-to-point
connection) and for connecting up to eight ISDN terminals
(point-to-multipoint connection).

Small Offices and Home Offices

The SPD (=Security Policy Database) defines the security services
available for IP traffic. These security services are dependent on
parameters such as the source and destination of the packet etc.

Performance features of the T-Net and T-ISDN networks such as
display of the caller's number, callback on busy, call forwarding,
changeable connection lock, changeable telephone number lock,
connection without dialling and transmission of charge information.
Availability depends on the standard of the connected terminals.

T-ISDN Basic Rate Interface with an extensive range of services:
call waiting, call forwarding, third-party conference, display of call
costs at the end of a connection, inquiry/brokering, telephone num-
ber transmission. In the special-features connection, three multiple
subscriber numbers are included as standard.

If you want to make a business call late in the evening from your
private sphere - say the living room - for example, you can define
your business telephone number as the outgoing multiple subscriber
number (MSN) for this call. The advantages of this are that the costs
for the connection are recorded for the selected MSN and the per-
son you are calling can identify you by the transferred MSN. Before
you call an external number, you can define which of your telephone
numbers is to be sent to the exchange and called party. You make
the selection using the telephone number index.

A speeddial index (000...299) can be assigned to each of the 300
telephone numbers in the telephone book. You then dial this speed-
dial index instead of the long telephone number. Note that telephone
numbers dialled using the speeddial function must also comply with
the dialrule.

Service Profile Identifier

The splitter separates data and voice signals on the DSL connec-
tion.

Technique for reducing data traffic (and thus saving costs), espe-
cially in WANSs.
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SSID

SSL

STAC
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The Service Set Identifier (SSID) or Network Name refers to the
wireless network code based on IEEE 802.11.

Secure Sockets Layer A technology, now standard, developed by
Netscape, which is generally used to secure HTTP traffic between a
web browser and a web server.

Data compression procedure.

Standard connection T-ISDN Basic Rate Interface with the performance features Inquiry/

Static IP address
Station guarding

Subaddressing

Subnet

Subnet mask

Subscriber Name

Suppress A-
telephone number
(CLIR)

Suppress B tele-
phone number
(COLR)

Brokering and Telephone Number Transmission. The standard con-
nection contains three multiple subscriber numbers.

A fixed IP address, in contrast to a dynamic IP address.
Deactivation of acoustic call signalling: do not disturb.

In addition to the transmission of ISDN telephone numbers, addition-
al information in the form of a subaddress can be transmitted from
the caller to the called party over the D channel when the connec-
tion is set up. Addressing that goes beyond the pure MSN, which
can be used e.g. specifically to locate several ISDN terminals that
can be reached on one telephone number for a particular service. In
the called terminal - e.g. a PC - various applications can also be ad-
dressed and in some cases executed. Costs are charged for the
performance feature, and it must be requested separately from the
network operator.

A network scheme that divides individual logical networks into smal-
ler physical units to simplify routing.

A method of splitting several IP networks into a series of subgroups
or subnetworks. The mask is a binary pattern that must match the IP
addresses in the network. 255.255.255.0 is the default subnet mask.
In this case, 254 different IP addresses can occur in a subnet, from
X.X.X.1 to x.x.x.254.

To distinguish between connections more easily, you can assign a
subscriber name for each internal subscriber.

CLIP/CLIR: Calling line identification presentation/calling line identi-
fication restriction

COLP/COLR: Connected line identification presentation/connected
line identification restriction = Activate/suppress transmission of
called party's telephone number to caller. This performance feature
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suppresses the display of the called subscriber's telephone number.
If display of the B telephone number is suppressed, your telephone
number is not transmitted to the caller when you take a call.

Suppress own tele- Temporary deactivation of the transmission of your own telephone
phone number number.

Suppression of the Performance feature of a PBX. The display of the telephone number
telephone number can be deactivated on an individual basis.

Switch LAN switches are network components with a similar function to
bridges or even gateways. They switch data packets between the in-
put and output port. In contrast to bridges, switches have several in-
put and output ports. This increases the bandwidth in the network.
Switches can also be used for conversion between networks with
different speeds (e.g. 100-mbps and 10-mbps networks).

Switchable dialling Option of switching between the pulse dialling method and MFC
method method by means of a switch or key input on the terminal, such as
the telephone or fax machine.

Synchronous Transmission process in which the sender and receiver operate with
exactly the same clock signals — in contrast to asynchronous trans-
mission. Spaces are bridged by a stop code.

Syslog Syslog is used as the de facto standard for transmitting log mes-
sages in an IP network. Syslog messages are sent as unencrypted
text messages over the UDP port 514 and collected centrally. They
are usually used to monitor computer systems.

System telephones Telephone that belongs to a modern PBX, which - depending on the
PBX - has a number of special features and keys, e.g. the T-
Concept PX722.

T-DSL Product name used by Deutsche Telekom AG for its DSL services
and products.

T-Fax Product name for T-Com fax machines.

T-ISDN Telephony, faxing, data transfer and online services from one net-
work and a single connection: T-ISDN offers exciting services with
numerous benefits, for example a point-to-multipoint connection -
the ideal solution for families or small businesses. This connection
option, which can be used with the existing telephone cable, costs
less than two telephone connections but offers far greater quality
and ease of use: Two independent lines, so that you can still make a
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T-NetBox

T-NetBox telephone
number

T-Online

T-Online software

T-Service

T-Service access

TA

TAPI
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phone call, receive a fax, or surf the Internet when another family
member is making a long call on the other line. Three or more tele-
phone numbers, which you can assign individually to your devices
and distribute differently if needed through simple programming
steps. Most ISDN telephones can "manage" several telephone num-
bers, so you can set up a "central" telephone in your household, for
example, to allow you to react to calls to all ISDN telephone num-
bers with this telephone. The fax and telephone in your home office
can also each be assigned a number, as can your son or daughter's
phone. As a result, each family member can be contacted with a
separate number, helping to eliminate "day-to-day friction"! And as
far as the costs are concerned, on request you can have your bill
broken down to show which units have been charged for the indi-
vidual ISDN telephone numbers.

The digital telephone network of T-Com for connecting analogue ter-
minals.

The answering machine in T-Net and T-ISDN. The T-NetBox can
store up to 30 messages.

Enter the current T-NetBox telephone number here if it differs from
the 08003302424 entered ex works. As soon as your T-NetBox re-
ceives a voice or fax message, notification is sent to your PBX.

Umbrella term the T-Com online platform. Offers services such as e-
mail and Internet access.

T-Com software decoder for all conventional computer systems that
enables access to T-Online. Supports all functions such as KIT, e-
mail and the Internet with a browser. T-Online users receive this
software free of charge.

T-Service carries out all installation work and configurations for the
PBX at the customer's request. The service ensures optimum voice
and data transmission at all times thanks to maintenance work.

T-Service access enables you to have your PBX configured by T-
Service. Give T-Service a call! Get advice and provide information
on your configuration requirements. T-Service will then configure
your PBX remotely without you having to do anything.

Terminal Adapter

Telephony Application Program Interface
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You can use the TAPI configuration to modify the TAPI driver in line
with the program that uses this driver. You can check which MSN is
to be assigned to a terminal, define a line name, and configure the
dialling parameters. First configure your PBX. You must then config-
ure the TAPI interface. Use the "TAPI Configuration" program.

Transmission Control Protocol

Transmission Control Protocol/Internet Protocol
Telecommunication connection unit

Terminal equipment

Terminal Endpoint Identifier

Term that describes the remote copying for transmitting texts,
graphics and documents true to the original over the telephone net-
work.

Telematics is a combination of telecommunication and computer
technology and describes data communication between systems
and devices.

Protocol from the TCP/IP protocol family. Telnet enables communic-
ation with a remote device in the network.

Device for interface adaptation. It enables different equipment to be
connected to T-ISDN. The terminal adapter a/b is used to connect
analogue terminals to the So interface of the ISDN Basic Rate Inter-
face. Existing analogue terminals can still be operated with tone di-
alling.

Trivial File Transfer Protocol

Tiger 192 is a relatively new and very fast hash algorithm.
Transport Layer Security

Multifrequency code method (MFC)

If you receive an internal call, e.g. from the subscriber with internal
telephone number 22, while you are away, this subscriber's internal
telephone number is stored in your telephone's caller list. However,
because your connection is automatically set to Automatic Outside
Line as a result of the ex works settings, you would first have to dial
** for a callback in order to obtain the internal dialling tone, and then



Funkwerk Enterprise Communications GmbH
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22. If "Transfer Internal Code" is active, ** is placed before the 22
and the callback can be made directly from the caller list.

The number of bits per second transmitted in T-Net or T-ISDN from

the PC or fax machine. Fax machines achieve up to 14.4 kbps, mo-
dems 56 kbps. In the ISDN, data and fax exchange with 64 kbps is
possible. With T-DSL, up to 8 mbps can be received and up to 768

kbps sent.

Terminal Selection Digit

TTL stands for Time to Live and describes the time during which a
data packet is sent between the individual servers before it is dis-
carded.

Twofish was a possible candidate for the AES (Advanced Encryp-
tion Standard). It is regarded as just as secure as Rijndael (AES),
but is slower.

Universal Asymmetric Digital Subscriber Line
User Datagram Protocol

Update to a software program (PBX firmware). An update is the up-
dated version of an existing software product, and is indicated by a
new version number.

Data transfer during online connections, where files are transferred
from the user's PC to another PC or to a data network server.

Universal Plug and Play

Data transmission rate from the client to the ISP.
Universal/Uniform Resource Locator

Universal Serial Bus

Electronic user guidance that takes the user through the required
functions of a terminal such as a telephone, answering machine or
fax machine step by step (menu-guided operation).

This function is only possible for system telephones and ISDN tele-
phones.

ITU-T recommendation for balanced dual-current interface lines (up
to 10 mbps).
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CCITT and ITU-T recommendation that defines the interface
between a PC or terminal as Data Terminal Equipment (DTE) and a
modem as Data Circuit-terminating Equipment (DCE).

ITU-T recommendation for unbalanced dual-current interface line.

ITU-T recommendation for data transmission at 48kbps in the range
from 60 to 108kHz.

Modem for V.35.
Data compression procedure.

ITU standard for 56 kbps analogue modems. In contrast to older
V.34 modems, data is sent in digital form to the client when the V.90
standard is used and does not need to be first converted from digital
to analogue on one side of the modem (provider), as was the case
with V.34 and earlier modems. This makes higher transmission
rates possible. A maximum speed of 56 kbps can be achieved only
under optimum conditions.

Letter dialling

Very high bit rate digital subscriber line (also called VADSL or BD-
SL).

VLAN ID

Van Jacobson Header Compression

Virtual LAN

Voice over IP

Virtual Private Network

Virtual Service Set

Wide Area Network

WAN interface

Remote station that is reached over a WAN, e.g. ISDN.

Server that provides documents in HTML format for access over the
Internet (WWW).

T-Online service with which e-mails can be sent and received world-
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wide on the Internet by means of a browser.
Wired Equivalent Privacy

(also known as RJ-45 plug) Plug used for ISDN terminals with eight
contacts. Developed by the US telephone company Western Bell.
Western plugs for analogue telephones have four or six contacts.

A graphical tool on Windows 95, 98 and Millennium that uses Win32
API to view and configure the IP address configuration of com-
puters.

A group of computers wirelessly connected to each other (wireless
LAN).

Wireless multimedia
Wi-Fi-protected access

Concentrates primarily on the needs of companies and offers secure
encryption and authentication. Uses 802.1x and the Extensible Au-
thentication Protocol (EAP) and thus offers an effective means of
user authentication.

Intended for private users or small businesses that do not run a
central authentication server. PSK stands for Pre-Shared Key and
means that AP and client use a fixed character string (8 to 63 char-
acters) known to all subscribers as the basis for key calculation for
wireless traffic.

World Wide Web

The X.21 recommendation defines the physical interface between
two network components in packet-switched data networks (e.g. Da-
tex-P).

The X.21bis recommendation defines the DTE/DCE interface to V-
series synchronous modems.

An internationally agreed standard protocol that defines the interface
between network components and a packet-switched data network.

ITU-T recommendation on the integration of X.25-compatible DTEs
in ISDN (D channel).

ITU-T standards that cover user directory services, see LDAP. Ex-
ample: The phone book is the directory in which you find people on



X.509

the basis of their name (agreement with the telephone directory).
The Internet supports several databases with information on users,
such as e-mail addresses, telephone numbers and postal ad-
dresses. You can search these databases to obtain information
about individuals.

ITU-T standards that define the format of the certificates and certific-
ate queries and their use.

R 1xxx/B3xxx/R4xxx
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